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Regulatory Compliance

Thermo Electron San Jose performs complete testing and evaluation of its products to ensure full 
compliance with applicable domestic and international regulations. When your system is 
delivered to you, it meets all pertinent electromagnetic compatibility (EMC) and safety standards 
as follows:

EMC issues have been evaluated by EMC TECHNOLOGY SERVICES, A Subsidiary of 
UNDERWRITERS LABORATORY, INC (UL)

Safety Compliance
Low Voltage Directive EN 61010-1:2001

Please be aware that any changes that you make to your system may void compliance with one or 
more of these EMC and/or safety standards.
Making changes to your system includes replacing a part. Thus, to ensure continued compliance 
with EMC and safety standards, replacement parts should be ordered from Thermo Electron or 
one of its authorized representatives.

FCC Compliance Statement

Note: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy. If it is not installed and used in accordance with the instruction manual, it may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference. In this case, the user will be required to correct the 
interference at his/her own expense.

EMC Certification

EN 55011 (1998) EN 61000-4-4 (1995)

EN 61326 (1998) EN 61000-4-5 (1995)

EN 61000-4-2 (1998) EN 61000-4-6 (1996)

EN 61000-4-3 (1996) EN 61000-4-11 (1994)

ENV 50204 (1995) FCC Class A
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Notice on Lifting and Handling of
Thermo Electron San Jose Instruments

For your safety, and in compliance with international regulations, the physical handling of this 
Thermo Electron San Jose instrument requires a team effort for lifting and/or moving the 
instrument. This instrument is too heavy and/or bulky for one person alone to handle safely.

Notice on the Proper Use of
Thermo Electron San Jose Instruments

In compliance with international regulations: If this instrument is used in a manner not 
specified by Thermo Electron San Jose, the protection provided by the instrument could be 
impaired.
TE SJ - 8 April 2003



Contents

�������������	
��
�_____________________________________________________________________
Contents

Read This First ........................................................................................................................... vii

Changes to the Manual and Online Help ............................................................................................. viii

Abbreviations ......................................................................................................................................... ix

Typographical Conventions ................................................................................................................. xiii
Data Input ...........................................................................................................................  xiii
Boxed Information..............................................................................................................  xiv
Topic Headings....................................................................................................................  xv

Safety Precautions ................................................................................................................................ xvi

Solvent and Gas Purity Requirements ................................................................................................ xviii

Service Philosophy ............................................................................................................................... xix

Level of Repair ..................................................................................................................................... xix

Reply Cards ........................................................................................................................................... xx

Introduction ............................................................................................................................... 1-1

1.1 Ion Polarity Modes..................................................................................................................... 1-3

1.2 Ionization Techniques ................................................................................................................ 1-4

1.3 Scan Power and Scan Modes ..................................................................................................... 1-5
MS Scan Mode .................................................................................................................... 1-5
MSn and MS/MS Scan Modes............................................................................................. 1-5

1.4 Scan Types ................................................................................................................................. 1-6
Full Scan.............................................................................................................................. 1-6
Selected Ion Monitoring ...................................................................................................... 1-7
Selected Reaction Monitoring ............................................................................................. 1-8
Data-Dependent Neutral Loss MSn ..................................................................................... 1-8
ZoomScan............................................................................................................................ 1-9

1.5 Data Types................................................................................................................................ 1-10
Profile Data Type............................................................................................................... 1-10
Centroid Data Type............................................................................................................ 1-10
____________________ Finnigan LCQ Series Hardware Manual_______________________  i������
���������������	�
��



Contents

_____________________________________________________________________ �������������	
��
�
Functional Description ............................................................................................................. 2-1

2.1 Autosampler............................................................................................................................... 2-3

2.2 Liquid Chromatograph .............................................................................................................. 2-4

2.3 Syringe Pump ............................................................................................................................ 2-5

2.4 Divert/Inject Valve..................................................................................................................... 2-6

2.5 MS Detector............................................................................................................................... 2-7
Controls and Indicators ....................................................................................................... 2-7
API Source .........................................................................................................................2-11
Ion Optics.......................................................................................................................... 2-14
Mass Analyzer................................................................................................................... 2-17
Ion Detection System........................................................................................................ 2-22
Vacuum System and Inlet Gasses Hardware..................................................................... 2-24
Cooling Fans ..................................................................................................................... 2-32
Electronic Assemblies....................................................................................................... 2-32

2.6 Data System............................................................................................................................. 2-47
Computer Hardware and Software.................................................................................... 2-47
Data System / MS Detector Interface ............................................................................... 2-47
Data System / Local Area Network Interface ................................................................... 2-48
Printer................................................................................................................................ 2-48

Preparing for Daily Operation ................................................................................................ 3-1

3.1 Checking the Disk Space........................................................................................................... 3-2

3.2 Checking the Helium and Nitrogen Supplies ............................................................................ 3-3

3.3 Checking the System Vacuum Levels ....................................................................................... 3-4

3.4 Printing a Hard Copy of the Status View .................................................................................. 3-6

LCQ Advantage MAX MS Detector Maintenance ................................................................ 4-1

4.1 Tools and Supplies..................................................................................................................... 4-4

4.2 Frequency of Cleaning............................................................................................................... 4-5

4.3 API Source Maintenance ........................................................................................................... 4-6
Flushing the Sample Transfer Line, Sample Tube, and API Probe .................................... 4-6
Flushing the Spray Shield, Ion Sweep Cone, Spray Cone, and Ion Transfer Capillary...... 4-8
Clearing the Bore of the Ion Transfer Capillary ............................................................... 4-10
Maintaining the API Stack .................................................................................................4-11
������
���������������	�
��ii _______________________ Finnigan LCQ Series Hardware Manual ____________________



Contents

�������������	
��
�_____________________________________________________________________
4.4 Cleaning the Ion Optics and Mass Analyzer............................................................................ 4-21
Shutting Down the System ................................................................................................ 4-21
Removing the Top Cover of the MS Detector................................................................... 4-22
Removing the Top Cover Plate of the Vacuum Manifold ................................................. 4-22
Removing the Ion Optics and Mass Analyzer................................................................... 4-23
Disassembling the Ion Optics and Mass Analyzer ............................................................ 4-25
Cleaning the Ion Optics and Mass Analyzer Parts ............................................................ 4-28
Reassembling the Ion Optics and Mass Analyzer ............................................................. 4-28
Reinstalling the Ion Optics and Mass Analyzer ................................................................ 4-30
Cleaning the Ion Detection System ................................................................................... 4-31
Reinstalling the Top Cover Plate of the Vacuum Manifold............................................... 4-33
Reinstalling the Top Cover of the MS Detector ................................................................ 4-34
Starting Up the System...................................................................................................... 4-34
Tuning the Ring Electrode and Octapole RF Voltages...................................................... 4-34

4.5 Replacing the Electron Multiplier............................................................................................ 4-40

4.6 Purging the Oil in the Forepump.............................................................................................. 4-45

4.7 Replacing the Oil Reservoir in the Turbomolecular Pump...................................................... 4-46
Removing the Turbomolecular Pump................................................................................ 4-46
Changing the Turbomolecular Pump Oil Reservoir .......................................................... 4-47
Reinstalling the Turbomolecular Pump............................................................................. 4-48

4.8 Cleaning the Fan Filter............................................................................................................. 4-49

LCQ Deca XP MAX MS Detector Maintenance .................................................................... 5-1

5.1 Tools and Supplies ..................................................................................................................... 5-4

5.2 Frequency of Cleaning ............................................................................................................... 5-5

5.3 API Source Maintenance ........................................................................................................... 5-6
Flushing the Sample Transfer Line, Sample Tube, and API Probe..................................... 5-6
Flushing the Spray Shield, Ion Sweep Cone, Spray Cone, and Ion Transfer Capillary ...... 5-8
Clearing the Bore of the Ion Transfer Capillary................................................................ 5-10
Maintaining the API Stack ................................................................................................ 5-11

5.4 Cleaning the Ion Optics and Mass Analyzer............................................................................ 5-21
Shutting Down the System ................................................................................................ 5-21
Removing the Top Cover of the MS Detector................................................................... 5-22
Removing the Top Cover Plate of the Vacuum Manifold ................................................. 5-22
Removing the Ion Optics and Mass Analyzer................................................................... 5-23
Disassembling the Ion Optics and Mass Analyzer ............................................................ 5-25
Cleaning the Ion Optics and Mass Analyzer Parts ............................................................ 5-28
____________________ Finnigan LCQ Series Hardware Manual______________________  iii������
���������������	�
��



Contents

_____________________________________________________________________ �������������	
��
�
Reassembling the Ion Optics and Mass Analyzer............................................................. 5-29
Reinstalling the Ion Optics and Mass Analyzer................................................................ 5-30
Cleaning the Ion Detection System................................................................................... 5-33
Reinstalling the Top Cover Plate of the Vacuum Manifold .............................................. 5-33
Reinstalling the Top Cover of the MS Detector................................................................ 5-34
Starting Up the System ..................................................................................................... 5-34
Tuning the Ring Electrode and Quadrupole/Octapole RF Voltages ................................. 5-34

5.5 Replacing the Electron Multiplier ........................................................................................... 5-40

5.6 Purging the Oil in the Forepump ............................................................................................. 5-45
Removing the Turbomolecular Pump ............................................................................... 5-45
Reinstalling the Turbomolecular Pump ............................................................................ 5-47

5.7 Cleaning the Fan Filter ............................................................................................................ 5-48

System Shutdown, Startup, and Reset .................................................................................... 6-1

6.1 Shutting Down the System in an Emergency ............................................................................ 6-2

6.2 Placing the System in Standby Condition ................................................................................. 6-4

6.3 Shutting Down the System Completely..................................................................................... 6-5

6.4 Starting Up the System after a Complete Shutdown ................................................................. 6-7
Starting Up the LC .............................................................................................................. 6-7
Starting Up the Data System............................................................................................... 6-7
Starting Up the MS Detector............................................................................................... 6-7
Starting Up the Autosampler............................................................................................... 6-8
Setting Up Conditions for Operation .................................................................................. 6-9

6.5 Resetting the MS Detector........................................................................................................6-11

6.6 Resetting the Tune and Calibration Parameters to their Default Values ................................. 6-12

6.7 Resetting the Data System....................................................................................................... 6-13
Resetting the Data System by Using the Microsoft Windows XP Shutdown and Restart 

Procedure.................................................................................................................... 6-13
Resetting the Data System by Using the Reset Button on the Personal Computer .......... 6-13

6.8 Turning Off Selected MS Detector Components..................................................................... 6-15

LCQ Advantage MAX Diagnostics and PCB and Assembly Replacement ......................... 7-1

7.1 Running the LCQ Advantage MAX Diagnostics ...................................................................... 7-2

7.2 Replacing a Fuse........................................................................................................................ 7-5
������
���������������	�
��iv ______________________ Finnigan LCQ Series Hardware Manual ____________________



Contents

�������������	
��
�_____________________________________________________________________
7.3 Replacing PCBs and Assemblies in the MS Detector................................................................ 7-8
Replacing Power Supplies in the Tower.............................................................................. 7-8
Replacing PCBs in the Embedded Computer.................................................................... 7-11
Replacing the Vent Delay PCB.......................................................................................... 7-13
Replacing the Electron Multiplier and Conversion Dynode Power Supply, 

Switched Balun PCB, Top Cover PCB, Waveform Amplifier PCB, RF Voltage 
Amplifier PCB, 8 kV Power Supply, and Battery Backup ......................................... 7-15

Replacing the System Control PCB .................................................................................. 7-21
Replacing the RF Voltage Control PCB and the Low Pass Filter PCB............................. 7-23

LCQ Deca XP MAX Diagnostics and PCB and Assembly Replacement ............................ 8-1

8.1 Running the LCQ Deca XP MAX Diagnostics ......................................................................... 8-2

8.2 Replacing a Fuse ........................................................................................................................ 8-5

8.3 Replacing PCBs and Assemblies in the MS Detector.............................................................. 8-10
Replacing Power Supplies in the Tower............................................................................ 8-10
Replacing PCBs in the Embedded Computer.................................................................... 8-15
Replacing the Vent Delay PCB and Backup Battery, Ion Gauge, and Vent Valve ............ 8-17
Replacing the Electron Multiplier and Conversion Dynode Power Supplies, 

Analyzer PCB, Analyzer Auxiliary PCB, Waveform Amplifier PCB, RF 
Voltage Amplifier PCB ............................................................................................... 8-20

Replacing the System Control PCB .................................................................................. 8-25
Replacing the RF Voltage Control PCB ............................................................................ 8-27
Replacing the Low Pass Filter PCB .................................................................................. 8-29

LCQ Advantage MAX Replaceable Parts .............................................................................. 9-1

9.1 MS Detector ............................................................................................................................... 9-2
API Stack............................................................................................................................. 9-2
Ion Optics ............................................................................................................................ 9-3
Mass Analyzer ..................................................................................................................... 9-4
Ion Detection System 

(Electron Multiplier / Conversion Dynode).................................................................. 9-4
Top Cover Plate of Vacuum Manifold................................................................................. 9-5
Divert/Inject Valve (Option)................................................................................................ 9-5
Syringe Pump ...................................................................................................................... 9-5
Turbomolecular Pump ......................................................................................................... 9-5
Forepump............................................................................................................................. 9-6
Vacuum System Assemblies................................................................................................ 9-6
Mechanical Assemblies ....................................................................................................... 9-7
Electrical Assemblies .......................................................................................................... 9-7
Printed Circuit Boards (PCBs) ............................................................................................ 9-8
____________________ Finnigan LCQ Series Hardware Manual_______________________ v������
���������������	�
��



Contents

_____________________________________________________________________ �������������	
��
�
RF Control / Detection Assemblies .................................................................................... 9-8
Cables.................................................................................................................................. 9-9
Covers ............................................................................................................................... 9-10

9.2 Data System – Hardware ..........................................................................................................9-11

9.3 Chemicals Kit .......................................................................................................................... 9-12

9.4 Accessory Kit .......................................................................................................................... 9-13

9.5 Recommended Spares.............................................................................................................. 9-15

9.6 Divert / Inject Valve Accessories............................................................................................. 9-17

9.7 Optional Tools ......................................................................................................................... 9-18

LCQ Deca XP MAX Replaceable Parts ................................................................................ 10-1

10.1 MS Detector............................................................................................................................. 10-2
API Stack .......................................................................................................................... 10-2
Ion Optics.......................................................................................................................... 10-3
Mass Analyzer................................................................................................................... 10-4
Ion Detection System (Electron Multiplier / Conversion Dynode) .................................. 10-4
Top Cover Plate of Vacuum Manifold .............................................................................. 10-5
Divert/Inject Valve (Option) ............................................................................................. 10-5
Syringe Pump.................................................................................................................... 10-5
Turbomolecular Pump....................................................................................................... 10-6
Forepumps......................................................................................................................... 10-6
Vacuum System Assemblies ............................................................................................. 10-6
Mechanical Assemblies..................................................................................................... 10-7
Electrical Assemblies........................................................................................................ 10-7
Printed Circuit Boards (PCBs).......................................................................................... 10-8
RF Control / Detection Assemblies .................................................................................. 10-8
Cables................................................................................................................................ 10-9
Covers ............................................................................................................................. 10-10

10.2 Data System – Hardware ........................................................................................................10-11

10.3 Chemicals Kit ........................................................................................................................ 10-12

10.4 Accessory Kit ........................................................................................................................ 10-13

10.5 Recommended Spares............................................................................................................ 10-15

10.6 Divert / Inject Valve Accessories........................................................................................... 10-17

10.7 Optional Tools ....................................................................................................................... 10-18
������
���������������	�
��vi ______________________ Finnigan LCQ Series Hardware Manual ____________________



Read This First

Welcome to the Thermo Electron, Finnigan LCQ™ Series LC/MS/MS 
system! LCQ Series instruments are members of the Finnigan™ family of MS 
detectors.

This Finnigan LCQ Series Hardware Manual contains a description of the 
modes of operation and principal hardware components of your LCQ Series 
system. In addition, this manual provides step-by-step instructions for 
cleaning and maintaining your LCQ Series MS detector.

The Finnigan LCQ Series Hardware Manual includes the following 
chapters:

Chapter 1: Introduction discusses the ion polarity modes, ionization modes, 
and scan modes of your LCQ Series system.

Chapter 2: Functional Description describes the principal components of 
your LCQ Series system and their respective functions. 

Chapter 3: Preparing for Daily Operation describes the checks of the LCQ 
Series system that you should perform every day before you begin your first 
analysis.

Chapter 4: LCQ Advantage MAX MS Detector Maintenance outlines the 
maintenance procedures that you should perform on a regular basis to 
maintain optimum LCQ Advantage MAX MS detector performance.

Chapter 5: LCQ Deca XP MAX MS Detector Maintenance outlines the 
maintenance procedures that you should perform on a regular basis to 
maintain optimum LCQ Deca XP MAX MS detector performance.

Chapter 6: System Shutdown, Startup, and Reset provides procedures for 
shutting down and starting up the LCQ Series system.

Chapter 7: LCQ Advantage MAX Diagnostics and PCB and Assembly 
Replacement discusses procedures for testing the major electronic circuits 
within the LCQ Advantage MAX MS detector and for replacing failed PCBs 
and assemblies.

Chapter 8: LCQ Deca XP MAX Diagnostics and PCB and Assembly 
Replacement discusses procedures for testing the major electronic circuits 
within the LCQ Deca XP MAX MS detector and for replacing failed PCBs 
and assemblies.

Chapter 9: LCQ Advantage MAX Replaceable Parts lists the replaceable 
parts for the LCQ Advantage MAX MS detector and data system.

Chapter 10: LCQ Deca XP MAX Replaceable Parts lists the replaceable 
parts for the LCQ Deca XP MAX MS detector and data system.
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Changes to the Manual and Online Help
To suggest changes to this manual or the online Help, please send your 
comments to:

Editor, Technical Publications
Thermo Electron San Jose
355 River Oaks Parkway
San Jose, CA 95134-1991
U.S.A.

You are encouraged to report errors or omissions in the text or index. 
Thank you.
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Abbreviations
The following abbreviations are used in this and other manuals and in the 
online Help.

A ampere

ac alternating current

ADC analog-to-digital converter

AP acquisition processor

APCI atmospheric pressure chemical ionization

API atmospheric pressure ionization

ASCII American Standard Code for Information 
Interchange

b bit

B byte (8 b)

baud rate data transmission speed in events per second

°C degrees Celsius

CD compact disc

CD-ROM compact disc read-only memory

cfm cubic feet per minute

CI chemical ionization

CIP carriage and insurance paid to

cm centimeter

cm3 cubic centimeter

CPU central processing unit (of a computer)

CRC cyclic redundancy check

CRM consecutive reaction monitoring

<Ctrl> control key on the terminal keyboard

d depth

Da dalton

DAC digital-to-analog converter

dc direct current

DDS direct digital synthesizer

DEP™ direct exposure probe

DS data system

DSP digital signal processor
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EI electron ionization

EMBL European Molecular Biology Laboratory

<Enter> enter key on the terminal keyboard

ESD electrostatic discharge

ESI electrospray ionization

eV electron volt

f femto (10-15)

°F degrees Fahrenheit

.fasta file extension of a SEQUEST search database file

FOB free on board

ft foot

FTP file transfer protocol

g gram

G giga (109)

GC gas chromatograph; gas chromatography

GC/MS gas chromatograph / mass spectrometer

GND electrical ground

GPIB general-purpose interface bus

GUI graphical user interface

h hour

h height

HPLC high-performance liquid chromatograph

HV high voltage

Hz hertz (cycles per second)

ICIS™ Interactive Chemical Information System

ICL™ Instrument Control Language™

ID inside diameter

IEC International Electrotechnical Commission

IEEE Institute of Electrical and Electronics Engineers

in. inch

I/O input/output

k kilo (103, 1000)

K kilo (210, 1024)

KEGG Kyoto Encyclopedia of Genes and Genomes

kg kilogram
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l length

L liter

LAN local area network

lb pound

LC liquid chromatograph; liquid chromatography

LC/MS liquid chromatograph / mass spectrometer

LED light-emitting diode

µ micro (10-6)

m meter

m milli (10-3)

M mega (106)

M+ molecular ion

MB Megabyte (1048576 bytes)

MH+ protonated molecular ion

min minute

mL milliliter

mm millimeter

MS mass spectrometer; mass spectrometry

MS MSn power: where n = 1

MS/MS MSn power: where n = 2

MSn MSn power: where n = 1 through 10

m/z mass-to-charge ratio

n nano (10-9)

NCBI National Center for Biotechnology Information 
(USA)

NIST National Institute of Standards and Technology 
(USA)

OD outside diameter

Ω ohm

p pico (10-12)

Pa pascal

PCB printed circuit board

PID proportional / integral / differential

P/N part number

P/P peak-to-peak voltage
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ppm parts per million

psig pounds per square inch, gauge

RAM random access memory

RF radio frequency

RMS root mean square

ROM read-only memory

RS-232 industry standard for serial communications

s second

SIM selected ion monitoring

solids probe direct insertion probe

SRM selected reaction monitoring

SSQ® single stage quadrupole

TCP/IP transmission control protocol / Internet protocol

TIC total ion current

Torr torr

TSQ® triple stage quadrupole

u atomic mass unit

URL uniform resource locator

V volt

V ac volts alternating current

V dc volts direct current

vol volume

w width

W watt

WWW World Wide Web

Note. Exponents are written as superscripts. In the corresponding online 
Help, exponents are sometimes written with a caret (^) or with e notation 
because of design constraints in the online Help. For example:

MSn (in this manual) MS^n (in the online Help)

105 (in this manual) 10^5 (in the online Help)
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Typographical Conventions
Typographical conventions have been established for Thermo Electron 
San Jose manuals for the following:

• Data input

• Boxed information

• Topic headings

Data Input

Throughout this manual, the following conventions indicate data input and 
output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is represented in bold face letters. 
(Titles of topics, chapters, and manuals also appear in bold face letters.) 

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled F1.

• Any command that requires pressing two or more keys simultaneously is 
shown with a plus sign connecting the keys. For example, “press 
<Shift> + <F1>” means press and hold the <Shift> key and then press the 
<F1> key.

• Any button that you click on the screen is represented in bold face letters 
and a different font. For example, “click on Close”.
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Boxed Information

Information that is important, but not part of the main flow of text, is 
displayed in a box such as the one below.

Boxed information can be of the following types:

• Note – information that can affect the quality of your data. In addition, 
notes often contain information that you might need if you are having 
trouble.

• Tip – helpful information that can make a task easier.

• Important – critical information that can affect the quality of your data.

• Caution – information necessary to protect your instrument from 
damage.

• CAUTION – hazards to human beings. Each CAUTION is accompanied 
by a CAUTION symbol. Each hardware manual has a blue CAUTION 
sheet that lists the CAUTION symbols and their meanings.

• DANGER – laser-related hazards to human beings. It includes 
information specific to the class of laser involved. Each DANGER is 
accompanied by the international laser radiation symbol.

Note. Boxes such as this are used to display information.
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Topic Headings

The following headings are used to show the organization of topics within a 
chapter:

Chapter 1
Chapter Name

1.2 Second Level Topics

Third Level Topics

Fourth Level Topics

Fifth Level Topics
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Safety Precautions
Observe the following safety precautions when you operate or perform 
service on the MS detector.

Do Not Perform Any Servicing Other Than That Contained in the 
Finnigan LCQ Series Hardware Manual.   

To avoid personal injury or damage to the instrument, do not perform any 
servicing other than that contained in the Finnigan LCQ Series Hardware 
Manual or related manuals unless you are qualified to do so.

Shut Down the MS Detector and Disconnect It From Line Power Before 
You Service It. 

High voltages capable of causing personal injury are used in the instrument. 
Some maintenance procedures require that the MS detector be shut down and 
disconnected from line power before service is performed. Do not operate the 
MS detector with the top or side covers off. Do not remove protective covers 
from PCBs.

Respect Heated Zones.

Treat heated zones with respect. The ion transfer capillary and the APCI 
vaporizer might be very hot and might cause severe burns if they are touched. 
Allow heated components to cool before you service them.

Place the MS Detector in Standby (or Off) Before You Open the 
Atmospheric Pressure Ionization (API) Source.

The presence of atmospheric oxygen in the API source when the MS detector 
is On could be unsafe. (the LCQ Series MS detector automatically turns the 
MS detector Off when you open the API source; however, it is best to take this 
added precaution.)

Make Sure You Have Sufficient Nitrogen For Your API Source.

Before you begin normal operation each day, make sure that you have 
sufficient nitrogen for your API source. The presence of atmospheric oxygen 
in the API source when the MS detector is On could be unsafe. (the LCQ 
Series MS detector automatically turns the MS detector Off when you run out 
of nitrogen, however, it is best to take this added precaution.)

Provide an Adequate Fume Exhaust System and Contain Waste Streams.

It is your responsibility to provide an adequate fume exhaust system. Samples 
and solvents that are introduced into the LCQ Series MS detector will 
eventually be exhausted from the forepump. Therefore, the forepump should 
be connected to a fume exhaust system. Consult local regulations for the 
proper method of exhausting the fumes from your system.
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The API source can accommodate high flow rates. Therefore, provisions must 
be made to collect the waste solvent. The API source is fitted with a 6 mm 
(0.25 in.) ID connector for solvent drainage. A 6 mm (0.25 in.) PVC drain 
tube, which is provided with the system, should be connected between the 
API source and an appropriate collection container. (The waste container can 
be something as simple as an old solvent bottle with a modified cap.)

Do not vent the PVC drain tube (or any vent tubing connected to the waste 
container) to the same fume exhaust system to which you have connected the 
forepump. The analyzer optics can become contaminated if the API source 
drain tube and the (blue) forepump exhaust tubing are connected to the same 
fume exhaust system.

Your laboratory must be equipped with at least two fume exhaust systems. 
Route the (blue) forepump exhaust tubing to a dedicated fume exhaust 
system. Route the PVC drain tube from the API source to the waste container. 
Vent the waste container to a dedicated fume exhaust system.

Use Care When Changing Vacuum Pump Oil.

Treat drained vacuum pump oil and pump oil reservoirs with care. Hazardous 
compounds introduced into the system might have become dissolved in the 
pump oil. Always use approved containers and procedures for disposing of 
waste oil. Whenever a pump that has been operating on a system used for the 
analysis of toxic, carcinogenic, mutagenic, or corrosive/irritant chemicals, the 
pump must be decontaminated by the user and certified to be free of 
contamination before repairs or adjustments are made by a Thermo Electron 
San Jose Customer Support Engineer or before it is sent back to the factory 
for service.
______________________ Finnigan LCQ Series Hardware Manual__________________ xvii������
���������������	�
��



Read This First
Solvent and Gas Purity Requirements _______________________________________ �������������	
��
�
Solvent and Gas Purity Requirements
Use the highest purity solvents available. The LCQ Series MS detector is 
extremely sensitive to solvent impurities. Some solvent impurities are 
transparent to UV/Visible detectors, but are easily detected by the LCQ Series 
MS detector. Liquid chromatography grade is the minimum acceptable purity. 
Higher grade solvents are preferred. Distilled water is recommended. 
Deionized water contains chemicals and is not recommended. 

The following is a list of international sources that can supply high quality 
solvents:

The LCQ Series MS detector uses argon as a collision gas. The argon should 
be high purity (99.995%). The required gas pressure is 135 ± 70 kPa (20 ± 10 
psig). Thermo Electron has found that particulate filters are often 
contaminated and are therefore not recommended.

The LCQ Series MS detector uses nitrogen as a sheath gas and auxiliary gas. 
The nitrogen should be high purity (99%). The required gas pressure is 
690 ± 140 kPa (100 ± 20 PSI).

Solvent Source Telephone Number

Mallinckrodt/Baker, Inc. Tel:  (800) 582-2537
Fax: (908) 859-6905

Burdick & Jackson, Inc. Tel:  (800) 368-0050
Fax: (231) 725-6216

EMD Chemicals, Inc. Tel:  (800) 222-0342
Fax: (856) 423-4389
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Service Philosophy
Servicing the LCQ Series system consists of performing procedures required 
to maintain system performance standards, to prevent system failure, and/or 
to restore the system to an operating condition. Routine and preventive 
maintenance procedures are documented in this manual.

Routine and preventive maintenance are the responsibility of the user during 
and after the warranty period. Regular maintenance will increase the life of 
the system, maximize the up-time of your system, and allow you to achieve 
optimum system performance.

Service not described in this manual should be performed only by a 
Thermo Electron Customer Support Engineer or similarly trained and 
qualified technical personnel.

Level of Repair
Thermo Electron’s service philosophy for LCQ Series systems calls for 
troubleshooting to the lowest part, assembly, PCB, or module listed in the 
Replaceable Parts chapter of this manual.

For mechanical failures: A mechanical assembly typically is to be repaired to 
the level of the smallest item listed in the Replaceable Parts chapter of this 
manual.

For electronic failures: PCBs are not repaired to the component level except 
in certain cases of fuses, relays, etc. When these exceptions occur, the 
components can be found in the Replaceable Parts chapter.
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Reply Cards
Thermo Electron San Jose manuals contain one or two reply cards. All 
manuals contain a Customer Registration / Reader Survey card and some 
contain a Change of Location card. These cards are located at the front of each 
manual.

The Customer Registration / Reader Survey card has two functions. First, 
when you return the card, you are placed on the Thermo Electron San Jose 
mailing list. As a member of this list, you receive application reports and 
technical reports in your area of interest, and you are notified of events of 
interest, such as user meetings. Second, it allows you to tell us what you like 
and do not like about the manual. 

The Change of Location card allows us to track the whereabouts of the 
instrument. Fill out and return the card if you move the instrument to another 
site within your company or if you sell the instrument. Occasionally, we need 
to notify owners of our products about safety or other issues.
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Chapter 1
Introduction

The LCQ Advantage MAX and LCQ Deca XP MAX instruments are 
members of the LCQ™ family of Finnigan™ MS detectors. The Finnigan 
LCQ Series MS detector is an analytical instrument that includes a mass 
spectrometer, a syringe pump, and a data system. See Figure 1-1. In a typical 
LC/MS analysis, a sample is introduced into a high performance liquid 
chromatograph (HPLC) either manually or by an autosampler. The sample is 
carried onto the LC column and separates into its chemical components as it 
moves through the column. The separated chemical components pass through 
a transfer line and then enter the LCQ Series MS detector to be analyzed. You 
can also introduce a sample directly into the MS detector with the syringe 
pump or through the divert/inject valve.

The LCQ Series MS detector consists of an atmospheric pressure ionization 
(API) source, ion optics, mass analyzer, and ion detection system. The ion 
optics, mass analyzer, ion detection system, and part of the API source are 
enclosed in a vacuum manifold. Ionization of the sample takes place in the 
API source. The specific method used to ionize the sample is referred to as the 
ionization technique. The ions produced in the API source are transmitted by 

Figure 1-1. LCQ Advantage MAX system
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the ion optics into the mass analyzer, where they are trapped in stable orbits 
by a time-varying electric field. The polarity of the potentials applied to the 
API source and ion optics determines whether positively charged ions or 
negatively charged ions are transmitted to the mass analyzer. You can 
configure the LCQ Series MS detector to analyze positively or negatively 
charged ions (called the ion polarity mode).

The lenses in the API source and ion optics act as a gate to start and stop the 
transmission of ions from the API source to the mass analyzer. The function 
of these lenses is controlled by an automatic gain control (AGC) that sets 
them to transmit the optimum number of ions to the mass analyzer.

The mass-to-charge ratios of the ions produced in the API source are 
measured by the mass analyzer. Selected ions are ejected from the mass 
analyzer and reach the ion detection system where they produce a signal. The 
signal produced is then amplified by the detection system electronics.

The ion detection system signal is analyzed by the LCQ Series data system. 
The data system serves as the user interface to the MS detector, autosampler, 
LC, and syringe pump. Refer to the online Help for more information on the 
LCQ Series data processing and instrument control software.

Each sequence of loading the mass analyzer with ions followed by mass 
analysis of the ions is called a scan. The LCQ Series MS detector uses several 
different scan modes and different scan types to load, fragment, and eject ions 
from the mass analyzer. The ability to vary the scan mode and scan type, as 
well as the ionization and ion polarity modes, affords the user great flexibility 
for solving complex analytical problems.

This chapter provides an overview of the LCQ Series MS detector. Specific 
topics covered are as follows:

• Ion polarity modes

• Ionization techniques

• Scan modes

• Scan types

• Data types
������
���������������	�
��1-2 ____________________ Finnigan LCQ Series Hardware Manual ____________________



Introduction

�������������	
��
�______________________________________________________ Ion Polarity Modes
1.1 Ion Polarity Modes
You can operate the LCQ Series MS detector in either of two ion polarity 
modes: positive or negative. The MS detector can control whether positive 
ions or negative ions are transmitted to the mass analyzer for mass analysis by 
changing the polarity of the potentials applied to the API source and ion 
optics. The ion optics are located between the API source and the mass 
analyzer.

The information obtained from a positive-ion mass spectrum is different from 
and complementary to that obtained from a negative-ion spectrum. Thus, the 
ability to obtain both positive-ion and negative-ion mass spectra aids you in 
the qualitative analysis of your sample. You can choose the ion polarity mode 
and ionization technique to obtain maximum sensitivity for the particular 
analyte of interest.
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1.2 Ionization Techniques
You can operate the LCQ Series MS detector using any of three ionization 
techniques, as follows: 

• Electrospray ionization (ESI) 

• Atmospheric pressure chemical ionization (APCI)

• Nanospray ionization (NSI)

For information about the theory and implementation of ESI and APCI, refer 
to the Finnigan Ion Max API Source Hardware Manual. For more 
information on NSI, refer to the LCQ Series Nanospray Ion Source 
Operator’s Manual.
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1.3 Scan Power and Scan Modes
Ions that are produced in the ion source are often referred to as parent ions. 
These parent ions can be mass analyzed to produce a mass spectrum. 
Alternatively, by varying the RF voltages of the mass analyzer, the LCQ 
Series MS detector can first eject all ions except for several selected parent 
ions, and then collide these ions with helium that is present in the mass 
analyzer. This helium is known as buffer gas. The collisions of the selected 
precursor ions with the helium can cause them to fragment into product ions. 
The product ions can be mass analyzed.

The number of stages of mass analysis is represented as MSn where n is the 
scan power. (Each stage of mass analysis includes an ion selection step.) The 
higher the scan power, the more structural information is obtained about the 
analyte.

The two scan powers supported by LCQ Advantage MAX in its standard 
configuration are as follows:

• MS scan mode (n = 1)

• MS/MS scan mode (n = 2)

LCQ Deca XP MAX, and LCQ Advantage MAX with special configurations 
support n values of up to 10. 

MS Scan Mode

The MS or mass spectrometry scan mode corresponds to a single stage of 
mass analysis (that is, a scan power of n = 1). The MS scan mode involves 
only parent ions, and no fragmentation of the parent ions takes place. The MS 
scan mode can be a full scan experiment or a selected ion monitoring (SIM) 
experiment (see below).

MSn and MS/MS Scan Modes

The MSn scan corresponds to two or more stages of mass analysis. The MSn 
scan is a special case (n = 2 scan power). The LCQ Advantage MAX MS 
detector can give only MS/MS scans, while the LCQ Deca XP MAX MS 
detector can give scan powers up to n = 10. In an MSn scan, parent ions are 
fragmented into product ions in one or more stages. An MS/MS scan can be a 
full scan experiment or a selected reaction monitoring (SRM) experiment. 
Higher scan powers can be used for full scan experiments, SRM, or 
data-dependent neutral loss experiments (see below).
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1.4 Scan Types 
You can operate the LCQ Series MS detector in the following scan types:

• Full scan

• Selected ion monitoring (SIM)

• Selected reaction monitoring (SRM)

• ZoomScan™

Full Scan

The full scan scan type provides a full mass spectrum of each analyte or 
parent ion. With full scan, in the last step of mass analysis (the ion scan-out 
step) the mass analyzer is scanned from the first mass to the last mass without 
interruption.

Full scan scan type provides more information about an analyte than does 
selected ion monitoring (SIM) or selected reaction monitoring (SRM), but full 
scan does not provide the sensitivity that can be achieved by the other scan 
types.

The full scan scan type includes the following:

• Single-stage full scan

• Two-stage full scan

Single-Stage Full Scan

The single-stage full scan type has one stage of mass analysis (n = 1 scan 
power). With single-stage full scan type, the ions formed in the ion source are 
stored in the mass analyzer. Then, these ions are sequentially scanned out of 
the mass analyzer to produce a full mass spectrum.

Single-stage full scan experiments can be used to determine the molecular 
weight of unknown compounds or the molecular weight of each component in 
a mixture of unknown compounds. For example, you need a full scan to 
determine the molecular weight of each component of a mixture of unknown 
compounds, because you do not know what masses to expect from the 
mixture.

To use the SIM or SRM scan type, you need to know what ions you are 
looking for before you can perform an experiment. Thus, for SIM or SRM 
you can use a full scan to determine the identity of an analyte and obtain its 
mass spectrum. Then, you might use SIM or SRM to do routine quantitative 
analysis of the compound.
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Two-Stage Full Scan

The two-stage full scan type has two stages of mass analysis (n = 2 scan 
power). In the first stage of mass analysis, the ions formed in the ion source 
are stored in the mass analyzer. Then, ions of one mass-to-charge ratio (the 
parent ions) are selected and all other ions are ejected from the mass analyzer. 
The parent ions are excited so that they collide with background gas that is 
present in the mass analyzer. The collisions of the parent ions cause them to 
fragment to produce one or more product ions. 

In the second stage of mass analysis, the product ions are stored in the mass 
analyzer. Then, they are sequentially scanned out of the mass analyzer to 
produce a full product ion mass spectrum.

The two-stage full scan type gives you more information about a sample than 
does SRM, but two-stage full scan type does not yield the speed that can be 
achieved by SRM. With two-stage full scan, you spend more time monitoring 
the product ions than you do in SRM. Thus, two-stage full scan provides 
greater information, but lower speed than SRM does.

To use the SRM scan type, you need to know what parent / product reaction 
you are looking for before you can perform an experiment. Thus, for SRM 
you might use one-stage full scan type to determine the parent mass spectrum 
and two-stage full scan type to determine the product mass spectra for parent 
ions of interest. Then, you might use SRM to do routine quantitative analysis 
of the compound.

Selected Ion Monitoring

Selected ion monitoring (SIM) is a single-stage (n = 1 scan power) technique 
in which a particular ion or set of ions is monitored. In the SIM scan type, the 
ions formed in the ion source are stored in the mass analyzer. Ions of one or 
more mass-to-charge ratios are selected and all other ions are ejected from the 
mass analyzer. Then, the selected ions are sequentially scanned out of the 
mass analyzer to produce a SIM mass spectrum.

SIM experiments are useful in detecting small quantities of a target compound 
in a complex mixture when the mass spectrum of the target compound is 
known. Thus, SIM is useful in trace analysis and in the rapid screening of a 
large number of samples for a target compound.

Because only a few ions are monitored, SIM can provide lower detection 
limits and greater speed than a single-stage full scan analysis can provide. 
SIM achieves lower detection limits because more time is spent monitoring 
significant ions that are known to occur in the mass spectrum of the target 
sample. SIM achieves greater speed because only a few ions of interest are 
monitored; regions of the spectrum that are empty or have no ions of interest 
are not monitored.
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SIM can improve the detection limit and decrease analysis time, but it can 
also reduce specificity. In SIM, only specific ions are monitored. Therefore, 
any compound that produces those ions appears to be the target compound. 
Thus, a false positive result can be obtained.

Selected Reaction Monitoring

Selected reaction monitoring (SRM) is a two-stage (n = 2 scan power) 
technique in which parent ion and product ion pairs are monitored. 

In the first stage of mass analysis, the ions formed in the ion source are stored 
in the mass analyzer. Ions of one mass-to-charge ratio (the parent ions) are 
selected and all other ions are ejected from the mass analyzer. Then, the 
parent ions are excited so that they collide with background gas that is present 
in the mass analyzer. The collisions of the parent ions cause them to fragment 
to produce one or more product ions.

In the second stage of mass analysis, the product ions are stored in the mass 
analyzer. Ions of one or more mass-to-charge ratios are selected and all other 
ions are ejected from the mass analyzer. Then, the selected ions are 
sequentially scanned out of the mass analyzer to produce an SRM product ion 
mass spectrum.

Like SIM, SRM allows for the very rapid analysis of trace components in 
complex mixtures. However, because you are monitoring pairs of ions (one 
product ion for each parent ion), the specificity obtained in SRM can be much 
greater than that obtained in SIM. Thus, you are very unlikely to get a false 
positive result with SRM. To get a false positive result, the interfering 
compound must do the following: First, it must form a parent ion of the same 
mass-to-charge ratio as the selected parent ion from the target compound. 
Second, it must also fragment to form a product ion of the same 
mass-to-charge ratio as the selected product ion from the target compound.

Data-Dependent Neutral Loss MSn

Data-Dependent Neutral Loss MSn experiments are another type of 
Data-Dependent experiment. These experiments allow you to select and 
fragment only those ions that exhibit a neutral loss that you specify. They are 
similar to SRM experiments in that you are monitoring an ion reaction, but 
they differ in that no single parent ion or product ion is selected for analysis. 
Instead you specify how many ions to monitor (for example, the 10 most 
intense parent ions), the MS detector identifies those ions in the n-1 scan 
order, then scans the nth fragmentation products for ions which represent a 
specified neutral loss from the selected parents.

For example, an experiment of this type could be used to identify which 
amino acid residues on a polypeptide have been phosphorylated. In the first 
stage of mass analysis the peptide ion is identified and all other ions are 
selectively ejected from the mass analyzer. In the second stage of mass 
������
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analysis the peptide ions are subjected to a low-energy fragmentation to 
remove phosphate groups, and the MS detector identifies product ions that 
show a mass loss equivalent to one or more phosphate groups, then selectively 
ejects all other ions from the mass analyzer. Finally, in the third stage of mass 
analysis, those product ions are fragmented to provide amino acid residues, 
and a full scan analysis provides the mass to charge ratios that allow you to 
identify the dephosphorylated amino acids.

Data-Dependent Neutral Loss experiments provide extremely selective tools 
for isolating and identifying specific components of a complex mixture. 

ZoomScan

The determination of the mass of an ion from its mass-to-charge ratio may be 
complicated by the fact that the charge state of the ion may be unknown. 
ZoomScan is a high resolution MS scan type in which the LCQ Series MS 
detector performs a high resolution scan that allows you to determine the 
charge state and molecular weight of an ion. The MS detector conducts a high 
resolution scan of 10 u width and evaluates the 12C /13C isotopic separation of 
a specified ion or ions. If the isotopic peaks are 1 u apart, the ion has a charge 
state of ±1. If the isotopic peaks are 0.5 u apart, the ion has a charge state of 
±2. If the isotopic peaks are 0.33 u apart, the ion has a charge state of ±3, and 
so on. You can then determine the molecular weight of the ion from a 
knowledge of the charge state and mass-to-charge ratio of the ion. You can 
conduct a ZoomScan analysis of up to ten ions by specifying the 
mass-to-charge ratios of the ions.
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1.5 Data Types
You can acquire and display mass spectral data (intensity versus 
mass-to-charge ratio) with the LCQ Series MS detector in one of two data 
types:

• Profile data type

• Centroid data type

Profile Data Type

In the profile data type, you can see the shape of the peaks in the mass 
spectrum. Each atomic mass unit is divided into approximately 15 sampling 
intervals. The intensity of the ion current is determined at each of the 
sampling intervals. The intensity at each sampling interval is displayed with 
the intensities connected by a continuous line. In general, the profile scan data 
type is used when you tune and calibrate the MS detector so that you can 
easily see and measure mass resolution.

Centroid Data Type

In the centroid data type, the mass spectrum is displayed as a bar graph. In 
this scan data type, the intensities of each set of 15 sampling intervals are 
summed.   This sum is displayed versus the integral center of mass of the 
15 sampling intervals. In general, the centroid scan data type is used for data 
acquisition because the scan speed is faster (but the resolution is lower) and 
the disk space requirements are smaller. Data processing is also much faster 
for centroid data.
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Chapter 2
Functional Description

This chapter describes the principal components of the LCQ Series MS 
detector system and their respective functions. The principal components of 
the system are as follows:

• Autosampler (optional)

• Liquid chromatograph (optional)

• Syringe pump

• Divert/inject valve (optional)

• MS detector

• Data system

A functional block diagram of the LCQ Series MS detector system is shown 
in Figure 2-1. A sample transfer line connects the LC to the MS detector. The 
autosampler and LC are usually installed on the left of the MS detector. The 
syringe pump and divert/inject valve are integrated into the MS detector 
cabinet.

Samples are injected (either manually or by an autosampler) into the LC inlet. 
The LC then separates the sample molecules by liquid chromatography. The 
separated constituents from the LC flow through the transfer line and are 
introduced into the atmospheric pressure ionization (API) source. You can 
also inject (infuse) samples into the API source with the syringe pump or the 
divert/inject valve.

Upon entering the API source, sample molecules are ionized by electrospray 
ionization (ESI) or atmospheric pressure chemical ionization (APCI). The ion 
optics focus and accelerate the resulting sample ions into the mass analyzer, 
where they are analyzed according to their mass-to-charge ratios. The sample 
ions are then detected by an ion detection system that produces a signal 
proportional to the number of ions detected. The ion current signal from the 
ion detection system is received and amplified by the system electronics and 
is then passed on to the data system for further processing, storage, and 
display. The data system provides the primary LCQ Series MS detector user 
interface.
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Figure 2-1. Functional block diagram of the LCQ Series MS detector system. The broad, 
single-headed arrows represent the flow of sample molecules through the 
instrument. The narrow, double-headed arrows represent electrical connections.
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2.1 Autosampler
The autosampler is used to inject samples automatically into the LC inlet. 
Thermo Electron Finnigan1 (Surveyor, AS3000, and AS3500), Waters 
(Alliance 2690), and Agilent2 (1050, 1090, and 1100) autosamplers can be 
controlled directly from the LCQ Series data system computer. With an 
autosampler, you can automate your LC/MS analyses.

You can configure the Xcalibur® data system for your autosampler from the 
data system computer. You specify the model name and model number by 
selecting the appropriate instrument button in the Instrument Configuration 
window, which is available by choosing Start > Programs > Xcalibur > 
Instrument Configuration. Refer to the Xcalibur online Help for a 
description of Instrument Configuration.

You can also set up, monitor, and control the autosampler from the data 
system computer from the Instrument Setup window, which is available by 
choosing Start > Programs > Xcalibur > Xcalibur and then clicking on 
the Instrument Setup button. Refer to the Xcalibur online Help for a 
description of Instrument Setup.

Front-panel (keypad) operation of the autosampler and maintenance 
procedures for the autosampler are described in the documentation provided 
with the autosampler.

1 Formerly Thermo Separation Products (TSP)

2 Formerly Hewlett-Packard (HP)

Note. For other autosamplers, the LCQ Series MS detector provides contact 
closure Start/Stop signals. Refer to LCQ Series Getting Connected for 
information on connecting an autosampler to the LCQ Series MS detector by 
contact closure Start/Stop signals.
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2.2 Liquid Chromatograph
The high performance liquid chromatograph (LC) separates a sample 
mixture into its chemical components by liquid chromatography. In liquid 
chromatography, the sample mixture partitions between a solid stationary 
phase of large surface area and a liquid mobile phase that percolates over the 
stationary phase. The molecular structure of each component of the mixture 
determines when each component elutes from the LC and enters the MS 
detector.

Thermo Electron Finnigan (Surveyor, P2000, and P4000), Waters (Alliance 
2690), and Agilent (1050, 1090, and 1100) LCs (and the corresponding UV 
detectors) can be controlled directly from the LCQ Series data system 
computer. Refer to LCQ Series Getting Connected for information on 
connecting an LC to the LCQ Series MS detector.

You can configure the Xcalibur data system for your LC and UV detector 
from the data system computer. You specify the model name and model 
number by selecting the appropriate instrument button in the Instrument 
Configuration window. Refer to the Xcalibur online Help for a description of 
Instrument Configuration.

You can also set up, monitor, and control the LC and UV detector from the 
data system computer from the Instrument Setup window. Refer to the 
Xcalibur online Help for a description of Instrument Setup.

Front-panel (keypad) operation of the LC and maintenance procedures for the 
LC are described in the documentation provided with the LC.
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2.3 Syringe Pump
The LCQ Series MS detector includes an electronically-controlled, integrated 
syringe pump. The syringe pump delivers sample solution from the syringe 
into the API source. See Figure 2-2. When the syringe pump is operating, a 
motor drives a pusher block that depresses the plunger of the syringe at a rate 
of 1% of the syringe volume per minute. Liquid flows out of the syringe 
needle and into the sample transfer line as the plunger is depressed. The 
syringe is held in place by a syringe holder. Refer to LCQ Series Getting 
Started for instructions on setting up the syringe pump.

You can start and stop the syringe pump from the Syringe Pump dialog box, 
which can be reached from the Tune Plus window (which is available by 
choosing Start > Programs > Xcalibur > LCQ Tune). You can also 
specify the Purge mode, in which the flow rate is 5% of the syringe volume 
per minute. Refer to the Xcalibur online Help for instructions on operating the 
syringe pump from the data system.

The syringe pump LED (see Figure 2-4) is illuminated green whenever the 
syringe pump is pumping. The LED is illuminated yellow if the syringe pump 
is at the end of its travel.

Figure 2-2. Syringe pump

LC Union Needle Syringe Syringe Holder Pusher Block
____________________ Finnigan LCQ Series Hardware Manual____________________  2-5������
���������������	�
��



Functional Description
Divert/Inject Valve ______________________________________________________ �������������	
��
�
2.4 Divert/Inject Valve
The divert/inject valve is located on the front of the LCQ Series MS detector 
to the left of the API source. See Figure 2-3. You can configure (plumb) the 
divert/inject valve as a loop injector (for flow injection analysis) or as a divert 
valve. Procedures for plumbing the valve in the loop injector or divert valve 
configuration are given in LCQ Series Getting Connected.

You can control the divert/inject valve from the data system. You specify the 
parameters of the divert/inject valve in the Divert/Inject Valve dialog box, 
which can be reached from the Tune Plus window, or the Divert Valve page, 
which can be reached from the Instrument Setup window. Refer to the online 
Help for instructions on operating the divert/inject valve from the data system.

You can also use the divert/inject valve button to divert the LC flow between 
the MS detector and waste when the valve is in the divert valve configuration, 
or switch between load and inject modes when the valve is in the loop injector 
configuration.

Figure 2-3. Divert/inject valve

LEDs

Divert/Inject 
Valve Button

Divert/Inject 
Valve

Sample Loop

Syringe Port
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2.5 MS Detector
The MS detector provides sample ionization and mass analysis of injected 
samples or samples eluted from a liquid chromatograph. The LCQ Series MS 
detector uses a quadrupole ion trap mass analyzer with an ion source external 
to the mass analyzer. Several important features of the LCQ Series MS 
detector are as follows:

• Universal, selective, and specific detector

• High sensitivity

• m/z 50 to 2000 mass range

• ESI, APCI, and NSI ionization techniques

• Positive and negative ion polarity modes

• MS and MS/MS scan modes 

• Full scan, SIM, SRM, and ZoomScan scan types

The MS detector includes the following components:

• Controls and indicators

• API source

• Ion optics

• Mass analyzer

• Ion detection system

• Vacuum system and inlet gasses hardware

• Cooling fans

• Electronic assemblies

Controls and Indicators

Six light-emitting diodes (LEDs) are located at the upper right side of the 
front panel of the MS detector. See Figure 2-4.

The LED labeled Power is illuminated whenever power is supplied to the 
vacuum system and electronic assemblies of the MS detector. The color of the 
LED depends on whether the MS detector is in the Normal, Warning, or 
Failure condition, as follows:

• In the Normal condition, the temperature in the embedded computer is 
less than 37 °C and its +5 V dc supply level is between +4.98 and 
+5.25 V dc. The Power LED is illuminated solid green.
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• In the Warning condition, the temperature in the embedded computer is 
marginal, or its +5 V dc is marginal. Marginal temperature is between 37 
and 45 °C. Marginal +5 V dc supply level is between +4.75 and 
4.97 V dc. The Power LED flashes yellow.

• In the Failure condition, the temperature in the embedded computer is 
greater than 45 °C or its +5 V dc supply level is less than +4.75 V dc. The 
Power LED is illuminated solid yellow and the MS detector is held in 
Reset mode until the failure condition is cleared.

The LED labeled Vacuum is illuminated green whenever the vacuum 
protection circuitry indicates that the vacuum is OK and the safety-interlock 
switch on the API source is depressed (that is, the API flange is secured to the 
spray shield). If the LED labeled Vacuum is not illuminated, high voltage is 
not applied to LCQ Series MS detector components.

The LED labeled Communication is illuminated yellow when the MS detector 
and the data system are trying to establish a communication link. The 
Communication LED is illuminated green when the communication link 
between the MS detector and the data system has been made.

The LED labeled System is illuminated yellow whenever the MS detector is in 
Standby (that is, high voltage is not supplied to the API source, mass analyzer, 
and ion detection system, but the MS detector power is on). The System LED 
is illuminated green whenever the MS detector is On (that is, high voltage is 
supplied to the API source, mass analyzer, and ion detection system).

The LED labeled Scan flashes blue whenever the MS detector is On and 
scanning ions.

The LED labeled Syringe Pump is illuminated green whenever the syringe 
pump is pumping. The Syringe Pump LED is illuminated yellow when the 
pump reaches its end of its travel. The LED is extinguished when the syringe 
pump is not on and not at the end of its travel.

Two additional LEDs and a push-button switch are located on the front panel 
above the divert/inject valve. See Figure 2-5. When the divert/inject valve is 
set up for loop injections, the divert/inject valve button toggles the valve 
between load and inject modes and the labels Load and Inject apply. When the 

Figure 2-4. Front panel LEDs of the MS detector
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divert/inject valve is set up for divert valve operation, the divert/inject valve 
button toggles the LC flow between the MS detector and the waste container 
and the labels Detector and Waste apply.

The main power circuit breaker switch (labeled Main Power) is located on 
the power panel at the lower right corner of the right side panel of the MS 
detector. See Figure 2-6 and Figure 2-7. In the Off (O) position, the circuit 
breaker removes all power to the MS detector, including the vacuum pumps. 
In the On (|) position, power is supplied to the MS detector. In the standard 
operational mode, the circuit breaker is kept in the On (|) position.

The electronics service switch (labeled Electronics) is located on the power 
panel. In the Service position the switch removes power to all components of 
the MS detector other than the vacuum system. In the Operating position 
power is supplied to all components of the MS detector.

Figure 2-5. Divert/inject valve button and LEDs 

Note. To shut off all power to the MS detector in an emergency, place the 
main power circuit breaker switch (labeled Main Power) in the Off (O) 
position. Do not use the electronics service switch (labeled Electronics).
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Figure 2-6. LCQ Advantage MAX Power Panel 

Figure 2-7. LCQ Deca XP MAX Power Panel 
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������
���������������	�
��2-10 ___________________ Finnigan LCQ Series Hardware Manual ____________________



Functional Description

�������������	
��
�___________________________________________________________ MS Detector
The reset button (labeled Reset) is also located on the power panel. When you 
press the reset button for longer than 3 s, LCQ Series MS detector software is 
reloaded from the data system. Refer to the topic Resetting the MS Detector 
in the System Shutdown, Startup, and Reset chapter for information on 
resetting the MS detector.

API Source

The atmospheric pressure ionization (API) source forms gas phase sample 
ions from sample molecules that are contained in solution. The API source 
also serves as the interface between the LC and the MS detector. You can 
operate the API source using either the electrospray ionization (ESI), 
atmospheric pressure chemical ionization (APCI), or nanospray ionization 
(NSI) technique.

For information about the ESI and APCI probes, refer to the Finnigan Ion 
Max API Source Hardware Manual. For more information on NSI, refer to 
the LCQ Series Nanospray Ion Source Operator’s Manual.

API Stack

The API stack consists of the components of the API source that are held 
under vacuum, except for the atmospheric pressure side of the spray shield, 
and the components of the ion sweep. The API stack includes the spray shield, 
ion sweep cone, spray cone, ion transfer capillary, heater assembly, vent 
prevent ball valve, extension mount, tube lens, skimmer, and tube lens and 
skimmer mount. See Figure 2-8. The same API stack is used for ESI, APCI, 
and NSI ionization techniques.
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The spray shield is a stainless steel cylindrical vessel that, in combination 
with the ESI, APCI, or NSI flange, and the spray cone, forms the atmospheric 
pressure region of the API source (also called the spray chamber). The spray 
shield inserts into an opening in the vacuum manifold and serves as a base for 
the API stack. An opening in the bottom of the spray shield serves as a drain 
for waste liquid. Two flange retainer bolts on the ESI, APCI, or NSI flange 
secure the flange to the atmospheric pressure side of the spray chamber.

The ion sweep cone is the outer stainless steel cone that is held by the spray 
cone. The spray cone is a stainless steel cone that fastens to the spray shield. 
The ion sweep cone is usually placed in one of two positions on the spray 
cone. This allows the distance between the opening of the ion sweep cone and 
the opening of the ion transfer capillary (see below) to be set to one of two 
definite values. Nitrogen can be made to flow in the gap between the ion 
sweep cone and the spray cone, and to exit the openings of the ion sweep 
cone.

The ion transfer capillary is an elongated cylindrical stainless steel tube that 
is attached to the spray cone. The ion transfer capillary assists in desolvating 
ions that are produced by the ESI, APCI, or NSI probes. Ions are focused into 
the ion transfer capillary in the atmospheric pressure region and transported to 
the skimmer region of the vacuum manifold by a decreasing pressure gradient 
and electrostatic forces. The ion transfer capillary can be heated to 300 ºC. 
Typical temperatures of the ion transfer capillary are 200 °C for ESI, 150 °C 
for APCI, and 165 °C for NSI.

The heater assembly is a dual cartridge heater that surrounds the ion transfer 
capillary but is not connected to the ion transfer capillary. The ion transfer 
capillary passes through a vent prevent ball valve that automatically seals if 
the ion transfer capillary is removed. Therefore, the ion transfer capillary may 
be removed and replaced without venting the instrument.

The extension mount is a combined tube and flange–like part that mounts to 
the spray shield. The extension mount surrounds the ion transfer capillary and 
is a mount for the tube lens and skimmer mount. 

Ions from the ion transfer capillary enter the tube lens. The tube lens has a 
mass dependent potential applied to it to focus the ions towards the opening of 
the skimmer (see below). An additional potential of between 0 and ±200 V 
(positive for positive ions and negative for negative ions), called the tube lens 
offset voltage, can be applied to the tube lens to accelerate the ions into 
background gas that is present in the skimmer region. Collisions with the 
background gas aid in the desolvation of the ions and increase sensitivity. If 
the tube lens offset voltage is too high, however, collisions with the 
background gas can be energetic enough to cause the ions to fragment. This 
fragmentation, called ion source collision induced dissociation (CID), 
decreases sensitivity. When you tune LCQ Advantage, you adjust the tube 
lens offset voltage to maximize sensitivity by balancing desolvation with 
fragmentation.
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The tube lens also serves as a gate to stop the injection of ions into the mass 
analyzer. A potential of -200 V is used to deflect positive ions away from the 
opening in the skimmer, and a potential of +200 V is used to deflect negative 
ions away from the opening in the skimmer.

Ions from the tube lens pass through the skimmer and move toward the first 
octapole. The skimmer acts as a vacuum baffle between the higher pressure 
skimmer region (at 1 Torr) and the lower pressure first octapole region (at 10-3 
Torr) of the vacuum manifold. The skimmer is at ground potential. The bore 
of the ion transfer capillary is mechanically offset with respect to the opening 
in the skimmer to reduce the number of neutral molecules and large charged 
particles that pass through the skimmer and create detector noise.

The distance between the vacuum end of the ion transfer capillary and the 
entrance to the skimmer is important. The extension mount, and of the tube 
lens and skimmer mount facilitate control of this distance. The tube lens and 
skimmer mount is inserted into the end of the extension mount. The tube lens 
and skimmer mount compresses a spring in the extension mount and is held in 
place by a retaining fork. This causes the entrance of the skimmer to be set at 
a fixed distance from the exit of the ion transfer capillary. 

Ion Optics

The LCQ Series MS detector uses magnetic fields to direct and focus the ion 
stream coming from the source. This section contains information on the ion 
optics for LCQ Advantage MAX and LCQ Deca XP MAX.

LCQ Advantage MAX

In the LCQ Advantage MAX, ions enter the ion optics after passing through 
the skimmer. The ion optics transmit ions from the API source to the mass 
analyzer. The ion optics consist of an octapole, a split octapole, and an 
interoctapole lens. See Figure 2-9 and Figure 2-16. Each octapole is an 
octagonal array of cylindrical rods that acts as an ion transmission device. An 
RF voltage (2.45 MHz, 400 V peak to peak) and dc offset voltage (typically 
-10 to +10 V) that are applied to the rods give rise to an electric field that 
guides the ions along the axis of the octapole. During ion transmission, the 
offset voltage is negative for positive ions and positive for negative ions. The 
octapole RF voltage is turned off during mass analysis.

The split octapole has four leads instead of two and can act as a gate as well as 
an ion transmission device. To terminate ion transmission, LCQ Advantage 
MAX applies a +150 V potential to the rods on one side of the octapole and 
–150 V to the other side.
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The split (first) octapole and the second octapole are separated by the 
interoctapole lens. The interoctapole lens assists in the focusing and gating of 
ions. The interoctapole lens also serves as a baffle between the first octapole 
region and the analyzer region of the vacuum manifold. The LCQ Advantage 
MAX tune procedure optimizes the potentials that are applied to the octapoles 
and interoctapole lens to maximize the ion current to the mass analyzer. 
During ion transmission, a potential of typically between -20 and +20 V is 
applied to the interoctapole lens. The potential is negative for positive ions 
and positive for negative ions. To terminate ion transmission during mass 
analysis, LCQ Advantage MAX applies a +132 V potential for positive ions 
or –132 V potential for negative ions.

LCQ Deca XP MAX

Ions enter the ion optics after passing through the skimmer. The ion optics 
transmit ions from the API source to the mass analyzer. The ion optics consist 
of one quadrupole, one octapole, and an interoctapole lens. See Figure 2-10.

Figure 2-9. Cross sectional view of the LCQ Advantage MAX ion optics
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The quadrupole is a quadrilateral array of square rods that acts as an ion 
transmission device. An RF voltage (2.45 MHz, 400 V peak to peak) and dc 
offset voltage (typically -10 to +10 V) that are applied to the rods give rise to 
an electric field that guides the ions along the axis of the quadrupole. During 
ion transmission, the offset voltage is negative for positive ions and positive 
for negative ions. 

The octapole is an octagonal array of cylindrical rods that acts as an ion 
transmission device. An RF voltage (2.45 MHz, 400 V peak to peak) and dc 
offset voltage (typically -10 to +10 V) that are applied to the rods give rise to 
an electric field that guides the ions along the axis of the octapole. During ion 
transmission, the offset voltage is negative for positive ions and positive for 
negative ions. The quadrupole/octapole RF voltage is turned off during mass 
analysis. 

The quadrupole and octapole are separated by the interoctapole lens. The 
interoctapole lens assists in the focusing and gating of ions. The interoctapole 
lens also serves as a baffle between the quadrupole region and the analyzer 
region of the vacuum manifold. The LCQ Deca XP tune procedure optimizes 
the potentials that are applied to the quadrupole, octapole, and interoctapole 
lens to maximize the ion current to the mass analyzer. During ion 
transmission, a potential of typically between -20 and +20 V is applied to the 
interoctapole lens. The potential is negative for positive ions and positive for 
negative ions. During mass analysis, the potential is +130 V for positive ions 
and -130 V for negative ions.

Figure 2-10. Cross sectional view of the LCQ Deca XP MAX ion optics
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Mass Analyzer

The quadrupole ion trap mass analyzer is the site of mass analysis (that is, ion 
storage, ion isolation, collision induced dissociation, and ion scan out). This 
section describes the components of the mass analyzer, the voltages applied to 
the mass analyzer electrodes, the use of helium damping gas in the mass 
analyzer cavity, and the operation of the mass analyzer during mass analysis.

Components of the Mass Analyzer

The mass analyzer is mounted on the analyzer mount opposite the second 
octapole. The mass analyzer is shown in cross section in Figure 2-11 and in a 
photograph in Figure 2-16.

The mass analyzer includes three stainless steel electrodes: the entrance 
endcap electrode; the exit endcap electrode; and the ring electrode. The inner 
surfaces of the electrodes are hyperbolic. Together, they form a cavity in 
which the mass analysis occurs.

The entrance endcap electrode is the electrode that is closest to the ion optics, 
and the exit endcap electrode is the electrode that is closest to the ion 
detection system. Both endcap electrodes have a small hole in their centers to 
permit the passage of ions into and out of the mass analyzer cavity. The ring 
electrode is located between the endcap electrodes. Ions produced in the API 
source enter the mass analyzer cavity through the entrance endcap electrode. 
Ions can be ejected through either endcap electrode during mass analysis. Ions 
that are ejected through the exit endcap electrode are focused by the 
conversion dynode accelerating potential through the exit lens (at ground 
potential) towards the ion detection system. Helium damping gas enters the 
mass analyzer cavity through a nipple on the exit endcap electrode.

The entrance endcap electrode, exit endcap electrode, and ring electrode are 
separated by two quartz spacer rings. The spacer rings position the electrodes 
at the proper distance apart and also serve as electrical insulators. Two 
nonconducting posts pass through both endcap electrodes and screw into the 
analyzer mount (also nonconducting). A spring washer and nut on the end of 
each post apply a force to the exit endcap electrode that holds the electrodes 
and spacers in place.

The mass analyzer dc offset voltage is applied to the mass analyzer electrodes 
to draw in ions from the ion optics. The magnitude of the mass analyzer dc 
offset voltage is -10 V for positive ion polarity mode and +10 V for negative 
ion polarity mode.

Various ac voltages are applied to the ring and endcap electrodes to trap, 
fragment, and eject ions according to their mass-to-charge ratios. These ac 
voltages, referred to as the ring electrode RF voltage, waveform voltage, 
resonance excitation RF voltage, and resonance ejection RF voltage, are 
discussed below.
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Ring Electrode RF Voltage

An ac voltage of constant frequency (0.76 MHz) and variable amplitude (0 to 
8500 V zero-to-peak) is applied to the ring electrode by a spring-loaded pin 
that contacts the ring electrode when the mass analyzer is in place. The 
frequency of the ac voltage is in the radio-frequency (RF) range, and this 
voltage is referred to as the ring electrode RF voltage.

The application of an RF voltage to the ring electrode produces a 
three-dimensional quadrupole field within the mass analyzer cavity. This 
time-varying field drives ionic motion in both the axial (toward the endcaps) 
and radial (from the ring electrode toward the center) directions. Ionic motion 
must be stable in both the axial and radial directions for an ion to remain 
trapped. (A stable trajectory is an oscillatory trajectory that is confined within 

Figure 2-11. Cross sectional view of the mass analyzer
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the mass analyzer.) During ion scan out, the system produces a 
mass-dependent instability to eject ions from the mass analyzer in the axial 
direction.

When the amplitude of the ring electrode RF voltage is low, all ions above a 
minimum mass-to-charge ratio are trapped. This RF voltage is referred to as 
the storage voltage, and the minimum mass-to-charge ratio is usually chosen 
to be greater than the mass-to-charge ratios associated with air, water, and 
solvent ions. During ion scan out, the ring electrode RF voltage is ramped at a 
constant rate corresponding to approximately 5,500 u/s. As the ring electrode 
RF voltage increases, ions of increasing mass-to-charge ratio become 
successively unstable in the axial direction and are ejected from the mass 
analyzer. The voltage at which an ion is ejected from the mass analyzer is 
defined as its resonance voltage. The ejection of ions of each mass-to-charge 
ratio occurs over a very short time. Many of these ions are detected by the ion 
detection system.

Ion Isolation Waveform Voltage, Resonance 
Excitation RF Voltage, and Resonance Ejection RF 
Voltage Applied to the Endcap Electrodes

The ion isolation waveform voltage, resonance excitation RF voltage, and 
resonance ejection RF voltage are ac voltages that are applied to the endcap 
electrodes to stimulate motion of the ions in the axial direction. The voltages 
applied to the endcap electrodes are equal in amplitude but are 180o out of 
phase to one another. When the RF frequency applied to the endcaps equals 
the resonance frequency of a trapped ion, which depends on its mass, the ion 
gains kinetic energy. If the magnitude of the applied voltage is large enough or 
the ion is given sufficient time, the ion is ejected from the mass analyzer in the 
axial direction.

The waveform voltage consists of a distribution of frequencies between 5 and 
380 kHz containing all resonance frequencies except for those corresponding 
to the ions to be trapped. The ion isolation waveform voltage acts during the 
ion isolation step of SIM, SRM, and MS/MS full scan applications. The ion 
isolation waveform voltage, in combination with the ring electrode RF 
voltage, ejects all ions except those of a selected mass-to-charge ratio or 
narrow ranges of mass-to-charge ratios. The ion isolation waveform voltage is 
calculated by the LCQ Series MS detector and automatically applied at the 
correct time.

During the collision induced dissociation step of SRM, and MS/MS full scan 
applications, the resonance excitation RF voltage is applied to the endcap 
electrodes to fragment parent ions into product ions. The resonance excitation 
RF voltage is not strong enough to eject an ion from the mass analyzer. 
However, ion motion in the axial direction is enhanced and the ion gains 
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kinetic energy. After many collisions with the helium damping gas, which is 
present in the mass analyzer, the ion gains enough internal energy to cause it 
to dissociate into product ions. The product ions are then mass analyzed.

During ion scan out, the resonance ejection RF voltage facilitates the ejection 
of ions from the mass analyzer and thus improves mass resolution. The 
resonance ejection RF voltage is applied at a fixed frequency and increasing 
amplitude during the ramp of the ring electrode RF voltage. Only when an ion 
is about to be ejected from the mass analyzer cavity by the ring electrode RF 
voltage is it in resonance with the resonance ejection RF voltage. When an ion 
approaches resonance, it moves farther away from the center of the mass 
analyzer, where the field generated by the ring electrode RF voltage is zero 
(and space-charge effects are strong), into a region where the field produced 
by the ring electrode RF voltage is strong (and space-charge effects are small). 
As a result, the ejection of the ion is facilitated, and mass resolution is 
significantly improved.

Helium Damping Gas in the Mass Analyzer Cavity

The mass analyzer cavity contains helium that is used as a damping gas and a 
collision activation partner. The helium damping gas enters the mass analyzer 
cavity through a nipple on the exit endcap electrode. The flow of gas (~1 
mL/min) into the mass analyzer cavity is regulated by a pressure regulator and 
a capillary restrictor. The flow of gas out of the mass analyzer cavity (and into 
the turbomolecular pump) is restricted by the holes in the endcap electrodes. 
The flows into and out of the cavity are matched so that the partial pressure of 
helium in the mass analyzer cavity is maintained at approximately 0.1 Pa (10-3 
Torr).

The collisions of the ions entering the mass analyzer with the helium slow the 
ions so they can be trapped by the RF field in the mass analyzer.

The presence of helium in the mass analyzer cavity significantly enhances 
sensitivity and mass spectral resolution. Before their ejection from the mass 
analyzer cavity, sample ions collide with helium atoms. These collisions 
reduce the kinetic energy of the ions, thereby damping the amplitude of their 
oscillations. As a result, the ions are focused into the center of the cavity 
rather than being allowed to spread throughout the cavity. 

Helium in the mass analyzer cavity also serves as a collision activation 
partner. During the collision induced dissociation step of an SRM or MS/MS 
full scan analysis, the resonance excitation RF voltage applied to the endcap 
electrodes drives parent ions into the helium atoms. After gaining sufficient 
internal energy from the resulting collisions, the parent ion dissociates into 
one or more product ions.
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Summary of Mass Analyzer Operation

The processes that occur in the mass analyzer can be broken down into four 
steps:

• Ion storage

• Ion isolation (SIM, SRM, and MS/MS full scan only)

• Collision induced dissociation (SRM and MS/MS full scan only)

• Ion scan out (the ion detection step)

For SRM and MS/MS full scan applications the ion isolation and collision 
induced dissociation steps are performed once. 

Before ion storage, the following conditions are established:

• Helium is present in the mass analyzer cavity at a partial pressure of about 
0.1 Pa (10-3 Torr).

• Ring electrode RF voltage is set to the storage voltage.

• Ion isolation waveform voltage, resonance excitation RF voltage, and 
resonance ejection RF voltage on the endcap electrodes are off.

With these conditions achieved, sample ions formed in the API source are 
trapped in the mass analyzer if the ions have mass-to-charge ratios greater 
than the minimum storage mass-to-charge ratio.

Next, for SIM, SRM, MS/MS, and MSn full scan analyses, the ion isolation 
waveform voltage is applied to the endcap electrodes, in combination with a 
ramp of the ring electrode RF voltage to a new storage voltage, to eject all 
ions except those of the selected mass-to-charge ratio.

Then, for SRM, MS/MS, and MSn full scan analyses, the resonance excitation 
RF voltage is applied to the endcap electrodes to cause collision induced 
dissociation. Product ions with mass-to-charge ratio greater than the 
minimum storage mass-to-charge ratio are stored. (The minimum storage 
mass during collision induced dissociation is typically set to one quarter of the 
parent ion mass-to-charge ratio.)

For SRM and MS/MS full scan applications the ion isolation and collision 
induced dissociation steps are performed once. For MSn full scan applications 
these steps are performed multiple times.

Finally, the sample ions or product ions are scanned out: The ring electrode 
RF voltage is ramped from low voltage to high voltage, and simultaneously 
the resonance ejection RF voltage is applied to the endcap electrodes to 
facilitate ejection. As the ring electrode RF voltage is increased, ions of 
greater and greater mass-to-charge ratios become unstable and are ejected 
from the mass analyzer. Many of these ions are focused toward the ion 
detection system where they are detected.
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Ion Detection System

The LCQ Series MS detector is equipped with a high sensitivity, off-axis ion 
detection system that produces a high signal-to-noise ratio and allows for 
voltage polarity switching between positive ion and negative ion modes of 
operation. The ion detection system includes a 15-kV conversion dynode and 
a channel electron multiplier. The ion detection system is located at the rear of 
the vacuum manifold behind the mass analyzer. See Figure 2-12 (cross 
sectional view), Figure 2-15 (conversion dynode), and Figure 2-16 (electron 
multiplier).

The conversion dynode is a concave metal surface that is located at a right 
angle to the ion beam. A potential of +15 kV for negative ion detection or 
-15 kV for positive ion detection is applied to the conversion dynode. When 
an ion strikes the surface of the conversion dynode, one or more secondary 
particles are produced. These secondary particles can include positive ions, 
negative ions, electrons, and neutrals. When positive ions strike a negatively 
charged conversion dynode, the secondary particles of interest are negative 
ions and electrons. When negative ions strike a positively charged conversion 
dynode, the secondary particles of interest are positive ions. These secondary 
particles are focused by the curved surface of the conversion dynode and are 
accelerated by a voltage gradient into the electron multiplier. The conversion 
dynode shield tube and shield disk shield the vacuum manifold from the 
electric field produced by the conversion dynode.

The electron multiplier is mounted on the top cover plate of the vacuum 
manifold next to the mass analyzer. See Figure 2-12 and Figure 2-16. The 
electron multiplier includes a cathode and an anode. The cathode of the 
electron multiplier is a lead-oxide, funnel-like resistor. A potential of up to 
-2.5 kV is applied to the cathode by the high voltage ring. The exit end of the 
cathode (at the anode) is near ground potential. The cathode is held in place 
by the high voltage ring, two support plates, the electron multiplier support, 
and the electron multiplier shield. A spring washer applies a force to the 
cathode to hold it in contact with the electron multiplier shield. The electron 
multiplier support is attached to the top cover plate of the vacuum manifold 
by two screws. 

The anode of the electron multiplier is a small cup located at the exit end of 
the cathode. The anode collects the electrons produced by the cathode. The 
anode screws into the anode feedthrough in the top cover plate.

Secondary particles from the conversion dynode strike the inner walls of the 
electron multiplier cathode with sufficient energy to eject electrons. The 
ejected electrons are accelerated farther into the cathode, drawn by the 
increasingly positive potential gradient. Due to the funnel shape of the 
cathode, the ejected electrons do not travel far before they again strike the 
inner surface of the cathode, thereby causing the emission of more electrons. 
Thus, a cascade of electrons is created that finally results in a measurable 
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current at the end of the cathode where the electrons are collected by the 
anode. The current collected by the anode is proportional to the number of 
secondary particles striking the cathode. 

Figure 2-12. Cross sectional view of the ion detection system, showing the electron multiplier 
and the conversion dynode
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Typically, the electron multiplier is set to a gain of about 3 × 105 (that is, for 
each ion or electron that enters, 3 × 105 electrons exit). The electrometer 
circuit converts this signal current into a voltage that is recorded by the data 
system. Refer to the topic Ion Detection System Electronic Assemblies on 
page 2-42.

The ion detection system of the LCQ Series MS detector increases signal and 
decreases noise. The high voltage applied to the conversion dynode results in 
a high conversion efficiency and increased signal. That is, for each ion 
striking the conversion dynode, many secondary particles are produced. The 
increase in conversion efficiency is more pronounced for more massive ions 
than for less massive ions.

Because of the off-axis orientation of the ion detection system relative to the 
mass analyzer, neutral molecules from the mass analyzer tend not to strike the 
conversion dynode or electron multiplier. As a result, the noise from neutral 
molecules is reduced.

Vacuum System and Inlet Gasses Hardware

The vacuum system evacuates the region around the API stack, ion optics, 
mass analyzer, and ion detection system. The principal components of the 
vacuum system include the following:

• Vacuum manifold

• Turbomolecular pump

• Forepump

• Convectron® gauge

• Ion gauge

The inlet gasses hardware controls the flow of damping gas, sheath gas, 
AUX/Sweep gas, and air (during venting) into the MS detector. The inlet 
gasses hardware includes the following components:

• Vent gas valve

• Damping gas inlet assembly

• Sheath gas valve

• Auxiliary gas valve

A functional block diagram of the vacuum system and inlet gasses hardware 
is shown for the LCQ Advantage MAX MS detector in Figure 2-13 and for 
the LCQ Deca XP MAX MS detector in Figure 2-14.
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Figure 2-13. Functional block diagram of the LCQ Advantage MAX vacuum system and inlet 
gasses hardware
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Vacuum Manifold

The vacuum manifold encloses the API stack, ion optics, mass analyzer, and 
ion detection system assemblies. The vacuum manifold is a thick-walled, 
aluminum chamber with a removable top cover plate, machined flanges on the 
front, sides, and bottom, and various electrical feedthroughs and gas inlets. 

The vacuum manifold is divided into three chambers by two baffles. See 
Figure 2-15. The region inside the first chamber, called the ion transfer 
capillary-skimmer region, is evacuated to 1 Torr by the forepump. The region 
inside the second chamber, called the first octapole region, is evacuated to 
10-3 Torr by the interstage port of the split-flow turbomolecular vacuum 
pump. The region inside the third chamber, called the analyzer region, is 
evacuated to 2 × 10-5 Torr by the high vacuum port of the split-flow 
turbomolecular pump. The turbomolecular pump in turn discharges into the 
forepump through the foreline.

Figure 2-14. Functional block diagram of the LCQ Deca XP MAX vacuum system and inlet gasses 
hardware
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Two high-voltage electrical feedthroughs pass through the vacuum manifold:

• A feedthrough for the high voltage for the conversion dynode passes 
through the rear wall

• A feedthrough for the ring electrode RF voltage of the mass analyzer 
passes through the bottom 

An inlet for the introduction of air into the vacuum manifold (for venting the 
manifold) passes through the front wall of the vacuum manifold. The vacuum 
manifold also has an opening for the ion gauge.

Figure 2-15. Vacuum manifold (interior)
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The removable top cover plate of the vacuum manifold holds the ion optics, 
mass analyzer, and electron multiplier (one part of the ion detection system). 
Thus, removal of the top cover plate allows easy access to these assemblies. 
Two handles on the top and four guide posts on the underside of the top cover 
plate facilitate its removal and installation. An electrically conductive O-ring 
provides a vacuum-tight seal between the top cover plate and the vacuum 
manifold. The top cover plate and its attached assemblies are shown in 
Figure 2-16.

Five electrical feedthroughs pass through the top cover plate:

• A 4-pin feedthrough for the split (first) octapole leads

• A 4-pin feedthrough for the second octapole leads

• An 8-pin feedthrough for the leads to the endcap electrodes and exit lens 
of the mass analyzer, and the interoctapole lens.

Figure 2-16. Top cover plate of the vacuum manifold (underside) and 
attached assemblies 

Helium 
Damping Gas 
Inlet

Mass 
Analyzer

4-pin Feed-
throughs Baffle

Guide
Post

Electron 
Multiplier

8-pin Feed-
through

Ion Optics
(Octapoles)
������
���������������	�
��2-28 ___________________ Finnigan LCQ Series Hardware Manual ____________________



Functional Description

�������������	
��
�___________________________________________________________ MS Detector
• A feedthrough for the high voltage for the cathode of the electron 
multiplier

• A feedthrough for the ion current signal from the anode of the electron 
multiplier

An inlet for the introduction of helium damping gas into the mass analyzer 
passes through the top cover plate.

Turbomolecular Pump

A Pfeiffer TMH 261-130 split-flow turbomolecular pump provides the 
vacuum for the first octapole and analyzer regions of the vacuum manifold. 
The turbomolecular pump mounts onto the underside of the vacuum manifold. 
The interstage port of the turbomolecular pump, which evacuates the first 
octapole region, is rated at 100 L/s. The high vacuum port of the 
turbomolecular pump, which evacuates the analyzer region, is rated at 
200 L/s. Under normal operating conditions the pump provides a vacuum of 
approximately 0.1 Pa (10-3 Torr) in the first octapole region, and 2 × 10-3 Pa 
(2 × 10-5 Torr) in the analyzer region.

Power to and regulation of the turbomolecular pump is provided by a Pfeiffer 
TC600 Turbomolecular Pump Controller, which is mounted on the 
turbomolecular pump. Power for the turbomolecular pump is turned off and 
on by the main power circuit breaker switch but not by the electronics service 
switch. The pump is air cooled by a fan that draws air in from the rear of the 
instrument.

Power to the turbomolecular pump is shut off if the foreline pressure, as 
measured by the Convectron gauge, is too high, or if the turbomolecular pump 
overheats. Vacuum protection is discussed further in the topic Vacuum 
System Electronic Assemblies on page 2-38.

Forepump

A Edwards E2M30 forepump (or rough pump) establishes the vacuum 
necessary for the proper operation of the turbomolecular pump. The forepump 
also evacuates the ion transfer capillary-skimmer region of the vacuum 
manifold. The pump has a maximum displacement of 650 L/min and 
maintains a minimum pressure of approximately 100 Pa (1 Torr). 

The forepump is connected to the turbomolecular pump by a section of 2.5 cm 
(1.0 in.) ID reinforced PVC tubing. The power cord of the forepump is 
plugged into the outlet labeled Rough Pump on the power panel (See 
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Figure 2-6 on page 2-10). This outlet supplies power to the pump and is 
controlled by the main power circuit breaker switch and not by the electronics 
service switch.

Convectron Gauge

The Convectron gauge measures the pressure in the ion transfer 
capillary-skimmer region of the vacuum manifold and the foreline, which 
connects the turbomolecular pump and the forepump. The pressure measured 
by the Convectron gauge is monitored by the System Control PCB. The 
System Control PCB detects whether the foreline pressure is too high for the 
proper operation of the turbomolecular pump. 

Ion Gauge

The pressure in the analyzer region of the vacuum manifold is measured by a 
Granville-Phillips® 342™ mini ion gauge. The ion gauge produces energetic 
electrons that cause the ionization of molecules in the ion gauge. Positive ions 
formed in the ion gauge are attracted to a collector. The collector current is 
related to the pressure in the vacuum manifold. The ion gauge is also involved 
in vacuum protection.

Vent Valve

The vent valve allows the vacuum manifold to be vented to air that has been 
filtered through a sintered nylon filter. The vent valve is a solenoid-operated 
valve. The vent valve is controlled by the Vent Delay PCB. The vent valve is 
closed when the solenoid is energized.

The vacuum manifold is vented when power is removed from the MS 
detector. (Power is removed from the MS detector by a power failure or by 
placing the main power circuit breaker in the Off (O) position.) A battery 
backup on the Vent Delay PCB provides power to the vent valve for 30 s after 
the power is removed. If external power is not restored to the MS detector in 
30 s, a circuit on the Vent Delay PCB times out, and power to the vent valve 
solenoid is shut off. When power to the vent valve solenoid is shut off, the 
vent valve opens and the manifold is vented to filtered air. The vent valve 
closes after power is restored to the MS detector. The battery backup is 
recharged automatically after power is restored.

Caution. Always plug the forepump power cord into the outlet labeled 
Rough Pump on the right side of the MS detector. Never plug it into a wall 
outlet.
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Damping Gas Inlet Assembly

The damping gas inlet assembly controls the flow of helium into the mass 
analyzer cavity. Helium (40 ±10 psig [275 ±70 kPa], 99.999% [ultra-high] 
purity) enters the MS detector through a 1/8-in. port labeled Helium In on the 
left side of the MS detector. See Figure 2-17. The LCQ Series MS detector 
regulates the flow of helium by use of a capillary restrictor and a pressure 
regulator on the helium line. The helium enters the mass analyzer through a 
nipple on the exit endcap electrode.

Helium in the mass analyzer cavity dampens ionic motion and improves the 
performance of the MS detector. Refer to the topic Helium Damping Gas in 
the Mass Analyzer Cavity on page 2-20.

Sheath Gas Valve

The sheath gas valve controls the flow of sheath gas (nitrogen) into the API 
source. Dry nitrogen (100 ±20 psig [690 ±140 kPa], 99% purity) enters the 
MS detector through a 1/4-in. port labeled Nitrogen In on the left side of the 
MS detector. See Figure 2-17. The sheath gas pressure is regulated by a valve 
that is controlled by the data system. You can set the sheath gas flow rate (20 
to 100 in arbitrary units) in the ESI Source and APCI Source dialog boxes 
from the Tune Plus window. Sheath gas is not used with an NSI source. The 
sheath gas enters the API source through 1/8-in. ID tubing.

In the event that sheath gas flow is lower than that required for operation, the 
LCQ Series MS detector displays a message and places the system in Standby 
mode.

Auxiliary Gas Valve

The auxiliary gas valve controls the flow of nitrogen through the Auxiliary 
(AUX) gas or Sweep gas inlets into the API source. Dry nitrogen 
(690 ±140 kPa [100 ±20 psig], 99% purity) enters the MS detector through a 
1/4-in. port labeled Nitrogen In on the left side of the MS detector. The 
auxiliary gas pressure is regulated by a flow valve that is controlled by the 
data system. You can set the AUX/Sweep gas flow rate (0 to 60 in arbitrary 
units) in the ESI Source and APCI Source dialog boxes. Refer to the LCQTM 

Note. Helium damping gas continues to flow to the mass analyzer even after 
the MS detector is powered off or placed in Standby. To save helium when 
the MS detector is not operational, turn off the helium flow at the tank.
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Series Nanospray Ion Source Operator’s Manual for a discussion of the 
use of auxiliary gas with the NSI source. The auxiliary gas enters the API 
source through 1/8-in. ID tubing.

Cooling Fans

Five 2800 L/min (100 ft3/min) fans provide cooling for the MS detector. One 
fan cools the RF voltage coil. Two fans cool the electronics in the tower. One 
fan cools the electronics in the embedded computer. One fan cools the 
turbomolecular pump. The exhaust air is expelled from the vent slots on the 
sides of the MS detector. 

+24 V dc power to the fans is provided by the +48, +24 V dc switching power 
supply.

Electronic Assemblies

The electronic assemblies that control the operation of the MS detector are 
distributed among various printed circuit boards (PCBs) and other modules 
located in the tower, embedded computer, and on or around the vacuum 
manifold of the MS detector.

The electronic assemblies of the MS detector include the following:

• Power Module and power distribution assemblies

Figure 2-17. I/O panel
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Caution. To ensure proper cooling, the MS detector must always be 
operated with its covers in place.
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• System Control PCB

• Vacuum system electronic assemblies

• RF/waveform voltage generation electronic assemblies

• Ion detection system electronic assemblies

• Embedded computer electronic assemblies

Functional block diagrams of the electronic assemblies and their 
interconnection with the various components of the MS detector are shown in 
Figure 2-18 through Figure 2-23.

Power Module and Power Distribution

The Power Module accepts line power, filters it, and provides it to various 
components of the MS detector. The Power Module includes the following 
components:

• Main power circuit breaker

• Surge suppressor

• Line filter

• Electronics service switch

A functional block diagram of the Power Module and MS detector power 
distribution is shown in Figure 2-18.

Line power of 230 V ac ± 10%, 10 A, 50/60 Hz, single phase enters the power 
panel on the right side panel of the MS detector, passes through the main 
power circuit breaker, surge suppressor, and then to a line filter and either one 
or two outlets for the forepumps (the LCQ Advantage MAX has one 
forepump, while the LCQ Deca XP MAX has two). See Figure 2-6 for the 
LCQ Advantage MAX and Figure 2-7 for the LCQ Deca XP MAX.

The main power circuit breaker switch, located on the right side panel of the 
MS detector (see Figure 2-6 and Figure 2-7), shuts off all power to the MS 
detector, including the vacuum system. After the main power circuit breaker 
switch, power goes to the rotary vane pump and the surge suppressor.

The surge suppressor protects the MS detector from surges in the line power.

The line filter removes noise from the line power.

After the line filter, power goes to the +48, +24 V switching power supply and 
the electronics service switch. 

The +48, +24 V switching power supply (located in the electronics tower) 
provides power to the ion transfer capillary heater circuitry, the 
Turbomolecular Pump Controller (which powers the turbomolecular pump), 
the embedded computer fan, turbomolecular pump fan, a fan in the electronics 
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tower to cool the +48, +24 V dc switching power supply, the Vent Delay PCB, 
and the Service Relay PCB. Refer to the topic Vacuum System Electronic 
Assemblies on page 2-38.

In the LCQ Advantage MAX, the Service Relay PCB also allows the +48, 
+24 V dc switching power supply to power the syringe pump, divert valve, 
ion transfer capillary heater (using +48 V power), and fans for the RF coil and 
electronics tower if the electronics service switch is in the Operational 
position.

The electronics service switch is a circuit breaker that allows you to service 
the non-vacuum system components of the MS detector with the vacuum 
system still in operation (See Figure 2-6). In the Service position the switch 
removes power to all components of the MS detector other than the vacuum 
system. In the Operational position power is supplied to all components of the 
MS detector.

After the electronics service switch, power goes to the +5 V, ±15 V, ±24 V 
switching power supply, ± the +36 V, -28 V switching power supply, the 
±210 V dc linear power supply (for LCQ Advantage MAX) or the AC 
Toroidal Transformer (for LCQ Deca XP MAX), and the System Control 
PCB. 

The +5 V, ±15 V, +24 V dc switching power supply provides +5 V dc, ± 15 V 
dc for general use. The +24 V dc is used by the ion gauge circuit (in LCQ 
Advantage MAX) and the 8 kV power supply. 

The +36 V, -28 V dc switching power supply provides +36 V dc and -28 V dc 
power for the RF circuits of the RF Voltage Amplifier PCB and Waveform 
Amplifier PCB. The enable/inhibit input to this power supply is connected to 
the vacuum status; outputs of this power supply are shut down when the 
Vacuum LED is off.

The ±210 V dc linear power supply (for LCQ Advantage MAX) or the AC 
toroidal transformer (for LCQ Deca XP MAX) provides± outputs for the lens 
drivers on the System Control PCB.

The 8 kV power supply delivers voltage to either the ESI needle in the ESI 
mode, or the corona discharge needle in the APCI mode. Typical operating 
voltages range between ±3 to ±6 kV. In the ESI mode, the voltage is regulated, 
whereas in the APCI mode, the current is regulated.

Note. For emergency shutoff of all power to the MS detector, place the main 
power circuit breaker switch in the Off (O) position. Do not use the 
electronics service switch to remove power to the system in an emergency. 
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Figure 2-18. Functional block diagram of the Power Module and power distribution of the MS 
detector
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System Control PCB

The System Control PCB is the principal PCB for controlling and monitoring 
the operation of the MS detector. The System Control PCB is the large board 
that is located on the right side of the MS detector. The many interconnections 
of the System Control PCB with other components of the MS detector can be 
seen in Figure 2-19 through Figure 2-23.

The System Control PCB contains the following components:

• Power supply regulation circuits

• Dc voltage control circuitry

• Divert/inject valve control circuit

• API source control circuit

• Electron multiplier control circuit

• Conversion dynode control circuit

• Ion transfer capillary heater/sensor control circuit

• APCI vaporizer heater/sensor control circuit/safety interlock relay

• Ion gauge control circuit

• Convectron® gauge control circuit

• Vacuum protection circuitry

• RF voltage control circuitry

• Temperature monitoring circuitry

• Diagnostic circuitry

• Interface with the embedded computer

The ±150 V dc power supply provides power for the dc voltages that are 
applied to the ion transfer capillary heater, octapoles, and mass analyzer 
electrodes. 

The ±210 V dc linear power supply (for LCQ Advantage MAX) or the AC 
toroidal transformer (for LCQ Deca XP MAX) provides power for the dc 
voltage that is applied to the tube lens. 

The ±24 V (for LCQ Advantage MAX) or ±20 V (for LCQ Deca XP) dc 
power supply provides power for the RF detector in the RF Voltage Control 
PCB. 

The +180 V dc power supply provides power for the ion gauge grid. 

The dc voltage control circuitry controls and monitors the dc voltages that are 
applied to the ion transfer capillary heater, tube lens, octapoles, interoctapole 
lens, and mass analyzer electrodes.

The divert/inject valve control circuit controls and monitors the divert/inject 
valve.
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The API source control circuit controls and monitors the high voltage that is 
applied to the ESI needle, the APCI corona discharge needle, and the NSI 
capillary.

The electron multiplier control circuit sends a signal to the electron 
multiplier power supply that is proportional to the voltage to be applied to the 
electron multiplier cathode. It also reads back a signal that is proportional to 
the actual voltage applied to the electron multiplier cathode. The electron 
multiplier control circuit lowers the electron multiplier voltage when mass 
analysis is not occurring.

The conversion dynode control circuit controls and monitors the polarity of 
the 15 kV potential that is applied to the conversion dynode.

The ion transfer capillary heater/sensor control circuit monitors the 
temperature of the ion transfer capillary via a platinum probe temperature 
sensor. It also provides the voltage needed by the ion transfer capillary heater.

The APCI vaporizer heater/sensor control circuit controls the temperature of 
the APCI vaporizer via a thermocouple sensor. It also provides 230 V ac line 
voltage to the heater in the APCI vaporizer.

The ion gauge control circuit controls the ion gauge and reads back the 
pressure signal. (The ion gauge measures the pressure in the analyzer region 
of the vacuum manifold.)

The Convectron gauge control circuit controls the Convectron gauge and 
reads back the pressure signal. (The Convectron gauge measures the pressure 
in the foreline and the ion transfer capillary-skimmer region of the vacuum 
manifold.)

The vacuum protection circuitry monitors the pressure in the foreline 
(between the turbomolecular pump and the forepump), as measured by the 
Convectron gauge, and in the analyzer region of the vacuum manifold, as 
measured by the ion gauge. Refer to the topic Vacuum System Electronic 
Assemblies on page 2-38 for more information on vacuum protection.

The RF voltage control circuitry controls and monitors the RF Voltage 
Amplifier PCB, Waveform Amplifier PCB, and RF Voltage Control PCB.

The switching power supply outputs distribute +5 V, ±15 V, and 
±24 V dc power to various PCBs and modules of the MS detector.

The temperature monitoring circuitry monitors the temperatures at the RF 
Voltage Control PCB, Top Cover PCB, RF Voltage Amplifier PCB, and 
System Control PCB.

The diagnostic circuitry monitors the outputs of various components and 
circuits on the LCQ Advantage MAX. Information on voltages, currents, 
temperatures, flow rates, logic, etc. is sent to the data system, where it can be 
accessed via the Tune Status view and the diagnostics program.
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The embedded computer interface is a high speed serial line that connects the 
System Control PCB with the Control DSP (digital signal processor) PCB in 
the embedded computer. The System Control PCB communicates with the 
data system computer via the embedded computer.

Vacuum System Electronic Assemblies

The vacuum system electronic assemblies control and monitor the vacuum 
system of the MS detector. The vacuum system electronic assemblies include 
the following:

• Vacuum protection circuitry

• Turbomolecular Pump Controller

• Vent Delay PCB

• Battery backup

• +48, +24 V dc switching power supply

A functional block diagram of the LCQ Advantage MAX vacuum system 
electronic assemblies is shown in Figure 2-19. That for the LCQ Deca XP 
MAX is shown in Figure 2-20.

The vacuum protection circuitry on the System Control PCB monitors the 
pressure in the ion transfer capillary-skimmer region of the vacuum manifold, 
as measured by the Convectron gauge, and in the analyzer region of the 
vacuum manifold, as measured by the ion gauge. The vacuum protection 
circuitry turns off power to the octapole and mass analyzer RF and waveform 
generation circuitry, 8 kV power supply (for the API source), electron 
multiplier and conversion dynode power supply, APCI vaporizer heater, and 
dc voltages to the ion transfer capillary heater, tube lens, octapoles, 
interoctapole lens, and mass analyzer if one or more of the following 
conditions arise:

• The pressure in the ion transfer capillary-skimmer region is above 3 Torr

• The pressure in the analyzer region is above 5 × 10-4 Torr

• The high-voltage safety interlock switch on the API source is open (that 
is, the API flange is not secured to the spray shield)

The LED labeled Vacuum on the front panel of the LCQ Series MS detector is 
illuminated green whenever the vacuum protection circuitry indicates that the 
vacuum is OK (and the safety interlock switch on the API source is closed).
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Figure 2-19. Functional block diagram of the LCQ Advantage MAX vacuum system electronic 
assemblies 
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Figure 2-20. Functional block diagram of the LCQ Deca XP MAX vacuum system electronic 
assemblies 
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The Pfeiffer TC600 Turbomolecular Pump Controller provides power to and 
control of the turbomolecular pump. The turbomolecular pump status 
(temperature, rotational speed, etc.) is sent from the Turbomolecular Pump 
Controller to the embedded computer over a serial line. Power for the 
Turbomolecular Pump Controller and the turbomolecular pump is turned off 
and on by the main power circuit breaker and not by the electronics service 
switch. 

The Vent Delay PCB controls the vent valve. The vent valve is closed when 
the solenoid is energized. The vacuum manifold is vented to filtered air 30 s 
after power is removed from the system.

The +48, +24 V dc switching power supply provides power to the ion transfer 
capillary heater, Turbomolecular Pump Controller, Vent Delay PCB, and vent 
valve during normal operating conditions. A battery backup on the Vent 
Delay PCB provides power to the Vent Delay PCB and vent valve during a 
power failure. If external power is not restored to the instrument after 30 s, a 
circuit on the Vent Delay PCB times out, and power to the vent valve solenoid 
is shut off. When power to the vent valve solenoid is shut off, the vent valve 
opens and the manifold is vented to filtered air. The vent valve closes after 
power is restored to the system. The battery backup is recharged 
automatically by the system after power is restored.

RF/Waveform Voltage Generation Electronic 
Assemblies

The RF/waveform voltage generation electronic assemblies produce the ring 
electrode RF voltage and the octapole RF voltage. They also produce the ion 
isolation waveform voltage, resonance excitation RF voltage, and resonance 
ejection RF voltage that are applied to the endcap electrodes of the mass 
analyzer. All RF and waveform voltages are controlled by the System Control 
PCB. 

The RF/waveform voltage generation electronic assemblies include the 
following components. See Figure 2-21.

• Waveform DDS PCB

• Waveform Amplifier PCB

• RF Voltage Amplifier PCB

• Low Pass Filter PCB

• Dc ring filter

• RF voltage coil

• RF Voltage Control PCB

• Top Cover PCB

• Switched Balun PCB (LCQ Advantage MAX only)
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• Auxiliary Amplifier PCB (LCQ Deca XP MAX only)

The Waveform DDS (direct digital synthesizer) PCB, which is a part of the 
embedded computer, provides the reference voltages for the resonance 
excitation RF voltage, resonance ejection RF voltage, ion isolation waveform 
voltage, and the octapole RF voltage These voltages are sent to the Waveform 
Amplifier PCB. It also provides the reference voltage for the ring electrode 
RF voltage, which is sent to the RF Voltage Amplifier PCB.

The Waveform Amplifier PCB receives and amplifies the ion isolation 
waveform produced by the Waveform DDS PCB. The Waveform Amplifier 
PCB also receives a sine wave reference signal from the Waveform DDS PCB 
that it uses to produce the resonance excitation, resonance ejection, and 
octapole RF voltages.

The RF Voltage Amplifier PCB provides the ring electrode RF primary 
voltage for the RF voltage coil. The RF Voltage Amplifier PCB receives a 
sine wave reference signal from the Waveform DDS PCB.

The Low Pass Filter PCB removes second and third harmonics from the ring 
electrode RF voltage.

The dc ring filter filters the dc offset voltage that is applied to the ring 
electrode.

The RF voltage coil amplifies the primary voltage from the RF Voltage 
Amplifier PCB to produce a secondary voltage of 0 to 8500 V ac (peak) that is 
supplied to the ring electrode of the mass analyzer. Also, the dc offset voltage 
that is applied to the ring electrode is added to the ring electrode RF voltage at 
the RF voltage coil.

The RF Voltage Control PCB detects and controls the amplitude of the RF 
voltage that is applied to the ring electrode. The RF Voltage Control PCB 
includes the mass control circuit, and it resides in a thermally stable housing, 
which helps to prevent mass calibration drift.

The Switched Balun PCB (in LCQ Advantage MAX) or the Auxiliary 
Amplifier PCB (in LCQ Deca XP MAX) receives the amplified octapole RF 
voltage from the Waveform DDS PCB, which is applied to the octapoles via 
the Top Cover PCB. The Switched Balun PCB also receives the amplified 
waveform voltages, resonance excitation RF voltage, and resonance ejection 
RF voltage from the Waveform Amplifier PCB. The Switched Balun PCB 
splits the waveform voltages, resonance excitation RF voltage, and resonance 
ejection RF voltage into two RF voltages that are 180° out of phase (one for 
each of the endcap electrodes of the mass analyzer). The endcap electrode dc 
offset voltage from the System Control PCB is then added to the waveform 
voltages, resonance excitation RF voltage, and resonance ejection RF voltage.
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The Top Cover PCB serves as the interface between the MS detector 
electronics and the ion optics, mass analyzer, and electron multiplier anode. 
(It is located on the top of the vacuum manifold top cover plate.) The Top 
Cover PCB receives the waveform voltage, resonance excitation RF voltage, 
and resonance ejection RF voltage (plus dc offset voltage), and then passes 
them to the endcap electrodes of the mass analyzer. The Top Cover PCB also 
receives the octapole RF voltage from the Switched Balun PCB. A trifilar coil 
on the Top Cover PCB splits the octapole RF voltage into two RF voltages 
that are 180° out of phase. (The two RF voltages are applied to alternate rods.) 
Two dc offset voltages for the split octapole and one dc offset voltage for the 
second octapole are added to the RF voltages at the trifilar coil.

Ion Detection System Electronic Assemblies

The ion detection system electronic assemblies provide high voltage to the 
electron multiplier and conversion dynode of the ion detection system. They 
also receive the electron multiplier output current signal, convert it to a 
voltage (by the electrometer circuit), and pass it to the data system. A 
functional block diagram of the ion detection system electronic assemblies is 
shown in Figure 2-22.

Figure 2-21. RF/waveform voltage generation electronic assemblies
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The ion detection system electronic assemblies include the following:

• Electron multiplier power supply

• Conversion dynode power supply

• Electrometer circuit

The electron multiplier power supply supplies the -0.8 kV to -2.5 kV dc high 
voltage to the cathode of the electron multiplier. The high voltage set control 
signal for the electron multiplier power supply comes from the System 
Control PCB. This signal controls a feedback control circuit and is 
proportional to the final high voltage to be applied to the electron multiplier 
cathode. The electron multiplier voltage is lowered by the System Control 
PCB during sample ionization to prolong the life of the electron multiplier.

The conversion dynode power supply supplies +15 kV and -15 kV dc high 
voltage to the conversion dynode. The polarity of the voltage applied to the 
conversion dynode is determined by a control signal from the System 
Control PCB.

The electrometer circuit, located in a shielded enclosure on the Top Cover 
PCB, receives the amplified ion current from the anode of the electron 
multiplier, converts the current into a voltage, and then integrates the voltage 
over time. The integrated voltage is then passed to the Acquisition DSP PCB 
(in the embedded computer) where it is processed and sent to the data system.

Figure 2-22. Functional block diagram of the ion detection system electronic assemblies
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Embedded Computer Electronic Assemblies

The embedded computer is a computer within the MS detector that 
coordinates instrument control, waveform and RF voltage generation, data 
acquisition, and communication with the data system and external devices. A 
functional block diagram of the embedded computer is shown in 
Figure 2-23. The embedded computer contains the following components:

• ATX mainboard (LCQ Advantage MAX only)

• ISA Single Port Computer (LCQ Deca XP MAX only)

• RS 232 to 485 Converter PCB (LCQ Advantage MAX only)

• RJ-45 Serial Connector (LCQ Deca XP MAX only)

• Waveform DDS PCB

• Control DSP PCB

• Acquisition DSP PCB

• Support PCB (LCQ Advantage MAX only)

• Ethernet PCB

The ATX mainboard distributes power to and communication between the 
Ethernet PCB, Support PCB, Acquisition DSP PCB, Control DSP PCB, and 
Waveform DDS PCB. The ATX mainboard includes a CPU, RAM memory, 
ISA bus, and PCI bus. Software to run the embedded computer is loaded into 
the RAM memory on bootup. 

The Waveform DDS (direct digital synthesizer) PCB provides the reference 
sine wave or ac voltages for the resonance excitation RF voltage, resonance 
ejection RF voltage, ion isolation waveform voltage, and octapole RF voltage. 
These voltages are sent to the Waveform Amplifier PCB in the MS detector. It 
also provides the reference voltage for the ring electrode RF voltage, which is 
sent to the RF Voltage Amplifier PCB.

Three coaxial cables transmit the ring electrode RF reference voltage, 
resonance excitation/ejection RF reference voltage, ion isolation waveform 
reference voltage, and octapole RF reference voltage from the Waveform 
DDS PCB to the RF Voltage Amplifier PCB and Waveform Amplifier PCB. 
The Waveform DDS PCB, Control DSP PCB, and Acquisition DSP PCB 
communicate with each other over a local bus.

The Control DSP (digital signal processor) PCB controls the MS detector via 
the System Control PCB. A high speed serial line serves as an interface 
between the Control DSP PCB and the System Control PCB. The Control 
DSP PCB is where most computations and control functions take place. For 
example, it determines what waveforms the Waveform DDS PCB produces 
and when to apply them.
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The Acquisition DSP PCB serves as the digital acquisition link with the 
electrometer on the Top Cover PCB. It receives data from the electrometer, 
processes it, and sends it to the data system via the Ethernet local area 
network connection.

The Support PCB provides power for the embedded computer. Software to 
run the embedded computer, which is contained in flash memory on the 
Support PCB, is loaded into RAM on bootup. After bootup, software to run 
the LCQ Series MS detector is transferred from the data system to the 
embedded computer over an Ethernet. You can reboot the embedded 
computer and download the LCQ Series MS detector software from the data 
system by pressing the reset button on the power panel.

The Ethernet PCB provides Ethernet communication between the embedded 
computer and the data system over a thinwire Ethernet cable.
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Figure 2-23. Functional block diagram of the embedded computer, showing communication with 
the MS detector and external devices
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2.6 Data System
The data system controls and monitors the LCQ Series MS detector system. 
The data system also processes data that is acquired by the LCQ Series MS 
detector system. The data system is composed of the following:

• Computer hardware and software

• Data system/MS detector interface

• Data system/local area network interface

• Printer (optional)

Computer Hardware and Software

To run Xcalibur 1.3 with the LCQ Series MS detector, the data system 
computer must have the following minimum system requirements:

• Pentium III 500 MHz with 128 MB RAM

• CD-ROM drive

• Video card and monitor capable of 1024 x 728 resolution and 65,536 
colors

• >4 GB hard drive

• Microsoft® Windows® 2000 with Service Pack 2 

• Microsoft Office XP

• Primary Ethernet adapter (data system to MS detector)

• Secondary Ethernet adapter (data system to local area network)

• 1.44-MB, 3.5-in. diskette drive

• Keyboard and mouse

Data System / MS Detector Interface 

The data system computer contains an Ethernet adapter (called the primary 
Ethernet adapter) that is dedicated to data system/MS detector 
communications. The Ethernet adapter on the instrument resides in the 
embedded computer box. A thinwire Ethernet cable connects the primary 
Ethernet adapter of the data system with the Ethernet connector on the power 
panel of the MS detector (see Figure 2-6).

Note. Depending upon the applications for which your LCQ Series MS 
detector is used, your data processing and connectivity requirements may 
differ from those listed here.
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Data System / Local Area Network Interface 

The data system computer contains a second Ethernet adapter called the 
secondary Ethernet adapter. The secondary Ethernet adapter is not involved in 
data system/MS detector communications. You can use the secondary 
Ethernet adapter to connect your LCQ Series PC to a local area network.

Printer

A high resolution laser printer is available with the LCQ Series MS detector 

as an option. The printer communicates with the PC via a parallel port 
(LPT1). Refer to the manual supplied by the manufacturer for details about 
the printer.

You set up the printer from the Print Setup dialog box. To open the Print Setup 
dialog box, choose File > Print Setup in any window.
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This chapter outlines the checks of the LCQ Series MS detector system that 
should be performed every day before you begin your first analysis. The 
following checks should be performed every day:

• Check disk space on the data system

• Check helium and nitrogen gas pressures

• Check system vacuum levels

• Print a hard copy of the Tune Plus Status view

Note. You do not need to calibrate or tune the LCQ Series MS detector as 
part of your daily routine.   

Calibration parameters are instrument parameters whose values do not vary 
with the type of experiment. You need to calibrate the LCQ Series MS 
detector perhaps once a month, and check the calibration once a week. Refer 
to Finnigan LCQ Series Getting Started for a procedure for calibrating the 
LCQ Series MS detector.

Tune parameters are instrument parameters whose values vary with the type 
of experiment. You need to tune the LCQ Series MS detector (or change the 
Tune Method) whenever you change the type of experiment. Refer to 
Finnigan LCQ Series Getting Started for procedures for tuning the LCQ 
Series MS detector in the ESI or APCI mode. (Note that the LCQ Series MS 
detector comes with several standard Tune Methods specific for various 
experimental conditions, so that tuning is often not required for many types 
of experiments.) 

Refer to Finnigan LCQ Series Nanospray Ion Source Operator’s 
Manual for information concerning the NSI technique.
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3.1 Checking the Disk Space
You should verify on a regular basis that your hard disk drive has enough free 
space for data acquisition. The amount of available disk space is shown in the 
Check Disk Space dialog box. To determine the amount of available disk 
space, proceed as follows:

1. From the Home Page window (which is available by choosing 
Start > Programs > Xcalibur > Xcalibur), choose Actions > 
Check Disk Space to open the Disk Space dialog box. The Disk Space 
dialog box lists the following:

• Current drive and directory (for example, 
C:\Xcalibur\system\programs)

• Number of MB that are available (free) on the current drive

• Percentage of the current drive that is available

• Total capacity of the current drive

2. To select another disk drive so that you can determine its disk space, click 
on the Directory button.

3. When you have completed this procedure, click on OK to close the 
dialog box.

If necessary, you can free space on the hard disk by deleting obsolete files and 
by moving files from the hard disk drive to a backup medium. First, copy files 
to the backup medium. After you have copied the files, you can delete them 
from the hard disk. Use the Microsoft Windows Explorer or File Manager 
copy (or backup) and delete commands to copy (or backup) and delete files. 
Refer to the Microsoft Windows 2000 users manual for information on the 
Explorer or File Manager.
������
���������������	�
��3-2 ____________________ Finnigan LCQ Series Hardware Manual ____________________



Preparing for Daily Operation

�������������	
��
�___________________________________Checking the Helium and Nitrogen Supplies
3.2 Checking the Helium and 
Nitrogen Supplies

Check the helium supply on the regulator of the gas tank. Make sure that you 
have sufficient gas for your analysis. If necessary, install a new tank of 
helium. Verify that the pressure of helium reaching the MS detector is 
between 200 and 350 kPa (30 to 50 psig). If necessary, adjust the pressure 
with the tank pressure regulator.

Check the nitrogen supply on the regulator of the nitrogen gas tank or liquid 
nitrogen boil-off tank. Make sure that you have sufficient gas for your 
analysis. Typical nitrogen consumption is 100 cubic feet per day (nitrogen on 
24 hours per day). If necessary, replace the tank. Verify that the pressure of 
nitrogen reaching the MS detector is between 550 and 830 kPa (80 to 120 
psig). If necessary, adjust the pressure with the tank pressure regulator.

CAUTION. Before you begin normal operation each day, ensure that you 
have sufficient nitrogen for your API source. If you run out of nitrogen, the 
LCQ Series MS detector automatically turns the MS detector Off to prevent 
the possibility of atmospheric oxygen from entering the ion source. The 
presence of oxygen in the ion source when the MS detector is On could be 
unsafe. (In addition, if the LCQ Series MS detector turns off the MS detector 
during an analytical run, you could lose data.)
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3.3 Checking the System Vacuum 
Levels

For proper performance, your LCQ Series system must operate at the proper 
vacuum levels. Operation of the system at vacuum levels that are too high can 
cause reduced sensitivity, tuning problems, and reduced lifetime of the 
electron multiplier. You should check your system for air leaks by checking 
the system vacuum levels before you begin your first acquisition.

Air leaks are indicated by the following:

• Vacuum manifold pressure above 5 x 10-4 Torr in the analyzer region (as 
measured by the ion gauge) or above 3 Torr in the capillary-skimmer 
region (as measured by the Convectron gauge). If either pressure is too 
high, the LED labeled Vacuum is not illuminated green. [Note that the 
safety interlock switch on the API source must be depressed (that is, the 
API flange must be secured to the spray shield) for the Vacuum LED to be 
illuminated green.]

• Vacuum manifold pressure levels as measured by the Convectron gauge 
and ion gauge are higher than the levels shown in Table 3-1.

You can check the current values of the pressures in the vacuum manifold, as 
measured by the Convectron gauge and ion gauge, in the Tune Plus window. 
In the Tune Plus window the pressures are listed in the Vacuum dialog box. To 
display the Vacuum dialog box, click on the vacuum button or choose 
Setup > Vacuum.

Compare the current values of the pressures in the vacuum manifold with the 
values listed in Table 3-1 and with values from Status views that you 
previously printed out. If the current values are higher than normal, you may 
have an air leak.

If the pressure is high (above 5 x 10-5 Torr in the analyzer region), and you 
have restarted the system within the last 30 to 60 min, wait an additional 
30 min and recheck the pressure. If the pressure is decreasing with time, 
check the pressure periodically until it is low enough for the proper operation 
of the MS detector.

Caution. Major air leaks are often identifiable merely by listening for a rush 
of air or a hissing sound somewhere on the instrument. A major leak might 
be caused, for example, by an extremely loose or disconnected fitting, by an 
O-ring that is not properly seated, or by an open valve. If you hear these 
sounds, do not turn on the high voltages to the MS detector.
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If the pressure remains high, your system may have an air leak. Check each 
fitting and flange on the system for tightness, and tighten the fittings or 
flanges that are loose. Do not tighten fittings indiscriminately. Pay particular 
attention to fittings that have been changed recently or to fittings that have 
been subjected to heating and cooling. Make sure that the top cover plate of 
the vacuum manifold and the spray shield of the API source are properly 
seated.

Table 3-1. Typical Pressure Readings

Conditions Convectron gauge reading 
(foreline, ion transfer 
capillary- skimmer region)

Ion gauge reading (analyzer 
region)

Helium on, ion transfer capillary open 
(200 °C)

0.9 to 1.1 Torr 1.0 x 10-5 to 1.5 x 10-5 Torr

Helium on, ion transfer capillary open
(25 °C)

1.2 Torr (or slightly higher) <2.0 x 10-5 Torr

Helium on, ion transfer capillary 
closed

2 x 10-3 to 1 x 10-2 Torr 8 x 10-6 Torr

Helium off, ion transfer capillary open
(200 °C)

0.9 to 1.1 Torr 3 x 10-6 Torr

Helium off, ion transfer capillary open
(25 °C)

1.2 Torr (or slightly higher) 4 x 10-6 Torr

Helium off, ion transfer capillary 
closed

2 x 10-3 to 5 x 10-3 Torr 2.0 x 10-6 Torr
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3.4 Printing a Hard Copy of the Status 
View

The Tune Plus Status view lists the current values of the instrument 
parameters. It is a good idea to print (or save in a file) a hard copy of the status 
view on a daily basis. This procedure allows you to detect problems by 
monitoring changes in the instrument parameters.

To print a copy of the Status view, proceed as follows:

1. From the Tune Plus window, choose Control > On (or click on the 
On/Standby button) to turn on voltages to the API source, ion optics, mass 
analyzer, and ion detection system.

2. Choose View > Display Status View (or click on the Display Status 
View button on the button bar). The Status view appears in the Tune Plus 
window.

3. Click on the Status view to make it the active window.

4. Print a hard copy of the Status view by choosing File > Print.

5. Choose Control > Standby to turn off voltages to the API source, ion 
optics, mass analyzer, and ion detection system.
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Chapter 4
LCQ Advantage MAX MS Detector

Maintenance

LCQ Advantage MAX performance depends on the maintenance of all parts 
of the instrument. It is your responsibility to maintain your system 
properly by performing the system maintenance procedures on a regular 
basis. 

This chapter describes routine MS detector maintenance procedures that must 
be performed to ensure optimum performance of the instrument. Most of the 
procedures involve cleaning. For example, procedures are provided for 
cleaning the API source, ion optics, mass analyzer, and ion detection system. 
Procedures are also presented for replacing the API sample tube, ion transfer 
capillary, and electron multiplier.

Routine and infrequent MS detector maintenance procedures are listed in 
Table 4-1.

Table 4-1. MS Detector maintenance procedures

MS Detector 
Component

Procedure Frequency Procedure Location

API source Flush (clean) sample 
transfer line, sample 
tube, and API probe

Daily page 4-6

API source Flush (clean) ion 
transfer capillary

Daily (or as needed*) page 4-8

API source Flush (clean) spray 
shield/spray cone

Daily page 4-8

Forepump Purge (decontaminate) 
oil

Daily (or as needed*) page 4-45

API source Clear ion transfer 
capillary

If ion transfer capillary 
bore is obstructed

page 4-10

API source Replace ion transfer 
capillary

If ion transfer capillary 
bore is corroded.

page 4-11

API source Clean API stack (spray 
shield, ion transfer 
capillary, tube lens, and 
skimmer)

As needed* page 4-17
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API source Replace sample tube If sample tube is broken 
or obstructed

Refer to the Finnigan 
Ion Max API Source 
Hardware Manual. 

Ion optics Clean octapoles and 
interoctapole lens

As needed* page 4-21

Mass analyzer Clean mass analyzer Yearly (or as needed*) page 4-21

Ion detection system Clean ion detection 
system (electron 
multiplier and 
conversion dynode)

Whenever the top cover 
plate of the vacuum 
manifold is removed

page 4-31

Ion detection system Replace electron 
multiplier anode and 
cathode

If noise in spectrum is 
excessive or proper 
electron multiplier gain 
can not be achieved

page 4-40

Turbomolecular pump Change oil reservoir At least once a year page 4-46

Turbomolecular pump Replace turbomolecular 
pump

If turbomolecular pump 
fails

page 4-46

Cooling fans Clean fan filter Every 4 months page 4-49

Forepump Add oil If oil level is low Manufacturer’s 
documentation

Forepump Change oil Every 3 months or if oil 
is cloudy or discolored

Manufacturer’s 
documentation

Fuses Replace fuse If fuse has blown LCQ Advantage MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

Electronic modules Replace electronic 
module

If electronic module fails LCQ Advantage MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

PCBs Replace PCB If PCB fails LCQ Advantage MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

Ion gauge Replace ion gauge If ion gauge fails LCQ Advantage MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

*Frequency depends on analytical conditions

Table 4-1. MS Detector maintenance procedures, continued

MS Detector 
Component

Procedure Frequency Procedure Location
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For instructions on maintaining LCs or autosamplers, refer to the manual that 
comes with the LC or autosampler.

This chapter contains the following sections:

• Tools and supplies

• Frequency of cleaning

• API source maintenance

• Cleaning the ion optics and mass analyzer

• Replacing the electron multiplier

• Purging the forepump oil

• Replacing the turbomolecular pump oil reservoir

• Cleaning the fan filter

Note. The keys to success with the procedures in this chapter are: 

Proceed methodically

Always wear clean, lint-free gloves when handling the components of the 
API source, ion optics, mass analyzer, and ion detection system

Always place the components on a clean, lint-free surface 

Always cover the opening in the top of the vacuum manifold with a large, 
lint-free tissue whenever you remove the top cover plate of the vacuum 
manifold

Never overtighten a screw or use excessive force

Never insert a test probe (for example, an oscilloscope probe) into the 
sockets of female cable connectors on PCBs
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4.1 Tools and Supplies
The LCQ Advantage MAX requires very few tools for you to perform routine 
maintenance procedures. You can remove and disassemble many of the 
components by hand. The tools, equipment, and chemicals listed in Table 4-2 
are needed for the maintenance of the API source, ion optics, mass analyzer, 
and ion detection system.

Table 4-2.  Tools, equipment, and chemicals

Description Part Number

Wrench, 5/16-in., hex socket (Allen)

Wrench, 9/16-in., socket

Wrench, 7/16-in., open end

Wrench, 9/16-in., open end

Wrench, 5/16-in., open end

Wrench, 1/2-in., open end

Wrench, 3/8-in., open end

Screwdrivers, set, ball point, Allen 
(also referred to as ball drivers)

00025-03025 

Screwdriver, slot head, large

Screwdriver, slot head, small

Screwdriver, Phillips, small

Fused-silica cutting tool

Hypodermic tube 00106-20000

Spray bottle

Beaker, 450 mL

Gloves, nylon 00301-09700

Kimwipes® or other lint-free industrial tissue

Applicators (swabs), cotton-tipped 00301-02000

Detergent

Clean, dry, compressed nitrogen gas

Distilled water

Methanol, HPLC grade or better

Tool, ion transfer capillary 70111-20258

CAUTION.  As with all chemicals, solvents and reagents should be stored 
and handled according to standard safety procedures and should be disposed 
of according to local and federal regulations.
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4.2 Frequency of Cleaning
The frequency of cleaning the components of the MS detector depends on the 
types and amounts of samples and solvents that are introduced into the 
instrument. In general, for a given sample and ionization technique, the closer 
an MS detector component is to the source of the ions, the more rapidly it 
becomes dirty.

• The sample tube, API probe, ion transfer capillary bore, and spray shield 
of the API source (including the ion sweep cone and the spray cone) 
should be cleaned at the end of each operating day to remove any residual 
salts from buffered mobile phases or other contamination that might have 
accumulated during normal operation. Refer to the topics Flushing the 
Sample Transfer Line, Sample Tube, and API Probe and Flushing the 
Spray Shield, Ion sweep cone, Spray Cone, and Ion Transfer 
Capillary on page 4-6 and page 4-8, respectively.

• The tube lens and skimmer of the API source become dirty at a slower 
rate than the API probe, spray shield, and ion transfer capillary. Refer to 
the topic Maintaining the API Stack on page 4-11.

• The ion optics and the mass analyzer become dirty at a rate significantly 
slower than the API source. Refer to the topic Cleaning the Ion Optics 
and Mass Analyzer on page 4-28.

• Clean the electron multiplier and conversion dynode whenever you 
remove the top cover plate of the vacuum manifold by blowing them with 
a clean, dry gas. Refer to the topic Cleaning the Ion Detection System 
on page 4-31.

When the performance of your system decreases significantly due to 
contamination, clean the components of the MS detector in the following 
order:

• Clean the API probe, spray shield, and ion transfer capillary

• Clean the tube lens and skimmer

• Clean the ion optics and mass analyzer
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4.3 API Source Maintenance
The API source requires a minimum of maintenance. Periodically, you need 
to clean the components of the API source to remove salts or other 
contaminants. The frequency of cleaning the API source depends on the types 
and amounts of samples and solvents that are introduced into the system.

Maintenance procedures are provided below to do the following:

• Flush the sample transfer line, sample tube, and API probe

• Flush the spray shield and the bore of the ion transfer capillary

• Clear a blocked ion transfer capillary

• Maintain the APCI probe assembly, including replacing the APCI sample 
tube

• Maintain the ESI probe assembly, including replacing the ESI sample 
tube

• Maintain the API stack, including replacing the ion transfer capillary

Flushing the Sample Transfer Line, Sample 
Tube, and API Probe

You should flush the sample transfer line, sample tube, and API probe at the 
end of each working day (or more often if you suspect they are contaminated) 
by flowing a 50:50 methanol / distilled water solution from the LC through 
the API source.

To flush the sample transfer line, sample tube, and API probe, proceed as 
follows:

1. Make sure that the API flange is secured to the spray shield by the two 
flange retainer bolts.

2. Choose Start > Programs > Xcalibur > LCQ Tune to open the Tune 
Plus window.

This manual provides maintenance procedures for the APCI probe and the 
ESI probe. For maintenance procedures for the NSI source, refer to the LCQ 
Series Nanospray Ion Source Operator’s Manual. 

CAUTION. AVOID EXPOSURE TO POTENTIALLY HARMFUL 
MATERIALS. Always wear protective gloves and safety glasses when you 
use solvents or corrosives. Also, contain waste streams and use proper 
ventilation. Refer to your supplier’s Material Safety Data Sheets (MSDS) for 
procedures that describe how to handle a particular solvent.
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3. From the Tune Plus window, choose Control > On (or click on the 
On/Standby button) to turn on the voltages and gas flows to the API 
source. 

• If you are operating in APCI mode, go to step 4.

• If you are operating in ESI mode, go to step 5.

4. Set up the APCI source as follows:

a. Ensure that the auxiliary gas line is connected to the A port on the 
APCI probe.

b. In the Tune Plus window, choose Setup > APCI Source (or click 
on the APCI Source button). The APCI Source dialog box appears.

c. In the APCI Source dialog box, use the Vaporizer Temp spin box to 
set the vaporizer temperature to 500 °C. 

d. Use the Sheath Gas Flow Rate spin box to set the sheath gas flow rate 
to 80 units.

e. Use the Aux Flow Rate spin box to set the auxiliary gas flow rate to 
10 units.

f. Use the Discharge Current spin box to set the discharge current to 
0 µ��

g. Click on OK to set the APCI parameters and close the dialog box. Go 
to step 6.

5. Set up the ESI source as follows:

a. Ensure that the auxiliary gas line is connected to the Aux port on the 
ESI probe.

b. In the Tune Plus window, choose Setup > ESI Source (or click on 
the ESI Source button). The ESI Source dialog box appears.

c. Use the Sheath Gas Flow Rate spin box to set the sheath gas flow rate 
to 80 units. 

d. Use the Aux Flow Rate spin box to set the auxiliary gas flow rate to 
10 units. 

e. Use the Spray Voltage spin box to set the spray voltage to 0 kV.

f. Click on OK to set the ESI parameters and close the dialog box.

6. Set up and start a flow of 50:50 methanol / water solution from the LC to 
the API source, as follows:

a. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

b. Select the LC tab.
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c. In the Inlet Direct Control dialog box, set the Flow Rate to a value 
that is typical for your experiments.

d. In the Inlet Direct Control dialog box, set the % spin boxes to 50% 
methanol and water.

e. Click on Start to start the LC pump.

7. Let the solution flow through the sample transfer line, sample tube, and 
API probe for 15 min. After 15 min, turn off the flow of liquid from the 
LC to the API source, as follows. Leave the API source (including the 
APCI vaporizer, sheath gas, and auxiliary gas) on for an additional 5 min.

a. In the Tune Plus window, click on the LC pump button. The Inlet 
Direct Control dialog box appears.

b. Select the LC tab.

c. Click on Stop to stop the LC pump.

8. After 5 min, turn off the API source by placing the MS detector in 
Standby: From the Tune Plus window, choose Control > Standby (or 
click on the On/Standby button).

Go on to the next topic: Flushing the Spray Shield and the Ion Transfer 
Capillary.

Flushing the Spray Shield, Ion Sweep Cone, 
Spray Cone, and Ion Transfer Capillary

You need to clean the spray shield, ion sweep cone, spray cone, and ion 
transfer capillary on a regular basis to prevent excessive contamination and to 
maintain optimum performance of your API source. A good practice is to 
flush the spray shield, ion sweep cone, spray cone, and ion transfer capillary 
at the end of each operating day after you flush the sample transfer line, 
sample tube, and API probe with a 50:50 methanol / water solution from the 
LC. (Refer to the topic Flushing the Sample Transfer Line, Sample Tube, 
and API Probe on page 4-6.) If you are operating the system with nonvolatile 
buffers in your solvent system or with high concentrations of sample, you 
might need to clean the spray shield, ion sweep cone, spray cone, and ion 
transfer capillary more often.

You do not need to vent the system to flush the spray shield, ion sweep cone, 
spray cone, and ion transfer capillary. 

To clean the spray shield, ion sweep cone, spray cone, and the ion transfer 
capillary, do the following:

1. Turn off the flow of liquid from the LC (or other sample introduction 
device) to the API source. To turn off the flow of liquid from the LC to the 
API source, do the following:
������
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a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

b. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

c. Select the LC tab and click on Stop to stop the LC pump.

2. From the Tune Plus window, choose Control > Standby (or click on the 
On/Standby button) to put the MS detector in Standby. If you are using 
the APCI Source, click on the APCI Source button. Then, in the APCI 
Source dialog box, use the Vaporizer Temp spin box to set the vaporizer 
temperature to 0 °C. For either APCI or ESI, turn the heat to the ion 
transfer capillary heater off.

3. Loosen the two flange retainer bolts that secure the API flange (APCI or 
ESI flange) to the spray shield.

4. Pull back the API flange from the spray shield.

5. Pull the ion sweep cone off of the spray cone, and place it on a large 
Kimwipe (or other lint-free tissue). Temporarily place another large 
Kimwipe on the bottom of the spray shield. (This Kimwipe is required to 
absorb the solution used to flush the spray cone, ion transfer capillary, and 
spray shield.)

6. Fill a spray bottle with a 50:50 solution of HPLC-grade 
methanol / distilled water. Spray approximately 5 mL of the solution at 
the opening of the ion transfer capillary. Do not touch the ion transfer 
capillary with the tip of the spray bottle.

7. Use the spray bottle filled with the 50:50 solution of HPLC-grade 
methanol / distilled water to flush contaminants from the accessible 
surfaces of the spray shield and the spray cone.

8. Remove the Kimwipe you used to absorb the solution. Swab the surface 
of the spray shield and spray cone with a dry Kimwipe.

9. Ensure that you have removed any salt or other contaminants that may 
have been deposited on the spray shield or spray cone.

10. If you are operating in the ESI mode, wipe off the ESI nozzle with a 
Kimwipe soaked with the 50:50 HPLC-grade methanol / water solution. 

CAUTION. AVOID BURNS. At operating temperatures, the APCI 
vaporizer, ion sweep cone, spray cone, and ion transfer capillary can 
severely burn you! The APCI vaporizer typically operates at 400 to 600 °C 
and the ion sweep cone, spray cone, and ion transfer capillary typically 
operate at 100 to 300 °C. Allow the heated vaporizer, ion sweep cone, spray 
cone, and ion transfer capillary to cool to room temperature, for 
approximately 20 min, before you touch or remove these components.
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11. Use the spray bottle filled with the 50:50 solution of HPLC-grade 
methanol / distilled water to flush contaminants from the interior and 
exterior surface of the ion sweep cone. Then swab the surface of the ion 
sweep cone with a dry Kimwipe.

Clearing the Bore of the Ion Transfer 
Capillary

A stainless steel hypodermic tube has been included in your accessory kit for 
clearing the ion transfer capillary in the unlikely event it should become 
blocked. However, since the ion transfer capillary can be easily removed and 
replaced without loss of vacuum, and you might want to replace the ion 
transfer capillary instead of cleaning the ion transfer capillary. 

If the pressure in the API region (as measured by the Convectron® gauge) 
drops considerably below 1 Torr, you should suspect a blocked ion transfer 
capillary. (You can check the Convectron gauge pressure in the Vacuum 
dialog box by choosing Setup > Vacuum from the Tune Plus window.)

You do not have to vent the system to clear the bore of the ion transfer 
capillary. To clear the bore of the ion transfer capillary, do the following:

1. Turn off the flow of liquid from the LC (or other sample introduction 
device) to the API source. To turn off the flow of liquid from the LC to the 
API source, do the following:

a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

b. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

c. Select the LC tab and click on Stop to stop the LC pump.

2. Loosen the two flange retainer bolts that secure the API flange (APCI or 
ESI) to the spray shield.

3. Pull back the API flange from the spray shield. 

Note. If you are finished operating your LCQ Advantage MAX for the day, 
cap the ion transfer capillary with the septum. Leave the API flange 
withdrawn from the spray shield. Purge the oil in the forepump as described 
in the topic Purging the Oil in the Forepump on page 4-45.

CAUTION. The APCI vaporizer typically operates at 400 to 600 °C and the 
ion sweep cone, spray cone, and ion transfer capillary typically operate at 
100 to 300 °C. Allow these components to come to ambient temperature 
before proceeding.
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4. Clear the bore of the ion transfer capillary by inserting and withdrawing 
the 28 gauge, 10-in. hypodermic tube (P/N 00106-20000) included in 
your accessory kit.

5. Fill a spray bottle with a 50:50 solution of HPLC-grade 
methanol / distilled water. From a distance of 10 cm from the entrance 
end of the ion transfer capillary, spray a small amount of the solution 
down the bore of the ion transfer capillary.

6. Repeat steps 5 and 6 several times.

7. Push the API flange assembly against the spray shield.

8. Secure the API flange to the spray shield with the two flange retainer 
bolts.

Maintaining the API Stack

The API stack includes the spray shield, ion sweep cone, spray cone, ion 
transfer capillary, capillary lens and skimmer mount, and the tube lens, and 
skimmer. The ion transfer capillary has a finite lifetime. You need to replace 
the ion transfer capillary if the ion transfer capillary bore becomes corroded or 
damaged. You also need to clean the spray shield, ion sweep cone, spray cone, 
ion transfer capillary, tube lens, skimmer, and the other components of the 
API stack on a periodic basis.

It is not necessary to vent the system in order to replace the ion transfer 
capillary. To replace the ion transfer capillary, proceed as follows:

1. Turn off the flow of liquid from the LC (or other sample introduction 
device) to the API source. To turn off the flow of liquid from the LC to the 
API source, do the following:

a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

b. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

c. Select the LC tab and click on Stop to stop the LC pump.

Note. If you have unblocked the ion transfer capillary, the Convectron gauge 
pressure should increase to a normal value (approximately 1 Torr). If you 
can not clear the ion transfer capillary by this method, use the instructions 
for removing the ion transfer capillary from the spray shield in the topic 
Maintaining the API Stack on page 4-11. Then, if you wish, try clearing 
the ion transfer capillary from the exit end by the same method. Otherwise, 
replace the ion transfer capillary with a new one. 
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2. Place the electronics service switch (located on the right side of the MS 
detector) in the Service position to turn off the non-vacuum system 
voltages.

3. Loosen the two flange retainer bolts that secure the API flange (APCI or 
ESI) to the spray shield.

4. Pull back and remove the API probe flange from the spray shield.

5. Remove the ion sweep cone from the spray cone.

6. Using the ion transfer capillary tool, (P/N 70111-20258) unscrew the ion 
transfer capillary from the spray cone.

7. Using the ion transfer capillary tool, hook the ion transfer capillary and 
remove it. Replace the Kalrez O-ring (P/N 00107-12750) if necessary.

8. Screw the new ion transfer capillary into the spray cone.

9. Install and bolt the API probe flange to the spray shield.

10. Place the electronics service switch in the Normal position.

11. Begin operation using the LC or other sample introduction device.

To replace or to clean the spray shield, tube lens and skimmer mount, tube 
lens, skimmer, or other API components, do each of the following, as 
described in this topic:

• Shut down and vent the system

• Remove the API stack

• Disassemble the API stack

• Clean the API stack components

• Reassemble the API stack

• Reinstall the API stack

• Start up the system

CAUTION. Make sure that the LCQ Advantage MAX electronics service 
switch is in the Service position before you proceed.

CAUTION. The APCI vaporizer typically operates at 400 to 600 °C and the 
ion sweep cone, spray cone, and ion transfer capillary typically operate at 
100 to 300 °C. Allow these components to come to ambient temperature 
before proceeding.

Note. You should flush the spray shield, ion sweep cone, spray cone and the 
bore of the ion transfer capillary at the end of each working day with a 50:50 
methanol / water solution. Refer to the topic Flushing the Spray Shield, 
Ion sweep cone, Spray Cone, and Ion Transfer Capillary on page 4-8. 
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Shutting Down the System

Shut down and vent the system as described in the topic Shutting Down the 
System Completely in the System Shutdown, Startup, and Reset chapter. 

Go on to the next topic: Removing the API Stack.

Removing the API Stack

To remove the API stack proceed as follows:

1. Loosen the two flange retainer bolts that secure the API probe assembly 
to the spray shield.

2. Pull back the API probe assembly from the spray shield.

3. Disconnect the waste line from the spray shield.

4. Disconnect the API stack electrical cable from the spray shield by turning 
the tab on the end of the cable counterclockwise (toward you) and then 
pulling the cable free. 

5. Grasp the spray shield with both hands and carefully pull it and the API 
stack free from the vacuum manifold. Place the API stack on a clean 
surface with the spray shield down. Allow the API stack to cool to 
ambient temperature before you disassemble the API stack.

The API stack is shown in Figure 4-1.

CAUTION. Make sure that the LCQ Advantage MAX power cord is 
unplugged before you proceed.

Note. If you are unable to dislodge the spray shield from the vacuum 
manifold, reattach the API flange to the spray shield and then pull the flange 
away from the vacuum manifold.
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Go on to the next topic: Disassembling the API Stack.

Disassembling the API Stack

Wait for the API stack to cool to ambient temperature before you disassemble 
it. Refer to Figure 4-1 and Figure 4-2 for the location of the various API stack 
components. 

To disassemble the API stack proceed as follows:

1. Disconnect the waste fitting so that the API stack can easily be set on a 
flat surface. 

2. Remove the ion sweep cone. 

Figure 4-1. API stack

Tube Lens And 
Skimmer Mount

Retainer
Clip

Tube Lens
Extension
Mount

Spray Shield

Spray Cone

Note. Wear clean, lint-free, nylon or cotton gloves when you handle the API 
stack components.
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3. Remove the ion transfer capillary. (Refer to Maintaining the API Stack) 

4. Disconnect the skimmer electrical lead from the lead pin on the skimmer.

5. Disconnect the tube lens electrical lead from the lead pin on the tube lens.

6. Push the tube lens and skimmer mount into the extension mount and 
remove the retaining clip. Allow the tube lens and skimmer mount to 
move back slowly.

7. Detach the skimmer from the tube lens and skimmer mount by pushing on 
its lead pin.

8. Detach the tube lens from the tube lens and skimmer mount by pushing 
the tube lens away from the mount.

9. Pull the extension mount from the spray shield

10. Disconnect the heater cable connector for the heater.

11. Loosen the two thumb nuts on the spray shield and remove the heater and 
the graphite seal.

Caution. The tube lens and skimmer mount is spring loaded. Ensure that the 
spring (P/N 00201-11599) that is compressed in the extension mount does 
not fly free when the tube lens and skimmer mount is removed. 
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Cleaning the API Stack Components

Inspect the API stack components for contamination that results from routine 
use. If dirty, clean the API stack components as follows.

Cleaning the Tube Lens

Clean the inner bore of the tube lens with HPLC-grade methanol and a 
cotton-tipped applicator (swab).

Cleaning the Skimmer

Look at the tip of the cone on the skimmer for a region that shows 
discoloration due to contamination. (The off-axis pattern that you see is a 
result of the sample/solvent that exits from the off-axis ion transfer capillary.) 
Use methanol and a cotton-tipped applicator or Kimwipe to clean the entrance 
and exit sides of the skimmer.

Cleaning the Ion Transfer Capillary

The ion transfer capillary is easily replaceable without venting the 
LCQ Advantage MAX, however, if you wish to clean the ion transfer 
capillary, do the following:

1. Use methanol and a Kimwipe to clean the entrance end, exit end, and 
exterior of the ion transfer capillary.

2. Clear the bore of the ion transfer capillary by inserting and withdrawing 
the 28 gauge, 10-in. hypodermic tube (P/N 00106-20000) included in 
your accessory kit.

3. Flush the bore of the ion transfer capillary with methanol.

4. Dry the bore of the ion transfer capillary with nitrogen gas. 

CAUTION. The APCI vaporizer typically operates at 400 to 600 °C and the 
ion sweep cone, spray cone, and ion transfer capillary typically operate at 
100 to 300 °C. Allow these components to come to ambient temperature 
before proceeding.

Note. Solvents required for cleaning the API stack components: For 
most cleaning applications, HPLC grade methanol is the solvent of choice. 
However, use of buffers or salt solutions may require that you use an acidic, 
aqueous solution. If you need to use a solvent other than methanol, after 
cleaning the ion source components, flush the component with water and 
then flush it with methanol as a final wash. In all cases, ensure that all 
solvent has evaporated from the component(s) before reassembly.
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5. Ensure that no residue or fibers remain at the exit end of the ion transfer 
capillary. Fibers in this area may become charged and interfere with the 
normal flow of ions.

Cleaning the Spray Shield and Spray Shield Cone

To clean the spray shield and spray shield cone, wipe the inside and outside 
of the spray shield and spray shield cone with methanol and a Kimwipe.

Go on to the next topic: Reassembling the API Stack.

Reassembling the API Stack

To reassemble the API stack, proceed as follows. Refer to Figure 4-1 and 
Figure 4-2 for the location of the API stack components.

1. It is recommended that you replace the graphite seal (P/N 7011-20216)

2. Seat the heater in the spray shield and secure with the two thumb nuts.

3. Reconnect the heater cable to the connector that is held by the spray 
shield. Turn the locking ring on the cable clockwise to lock the cable. 

4. Insert the extension mount.

5. Reinstall the wave spring, tube lens and skimmer mount into the 
extension mount and use the retaining clip to hold it in place.
������
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6. Align the guide pin on the tube lens with the guide pin hole on the tube 
lens and skimmer mount. Reinstall the tube lens by inserting it into the 
tube lens and skimmer mount.

7. Align the lead pin on the skimmer with the lead pin hole on the tube lens 
and skimmer mount. Reinstall the skimmer by inserting it into the tube 
lens and skimmer mount.

8. Reconnect the tube lens lead to the lead pin on the tube lens. Use 
needlenose pliers if necessary.

9. Reconnect the skimmer lead to the lead pin on the skimmer. Use 
needlenose pliers if necessary.

10. Inspect the API stack. Ensure that the 3.85-in. ID O-ring 
(P/N 00107-14100) has no cracks, is otherwise in good condition, and is 
properly seated on the spray shield. Ensure that all components fit 
together tightly. 

Figure 4-3. Exploded view of the front of the API stack

Spray Cone

Ion Transfer 

Capillary
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O-Ring
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11. Reinstall the ion transfer capillary. See Figure 4-3. Replace the Kalrez 
O-ring (P/N 00107-12750) if necessary. Refer to the topic Maintaining 
the API Stack on page 4-11.

12. Reinstall the ion sweep cone (if being used).

Go on to the next topic: Reinstalling the API Stack.

Reinstalling the API Stack

To reinstall the API stack, proceed as follows:

1. Align the API stack with the opening in the front of the vacuum manifold. 
Turn the API stack until the guide pin on the spray shield is aligned with 
the guide pin hole in the vacuum manifold.

2. Carefully insert the API stack into the opening in the vacuum manifold 
until it seats in the vacuum manifold. 

3. Reconnect the API stack cable to the connector on the spray shield. Turn 
the tab on the end of the cable clockwise (away from you) to secure the 
cable.

4. Reconnect the waste line to the spray shield.

Go on to the next topic: Starting Up the System.

Starting Up the System

Start up the system as described in the topic Starting Up the System After a 
Complete Shutdown in the System Shutdown, Startup, and Reset chapter.
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4.4 Cleaning the Ion Optics and Mass 
Analyzer

An accumulation of chemicals on the surfaces of the ion optics and mass 
analyzer forms an insulating layer that can modify the electrical fields that 
control ion transmission and mass analysis. Therefore, clean ion optics and 
mass analyzer are essential for the proper operation of the instrument. The ion 
optics and mass analyzer require cleaning less often than the API source. The 
frequency of cleaning depends on the type and quantity of the compounds that 
you analyze.

Cleaning the ion optics and mass analyzer involves the following steps, as 
described in this section:

• Shut down and vent the system

• Remove the top cover of the MS detector

• Remover the top cover plate of the vacuum manifold

• Remove the ion optics and mass analyzer

• Disassemble the ion optics and mass analyzer

• Clean the ion optics and mass analyzer parts

• Reassemble the ion optics and mass analyzer

• Reinstall the ion optics and mass analyzer

• Reinstall the top cover plate of the vacuum manifold

• Reinstall the top cover of the MS detector

• Start up the system

• Tune the ring electrode and octapole RF voltages

Shutting Down the System

Shut down and vent the system as described in the topic Shutting Down the 
System Completely in the System Shutdown, Startup, and Reset chapter. 

Go on to the next topic: Removing the Top Cover of the MS Detector.

CAUTION. Make sure that the LCQ Advantage MAX power cord is 
unplugged before you proceed.
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Removing the Top Cover of the MS Detector

Remove the top cover of the MS detector as follows:

1. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful not to 
damage any fused silica tubing leading to the API source.

2. Unclip the two fasteners that hold the top cover to the MS detector 
chassis. The fasteners are located in the upper right and left corners of the 
chassis.

3. Slide the top cover forward by about 1.25 cm (0.5 in.). 

4. With one hand under the center of the top cover, lift the top cover up and 
away from the MS detector.

Go on to the next topic: Removing the Top Cover Plate of the Vacuum 
Manifold.

Removing the Top Cover Plate of the Vacuum 
Manifold

You need to remove the top cover plate of the vacuum manifold to access the 
ion optics, mass analyzer, and ion detection system. The top cover plate is 
held in place by gravity and by the air pressure differential between the 
vacuum manifold and atmospheric pressure. Five cables and one gas line are 
connected to the top cover plate. See Figure 4-4.

To remove the top cover plate, proceed as follows:

1. Disconnect from the Switched Balun PCB (at J1) the endcaps RF / 
octapole RF coaxial cable that comes from the Waveform Amplifier PCB.

2. Disconnect from the Switched Balun PCB (at P1) the endcaps dc offset 
cable.

3. Disconnect the electron multiplier high voltage coaxial cable that comes 
from the electron multiplier power supply.

4. Disconnect from the Top Cover PCB (at ACQU/DSP) the electrometer 
cable. (If necessary, use a small screw driver to loosen the screws that 
secure the cable.)

5. Disconnect from the Top Cover PCB (at ANALYZER) the lenses / 
octapole dc offsets cable that comes from the System Control PCB.

6. Use a 7/16-in. open-end wrench to disconnect the helium damping gas 
line from the fitting.

7. Carefully lift the top cover plate straight up by its two handles. Take care 
not to damage the components on the underside of the cover plate. Place 
the cover plate upside down (supported on its handles) on a flat surface.
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8. Cover the opening in the top of the vacuum manifold with a large, 
lint-free tissue.

Go on to the next topic: Removing the Ion Optics and Mass Analyzer.

Removing the Ion Optics and Mass Analyzer

The ion optics and mass analyzer are mounted on a baffle on the underside of 
the top cover plate of the vacuum manifold. See Figure 4-5.

Figure 4-4. Electrical connections and damping gas line connection to the top cover plate of the 
vacuum manifold
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Use the following procedure to remove the ion optics and mass analyzer from 
the top cover plate. Refer to Figure 4-6 and Figure 4-7 for the location of the 
ion optics and mass analyzer components.

1. Prepare a clean work area by covering the area with lint-free paper. Place 
each part on the paper as you remove it.

2. Disconnect the four electrical leads to the split (first) octapole. Hold the 
octapole mount with one hand; loosen and remove the two thumb screws 
that hold the octapole mount to the baffle on the top cover plate of the 
vacuum manifold. See Figure 4-5.

3. Remove the split (first) octapole and octapole mount.

4. Disconnect the electrical lead to the interoctapole lens. Remove the 
interoctapole lens.

5. Disconnect the electrical leads to the second octapole and to the exit lens, 
exit endcap electrode, and entrance endcap electrode of the mass analyzer.

Note. Wear clean, lint-free, nylon or cotton gloves when you handle the ion 
optics and mass analyzer components.

Figure 4-5. Mass analyzer and ion optics, mounted to the baffle on the top cover plate of the 
vacuum manifold
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6. Disconnect the damping gas line from the nipple on the exit endcap 
electrode by pulling the line free from the nipple (Figure 4-5).

7. Hold the mass analyzer with one hand; loosen the two thumb screws that 
hold the analyzer mount to the baffle (Figure 4-5).

8. With one hand holding the mass analyzer and the other hand holding the 
analyzer mount, lift the mass analyzer, second octapole, and analyzer 
mount out and away from the baffle on the top cover plate. Be careful not 
to touch the electron multiplier with the mass analyzer. This could 
damage the electropolished surface.

Go on to the next topic: Disassembling the Ion Optics and Mass Analyzer.

Disassembling the Ion Optics and Mass 
Analyzer

To disassemble the ion optics and mass analyzer, proceed as follows. Refer to 
Figure 4-6 and Figure 4-7 for the location of the ion optics and mass analyzer 
components.

1. Remove the split (first) octapole from the octapole mount.

2. Remove the second octapole from the analyzer mount.

3. Disassemble the mass analyzer as follows:

a. Remove the exit lens by pulling the exit lens out of the exit lens 
sleeve. Be careful not to damage the pin.

b. Remove the exit lens sleeve by squeezing the sleeve and pulling it out 
of the recess in the exit endcap electrode.

c. Unscrew and remove the two nuts from the posts.

d. Remove the two spring washers from the posts.

e. Remove the exit endcap electrode from the posts.

f. Remove the two spacer rings and the ring electrode.

g. Remove the entrance endcap electrode from the posts.

h. Remove the octapole adapter sleeve by and pulling it out of the recess 
in the entrance endcap electrode.

i. Unscrew and remove the two posts from the analyzer mount.

Go on to the next topic: Cleaning the Ion Optics and Mass Analyzer Parts.
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Cleaning the Ion Optics and Mass Analyzer 
Parts

Use the following procedure to remove contamination from the ion optics and 
mass analyzer parts. Clean each part in turn. After cleaning, place each part on 
a clean, lint free surface.

1. With a soft tooth brush or lint-free swab, scrub the ion optics or mass 
analyzer part with a solution of detergent and water.

2. Rinse the part with tap water to remove the detergent.

3. Rinse the part with distilled water.

4. Place the part in a tall beaker and immerse it completely in HPLC-grade 
methanol. Move the part up and down in the methanol for 15 s.

5. Remove the part from the methanol bath; then rinse it thoroughly with 
fresh methanol.

6. Dry the part with a rapid stream of nitrogen gas.

7. Inspect each part for contamination and dust. If necessary, repeat the 
cleaning procedure.

After all ion optics and mass analyzer parts are clean and dry, go on to the 
next topic: Reassembling the Ion Optics and Mass Analyzer.

Reassembling the Ion Optics and Mass 
Analyzer

Use the following procedure to reassemble the ion optics and mass analyzer. 
Refer to Figure 4-6 on page 4-26 and Figure 4-7 on page 4-27.

1. Reassemble the mass analyzer as follows:

Caution. Take care not to chip, scratch, or break the spacer rings of the mass 
analyzer. Take care not to bump or jar the octapoles. Do not place the 
octapoles in an ultrasonic cleaner.

Note. When you clean the ion optics and mass analyzer parts, pay particular 
attention to the inside surfaces. 

Note. Wear clean, lint-free, nylon or cotton gloves to handle the parts after 
you clean them in methanol.

Note. Wear clean, lint-free, nylon or cotton gloves when you handle 
components of the mass analyzer.
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a. Reinstall the two posts by screwing them by hand into the analyzer 
mount. (Both ends are the same.)

b. Reinstall the octapole adapter sleeve by inserting it into the entrance 
endcap electrode. (The entrance endcap electrode is the one without 
the damping gas nipple.)

c. Reinstall the entrance endcap electrode onto the posts. Ensure that the 
electrode is oriented such that the convex surface faces away from the 
analyzer mount. Also, the opening in which the pin on the end of the 
electrical lead inserts should be close to the top cover plate when the 
analyzer mount is installed on the top cover plate. 

d. Place a quartz spacer ring into the groove in the entrance endcap 
electrode.

e. Reinstall the ring electrode onto the spacer ring so that the spacer ring 
is held securely between the electrodes. The orientation of the ring 
electrode is unimportant. (Both sides are the same.)

f. Reinstall the second quartz spacer ring into the groove in the ring 
electrode.

g. Reinstall the exit endcap electrode (the one with the damping gas 
nipple) on the posts such that the spacer ring is held in place between 
the ring electrode and the exit endcap electrode. Make sure that the 
electrode is oriented such that the convex surface faces the spacer 
ring. Also, the damping gas nipple should point toward the top cover 
plate when the analyzer mount is installed on the top cover plate.

h. Inspect the mass analyzer assembly. Ensure that all the parts are 
aligned properly and that they all fit together snugly.

i. Reinstall the two spring washers on the posts such that the convex 
side of the washer is toward the exit endcap electrode.

j. Reinstall the two analyzer nuts onto the posts and tighten the nuts by 
hand until they are finger tight. Do not overtighten the nuts.

k. Squeeze the exit lens sleeve and insert it into the recess in the exit 
endcap electrode. See Figure 4-7 on page 4-27 for the proper 
orientation of the exit lens sleeve.

l. Insert the exit lens into the exit lens sleeve such that the lead pin on 
the exit lens points in the same direction as the 8-pin feedthrough 
when the analyzer mount is installed on the top cover plate. Make 
sure that the exit lens lead pin does not contact the nut on the end of 
the mass analyzer post.

Caution. Handle the spacer rings carefully. Do not scrape the spacer rings 
against any metal surfaces. Metal deposits on the surfaces of the spacer rings 
might cause the RF voltage to arc across the spacer rings to the endcaps. Do 
not overtighten the mass analyzer nuts.
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2. Insert the split (first) octapole into the octapole mount. The split octapole 
has four lead pins.

3. Insert the nonsplit (second) octapole through the cylindrical end of the 
analyzer mount until it seats in the octapole adapter sleeve in the entrance 
endcap electrode of the mass analyzer. Turn the octapole until the lead 
pins are on the same side as the 4-pin feedthrough (when the analyzer 
mount is mounted on the top cover plate).

Go on to the next topic: Reinstalling the Ion Optics and Mass Analyzer.

Reinstalling the Ion Optics and Mass 
Analyzer

Use the following procedure to reinstall the ion optics and mass analyzer 
onto the top cover plate of the vacuum manifold:

1. Insert the cylindrical end of the analyzer mount (with the mass analyzer 
and second octapole [the octapole with two lead pins] attached) into the 
opening in the baffle on the top cover plate of the vacuum manifold. 
Ensure that the open side of the analyzer mount is away from the top 
cover plate. See Figure 4-5.

2. Secure the analyzer mount to the baffle with the two thumb screws.

3. Insert the interoctapole lens, lead pin first, through the opening in the 
baffle. Turn the interoctapole lens until the lead pin is on the same side as 
the 8-pin feedthrough. Ensure that the second octapole is held securely 
between the endcap electrode and the interoctapole lens. Also ensure that 
the lead pins on the second octapole are on the same side as the 4-pin 
feedthrough.

4. Attach the split (first) octapole and octapole mount to the baffle on the top 
cover plate with the two thumb screws. Ensure that the interoctapole lens 
is held securely between the two octapoles. Also ensure that the lead pins 
on the split octapole are on the same side as the 4-pin feedthrough.

5. Inspect the ion optics. Ensure that all the parts are aligned properly and 
that they all fit together snugly.

6. Reconnect the four electrical leads from the 4-pin feedthrough to the split 
(first) octapole according to the wiring diagram shown in Figure 4-8 on 
page 4-32. 

7. Reconnect the two electrical leads from the other 4-pin feedthrough to the 
second octapole according to the wiring diagram shown in Figure 4-8.

Note. Wear clean, lint-free, nylon or cotton gloves when you handle 
components of the ion optics and mass analyzer.
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8. Reconnect the electrical lead from pin 2 of the 8-pin feedthrough to the 
interoctapole lens according to the wiring diagram shown in Figure 4-8.

9. Reconnect the electrical lead from pin 4 of the 8-pin feedthrough to the 
entrance endcap electrode according to the wiring diagram shown in 
Figure 4-8, by inserting the pin on the end of the lead into the socket in 
the electrode.

10. Reconnect the electrical lead from pin 5 of the 8-pin feedthrough to the 
exit endcap electrode according to the wiring diagram shown in 
Figure 4-8, by inserting the pin on the end of the lead into the socket in 
the electrode.

11. Reconnect the electrical lead from pin 7 of the 8-pin feedthrough to the 
exit lens according to the wiring diagram shown in Figure 4-8. Ensure 
that the exit lens lead pin does not contact the nut.

12. Reconnect the damping gas line to the nipple on the exit endcap electrode.

Go on to the next topic: Cleaning the Ion Detection System.

Cleaning the Ion Detection System

The conversion dynode and electron multiplier of the ion detection system 
must be kept dust free. Clean the conversion dynode and electron multiplier 
whenever you remove the top cover plate of the vacuum manifold. Cleaning 
the conversion dynode and electron multiplier involves only blowing them 
with clean, dry gas such as nitrogen. Freon gas is not recommended. Do not 
use liquids to clean the ion detection system components. Always cover the 
opening in the top of the vacuum manifold with a large, lint-free tissue 
whenever you remove the top cover plate of the vacuum manifold.

Go on to the next topic: Reinstalling the Top Cover Plate of the Vacuum 
Manifold.

Note. Check all leads and ensure that they are secure and that they go to the 
proper electrodes.
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Reinstalling the Top Cover Plate of the 
Vacuum Manifold

Use the following procedure to reinstall the top cover plate of the vacuum 
manifold:

1. Remove the tissue from the opening in the top of the vacuum manifold.

2. Check the O-ring that surrounds the opening for signs of wear, and 
replace it if necessary (P/N 97000-40015). Make sure that the O-ring is 
seated properly.

3. Carefully lift the top cover plate up by its two handles and turn it over. 
Orient the top cover plate such that the electron multiplier is over the 
conversion dynode. Carefully insert the guide posts on the underside of 
the top cover plate into the guide holes in the vacuum manifold. Slowly 
lower the cover plate onto the opening in the vacuum manifold. Take care 
not to damage the components on the underside of the cover plate. Ensure 
that the cover plate is seated properly on the vacuum manifold. 

4. Use a 7/16-in. open-end wrench to reconnect the helium damping gas line 
to the fitting. See Figure 4-4 on page 4-23.

5. Reconnect to the Switched Balun PCB (at J1) the endcaps RF / octapole 
RF coaxial cable that comes from the Waveform Amplifier PCB. See 
Figure 4-4 on page 4-23.

6. Reconnect to the Switched Balun PCB (at P1) the endcaps dc offset cable. 
See Figure 4-4 on page 4-23.

7. Reconnect the electron multiplier high voltage coaxial cable that comes 
from the electron multiplier power supply. See Figure 4-4 on page 4-23.

8. Reconnect to the Top Cover PCB (at ACQU/DSP) the electrometer cable. 
See Figure 4-4 on page 4-23.

9. Reconnect to the Top Cover PCB (at ANALYZER) the lenses / octapole 
dc offsets cable that comes from the System Control PCB. See Figure 4-4 
on page 4-23.

Go on to the next topic: Reinstalling the Top Cover of the MS Detector.

Note. Periodically, remove any contamination that might be on the inner 
walls of the manifold by wiping the inner walls with a lint-free tissue soaked 
in HPLC-grade methanol. Use a cotton-tipped applicator soaked in methanol 
to clean around inlets and feedthroughs.
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Reinstalling the Top Cover of the MS 
Detector 

Reinstall the top cover of the MS detector as follows:

1. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench.

2. With one hand under the center of the top cover, place the top cover over 
the MS detector such that the front of the cover is about 1.2 cm (0.5 in.) in 
front of the front of the MS detector.

3. Slide the cover back until it is flush with the front doors (when they are 
closed).

4. Reclip the two fasteners to secure the top cover to the chassis. 

5. Close the front door of MS detector. Tighten the 1/4-in. Allen screw on 
the right side of the door with an Allen wrench.

6. Reconnect any tubing between the syringe pump and the API source to 
accommodate your instrument configuration.

Go on to the next topic: Starting Up the System.

Starting Up the System

Start up the system as described in the topic Starting Up the System After a 
Complete Shutdown on page 6-7 in the System Shutdown, Startup, and 
Reset chapter.

Go on to the next topic: Tuning the Ring Electrode and Octapole RF 
Voltages.

Tuning the Ring Electrode and Octapole RF 
Voltages

You need to tune the ring electrode RF voltage and the octapole RF voltage 
whenever you service the mass analyzer or ion optics. You also need to tune 
these voltages if you replace any electronic assembly that is involved in 
producing the RF voltages. You use the Diagnostics program to tune the ring 
electrode and octapole RF voltages.

To tune the ring electrode and octapole RF voltages, proceed as follows:

1. Allow the LCQ Advantage MAX to pump down for at least 15 min after 
start up.

2. Choose Start > Programs > Xcalibur > LCQ Tune to open the Tune 
Plus window.

3. Choose Control > On to turn the LCQ Advantage MAX On.
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4. Open the Diagnostics dialog box and Graph view as follows:

a. In the Tune Plus window, choose View > Display Graph View to 
open the Graph view.

b. In the Tune Plus window, choose Diagnostics > Diagnostics to 
open the Diagnostics dialog box.

c. Select the Graphs tab to display the Graphs page.

d. Reposition the Diagnostics dialog box so that it does not obscure the 
Graph view. See Figure 4-9.

5. Tune the octapole RF voltage, as follows:

a. Select Tune octapole frequency in the Test Type list box.

b. Select the Once option button in the How Many Times group box.

c. Click on the Start button to start the octapole RF voltage tune 
program. A frequency function appears in the Graph view. See 
Figure 4-10. The minimum of the frequency function should lie 
between 2400 and 2550 kHz. 

d. When the octapole tune program is finished, LCQ Advantage MAX 
displays the message: Do you want to accept the octapole frequency? 
Click on the Yes button.

Figure 4-9. Diagnostics dialog box and Graph view
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6. Tune the ring electrode RF voltage modulation, as follows:

a. Select Tune RF modulation in the Test Type text box.

b. Select the Once option button in the How Many Times group box.

c. Click on the Start button to start the ring electrode RF modulation 
tune program. The Graph view should look like Figure 4-11:

• The standing wave ratio switch line should be at 10 V over the 
entire range.

• The detected RF voltage should be a straight line that begins at 
the origin and intersects the standing wave ratio switch line near 
the highest mass line.

• The RF voltage modulation should be a curved line that begins at 
the origin and intersects the highest mass line at a value between 
3.5 and 4.5 V.

d. Inspect the Graph view:

• If the three above conditions are met, proceed to step 7. 

Figure 4-10. Graph view for octapole RF voltage tuning
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• If the three above conditions are met over part of the range but 
not all of the range (the curves flatten or change value abruptly), 
tune the RF voltage frequency as described in step 7. Then, repeat 
step 6.

• If the standing wave ratio switch, detected RF voltage, and RF 
voltage modulation lines are all flat, then there might be a loose 
connection. Make sure that all cables and leads are properly 
connected and that the spring-loaded pin on the RF voltage 
feedthrough properly contacts the ring electrode. Repeat step 6.

7. Tune the ring electrode RF voltage frequency, as follows:

a. Select Tune RF frequency in the Test Type text box. The Continuously 
option button in the How Many Times group box is automatically 
selected.

b. Click on the Start button to start the ring electrode RF frequency tune 
program. The Graph view displays several tune functions, a 
frequency cursor, and a frequency window. See Figure 4-12.

c. Allow the program to make at least five passes. Then determine 
whether the frequency cursor lies within the frequency window as 
follows:

Figure 4-11. Graph view for ring electrode RF voltage modulation tuning
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• If the frequency cursor lies within the frequency window, then the 
ring electrode RF voltage frequency is tuned properly. Click on the 
Stop button and exit from the diagnostics program.

• If the frequency cursor lies outside the frequency window, then you 
need to manually adjust the ring electrode RF voltage frequency. 
Leave the Graph view displayed. Go on to the next step.

8. Manually adjust the ring electrode RF voltage frequency, as follows:

a. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right with an Allen wrench. 

b. With a Phillips screw driver, remove the air deflector to expose the 
tuning stud. See Figure 4-13.

c. With a wrench, loosen the 9/16-in. lock nut that holds the tuning stud 
in place.

d. With a screw driver, turn the tuning stud until the frequency cursor 
lies slightly to the left of the center of the frequency window. (The 
cursor should shift slightly to the right when the air deflector is 
reinstalled.)

e. Tighten the 9/16-in. lock nut.

f. Reinstall the air deflector and close the front door of MS detector. 
Tighten the 1/4-in. Allen screw on the right side of the door with an 

Figure 4-12. Graph view for ring electrode RF voltage tuning
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Allen wrench. Make sure that the frequency cursor is still within the 
frequency window. If necessary, repeat the above steps.

g. Click on the Stop button to stop the ring electrode RF voltage 
frequency tune program.

Figure 4-13. Ring electrode RF voltage tuning stud
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4.5 Replacing the Electron Multiplier
The electron multiplier of the ion detection system includes an anode and a 
cathode. The anode and cathode have finite lifetimes. The anode loses 
sensitivity over time due to contamination of its surface. Things that decrease 
the lifetime of the cathode include heat, electron flow (which produces 
internal heat), air (which causes oxidation and arcing), and water (which 
causes arcing).

The following symptoms suggest that the electron multiplier may need 
replacing:

• Excessive noise in the mass spectrum

• Inability of the multiplier gain calibration procedure to achieve a gain of 
3 × 105 electrons per ion with an electron multiplier voltage less than or 
equal to 2.5 kV

You can read the current value of the electron multiplier voltage in the Ion 
Detection System dialog box, which can be reached from the Tune Plus 
window by choosing Setup > Ion Detection System.

If you are having problems with the ion detection system, you need to replace 
the anode and cathode of the electron multiplier. You can replace the cathode 
separately or as part of the electron multiplier assembly.

To replace the anode and cathode of the electron multiplier, or the entire 
electron multiplier assembly, proceed as follows:

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely on page 6-5 in the System Shutdown, Startup, 
and Reset chapter. 

2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 4-22.

3. Remove the top cover plate of the vacuum manifold as described in the 
topic Removing the Top Cover Plate of the Vacuum Manifold on 
page 4-22.

4. With an Allen wrench, remove the two socket-head screws that hold the 
electron multiplier support to the top cover plate of the vacuum manifold. 
See Figure 4-14.

5. With one hand hold the high voltage tube and with the other hand hold the 
electron multiplier support. Then, detach the high voltage tube from the 

CAUTION. Make sure that the LCQ Advantage MAX power cord is 
unplugged before you proceed.

Note. Wear clean, lint-free, nylon or cotton gloves when you handle the 
electron multiplier components.
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high voltage feedthrough in the top cover plate and remove the electron 
multiplier as a unit. (The anode remains in the anode feedthrough in the 
top cover plate.)

6. Remove the anode from the anode feedthrough by unscrewing it 
counterclockwise by hand.

7. Install a new anode (P/N 96000-20076) in the anode feedthrough in the 
top cover plate by screwing it clockwise by hand.

If you want to replace the entire electron multiplier, install a new electron 
multiplier (P/N 96000-60036) in the next step. If you want to replace only 
the cathode, install the old electron multiplier in the next step.

8. With one hand holding the high voltage tube and the other hand holding 
the electron multiplier support, install the electron multiplier on the top 
cover plate. Ensure that the high voltage tube is properly inserted in the 
high voltage feedthrough and that the screw holes in the electron 
multiplier support are aligned with the screw holes in the top cover plate.

9. Reinstall the two socket-head screws that secure the electron multiplier 
support to the top cover plate. Tighten the screws with an Allen wrench.

• If you installed a new electron multiplier in step 8, go to step 11.

• If you want to replace the cathode, go on to the next step.

10. To replace the cathode, proceed as follows. See Figure 4-15.

a. With a Phillips screwdriver, loosen (but do not remove) the two 
screws that secure the support plates to the high voltage ring.

b. With one hand, hold the high voltage tube. With the other hand, hold 
the high voltage ring. Then, detach the high voltage tube from the 
high voltage feedthrough and remove the electron multiplier. Place it 
on a clean surface. (The electron multiplier support and the support 
plates should remain attached to the top cover plate.)

c. Turn the assembly over. With a Phillips screwdriver, remove the two 
screws that secure the electron multiplier shield to the high voltage 
ring.

d. Remove the electron multiplier shield and cathode from the high 
voltage ring.

e. Insert the narrow end of a new cathode (P/N 00022-02400) first 
through the spring washer and then through the high voltage ring.

Caution. Be careful not to damage the surface of the electron multiplier 
shield. The electron multiplier shield has been electropolished to prevent 
field emission.
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f. Place the electron multiplier shield over the wide end of the cathode 
such that the screw holes in the electron multiplier shield are aligned 
with the screw holes in the high voltage ring.

g. Hold the high voltage ring and electron multiplier shield together to 
depress the spring washer. Secure the high voltage ring to the electron 
multiplier shield by using the two Phillips-head screws. (The cathode 
should be held in place between the high voltage ring and the electron 
multiplier shield.)

h. Insert the end of the high voltage tube in the electron multiplier 
feedthrough in the top cover plate. Reattach the high voltage ring to 
the support plates by inserting the two screws in the sides of the high 
voltage ring into the notches in the two support plates. Tighten the 
two Phillips-head screws that secure the high voltage ring to the two 
support plates.

Figure 4-14. Exploded view of the electron multiplier, showing the anode
������
���������������	�
��4-42 ___________________ Finnigan LCQ Series Hardware Manual ____________________



LCQ Advantage MAX MS Detector Maintenance

�������������	
��
�____________________________________________Replacing the Electron Multiplier
11. Reinstall the top cover plate of the vacuum manifold over the opening in 
the vacuum manifold as described in the topic Reinstalling the Top 
Cover Plate of the Vacuum Manifold on page 4-33.

12. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 4-34.

13. Start up the LCQ Advantage MAX system as described in the topic 
Starting Up the System After a Complete Shutdown in the System 
Shutdown, Startup, and Reset chapter.

14. Set the electron multiplier voltage to -800 V as follows:

a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

Figure 4-15. Exploded view of the electron multiplier, showing the cathode
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b. From the Tune Plus window, choose Diagnostics > Diagnostics.

c. Select the Graphs tab to display the Graphs page.

d. In the Set Device Value option box, select Multiplier (V).

e. In the text box to the right of the Set Device Value option box, 
enter -800.

f. Click on the Set button to set the electron multiplier voltage 
to -800 V.

g. Click on the OK button to return to Tune Plus.

15. Calibrate the electron multiplier voltage as follows:

a. Allow the system to pump down for at least one hour before you turn 
on the high voltages.

b. Set up for the infusion of the tuning solution into the MS detector as 
described in LCQ Series Getting Started.

c. From the Tune Plus window, choose Control > Calibrate. The 
Calibrate dialog box appears.

d. Click on the Semi-Automatic tab to display the Semi-Automatic 
page.

e. Select the Electron Multiplier Gain option. Click on the Start button 
to start the multiplier gain procedure.

16. After the Electron Multiplier Gain program is finished, set up for ESI or 
APCI operation as described in LCQ Series Getting Started.
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4.6 Purging the Oil in the Forepump
You need to purge (decontaminate) the oil in the forepump on a daily basis to 
remove water and other dissolved chemicals from the pump oil. Water and 
other chemicals in the forepump can cause corrosion and decrease the lifetime 
of the pump. A good time to purge the oil is at the end of the working day 
after you flush the API probe, spray shield, and ion transfer capillary.

To purge the oil in the forepump, proceed as follows:

1. Turn off the flow of sample solution from the LC to the MS detector.

2. From the Tune Plus window, choose Control > Standby (or click on the 
On/Standby button) to put the MS detector in Standby.

3. Withdraw the API flange from the spray shield and place a septum over 
the entrance to the ion transfer capillary.

4. Open the gas ballast valve on the forepump by turning it to position |. 
Refer to the manual that came with the pump for the location of the gas 
ballast valve.

5. Allow the pump to run for 2 hours with the gas ballast valve open.

6. After 2 hours, close the gas ballast valve by turning it to position O.

7. Top off oil in the forepump reservoir if the level is lower than two-thirds 
of the maximum level visible in the viewing window.
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4.7 Replacing the Oil Reservoir in the 
Turbomolecular Pump

You need to replace the oil reservoir in the turbomolecular pump at least once 
a year. Replacing the oil reservoir in the turbomolecular pump involves the 
following steps:

• Removing the Turbomolecular Pump

• Changing the Turbomolecular Pump Oil Reservoir

• Reinstalling the Turbomolecular Pump

Removing the Turbomolecular Pump

To remove the turbomolecular pump, proceed as follows:

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely in the System Shutdown, Startup, and Reset 
chapter. Be sure that the vacuum manifold is completely vented before 
continuing.

2. Disconnect any sample tubes between the syringe pump and the API 
source.

3. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right with an Allen wrench. 

4. Loosen the hose clamp and disconnect the vacuum hose from the 
turbomolecular pump at the foreline union. See Figure 4-16. 

5. Disconnect the power cable from the front of the electronics tower.

6. Disconnect the turbomolecular pump communication cable.

7. Unscrew and remove the aluminum plate that is attached to the manifold 
fascia.

Note. If the turbomolecular pump fails, it must be replaced 
(P/N 00108-02644). To replace the turbomolecular pump, remove the pump 
as described in the topic Removing the Turbomolecular Pump. Then, 
install a new pump as described in the topic Reinstalling the 
Turbomolecular Pump.

CAUTION. Make sure that the LCQ Advantage MAX power cord is 
unplugged before you proceed.
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8. Lower the turbomolecular pump by loosening the two socket screws 
under the rails. You do not need to remove the screws.

9. Pull the turbomolecular pump out on the rails. 

10. Remove the turbomolecular pump.

Go on to the next topic: Changing the Turbomolecular pump Oil 
Reservoir.

Changing the Turbomolecular Pump Oil 
Reservoir

To change the turbomolecular pump oil reservoir, proceed as follows:

1. Turn the turbomolecular pump upside down on a work bench.

2. Using a large screwdriver, unscrew the locking cap on the bottom of the 
turbomolecular pump. Remove the locking cap and O-ring.

3. Using a pair of tweezers, remove the oil reservoir from the pump. Dispose 
of the oil reservoir properly.

Figure 4-16. Turbomolecular pump

CAUTION. Toxic residues from samples are likely to be concentrated in the 
pump oil. Spent pump oil must be disposed of in accordance with local and 
federal regulations.
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4. Place a new oil reservoir (P/N 00950-01117) in the cavity in the bottom of 
the pump.

5. Check the condition of the Viton O-ring. If it has any nicks or breaks, 
replace it with a new one.

6. Reinstall the O-ring and locking cap. Tighten the locking cap securely 
with a large screwdriver.

Go on to the next topic: Reinstalling the Turbomolecular Pump.

Reinstalling the Turbomolecular Pump

To reinstall the turbomolecular pump, proceed as follows (see Figure 4-16):

1. Check the condition of the Viton O-rings around the two openings on the 
bottom of the vacuum manifold. (Use a small flashlight to illuminate the 
O-rings.) If they have any nicks or breaks, replace them with new ones 
(P/N 00107-11100).

2. Place the turbomolecular pump on the turbomolecular pump rails.

3. Slide the turbomolecular pump into position under the openings in the 
vacuum manifold.

4. Carefully tighten the two socket screws that hold the turbomolecular 
pump rails to the vacuum manifold. Do not overtighten the screws.

5. Reconnect the vacuum hose to the foreline union. Tighten the hose clamp 
that secures the vacuum hose to the union.

6. Reinstall the aluminum plate.

7. Reconnect the turbomolecular pump power cable.

8. Reconnect the turbomolecular pump communication cable.

9. Reconnect the vacuum hose to the foreline union. 

10. Close the front door of MS detector. Tighten the 1/4-in. Allen screw on 
the right side of the door with an Allen wrench.

11. Reconnect any tubing between the syringe pump and the API source that 
you disconnected earlier.

12. Restart the system as described in the topic Starting Up the System 
After a Complete Shutdown in the System Shutdown, Startup, and 
Reset chapter.
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4.8 Cleaning the Fan Filter
You need to clean the fan filter, located on the rear of the MS detector, every 
four months. To clean the fan filter, proceed as follows:

1. Remove the fan filter by reaching behind the MS detector and pulling the 
fan filter out to the right.

2. Wash the fan filter in a solution of soap and water.

3. Rinse the fan filter with tap water.

4. Squeeze the water from the fan filter and allow it to air dry.

5. When the fan filter is completely dry, reinstall it on the rear of the MS 
detector [or replace it with a new one (P/N 97000-20299)].
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Chapter 5
LCQ Deca XP MAX MS Detector

Maintenance

LCQ Deca XP MAX performance depends on the maintenance of all parts of 
the instrument. It is your responsibility to maintain your system properly 
by performing the system maintenance procedures on a regular basis. 

This chapter describes routine MS detector maintenance procedures that must 
be performed to ensure optimum performance of the instrument. Most of the 
procedures involve cleaning. For example, procedures are provided for 
cleaning the API source, ion optics, mass analyzer, and ion detection system. 
Procedures are also presented for replacing the API sample tube, ion transfer 
capillary, and electron multiplier.

Routine and infrequent MS detector maintenance procedures are listed in 
Table 5-1.

Table 5-1. MS Detector maintenance procedures

MS Detector 
Component

Procedure Frequency Procedure Location

API source Flush (clean) sample 
transfer line, sample 
tube, and API probe

Daily page 5-6

API source Flush (clean) ion 
transfer capillary

Daily (or as needed*) page 5-8

API source Flush (clean) spray 
shield/spray cone

Daily page 5-8

Forepump Purge (decontaminate) 
oil

Daily (or as needed*) page 5-45

API source Clear ion transfer 
capillary

If ion transfer capillary 
bore is obstructed

page 5-10

API source Replace ion transfer 
capillary

If ion transfer capillary 
bore is corroded.

page 5-11

API source Clean API stack (spray 
shield, ion transfer 
capillary, tube lens, and 
skimmer)

As needed* page 5-17

API source Replace sample tube If sample tube is broken 
or obstructed

Refer to the Finnigan 
Ion Max API Source 
Hardware Manual. 
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For instructions on maintaining LCs or autosamplers, refer to the manual that 
comes with the LC or autosampler.

Ion optics Clean quadrupole, 
octapole and 
interoctapole lens

As needed* page 5-21

Mass analyzer Clean mass analyzer Yearly (or as needed*) page 5-21

Ion detection system Clean ion detection 
system (electron 
multiplier and 
conversion dynode)

Whenever the top cover 
plate of the vacuum 
manifold is removed

page 5-33

Ion detection system Replace electron 
multiplier anode and 
cathode

If noise in spectrum is 
excessive or proper 
electron multiplier gain 
can not be achieved

page 5-40

Turbomolecular pump Replace turbomolecular 
pump

If turbomolecular pump 
fails

page 5-45

Cooling fans Clean fan filter Every 4 months page 5-48

Forepump Add oil If oil level is low Manufacturer’s 
documentation

Forepump Change oil Every 3 months or if oil 
is cloudy or discolored

Manufacturer’s 
documentation

Fuses Replace fuse If fuse has blown LCQ Deca XP MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

Electronic modules Replace electronic 
module

If electronic module fails LCQ Deca XP MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

PCBs Replace PCB If PCB fails LCQ Deca XP MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

Ion gauge Replace ion gauge If ion gauge fails LCQ Deca XP MAX 
Diagnostics and PCB 
and Assembly 
Replacement chapter

*Frequency depends on analytical conditions

Table 5-1. MS Detector maintenance procedures, continued

MS Detector 
Component

Procedure Frequency Procedure Location
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This chapter contains the following sections:

• Tools and Supplies

• Frequency of Cleaning

• API Source Maintenance

• Cleaning the Ion Optics and Mass Analyzer

• Replacing the Electron Multiplier

• Purging the Oil in the Forepump

• Cleaning the Fan Filter

Note. The keys to success with the procedures in this chapter are: 

Proceed methodically

Always wear clean, lint-free gloves when handling the components of the 
API source, ion optics, mass analyzer, and ion detection system

Always place the components on a clean, lint-free surface 

Always cover the opening in the top of the vacuum manifold with a large, 
lint-free tissue whenever you remove the top cover plate of the vacuum 
manifold

Never overtighten a screw or use excessive force

Never insert a test probe (for example, an oscilloscope probe) into the 
sockets of female cable connectors on PCBs
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5.1 Tools and Supplies
The LCQ Deca XP MAX requires very few tools for you to perform routine 
maintenance procedures. You can remove and disassemble many of the 
components by hand. The tools, equipment, and chemicals listed in Table 5-2 
are needed for the maintenance of the API source, ion optics, mass analyzer, 
and ion detection system.

Table 5-2.  Tools, equipment, and chemicals

Description Part Number

Wrench, 5/16-in., hex socket (Allen)

Wrench, 9/16-in., socket

Wrench, 7/16-in., open end

Wrench, 9/16-in., open end

Wrench, 5/16-in., open end

Wrench, 1/2-in., open end

Wrench, 3/8-in., open end

Screwdrivers, set, ball point, Allen 
(also referred to as ball drivers)

00025-03025 

Screwdriver, slot head, large

Screwdriver, slot head, small

Screwdriver, Phillips, small

Fused-silica cutting tool

Hypodermic tube 00106-20000

Spray bottle

Beaker, 450 mL

Gloves, nylon 00301-09700

Kimwipes® or other lint-free industrial tissue

Applicators (swabs), cotton-tipped 00301-02000

Detergent

Clean, dry, compressed nitrogen gas

Distilled water

Methanol, HPLC grade or better

Tool, ion transfer capillary 70111-20258

CAUTION.  As with all chemicals, solvents and reagents should be stored 
and handled according to standard safety procedures and should be disposed 
of according to local and federal regulations.
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5.2 Frequency of Cleaning
The frequency of cleaning the components of the MS detector depends on the 
types and amounts of samples and solvents that are introduced into the 
instrument. In general, for a given sample and ionization technique, the closer 
an MS detector component is to the source of the ions, the more rapidly it 
becomes dirty.

• The sample tube, API probe, ion transfer capillary bore, and spray shield 
of the API source (including the ion sweep cone and the spray cone) 
should be cleaned at the end of each operating day to remove any residual 
salts from buffered mobile phases or other contamination that might have 
accumulated during normal operation. Refer to the topics Flushing the 
Sample Transfer Line, Sample Tube, and API Probe and Flushing the 
Spray Shield, Ion sweep cone, Spray Cone, and Ion Transfer 
Capillary on page 5-6 and page 5-8, respectively.

• The tube lens and skimmer of the API source become dirty at a slower 
rate than the API probe, spray shield, and ion transfer capillary. Refer to 
the topic Maintaining the API Stack on page 5-11.

• The ion optics and the mass analyzer become dirty at a rate significantly 
slower than the API source. Refer to the topic Cleaning the Ion Optics 
and Mass Analyzer on page 5-28.

• Clean the electron multiplier and conversion dynode whenever you 
remove the top cover plate of the vacuum manifold by blowing them with 
a clean, dry gas. Refer to the topic Cleaning the Ion Detection System 
on page 5-28.

When the performance of your system decreases significantly due to 
contamination, clean the components of the MS detector in the following 
order:

• Clean the API probe, spray shield, and ion transfer capillary

• Clean the tube lens and skimmer

• Clean the ion optics and mass analyzer
____________________ Finnigan LCQ Series Hardware Manual____________________  5-5������
���������������	�
��



LCQ Deca XP MAX MS Detector Maintenance
API Source Maintenance _________________________________________________ �������������	
��
�
5.3 API Source Maintenance
The API source requires a minimum of maintenance. Periodically, you need to 
clean the components of the API source to remove salts or other 
contaminants. The frequency of cleaning the API source depends on the types 
and amounts of samples and solvents that are introduced into the system.

Maintenance procedures are provided below to do the following:

• Flush the sample transfer line, sample tube, and API probe

• Flush the spray shield and the bore of the ion transfer capillary

• Clear a blocked ion transfer capillary

• Maintain the APCI probe assembly, including replacing the APCI sample 
tube

• Maintain the ESI probe assembly, including replacing the ESI sample 
tube

• Maintain the API stack, including replacing the ion transfer capillary

Flushing the Sample Transfer Line, Sample 
Tube, and API Probe

You should flush the sample transfer line, sample tube, and API probe at the 
end of each working day (or more often if you suspect they are contaminated) 
by flowing a 50:50 methanol / distilled water solution from the LC through 
the API source.

To flush the sample transfer line, sample tube, and API probe, proceed as 
follows:

1. Make sure that the API flange is secured to the spray shield by the two 
flange retainer bolts.

2. Choose Start > Programs > Xcalibur > LCQ Tune to open the Tune 
Plus window.

This manual provides maintenance procedures for the APCI probe and the 
ESI probe. For maintenance procedures for the NSI source, refer to the LCQ 
Series Nanospray Ion Source Operator’s Manual. 

CAUTION. AVOID EXPOSURE TO POTENTIALLY HARMFUL 
MATERIALS. Always wear protective gloves and safety glasses when you 
use solvents or corrosives. Also, contain waste streams and use proper 
ventilation. Refer to your supplier’s Material Safety Data Sheets (MSDS) for 
procedures that describe how to handle a particular solvent.
������
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3. From the Tune Plus window, choose Control > On (or click on the 
On/Standby button) to turn on the voltages and gas flows to the API 
source. 

• If you are operating in APCI mode, go to step 4.

• If you are operating in ESI mode, go to step 5.

4. Set up the APCI source as follows:

a. Ensure that the auxiliary gas line is connected to the A port on the 
APCI probe.

b. In the Tune Plus window, choose Setup > APCI Source (or click 
on the APCI Source button). The APCI Source dialog box appears.

c. In the APCI Source dialog box, use the Vaporizer Temp spin box to 
set the vaporizer temperature to 500 °C. 

d. Use the Sheath Gas Flow Rate spin box to set the sheath gas flow rate 
to 80 units.

e. Use the Aux Flow Rate spin box to set the auxiliary gas flow rate to 
10 units.

f. Use the Discharge Current spin box to set the discharge current 
to 0 µ��

g. Click on OK to set the APCI parameters and close the dialog box.

Go to step 6.

5. Set up the ESI source as follows:

a. Ensure that the auxiliary gas line is connected to the Aux port on the 
ESI probe.

b. In the Tune Plus window, choose Setup > ESI Source (or click on 
the ESI Source button). The ESI Source dialog box appears.

c. Use the Sheath Gas Flow Rate spin box to set the sheath gas flow rate 
to 80 units. 

d. Use the Aux Flow Rate spin box to set the auxiliary gas flow rate to 
10 units. 

e. Use the Spray Voltage spin box to set the spray voltage to 0 kV.

f. Click on OK to set the ESI parameters and close the dialog box.

6. Set up and start a flow of 50:50 methanol / water solution from the LC to 
the API source, as follows:

a. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

b. Select the LC tab.
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c. In the Inlet Direct Control dialog box, set the Flow Rate to a value 
that is typical for your experiments.

d. In the Inlet Direct Control dialog box, set the % spin boxes to 50% 
methanol and water.

e. Click on Start to start the LC pump.

7. Let the solution flow through the sample transfer line, sample tube, and 
API probe for 15 min. After 15 min, turn off the flow of liquid from the 
LC to the API source, as follows. Leave the API source (including the 
APCI vaporizer, sheath gas, and auxiliary gas) on for an additional 5 min.

a. In the Tune Plus window, click on the LC pump button. The Inlet 
Direct Control dialog box appears.

b. Select the LC tab.

c. Click on Stop to stop the LC pump.

8. After 5 min, turn off the API source by placing the MS detector in 
Standby: From the Tune Plus window, choose Control > Standby (or 
click on the On/Standby button).

Go on to the next topic: Flushing the Spray Shield and the Ion Transfer 
Capillary.

Flushing the Spray Shield, Ion Sweep Cone, 
Spray Cone, and Ion Transfer Capillary

You need to clean the spray shield, ion sweep cone, spray cone, and ion 
transfer capillary on a regular basis to prevent excessive contamination and to 
maintain optimum performance of your API source. A good practice is to 
flush the spray shield, ion sweep cone, spray cone, and ion transfer capillary 
at the end of each operating day after you flush the sample transfer line, 
sample tube, and API probe with a 50:50 methanol / water solution from the 
LC. (Refer to the topic Flushing the Sample Transfer Line, Sample Tube, 
and API Probe on page 5-6.) If you are operating the system with nonvolatile 
buffers in your solvent system or with high concentrations of sample, you 
might need to clean the spray shield, ion sweep cone, spray cone, and ion 
transfer capillary more often.

You do not need to vent the system to flush the spray shield, ion sweep cone, 
spray cone, and ion transfer capillary. 

To clean the spray shield, ion sweep cone, spray cone, and the ion transfer 
capillary, do the following:

1. Turn off the flow of liquid from the LC (or other sample introduction 
device) to the API source. To turn off the flow of liquid from the LC to the 
API source, do the following:
������
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a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

b. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

c. Select the LC tab and click on Stop to stop the LC pump.

2. From the Tune Plus window, choose Control > Standby (or click on the 
On/Standby button) to put the MS detector in Standby. If you are using 
the APCI Source, click on the APCI Source button. Then, in the APCI 
Source dialog box, use the Vaporizer Temp spin box to set the vaporizer 
temperature to 0 °C. For either APCI or ESI, turn the heat to the ion 
transfer capillary heater off.

3. Loosen the two flange retainer bolts that secure the API flange (APCI or 
ESI flange) to the spray shield.

4. Pull back the API flange from the spray shield.

5. Pull the ion sweep cone off of the spray cone, and place it on a large 
Kimwipe (or other lint-free tissue). Temporarily place another large 
Kimwipe on the bottom of the spray shield. (This Kimwipe is required to 
absorb the solution used to flush the spray cone, ion transfer capillary, and 
spray shield.)

6. Fill a spray bottle with a 50:50 solution of HPLC-grade 
methanol / distilled water. Spray approximately 5 mL of the solution at 
the opening of the ion transfer capillary. Do not touch the ion transfer 
capillary with the tip of the spray bottle.

7. Use the spray bottle filled with the 50:50 solution of HPLC-grade 
methanol / distilled water to flush contaminants from the accessible 
surfaces of the spray shield and the spray cone.

8. Remove the Kimwipe you used to absorb the solution. Swab the surface 
of the spray shield and spray cone with a dry Kimwipe.

9. Ensure that you have removed any salt or other contaminants that may 
have been deposited on the spray shield or spray cone.

10. If you are operating in the ESI mode, wipe off the ESI nozzle with a 
Kimwipe soaked with the 50:50 HPLC-grade methanol / water solution. 

CAUTION. AVOID BURNS. At operating temperatures, the APCI 
vaporizer, ion sweep cone, spray cone, and ion transfer capillary can 
severely burn you! The APCI vaporizer typically operates at 400 to 600 °C 
and the ion sweep cone, spray cone, and ion transfer capillary typically 
operate at 100 to 300 °C. Allow the heated vaporizer, ion sweep cone, spray 
cone, and ion transfer capillary to cool to room temperature, for 
approximately 20 min, before you touch or remove these components.
____________________ Finnigan LCQ Series Hardware Manual____________________  5-9������
���������������	�
��



LCQ Deca XP MAX MS Detector Maintenance
API Source Maintenance _________________________________________________ �������������	
��
�
11. Use the spray bottle filled with the 50:50 solution of HPLC-grade 
methanol / distilled water to flush contaminants from the interior and 
exterior surface of the ion sweep cone. Then swab the surface of the ion 
sweep cone with a dry Kimwipe.

Clearing the Bore of the Ion Transfer 
Capillary

A stainless steel hypodermic tube has been included in your accessory kit for 
clearing the ion transfer capillary in the unlikely event it should become 
blocked. However, since the ion transfer capillary can be easily removed and 
replaced without loss of vacuum, and you might want to replace the ion 
transfer capillary instead of cleaning the ion transfer capillary. 

If the pressure in the API region (as measured by the Convectron® gauge) 
drops considerably below 1 Torr, you should suspect a blocked ion transfer 
capillary. (You can check the Convectron gauge pressure in the Vacuum 
dialog box by choosing Setup > Vacuum from the Tune Plus window.)

You do not have to vent the system to clear the bore of the ion transfer 
capillary. To clear the bore of the ion transfer capillary, do the following:

1. Turn off the flow of liquid from the LC (or other sample introduction 
device) to the API source. To turn off the flow of liquid from the LC to the 
API source, do the following:

a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

b. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

c. Select the LC tab and click on Stop to stop the LC pump.

2. Loosen the two flange retainer bolts that secure the API flange (APCI or 
ESI) to the spray shield.

3. Pull back the API flange from the spray shield. 

Note. If you are finished operating your LCQ Deca XP MAX for the day, 
cap the ion transfer capillary with the septum. Leave the API flange 
withdrawn from the spray shield. Purge the oil in the forepump as described 
in the topic Purging the Oil in the Forepump on page 5-45.

CAUTION. The APCI vaporizer typically operates at 400 to 600 °C and the 
ion sweep cone, spray cone, and ion transfer capillary typically operate at 
100 to 300 °C. Allow these components to come to ambient temperature 
before proceeding.
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4. Clear the bore of the ion transfer capillary by inserting and withdrawing 
the 28 gauge, 10-in hypodermic tube (P/N 00106-20000) included in your 
accessory kit.

5. Fill a spray bottle with a 50:50 solution of HPLC-grade 
methanol / distilled water. From a distance of 10 cm from the entrance 
end of the ion transfer capillary, spray a small amount of the solution 
down the bore of the ion transfer capillary.

6. Repeat steps 5 and 6 several times.

7. Push the API flange assembly against the spray shield.

8. Secure the API flange to the spray shield with the two flange 
retainer bolts.

Maintaining the API Stack

The API stackincludes the spray shield, ion sweep cone, spray cone, ion 
transfer capillary, capillary lens and skimmer mount, and the tube lens, and 
skimmer. The ion transfer capillary has a finite lifetime. You need to replace 
the ion transfer capillary if the ion transfer capillary bore becomes corroded or 
damaged. You also need to clean the spray shield, ion sweep cone, spray cone, 
ion transfer capillary, tube lens, skimmer, and the other components of the 
API stack on a periodic basis.

It is not necessary to vent the system in order to replace the ion transfer 
capillary. To replace the ion transfer capillary, proceed as follows:

1. Turn off the flow of liquid from the LC (or other sample introduction 
device) to the API source. To turn off the flow of liquid from the LC to the 
API source, do the following:

a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

b. In the Tune Plus window, choose Setup > Direct Inlet Control (or 
click on the LC pump button). The Inlet Direct Control dialog box 
appears.

c. Select the LC tab and click on Stop to stop the LC pump.

Note. If you have unblocked the ion transfer capillary, the Convectron gauge 
pressure should increase to a normal value (approximately 1 Torr). If you 
can not clear the ion transfer capillary by this method, use the instructions 
for removing the ion transfer capillary from the spray shield in the topic 
Maintaining the API Stack on page 5-11. Then, if you wish, try clearing 
the ion transfer capillary from the exit end by the same method. Otherwise, 
replace the ion transfer capillary with a new one. 
____________________ Finnigan LCQ Series Hardware Manual___________________  5-11������
���������������	�
��



LCQ Deca XP MAX MS Detector Maintenance
API Source Maintenance _________________________________________________ �������������	
��
�
2. Place the electronics service switch (located on the right side of the MS 
detector) in the Service position to turn off the non-vacuum system 
voltages.

3. Loosen the two flange retainer bolts that secure the API flange (APCI or 
ESI) to the spray shield.

4. Pull back and remove the API probe flange from the spray shield.

5. Remove the ion sweep cone from the spray cone.

6. Using the ion transfer capillary tool, (P/N 70111-20258) unscrew the ion 
transfer capillary from the spray cone.

7. Using the ion transfer capillary tool, hook the ion transfer capillary and 
remove it. Replace the Kalrez O-ring (P/N 00107-12750) if necessary.

8. Screw the new ion transfer capillary into the spray cone.

9. Install and bolt the API probe flange to the spray shield.

10. Place the electronics service switch in the Normal position.

11. Begin operation using the LC or other sample introduction device.

To replace or to clean the spray shield, tube lens and skimmer mount, tube 
lens, skimmer, or other API components, do the following, as described in this 
topic:

• Shut down and vent the system

• Remove the API stack

• Disassemble the API stack

• Clean the API stack components

• Reassemble the API stack

• Reinstall the API stack

• Start up the system

CAUTION. Make sure that the LCQ Deca XP MAX electronics service 
switch is in the Service position before you proceed.

CAUTION. The APCI vaporizer typically operates at 400 to 600 °C and the 
ion sweep cone, spray cone, and ion transfer capillary typically operate at 
100 to 300 °C. Allow these components to come to ambient temperature 
before proceeding.

Note. You should flush the spray shield, ion sweep cone, spray cone and the 
bore of the ion transfer capillary at the end of each working day with a 50:50 
methanol / water solution. Refer to the topic Flushing the Spray Shield, 
Ion sweep cone, Spray Cone, and Ion Transfer Capillary on page 5-8. 
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Shutting Down the System

Shut down and vent the system as described in the topic Shutting Down the 
System Completely in the System Shutdown, Startup, and Reset chapter. 

Go on to the next topic: Removing the API Stack.

Removing the API Stack

To remove the API stack proceed as follows:

1. Loosen the two flange retainer bolts that secure the API probe assembly 
to the spray shield.

2. Pull back the API probe assembly from the spray shield.

3. Disconnect the waste line from the spray shield.

4. Disconnect the API stack electrical cable from the spray shield by turning 
the tab on the end of the cable counterclockwise (toward you) and then 
pulling the cable free.

5. Grasp the spray shield with both hands and carefully pull it and the API 
stack free from the vacuum manifold. Place the API stack on a clean 
surface with the spray shield down. Allow the API stack to cool to 
ambient temperature before you disassemble the API stack.

The API stack is shown in Figure 5-1.

Go on to the next topic: Disassembling the API Stack.

CAUTION. Make sure that the LCQ Deca XP MAX power cord is 
unplugged before you proceed.

Note. If you are unable to dislodge the spray shield from the vacuum 
manifold, reattach the API flange to the spray shield and then pull the flange 
away from the vacuum manifold.
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Disassembling the API Stack

Wait for the API stack to cool to ambient temperature before you disassemble 
it. Refer to Figure 5-1 and Figure 5-2 for the location of the various API stack 
components. 

To disassemble the API stack proceed as follows:

1. Disconnect waste fitting so that API stack can easily be set on a flat 
surface. 

2. Remove ion sweep cone. 

3. Remove ion transfer capillary. (Refer to Maintaining the API Stack) 

Figure 5-1. API stack

Tube Lens
And 
Skimmer Mount

Retainer
Clip

Tube Lens
Extension
Mount

Spray Shield

Spray Cone

Note. Wear clean, lint-free, nylon or cotton gloves when you handle the API 
stack components.
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4. Disconnect the skimmer electrical lead from the lead pin on the skimmer.

5. Disconnect the tube lens electrical lead from the lead pin on the tube lens.

6. Push the tube lens and skimmer mount into the extension mount and 
remove the retaining clip. Allow the tube lens and skimmer mount to 
move back slowly.

7. Detach the skimmer from the tube lens and skimmer mount by pushing on 
its lead pin.

8. Detach the tube lens from the tube lens and skimmer mount by pushing 
the tube lens away from the mount.

9. Pull the extension mount from the spray shield

10. Disconnect the heater cable connector for the heater.

11. Loosen the two thumb nuts on the spray shield and remove the heater and 
the graphite seal.

Caution. The tube lens and skimmer mount is spring loaded. Ensure that the 
spring (P/N 00201-11599) that is compressed in the extension mount does 
not fly free when the tube lens and skimmer mount is removed. 
____________________ Finnigan LCQ Series Hardware Manual___________________  5-15������
���������������	�
��



�
�
�
�
�
�

�
�
�
�
�
�
�
�
��
�
�
�
�
�
	
�

�
�

5-
16

__
__

__
__

__
__

__
__

__
__

__
__

__
__

__
__

__
_

F
in

ni
ga

n 
LC

Q
 S

er
ie

s 
H

ar
dw

ar
e 

M
an

ua
l_

__
__

__
__

__
__

__
__

__
__

__
__

__
__

__
__

__
__

__
__

__
__

_

F
ig

u
re

 5
-2

.
E

xp
lo

d
ed

 v
ie

w
 o

f 
th

e 
b

ac
k 

o
f 

th
e 

A
P

I s
ta

ck

G
R

A
P

H
IT

E

S
E

A
L

H
E

A
T

E
R

T
H

U
M

B

N
U

T
S

 (
2
)

R
E

T
A

IN
E

R

C
L

IP W
A

V
E

 S
P

R
IN

G

T
U

B
E

 L
E

N
S

A
N

D
 S

K
IM

M
E

R

M
O

U
N

T

T
U

B
E

 L
E

N
S

L
E

A
D

 P
IN

E
X

T
E

N
S

IO
N

M
O

U
N

T

S
P

R
A

Y

S
H

IE
L

D



LCQ Deca XP MAX MS Detector Maintenance

�������������	
��
�_________________________________________________ API Source Maintenance
Cleaning the API Stack Components

Inspect the API stack components for contamination that results from routine 
use. If dirty, clean the API stack components as follows.

Cleaning the Tube Lens

Clean the inner bore of the tube lens with HPLC-grade methanol and a 
cotton-tipped applicator (swab).

Cleaning the Skimmer

Look at the tip of the cone on the skimmer for a region that shows 
discoloration due to contamination. (The off-axis pattern that you see is a 
result of the sample/solvent that exits from the off-axis ion transfer capillary.) 
Use methanol and a cotton-tipped applicator or Kimwipe to clean the entrance 
and exit sides of the skimmer.

Cleaning the Ion Transfer Capillary

The ion transfer capillary is easily replaceable without venting the LCQ Deca 
XP MAX, however, if you wish to clean the ion transfer capillary, do the 
following:

1. Use methanol and a Kimwipe to clean the entrance end, exit end, and 
exterior of the ion transfer capillary.

2. Clear the bore of the ion transfer capillary by inserting and withdrawing 
the 28 gauge, 10-in. hypodermic tube (P/N 00106-20000) included in 
your accessory kit.

3. Flush the bore of the ion transfer capillary with methanol.

4. Dry the bore of the ion transfer capillary with nitrogen gas. 

CAUTION. The APCI vaporizer typically operates at 400 to 600 °C and the 
ion sweep cone, spray cone, and ion transfer capillary typically operate at 
100 to 300 °C. Allow these components to come to ambient temperature 
before proceeding.

Note. Solvents required for cleaning the API stack components: For 
most cleaning applications, HPLC grade methanol is the solvent of choice. 
However, use of buffers or salt solutions may require that you use an acidic, 
aqueous solution. If you need to use a solvent other than methanol, after 
cleaning the ion source components, flush the component with water and 
then flush it with methanol as a final wash. In all cases, ensure that all 
solvent has evaporated from the component(s) before reassembly.
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5. Ensure that no residue or fibers remain at the exit end of the ion transfer 
capillary. Fibers in this area may become charged and interfere with the 
normal flow of ions.

Cleaning the Spray Shield and Spray Shield Cone

To clean the spray shield and spray shield cone, wipe the inside and outside 
of the spray shield and spray shield cone with methanol and a Kimwipe.

Go on to the next topic: Reassembling the API Stack.

Reassembling the API Stack

To reassemble the API stack, proceed as follows. Refer to Figure 5-1 and 
Figure 5-2 for the location of the API stack components.

1. It is recommended that you replace the graphite seal (P/N 7011-20216)

2. Seat the heater in the spray shield and secure with the two thumb nuts.

3. Reconnect the heater cable to the connector that is held by the spray 
shield. Turn the locking ring on the cable clockwise to lock the cable. 

4. Insert the extension mount.

5. Reinstall the wave spring, tube lens and skimmer mount into the 
extension mount and use the retaining clip to hold it in place.

6. Align the guide pin on the tube lens with the guide pin hole on the tube 
lens and skimmer mount. Reinstall the tube lens by inserting it into the 
tube lens and skimmer mount.

7. Align the lead pin on the skimmer with the lead pin hole on the tube lens 
and skimmer mount. Reinstall the skimmer by inserting it into the tube 
lens and skimmer mount.

8. Reconnect the tube lens lead to the lead pin on the tube lens. Use 
needlenose pliers if necessary.

9. Reconnect the skimmer lead to the lead pin on the skimmer. Use 
needlenose pliers if necessary.

10. Inspect the API stack. Ensure that the 3.85-in. ID O-ring 
(P/N 00107-14100) has no cracks, is otherwise in good condition, and is 
properly seated on the spray shield. Ensure that all components fit 
together tightly. 

11. Reinstall the ion transfer capillary. See Figure 5-3. Replace the Kalrez 
O-ring (P/N 00107-12750) if necessary. Refer to the topic Maintaining 
the API Stack on page 5-11.

12. Reinstall the ion sweep cone (if being used).

Go on to the next topic: Reinstalling the API Stack.
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Reinstalling the API Stack

To reinstall the API stack, proceed as follows:

1. Align the API stack with the opening in the front of the vacuum manifold. 
Turn the API stack until the guide pin on the spray shield is aligned with 
the guide pin hole in the vacuum manifold.

2. Carefully insert the API stack into the opening in the vacuum manifold 
until it seats in the vacuum manifold. 

3. Reconnect the API stack cable to the connector on the spray shield. Turn 
the tab on the end of the cable clockwise (away from you) to secure the 
cable.

4. Reconnect the waste line to the spray shield.

Go on to the next topic: Starting Up the System.

Figure 5-3. Exploded view of the front of the API stack
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Starting Up the System

Start up the system as described in the topic Starting Up the System After a 
Complete Shutdown in the System Shutdown, Startup, and Reset chapter.
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5.4 Cleaning the Ion Optics and Mass 
Analyzer

An accumulation of chemicals on the surfaces of the ion optics and mass 
analyzer forms an insulating layer that can modify the electrical fields that 
control ion transmission and mass analysis. Therefore, clean ion optics and 
mass analyzer are essential for the proper operation of the instrument. The ion 
optics and mass analyzer require cleaning less often than the API source. The 
frequency of cleaning depends on the type and quantity of the compounds that 
you analyze.

Cleaning the ion optics and mass analyzer involves the following steps:

• Shut down and vent the system

• Remove the top cover of the MS detector

• Remover the top cover plate of the vacuum manifold

• Remove the ion optics and mass analyzer

• Disassemble the ion optics and mass analyzer

• Clean the ion optics and mass analyzer parts

• Reassemble the ion optics and mass analyzer

• Reinstall the ion optics and mass analyzer

• Reinstall the top cover plate of the vacuum manifold

• Reinstall the top cover of the MS detector

• Start up the system

• Tune the ring electrode and octapole RF voltages

Shutting Down the System

Shut down and vent the system as described in the topic Shutting Down the 
System Completely on page 6-5 in the System Shutdown, Startup, and 
Reset chapter. 

Go on to the next topic: Removing the Top Cover of the MS Detector.

CAUTION. Make sure that the LCQ Deca XP MAX power cord is 
unplugged before you proceed.
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Removing the Top Cover of the MS Detector

Remove the top cover of the MS detector as follows:

1. Open the left and right front doors of the MS detector by loosening the 
1/4-in. Allen screw on the right front door with an Allen wrench. Be 
careful not to damage any fused silica tubing leading to the API source.

2. Open the two fasteners that hold the top cover to the MS detector chassis. 
The fasteners are located in the upper right and left corners of the chassis.

3. With one hand under the center of the top cover, lift the top cover up and 
away from the MS detector.

Go on to the next topic: Removing the Top Cover Plate of the Vacuum 
Manifold.

Removing the Top Cover Plate of the Vacuum 
Manifold

You need to remove the top cover plate of the vacuum manifold to access the 
ion optics, mass analyzer, and ion detection system. The top cover plate is 
held in place by gravity and by the air pressure differential between the 
vacuum manifold and atmospheric pressure. Six cables and one gas line are 
connected to the top cover plate. See Figure 5-4.

To remove the top cover plate, proceed as follows:

1. Disconnect (at ANAL. AUX 1 IN) the octapoles cable that comes from 
the Analyzer Auxiliary PCB.

2. Disconnect (at ANALYZER) the lenses cable that comes from the System 
Control PCB.

3. Disconnect (at ANAL. AUX 2 IN and ANAL. AUX 3 IN) the two endcap 
electrode cables that come from the Analyzer Auxiliary PCB.

4. Disconnect (at ACQU/DSP) the electrometer cable. (If necessary, use a 
small screw driver to loosen the screws that secure the cable.)

5. Disconnect (at MULT) the electron multiplier high voltage cable that 
comes from the electron multiplier power supply.

6. Use a 7/16-in. open-end wrench to disconnect the helium damping gas 
line from the fitting.

7. Carefully lift the top cover plate straight up by its two handles. Take care 
not to damage the components on the underside of the cover plate. Place 
the cover plate upside down (supported on its handles) on a flat surface.

8. Cover the opening in the top of the vacuum manifold with a large, 
lint-free tissue.

Go on to the next topic: Removing the Ion Optics and Mass Analyzer.
������
���������������	�
��5-22 ___________________ Finnigan LCQ Series Hardware Manual ____________________



LCQ Deca XP MAX MS Detector Maintenance

�������������	
��
�___________________________________ Cleaning the Ion Optics and Mass Analyzer
Removing the Ion Optics and Mass Analyzer

The ion optics and mass analyzer are mounted on a baffle on the underside of 
the top cover plate of the vacuum manifold. See Figure 5-5.

Use the following procedure to remove the ion optics and mass analyzer from 
the top cover plate. See Figure 5-6 and Figure 5-7 for the location of the ion 
optics and mass analyzer components.

Figure 5-4. Electrical connections and damping gas line connection 
to the top cover plate of the vacuum manifold

Endcap Cables

Electrometer 
Cable

Electron Multiplier
High Voltage Cable

Damping Gas Line

Lenses Cable

Octapole/Quadrupole Cable

Note. Wear clean, lint-free, nylon or cotton gloves when you handle the ion 
optics and mass analyzer components.
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1. Prepare a clean work area by covering the area with lint-free paper. Place 
each part on the paper as you remove it.

2. Disconnect the four electrical leads to the quadrupole.

3. Hold the quadrupole mount with one hand; loosen and remove the two 
thumb screws that hold the quadrupole mount to the baffle on the top 
cover plate of the vacuum manifold.

4. Remove the quadrupole and quadrupole mount.

5. Disconnect the electrical lead to the interoctapole lens. Remove the 
interoctapole lens.

6. Disconnect the electrical leads to the octapole and to the entrance lens, 
entrance endcap electrode, exit endcap electrode, and the exit lens of the 
mass analyzer.

7. Disconnect the damping gas line from the nipple on the exit endcap 
electrode by pulling the line free from the nipple. See Figure 5-7

8. Hold the mass analyzer with one hand; loosen the two thumb screws that 
hold the analyzer mount to the baffle.

9. With one hand holding the mass analyzer and the other hand holding the 
analyzer mount, lift the mass analyzer, octapole, and analyzer mount out 

Figure 5-5. Mass analyzer and ion optics, mounted to the baffle on the top cover plate of the 
vacuum manifold
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and away from the baffle on the top cover plate. Be careful not to touch 
the electron multiplier with the mass analyzer. This could damage the 
electropolished surface.

Go on to the next topic: Disassembling the Ion Optics and Mass Analyzer.

Disassembling the Ion Optics and Mass 
Analyzer

To disassemble the ion optics and mass analyzer, proceed as follows. See 
Figure 5-6 and Figure 5-7 for the location of the ion optics and mass analyzer 
components.

1. Remove the quadrupole from the quadrupole mount.

2. Remove the octapole from the analyzer mount.

3. Disassemble the mass analyzer, as follows:

a. Remove the entrance lens by pulling the entrance lens out of the 
entrance lens sleeve.

b. Remove the entrance lens sleeve by squeezing the sleeve and pulling 
it out of the recess in the entrance endcap electrode.

c. Remove the exit lens by pulling the exit lens out of the exit lens 
sleeve. Use the connector pin to aid you pull off the lens.

d. Remove the exit lens sleeve by squeezing the sleeve and pulling it out 
of the recess in the exit endcap electrode.

e. Unscrew and remove the two analyzer nuts from the analyzer posts.

f. Remove the two spring washers from the analyzer posts.

g. Remove the exit endcap electrode from the analyzer posts.

h. Remove the two quartz spacer rings and the ring electrode.

i. Remove the entrance endcap electrode from the posts.

j. Unscrew and remove the two posts from the analyzer mount.

Go on to the next topic: Cleaning the Ion Optics and Mass Analyzer Parts.
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Cleaning the Ion Optics and Mass Analyzer 
Parts

Use the following procedure to remove contamination from the ion optics and 
mass analyzer parts. Clean each part in turn. After cleaning, place each part on 
a clean, lint free surface.

1. With a soft tooth brush or lint-free swab, scrub the ion optics or mass 
analyzer part with a solution of detergent and water.

2. Rinse the part with tap water to remove the detergent.

3. Rinse the part with distilled water.

4. Place the part in a tall beaker and immerse it completely in HPLC-grade 
methanol. Move the part up and down in the methanol for 15 s.

5. Remove the part from the methanol bath; then rinse it thoroughly with 
fresh methanol.

6. Dry the part with a rapid stream of nitrogen gas.

7. Inspect each part for contamination and dust. If necessary, repeat the 
cleaning procedure.

After all ion optics and mass analyzer parts are clean and dry, go on to the 
next topic: Reassembling the Ion Optics and Mass Analyzer.

Caution. Take care not to chip, scratch, or break the spacer rings of the mass 
analyzer. Take care not to bump or jar the octapoles. Do not place the 
octapoles in an ultrasonic cleaner.

Note. When you clean the ion optics and mass analyzer parts, pay particular 
attention to the inside surfaces. 

Note. Wear clean, lint-free, nylon or cotton gloves to handle the parts after 
you clean them in methanol.
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Reassembling the Ion Optics and Mass 
Analyzer

Use the following procedure to reassemble the ion optics and mass analyzer. 
See Figure 5-6 and Figure 5-7.

1. Reinstall the analyzer posts by screwing them by hand into the analyzer 
mount. (Both ends are the same.)

2. Reinstall the entrance endcap electrode onto the analyzer posts. (The 
entrance endcap electrode is the one without the damping gas nipple.) 
Ensure that the electrode is oriented such that the convex surface faces 
away from the analyzer mount. Also, the opening in which the pin on the 
end of the electrical lead inserts should be close to the top cover plate 
when the analyzer mount is installed on the top cover plate.

3. Place a quartz spacer ring into the groove in the entrance endcap 
electrode.

4. Reinstall the ring electrode onto the quartz spacer ring so that the spacer 
ring is held securely between the electrodes. The orientation of the ring 
electrode is unimportant. 

5. Reinstall the second quartz spacer ring into the groove in the ring 
electrode.

6. Reinstall the exit endcap electrode (the one with the damping gas nipple) 
on the analyzer posts such that the quartz spacer ring is held in place 
between the ring electrode and the exit endcap electrode. Make sure that 
the electrode is oriented such that the convex surface faces the spacer 
ring. Also, the damping gas nipple should point toward the top cover plate 
when the analyzer mount is installed on the top cover plate.

7. Inspect the mass analyzer assembly. Ensure that all the parts are aligned 
properly and that they all fit together snugly.

8. Reinstall the spring washers on the analyzer posts such that the convex 
side of the washer is toward the exit endcap electrode.

9. Reinstall the analyzer nuts onto the analyzer posts and tighten the nuts by 
hand until they are finger tight. Do not overtighten the nuts.

Note. Wear clean, lint-free, nylon or cotton gloves when you handle 
components of the mass analyzer.

Caution. Handle the spacer rings carefully. Do not scrape the spacer rings 
against any metal surfaces. Metal deposits on the surfaces of the spacer rings 
might cause the RF voltage to arc across the spacer rings to the endcaps. Do 
not overtighten the mass analyzer nuts.
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10. Squeeze the exit lens sleeve and insert it into the recess in the exit endcap 
electrode. See Figure 5-7 on page 5-27 for the proper orientation of the 
exit lens sleeve.

11. Insert the exit lens into the exit lens sleeve such that the lead pin on the 
exit lens points in the same direction as the 8-pin feedthrough when the 
analyzer mount is installed on the top cover plate. Make sure that the exit 
lens lead pin does not contact the nut on the end of the mass analyzer post.

Go on to the next topic: Reinstalling the Ion Optics and Mass Analyzer.

Reinstalling the Ion Optics and Mass 
Analyzer

Use the following procedure to reinstall the ion optics and mass analyzer 
onto the top cover plate of the vacuum manifold:

1. Insert the cylindrical end of the analyzer mount (with the mass analyzer 
and second octapole [the octapole with two lead pins] attached) into the 
opening in the baffle on the top cover plate of the vacuum manifold. 
Ensure that the open side of the analyzer mount is away from the top 
cover plate. See Figure 5-5 on page 5-24.

2. Secure the analyzer mount to the baffle with the two thumb screws.

3. Insert the interoctapole lens, lead pin first, through the opening in the 
baffle. Turn the interoctapole lens until the lead pin is on the same side as 
the 8-pin feedthrough. Ensure that the second octapole is held securely 
between the endcap electrode and the interoctapole lens. Also ensure that 
the lead pins on the second octapole are on the same side as the 4-pin 
feedthrough.

4. Attach the split (first) octapole and octapole mount to the baffle on the top 
cover plate with the two thumb screws. Ensure that the interoctapole lens 
is held securely between the two octapoles. Also ensure that the lead pins 
on the split octapole are on the same side as the 4-pin feedthrough.

5. Inspect the ion optics. Ensure that all the parts are aligned properly and 
that they all fit together snugly.

6. Reconnect the four electrical leads from the 4-pin feedthrough to the split 
(first) octapole according to the wiring diagram shown in Figure 5-8. 

7. Reconnect the two electrical leads from the other 4-pin feedthrough to the 
second octapole according to the wiring diagram shown in Figure 5-8.

Note. Wear clean, lint-free, nylon or cotton gloves when you handle 
components of the ion optics and mass analyzer.
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8. Reconnect the electrical lead from pin 2 of the 8-pin feedthrough to the 
interoctapole lens according to the wiring diagram shown in
 Figure 5-8.

9. Reconnect the electrical lead from pin 4 of the 8-pin feedthrough to the 
entrance endcap electrode according to the wiring diagram shown in 
Figure 5-8, by inserting the pin on the end of the lead into the socket in 
the electrode.

10. Reconnect the electrical lead from pin 5 of the 8-pin feedthrough to the 
exit endcap electrode according to the wiring diagram shown in 
Figure 5-8, by inserting the pin on the end of the lead into the socket in 
the electrode.

11. Reconnect the electrical lead from pin 7 of the 8-pin feedthrough to the 
exit lens according to the wiring diagram shown in Figure 5-8. Ensure 
that the exit lens lead pin does not contact the nut.

12. Reconnect the damping gas line to the nipple on the exit endcap electrode.

Go on to the next topic: Cleaning the Ion Detection System.

Note. Check all leads and ensure that they are secure and that they go to the 
proper electrodes.
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Cleaning the Ion Detection System

The conversion dynode and electron multiplier of the ion detection system 
must be kept dust free. Clean the conversion dynode and electron multiplier 
whenever you remove the top cover plate of the vacuum manifold. Cleaning 
the conversion dynode and electron multiplier involves only blowing them 
with clean, dry gas such as nitrogen. Freon gas is not recommended. Do not 
use liquids to clean the ion detection system components. Always cover the 
opening in the top of the vacuum manifold with a large, lint-free tissue 
whenever you remove the top cover plate of the vacuum manifold.

Go on to the next topic: Reinstalling the Top Cover Plate of the Vacuum 
Manifold.

Reinstalling the Top Cover Plate of the 
Vacuum Manifold

Use the following procedure to reinstall the top cover plate of the vacuum 
manifold:

1. Remove the tissue from the opening in the top of the vacuum manifold.

2. Check the O-ring that surrounds the opening for signs of wear, and 
replace it if necessary (P/N 97000-40015). Make sure that the O-ring is 
seated properly.

3. Carefully lift the top cover plate up by its two handles and turn it over. 
Orient the top cover plate such that the electron multiplier is over the 
conversion dynode. Carefully insert the guide posts on the underside of 
the top cover plate into the guide holes in the vacuum manifold. Slowly 
lower the cover plate onto the opening in the vacuum manifold. Take care 
not to damage the components on the underside of the cover plate. Ensure 
that the cover plate is seated properly on the vacuum manifold. 

4. Use a 7/16-in. open-end wrench to reconnect the helium damping gas line 
to the fitting.

5. Reconnect (at ANAL. AUX 1 IN) the octapoles cable that comes from the 
Analyzer Auxiliary PCB.

6. Reconnect (at ANALYZER) the lenses cable that comes from the System 
Control PCB.

7. Reconnect (at ANAL. AUX 2 IN and ANAL. AUX 3 IN) the two endcap 
electrode cables that come from the Analyzer Auxiliary PCB.

Note. Periodically, remove any contamination that might be on the inner 
walls of the manifold by wiping the inner walls with a lint-free tissue soaked 
in HPLC-grade methanol. Use a cotton-tipped applicator soaked in methanol 
to clean around inlets and feedthroughs.
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8. Reconnect (at ACQU/DSP) the electrometer cable.

9. Reconnect (at MULT) the electron multiplier high voltage cable that 
comes from the electron multiplier power supply.

Go on to the next topic: Reinstalling the Top Cover of the MS Detector.

Reinstalling the Top Cover of the MS 
Detector 

Reinstall the top cover of the MS detector as follows:

1. Open the left and right front doors of the MS detector.

2. With one hand under the center of the top cover, place the top cover on the 
MS detector chassis. Slide the top cover forward until it is engages the 
four guides located at the rear of the chassis.

3. Lower the front of the top cover onto the chassis so that the two guide 
posts located on the front underside of the top cover enter the guide holes 
located on the top of the chassis.

4. Secure the top cover to the chassis with the two latches located on the 
front of the chassis. 

5. Close the left and right front doors of the MS detector.

6. Reconnect any tubing between the syringe pump and the API source to 
accommodate your instrument configuration.

Go on to the next topic: Starting Up the System.

Starting Up the System

Start up the system as described in the topic Starting Up the System After a 
Complete Shutdown on page 6-7 in the System Shutdown, Startup, and 
Reset chapter.

Go on to the next topic: Tuning the Ring Electrode and Octapole RF 
Voltages.

Tuning the Ring Electrode and 
Quadrupole/Octapole RF Voltages

You need to tune the ring electrode RF voltage and the quadrupole/octapole 
RF voltage whenever you service the mass analyzer or ion optics. You also 
need to tune these voltages if you replace any electronic assembly that is 
involved in producing the RF voltages. Use the Diagnostics program to tune 
the ring electrode and quadrupole/octapole RF voltages.
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To tune the ring electrode and octapole RF voltages, proceed as follows:

1. Allow the LCQ Deca XP MAX to pump down for at least 15 min after 
start up.

2. Choose Start > Programs > Xcalibur > LCQ Tune to open the Tune 
Plus window.

3. Choose Control > On to turn the LCQ Deca XP MAX On.

4. Open the Diagnostics dialog box and Graph view as follows:

a. In the Tune Plus window, choose View > Display Graph View to 
open the Graph view.

b. In the Tune Plus window, choose Diagnostics > Diagnostics to 
open the Diagnostics dialog box.

c. Select the Graphs tab to display the Graphs page.

d. Reposition the Diagnostics dialog box so that it does not obscure the 
Graph view. See Figure 5-9.

5. Tune the quadrupole/octapole RF voltage, as follows:

a. Select Tune multipole frequency in the Test Type list box.

b. Select the Once option button in the How Many Times group box.

c. Click on the Start button to start the quadrupole/octapole RF voltage 
tune program. A frequency function appears in the Graph view. See 
Figure 5-10. The minimum of the frequency function should lie 
between 2400 and 2550 kHz. 

d. When the quadrupole/octapole tune program is finished, LCQ Deca 
XP MAX displays the message: Do you want to accept the octapole 
frequency? Click on the Yes button.
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Figure 5-9. Diagnostics dialog box and Graph view

Figure 5-10. Graph view for octapole RF voltage tuning
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6. Tune the ring electrode RF voltage modulation, as follows:

a. Select Tune RF modulation in the Test Type text box.

b. Select the Once option button in the How Many Times group box.

c. Click on the Start button to start the ring electrode RF modulation 
tune program. The Graph view should look like Figure 5-11:

• The standing wave ratio switch line should be at 10 V over the 
entire range.

• The detected RF voltage should be a straight line that begins at 
the origin and intersects the standing wave ratio switch line near 
the highest mass line.

• The RF voltage modulation should be a curved line that begins at 
the origin and intersects the highest mass line at a value between 
3.5 and 4.5 V.

d. Inspect the Graph view:

• If the three above conditions are met, proceed to step 7. 

• If the three above conditions are met over part of the range but 
not all of the range (the curves flatten or change value abruptly), 
tune the RF voltage frequency as described in step 7. Then, repeat 
step 6.

Figure 5-11. Graph view for ring electrode RF voltage modulation tuning

Standing Wave 
Ratio Switch

Detected RF
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Highest Mass

RF Voltage 
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• If the standing wave ratio switch, detected RF voltage, and RF 
voltage modulation lines are all flat, then there might be a loose 
connection. Make sure that all cables and leads are properly 
connected and that the spring-loaded pin on the RF voltage 
feedthrough properly contacts the ring electrode. Repeat step 6.

7. Tune the ring electrode RF voltage frequency, as follows:

a. Select Tune RF frequency in the Test Type text box. The Continuously 
option button in the How Many Times group box is automatically 
selected.

b. Click on the Start button to start the ring electrode RF frequency tune 
program. The Graph view displays several tune functions, a 
frequency cursor, and a frequency window. See Figure 5-12.

c. Allow the program to make at least five passes. Then check to see 
whether the frequency cursor lies within the frequency window.

• If the frequency cursor lies within the frequency window, then the 
ring electrode RF voltage frequency is tuned properly. Click on 
the Stop button and exit from the diagnostics program.

• If the frequency cursor lies outside the frequency window, then 
you need to manually adjust the ring electrode RF voltage 
frequency. Leave the Graph view displayed. Go on to the next 
step.

Figure 5-12. Graph view for ring electrode RF voltage tuning
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8. Manually adjust the ring electrode RF voltage frequency, as follows:

a. Open the left front door of the MS detector.

b. With a Phillips screw driver, remove the air deflector to expose the 
tuning stud. 

c. With a wrench, loosen the 9/16-in. lock nut that holds the tuning stud 
in place. See Figure 5-13.

d. With a screw driver, turn the tuning stud until the frequency cursor 
lies slightly to the left of the center of the frequency window. (The 
cursor should shift slightly to the right when the air deflector is 
reinstalled.) 

e. Tighten the 9/16-in. lock nut.

f. Reinstall the air deflector and close the left front door of the MS 
detector. Make sure that the frequency cursor is still within the 
frequency window. If necessary, repeat the above steps.

g. Select the Stop button to stop the ring electrode RF voltage frequency 
tune program.

Figure 5-13. Ring electrode RF voltage tuning stud
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5.5 Replacing the Electron Multiplier
The electron multiplier of the ion detection system includes an anode and a 
cathode. The anode and cathode have finite lifetimes. The anode loses 
sensitivity over time due to contamination of its surface. Things that decrease 
the lifetime of the cathode include heat, electron flow (which produces 
internal heat), air (which causes oxidation and arcing), and water (which 
causes arcing).

The following symptoms suggest that the electron multiplier may need 
replacing:

• Excessive noise in the mass spectrum

• Inability of the multiplier gain calibration procedure to achieve a gain of 
3 × 105 electrons per ion with an electron multiplier voltage less than or 
equal to 2.5 kV

You can read the current value of the electron multiplier voltage in the Ion 
Detection System dialog box, which can be reached from the Tune Plus 
window by choosing Setup > Ion Detection System.

If you are having problems with the ion detection system, you need to replace 
the anode and cathode of the electron multiplier. You can replace the cathode 
separately or as part of the electron multiplier assembly.

To replace the anode and cathode of the electron multiplier, or the entire 
electron multiplier assembly, proceed as follows:

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely on page 6-5 in the System Shutdown, Startup, 
and Reset chapter. 

2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22.

3. Remove the top cover plate of the vacuum manifold as described in the 
topic Removing the Top Cover Plate of the Vacuum Manifold on 
page 5-22.

4. With an Allen wrench, remove the two socket-head screws that hold the 
electron multiplier support to the top cover plate of the vacuum manifold. 
See Figure 5-14 on page 5-42.

5. With one hand hold the high voltage tube and with the other hand hold the 
electron multiplier support. Then, detach the high voltage tube from the 

CAUTION. Make sure that the LCQ Deca XP MAX power cord is 
unplugged before you proceed.

Note. Wear clean, lint-free, nylon or cotton gloves when you handle the 
electron multiplier components.
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high voltage feedthrough in the top cover plate and remove the electron 
multiplier as a unit. (The anode remains in the anode feedthrough in the 
top cover plate.)

6. Remove the anode from the anode feedthrough by unscrewing it 
counterclockwise by hand.

7. Install a new anode (P/N 96000-20076) in the anode feedthrough in the 
top cover plate by screwing it clockwise by hand.

If you want to replace the entire electron multiplier, install a new electron 
multiplier (P/N 96000-60036) in the next step. If you want to replace only 
the cathode, install the old electron multiplier in the next step.

8. With one hand holding the high voltage tube and the other hand holding 
the electron multiplier support, install the electron multiplier on the top 
cover plate. Ensure that the high voltage tube is properly inserted in the 
high voltage feedthrough and that the screw holes in the electron 
multiplier support are aligned with the screw holes in the top cover plate.

9. Reinstall the two socket-head screws that secure the electron multiplier 
support to the top cover plate. Tighten the screws with an Allen wrench.

• If you installed a new electron multiplier in step 8, go to step 11.

• If you want to replace the cathode, go on to the next step.

10. To replace the cathode, proceed as follows. See Figure 5-15 on page 5-43.

a. With a Phillips screwdriver, loosen (but do not remove) the two 
screws that secure the support plates to the high voltage ring.

b. With one hand, hold the high voltage tube. With the other hand, hold 
the high voltage ring. Then, detach the high voltage tube from the 
high voltage feedthrough and remove the electron multiplier. Place it 
on a clean surface. (The electron multiplier support and the support 
plates should remain attached to the top cover plate.)

c. Turn the assembly over. With a Phillips screwdriver, remove the 
two screws that secure the electron multiplier shield to the high 
voltage ring.

d. Remove the electron multiplier shield and cathode from the high 
voltage ring.

e. Insert the narrow end of a new cathode (P/N 00022-02400) first 
through the spring washer and then through the high voltage ring.

f. Place the electron multiplier shield over the wide end of the cathode 
such that the screw holes in the electron multiplier shield are aligned 
with the screw holes in the high voltage ring.

Caution. Be careful not to damage the surface of the electron multiplier 
shield. The electron multiplier shield has been electropolished to prevent 
field emission.
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g. Hold the high voltage ring and electron multiplier shield together to 
depress the spring washer. Secure the high voltage ring to the electron 
multiplier shield by using the two Phillips-head screws. (The cathode 
should be held in place between the high voltage ring and the electron 
multiplier shield.)

h. Insert the end of the high voltage tube in the electron multiplier 
feedthrough in the top cover plate. Reattach the high voltage ring to 
the support plates by inserting the two screws in the sides of the high 
voltage ring into the notches in the two support plates. Tighten the 
two Phillips-head screws that secure the high voltage ring to the two 
support plates.

Figure 5-14. Exploded view of the electron multiplier, showing the anode
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11. Reinstall the top cover plate of the vacuum manifold over the opening in 
the vacuum manifold as described in the topic Reinstalling the Top 
Cover Plate of the Vacuum Manifold on page 5-33.

12. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 5-34.

13. Start up the LCQ Deca XP MAX system as described in the topic 
Starting Up the System After a Complete Shutdown in the System 
Shutdown, Startup, and Reset chapter.

14. Set the electron multiplier voltage to -800 V as follows:

a. Choose Start > Programs > Xcalibur > LCQ Tune to open the 
Tune Plus window.

Figure 5-15. Exploded view of the electron multiplier, showing the cathode
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b. From the Tune Plus window, choose Diagnostics > Diagnostics.

c. Select the Graphs tab to display the Graphs page.

d. In the Set Device Value option box, select Multiplier (V).

e. In the text box to the right of the Set Device Value option box, enter 
-800.

f. Click on the Set button to set the electron multiplier voltage to 
-800 V.

g. Click on the OK button to return to Tune Plus.

15. Calibrate the electron multiplier voltage as follows:

a. Allow the system to pump down for at least one hour before you turn 
on the high voltages.

b. Set up for the infusion of the tuning solution into the MS detector as 
described in LCQ Series Getting Started.

c. From the Tune Plus window, choose Control > Calibrate. The 
Calibrate dialog box appears.

d. Click on the Semi-Automatic tab to display the Semi-Automatic 
page.

e. Select the Electron Multiplier Gain option. Click on the Start button 
to start the multiplier gain procedure.

16. After the Electron Multiplier Gain program is finished, set up for ESI or 
APCI operation as described in LCQ Series Getting Started.
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5.6 Purging the Oil in the Forepump
You need to purge (decontaminate) the oil in the forepump on a daily basis to 
remove water and other dissolved chemicals from the pump oil. Water and 
other chemicals in the forepump can cause corrosion and decrease the lifetime 
of the pump. A good time to purge the oil is at the end of the working day 
after you flush the API probe, spray shield, and ion transfer capillary.

To purge the oil in the forepump, proceed as follows:

1. Turn off the flow of sample solution from the LC to the MS detector.

2. From the Tune Plus window, choose Control > Standby (or click on the 
On/Standby button) to put the MS detector in Standby.

3. Withdraw the API flange from the spray shield and place a septum over 
the entrance to the ion transfer capillary.

4. Open the gas ballast valve on the forepump by turning it to position |. 
Refer to the manual that came with the pump for the location of the gas 
ballast valve.

5. Allow the pump to run for 2 hours with the gas ballast valve open.

6. After 2 hours, close the gas ballast valve by turning it to position O.

7. Top off oil in the forepump reservoir if the level is lower than two-thirds 
of the maximum level visible in the viewing window.

Removing the Turbomolecular Pump

To remove the turbomolecular pump, proceed as follows:

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely on page 6-5 in the System Shutdown, Startup, 
and Reset chapter. Be sure that the vacuum manifold is completely 
vented before continuing.

2. Disconnect any sample tubes between the syringe pump and the API 
source.

3. Open the left and right front doors of the MS detector by loosening the 
1/4-in. Allen screw on the right front door with an Allen wrench. 
(Disconnect any sample tubes between the syringe pump and the API 
source before opening the right front door.)

4. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22.

CAUTION. Make sure that the LCQ Deca XP MAX power cord is 
unplugged before you proceed.
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5. Loosen the hose clamp that secures the vacuum hose to the tee 
(P/N 97144-20031) See Figure 5-16. Disconnect the vacuum hose from 
the tee.

6. Remove the AT box.

7. Disconnect the power cable from the turbomolecular pump controller.

8. With a 3/16-in. ball driver or Allen wrench, carefully loosen the two Allen 
screws that hold the rails and turbomolecular pump to the vacuum 
manifold.

9. Pull the turbomolecular pump out on the rails. If necessary, disconnect 
one or more of the vacuum hoses at the foreline union by loosening the 
clamping rings and then pulling the hoses free from the foreline union.

10. Remove the turbomolecular pump.

Go on to the next topic: Reinstalling the Turbomolecular Pump.

Figure 5-16. Turbomolecular pump
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Reinstalling the Turbomolecular Pump

To reinstall the turbomolecular pump, proceed as follows (see Figure 5-16):

1. Check the condition of the Viton O-rings around the two openings on the 
bottom of the vacuum manifold. (Use a small flashlight to illuminate the 
O-rings.) If they have any nicks or breaks, replace them with new ones 
(P/N 00107-11100).

2. Place the turbomolecular pump on the turbomolecular pump rails.

3. Slide the turbomolecular pump into position under the openings in the 
vacuum manifold.

4. With a 3/16-in. ball driver or Allen wrench, carefully tighten the two 
Allen screws that hold the rails and turbomolecular pump to the vacuum 
manifold. Do not overtighten the screws.

5. Reconnect the vacuum hose to the tee P/N 97144-20031). Tighten the 
hose clamp that secures the vacuum hose to the tee.

6. Reconnect the turbomolecular pump power cable to the turbomolecular 
pump controller.

7. Reinstall AT box.

8. If necessary, reconnect the vacuum hoses to the foreline union. Tighten 
the clamping rings to secure the vacuum hoses to the foreline union.

9. Reinstall the top cover of the MS detector by following the procedure in 
the topic Reinstalling the Top Cover of the MS Detector on page 5-34.

10. Close the left and right front doors of MS detector.

11. Reconnect any tubing between the syringe pump and the API source that 
you disconnected earlier.

12. Restart the system as described in the topic Starting Up the System 
After a Complete Shutdown on page 6-7 in the System Shutdown, 
Startup, and Reset chapter.
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5.7 Cleaning the Fan Filter
You need to clean the fan filter, located on the rear of the MS detector, every 
four months. To clean the fan filter, proceed as follows:

1. Remove the fan filter by reaching behind the MS detector and pulling the 
fan filter out to the right.

2. Wash the fan filter in a solution of soap and water.

3. Rinse the fan filter with tap water.

4. Squeeze the water from the fan filter and allow it to air dry.

5. When the fan filter is completely dry, reinstall it on the rear of the MS 
detector [or replace it with a new one (P/N 97000-20299)].
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Chapter 6
System Shutdown, Startup, and Reset

Many maintenance procedures for the LCQ Series MS detector require that 
the MS detector be shut down completely. In addition, the MS detector can be 
placed in Standby if the system is not to be used for 12 hours or more.

This chapter contains the following sections:

• Shutting Down the System in an Emergency

• Placing the System in Standby Condition

• Shutting Down the System Completely

• Starting Up the System after a Complete Shutdown

• Resetting the MS Detector

• Resetting the Tune and Calibration Parameters to their Default Values

• Resetting the Data System

• Turning Off Selected MS Detector Components
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6.1 Shutting Down the System in an 
Emergency

If you need to turn off the MS detector in an emergency, place the main power 
circuit breaker switch, located on the power panel on the right side panel of 
the MS detector (see Figure 6-1 and Figure 6-2), in the Off (O) position. This 
turns off all power to the MS detector, including the vacuum pumps. Although 
removing power abruptly will not harm any component within the system, 
this is not the recommended shutdown procedure to follow. Refer to the 
Shutting Down the System Completely topic, on page 6-5, for the 
recommended procedure. 

To turn off the LC, autosampler, and computer in an emergency, use the on/off 
switches on the LC, autosampler, and computer, respectively.

Figure 6-1. LCQ Advantage MAX power panel, showing the Reset 
button electronics service switch, and the main power 
circuit breaker switch

Reset Button Electronics Service Switch Main Power Circuit
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Figure 6-2. LCQ Deca XP MAX power panel, showing the Reset 
button electronics service switch, and the main power 
circuit breaker switch

Reset Button Electronics Service Switch Main Power Circuit
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6.2 Placing the System in Standby 
Condition

The LCQ Series system does not need to be shut down completely if you are 
not going to use it for a short period of time, such as overnight or over 
weekends. When you are not going to operate the system for 12 hours or 
more, you can leave the system in a standby condition.

Use the following procedure to place the LCQ Series system in the standby 
condition:

1. Wait until data acquisition, if any, is complete.

2. Turn off the flow of sample solution from the LC to the API source, as 
follows: 

a. In the Tune Plus window, click on the LC button. The Inlet Direct 
Control dialog box appears.

b. Click on Stop to stop the LC pump.

3. From the Tune Plus window, choose Control > Standby (or click on the 
On/Standby button) to put the MS detector in Standby. When you choose 
Control > Standby, the LCQ Series MS detector turns off the electron 
multiplier, conversion dynode, 8 kV power to the API source, ring 
electrode RF voltage, and octapole RF voltage. LCQ Series also turns off 
the auxiliary gas and sets the sheath gas flow to 0 units. See Table 6-1 on 
page 6-16 for the On/Off status of MS detector components when the MS 
detector is in the standby condition. The System LED on the front panel 
of the MS detector is illuminated yellow when the system is in Standby.

4. Flush the spray shield and the entrance end of the ion transfer capillary of 
the API source as describe in the topic Flushing the Spray Shield and 
Ion Transfer Capillary in the MS Detector Maintenance chapter. Cap 
the ion transfer capillary with the septum. Leave the API flange 
withdrawn from the spray shield.

5. Purge the forepump oil as described in the topic Purging the Forepump 
Oil in the MS Detector Maintenance chapter. 

6. Leave the MS detector power on.

7. Leave the LC power on.

8. Leave the autosampler power on.

9. Leave the data system power on.

Note. For instructions on how to operate the LC from the front panel, refer 
to the manual that came with the LC.
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6.3 Shutting Down the System 
Completely

The LCQ Series system does not need to be shut down completely if you are 
not going to use it for a short period of time, such as overnight or over 
weekends. (Refer to the topic Placing the System in Standby Condition, 
above.) Shut down the system completely only if it is to be unused for an 
extended period or if it must be shut down for a maintenance or service 
procedure.

Use the following procedure to shut down the LCQ Series system completely:

1. Turn off the flow of sample solution from the LC (or other sample 
introduction device).

2. From the Tune Plus window, choose Control > Standby (or click on the 
On/Standby button) to put the MS detector in Standby. When you place 
the MS detector in Standby mode, the LCQ Series MS detector turns off 
the electron multiplier, conversion dynode, 8 kV power to the API source, 
main RF voltage, and octapole RF voltage, sheath and auxiliary gasses.

3. Place the electronics service switch, located on the power panel (see 
Figure 6-1 on page 6-2 for the LCQ Advantage MAX, or Figure 6-2 on 
page 6-3 for the LCQ Deca XP MAX), in the Service position. Power to 
the non-vacuum system electronics is turned off when you place the 
electronics service switch in the Service position.

4. Place the main power circuit breaker switch, located on the power panel 
(Figure 6-2) in the Off (O) position. When you place the main power 
circuit breaker switch in the Off (O) position, the following occurs:

• All power to the MS detector, including the turbomolecular pump and 
rotary vane pump, is turned off. (All LEDs on the front panel of the 
MS detector are off.)

• The battery backup on the Vent Delay PCB provides power to the 
vent valve for 30 s. After 30 s, a circuit on the Vent Delay PCB times 
out, and power to the vent valve solenoid is shut off. When power to 
the vent valve solenoid is shut off, the vent valve opens and the 
vacuum manifold is vented to filtered air. You can hear a hissing 
sound as the air passes through the air filter.

• After about 2 min, the vacuum manifold is at atmospheric pressure.

5. Unplug the power cord for the MS detector.

Note. For instructions on how to operate the LC from the front panel, refer 
to the manual that came with the LC.

CAUTION. Allow heated components to cool before servicing them.
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6. Turn off the (optional) LC. Follow the procedure described in the manual 
that came with the LC.

7. Turn off the helium damping gas supply at the tank. 

8. Turn off the nitrogen supply at the tank.

9. Turn off the data system as follows:

a. Choose Start > Shut Down from the Microsoft Windows 2000 task 
bar. The Shut Down Microsoft Windows dialog box appears.

b. Select the Shut Down The Computer option button, and then click on 
Yes to start the Microsoft Windows 2000 shutdown procedure.

c. When the Microsoft Windows 2000 shutdown procedure tells you 
that it is safe to turn off the computer, turn off the monitor and 
computer by using the on/off switches.

10. Turn off the (optional) printer by using the on/off switch.

11. Turn off the (optional) autosampler by using the main power on/off 
switch.

Note. If you are planning to perform routine or preventive system 
maintenance on the MS detector only, you do not need to turn off the LC, 
data system, and autosampler. In this case, the shutdown procedure is 
completed. However, if you do not plan to operate your system for an 
extended period of time, we recommend that you turn off the LC, data 
system, and autosampler as described in steps 6 through 11 below.
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6.4 Starting Up the System after a 
Complete Shutdown

To start up the LCQ Series system after it has been shut down completely, you 
need to do the following:

• Start up the (optional) LC

• Start up the data system

• Start up the MS detector

• Start up the (optional) autosampler

• Set up conditions for operation

Starting Up the LC

To start up the LC, follow the startup procedure described in the manual that 
came with the LC. If necessary, configure the LC as described in LCQ Series 
Getting Connected. Do not turn on the liquid flow to the MS detector.

Starting Up the Data System

Use the following procedure to start up the data system: 

1. Turn on the monitor, computer, and printer.

2. Observe the Microsoft Windows 2000 startup procedure on the monitor. 

3. Press <Ctrl>+<Alt>+<Del> when you are prompted to do so. Then, click 
on OK or enter your password (if you have one) in the Logon Information 
dialog box to complete the start up procedure.

Starting Up the MS Detector

Use the following procedure to start up the MS detector.

1. Turn on the flows of helium and nitrogen at the tanks if they are off.

2. Make sure that the main power circuit breaker switch is in the 
Off (O) position and the electronics service switch is in the Service 
position.

3. Plug in the power cord for the MS detector.

Note. The data system must be running before you start up the MS detector. 
The MS detector will not operate until software is received from the data 
system.
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4. Place the main power circuit breaker switch in the On (|) position. When 
you place the main power circuit breaker switch in the On (|) position, the 
forepump and the turbomolecular pump are started. All LEDs on the MS 
detector front panel are off.

5. Allow the MS detector to pump down for 5 min.

6. Place the electronics service switch in the Operational position. When 
you place the electronics service switch in the Operational position, the 
following occurs:

• The Power LED on the MS detector front panel is illuminated green 
to indicate that power is provided to the MS detector electronics. (The 
electron multiplier, conversion dynode, 8 kV power to the API 
source, main RF voltage, and octapole RF voltage remain off.)

• The embedded computer reboots. After several seconds the 
Communication LED on the front panel is illuminated yellow to 
indicate that the data system and the MS detector have started to 
establish a communication link.

• After several more seconds, the Communication LED is illuminated 
green to indicate that the data system and the MS detector have 
established a communication link. Ensure that the instrument console 
window is active. Software for the operation of the MS detector is 
then transferred from the data system to the MS detector.

• After 3 minutes, the System LED is illuminated yellow to indicate 
that the software transfer from the data system to the MS detector is 
complete and that the instrument is in Standby.

If you have an autosampler, go on to the next topic: Starting Up the 
Autosampler. If you do not have an autosampler, go to the topic: Setting Up 
Conditions for Operation.

Starting Up the Autosampler

To start up the autosampler, place the main power switch on the autosampler 
in the on position. If necessary, configure the autosampler. For procedures for 
placing sample vials, preparing solvent and waste bottles, installing syringes, 
etc., refer to the manual that came with the autosampler. Refer also to LCQ 
Series Getting Connected.

Note. The Vacuum LED on the front panel of the MS detector is illuminated 
green only if the pressure in the vacuum manifold is below the maximum 
allowable pressure (5 × 10-4 Torr in the analyzer region, and 2 Torr in the 
capillary-skimmer region), and the safety interlock switch on the API source 
is depressed (that is, the API flange is secured to the spray shield). 
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Setting Up Conditions for Operation

Set up your LCQ Series MS detector for operation as follows:

1. Before you begin data acquisition with your LCQ Series system, you need 
to allow the system to pump down for at least 1 hour. Operation of the 
system with excessive air and water in the vacuum manifold can cause 
reduced sensitivity, tuning problems, and reduced lifetime of the electron 
multiplier.

2. Ensure that the helium pressure and nitrogen pressure are within the 
operational limits (helium: 40 ±10 psig [275 ±70 kPa], nitrogen:
100 ±20 psig [690 ±140 kPa]).

3. Open the Tune Plus window by selecting Start > Programs > 
Xcalibur > LCQ Tune.

4. In the Tune Plus window, click on the Status button to open the status 
panel. See Figure 6-3.

5. Look at the status panel in the Tune Plus window. Check to see if the 
pressure measured by the ion gauge is below about 5 ×10-5 Torr, and the 
pressure measured by the Convectron gauge is around 1 Torr. Compare 
the values of the other parameters in the status panel with values that you 
recorded previously.

6. Set up for ESI or APCI operation as described in LCQ Series Getting 
Started.

Note. Air in the helium line must be purged or given sufficient time to be 
purged for normal MS detector performance.

Note. You do not need to calibrate or tune the LCQ Series MS detector each 
time you restart.

Calibration parameters are instrument parameters whose values do not vary 
with the type of experiment. You need to calibrate the LCQ Series MS 
detector perhaps once a month, and check the calibration once a week. Refer 
to LCQ Series Getting Started for a procedure for calibrating the LCQ 
Series MS detector.

Tune parameters are instrument parameters whose values vary with the type 
of experiment. You need to tune the LCQ Series MS detector (or change the 
Tune Method) whenever you change the type of experiment. Refer to LCQ 
Series Getting Started for procedures for tuning the LCQ Series MS 
detector in the ESI or APCI mode. (Note that the LCQ Series MS detector 
comes with several standard Tune Methods specific for various experimental 
conditions, so that tuning is often not required for many types of 
experiments.)
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Figure 6-3. Status Panel Open in Tune Plus Window
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6.5 Resetting the MS Detector
If communication between the MS detector and data system computer is lost, 
it may be necessary to reset the MS detector using the Reset button on the 
power panel. When you press the Reset button (for 3 s), an interrupt in the 
embedded computer is created. This causes the embedded computer to restart 
in a known (default) state. See Figure 6-1 on page 6-2 (for LCQ Advantage 
MAX) or Figure 6-2 on page 6-3 (for LCQ Deca XP MAX) for the location of 
the Reset button.

The procedure given here assumes that the MS detector and data system 
computer are both powered on and operational. If the MS detector, data 
system computer, or both are off, refer to the topic Starting Up the System 
after a Complete Shutdown on page 6-7.

To reset the MS detector, press the Reset button located on the power panel 
for 3 s. Make sure the Communication LED is extinguished before releasing 
the Reset button. When you press the Reset button (for 3 s), the following 
occurs:

• An interrupt on the embedded computer causes the CPU to reboot. All 
LEDs on the front panel of the MS detector are off except the Power LED.

• After several seconds, the Communication LED is illuminated yellow to 
indicate that the data system and the MS detector are starting to establish 
a communication link.

• After several more seconds, the Communication LED is illuminated 
green to indicate that the data system and the MS detector have 
established a communication link. Software for the operation of the MS 
detector is then transferred from the data system to the MS detector.

• After 3 min the software transfer is complete. The System LED is 
illuminated either green to indicate that the instrument is functional and 
the high voltages are on, or yellow to indicate that the instrument is 
functional, and it is in Standby.
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6.6 Resetting the Tune and 
Calibration Parameters to their 
Default Values

You can reset the LCQ Series MS detector tune and calibration parameters to 
their default values at any time. This feature may be useful if you have 
manually set some parameters that have resulted in less than optimum 
performance. To reset the MS detector tune and calibration parameters to their 
default values, proceed as follows:

1. In the Tune Plus window, choose File > Restore Factory Calibration 
to restore the default calibration parameters, or choose File > Restore 
Factory Tune Method to restore the default tune parameters.

2. To optimize the LCQ Series system parameters (that is, to calibrate or 
tune the system), perform the calibration or tune procedure as described 
in LCQ Series Getting Started.

Note. Make sure that the problems that you are experiencing are not due to 
improper API source settings (spray voltage, sheath and auxiliary gas flow, 
ion transfer capillary temperature, etc.) before resetting the system 
parameters to their default values.
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6.7 Resetting the Data System
There are two ways to reset the data system:

• By using the Microsoft Windows 2000 shutdown and restart procedure

• By pressing the reset button on the personal computer

Resetting the Data System by Using the 
Microsoft Windows XP Shutdown and 
Restart Procedure

If possible, use the Microsoft Windows XP shutdown and restart procedure to 
shut down and restart the data system so that Microsoft Windows XP can 
properly close applications and save changes to files.

To reset the data system by using the Microsoft Windows XP shutdown and 
restart procedure, proceed as follows:

1. Choose Start > Shut Down from the Microsoft Windows XP task bar. 
The Shut Down Microsoft Windows dialog box appears.

2. Select the Restart The Computer option button, and then click on Yes to 
start the Microsoft Windows XP shutdown and restart procedure.

3. Observe the Microsoft Windows XP shutdown and restart procedure on 
the monitor. 

4. Press <Ctrl>+<Alt>+<Del> when you are prompted to do so. Then, click 
on OK or enter your password (if you have one) in the Logon Information 
dialog box to complete the shutdown and restart procedure.

Resetting the Data System by Using the 
Reset Button on the Personal Computer

If you are unable to reset the data system by using the Microsoft Windows 
2000 shutdown and restart procedure, proceed as follows:

1. Press the reset button on the personal computer.

2. Observe the Microsoft Windows XP shutdown and restart procedure on 
the monitor. 

Note. The communications link between the data system and the MS 
detector should be automatically reestablished after you reset the data 
system. When this occurs the Communication LED on the front panel of the 
MS detector is illuminated yellow and then green. If the system is unable to 
reestablish the communications link, press the Reset button (for 3 s) on the 
power panel of the MS detector. 
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3. Press <Ctrl>+<Alt>+<Del> when you are prompted to do so. Then, click 
on OK or enter your password (if you have one) in the Logon Information 
dialog box to complete the shutdown and restart procedure.

4. When the shutdown and restart procedure has completed, choose 
Start > Programs > Xcalibur > LCQ Tune to display the Tune Plus 
window.

Note. The communications link between the data system and the MS 
detector should be automatically reestablished after you reset the data 
system. When this occurs the Communication LED on the front panel of the 
MS detector is illuminated yellow and then green. If the system is unable to 
reestablish the communications link, press the Reset button (for 3 s) on the 
power panel of the MS detector.
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6.8 Turning Off Selected MS Detector 
Components

There are five ways that you can turn off some or all of the MS detector 
components

• Turn off individual MS detector components from the Tune Plus window. 
Turning off individual MS detector components might be necessary when 
you are troubleshooting or when you are running certain diagnostic 
procedures.

• Place the MS detector in Standby. Standby is the normal condition to 
leave the MS detector in when it is not in use. Choose
Control > Standby (or toggle the On/Standby button) from the Tune 
Plus window to place the MS detector in Standby.

• Place the MS detector in the Off condition. The Off condition is similar to 
Standby, except all high voltage components of the MS detector are 
turned off. Choose Control > Off from the Tune Plus window to place 
the MS detector in the Off condition.

• Place the electronics service switch in the Service position. The 
electronics service switch allows you to perform maintenance procedures 
involving non-vacuum system components of the MS detector.

• Place the main power circuit breaker switch in the Off (O) position. 
Placing the main power circuit breaker switch in the Off (O) position 
removes all power to the MS detector, including the vacuum system.

The on/off status of MS detector components, voltages, and gas flows is 
summarized in Table 6-1.
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Table 6-1. On/Off Status of MS Detector Components, Voltages, and Gas Flows

MS detector component Standby Off Electronics 
service switch in 
Service position

Main power circuit 
breaker switch in 
Off (O) position

Electron multiplier Off Off Off Off

Conversion dynode Off Off Off Off

Mass analyzer RF/waveform 
voltages

Off Off Off Off

Mass analyzer dc offset 
voltage

On Off Off Off

Octapole/Multipole RF 
voltage

Off Off Off Off

Octapole/Multipole dc offset 
voltage

On Off Off Off

Interoctapole lens On Off Off Off

Tube lens On Off Off Off

Ion transfer capillary heater On On Off Off

Ion transfer capillary dc 
offset

On Off Off Off

Corona discharge needle Off Off Off Off

APCI vaporizer Off Off Off Off

ESI needle Off Off Off Off

Sheath gas Off Off Off Off

Auxiliary gas Off Off Off Off

Helium damping gas On On On On

Vent valve Closed Closed Closed Open (after 30 s)

Turbomolecular pump On On On Off

Forepump On On On Off

Vent Delay PCB On On On Off (after 30 s)

Embedded computer On On Off Off

Turbomolecular Pump 
Controller

On On On Off

Power supply, electron 
multiplier and conversion 
dynode

Off Off Off Off

Power supply, 8 kV Off Off Off Off

Power supply, +5, ±15, ±24 V 
dc switching

On On Off Off
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Power supply, +36, -28 V dc 
switching

On Off Off Off

Power supply, +48, +24 V 
switching

On On On Off

Power supply, +180 V dc On On Off Off

Power supply, ±150 V dc On Off Off Off

Power supply, +36 V dc On Off Off Off

Power supply, +4 V dc (XP 
Only)

On On Off Off

Power supply, ±210 V dc 
linear (LCQ Advantage MAX 
Only)

On Off Off Off

Power supply, ±205 V dc 
linear (Toroidal Transformer, 
XP Only)

On Off Off Off

Fan, turbomolecular pump On On On Off

Fan, RF coil On On Off Off

Fan, upper tower On On Off Off

Fan, lower tower On On On Off

Fan, embedded computer On On On Off

Convectron gauge On On Off Off

Ion gauge On On Off Off

Syringe pump On On Off Off

Table 6-1. On/Off Status of MS Detector Components, Voltages, and Gas Flows, continued

MS detector component Standby Off Electronics 
service switch in 
Service position

Main power circuit 
breaker switch in 
Off (O) position
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Chapter 7
LCQ Advantage MAX Diagnostics and

PCB and Assembly Replacement

Many of the MS detector components can be tested by the 
LCQ Advantage MAX diagnostics. Thermo Electron’s service philosophy for 
the LCQ Advantage MAX system calls for troubleshooting to the lowest part, 
assembly, PCB, or module listed in the Replaceable Parts chapter. You 
should replace LCQ Advantage MAX components when indicated by the 
LCQ Advantage MAX diagnostics, by Thermo Electron San Jose Technical 
Support, or by a Thermo Electron San Jose Customer Support Engineer.

This chapter contains the following sections:

• Running the LCQ Advantage MAX Diagnostics

• Replacing a Fuse

• Replacing PCBs and Assemblies in the MS Detector
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7.1 Running the LCQ Advantage MAX 
Diagnostics 

The LCQ Advantage MAX diagnostics system is used to test the major 
electronic circuits within the instrument and indicate whether the circuits pass 
or fail the tests. If there is a problem with the instrument electronics, the 
LCQ Advantage MAX diagnostics can often locate the problem. You can then 
often correct the problem yourself by replacing a faulty PCB or assembly.

The LCQ Advantage MAX diagnostics does not diagnose problems that are 
not electrical in nature. For example, it does not diagnose poor sensitivity due 
to misaligned or dirty components or to improper tuning. Therefore, it is 
important to have someone who is familiar with system operation and basic 
hardware theory run the diagnostics and use it to assist in isolating any 
problems.

Before running the diagnostics, you should consider the following:

• Did the system fail when you were running samples?

• Did problems occur after you performed maintenance on the instrument, 
data system, or peripherals?

• Did you change the system’s configuration, cables, or peripherals just 
before the problem occurred?

If the answer is yes to the first item above, there is the possibility of a 
hardware failure, and running the diagnostics is appropriate.

If the answer is yes to one of the last two items above, the problem is probably 
mechanical, not electrical. Reverify that alignment, configurations, and cable 
connections are correct before you run the LCQ Advantage MAX diagnostics.

To run the LCQ Advantage MAX diagnostics, proceed as follows:

1. Tune the ring electrode and octapole RF voltages as described in the topic 
Tuning the Ring Electrode and Octapole RF Voltages on page 4-34 in 
the LCQ Advantage MAX MS Detector Maintenance chapter.

2. In the Tune Plus window, choose Diagnostics > Diagnostics. (To 
open Tune Plus, choose Start > Programs > Xcalibur > LCQ Tune.) 
The Diagnostics dialog box appears. See Figure 7-1.

3. Select one of the following options (refer to Table 7-1):

• To test all of the electronic subsystems (that is, the vacuum system, 
power supplies, lenses, ion detection system, and RF voltage 
electronics), click on the All tab and select the Everything option.

• To test an individual subsystem, click on the tab corresponding to that 
subsystem and select the appropriate options. Refer to Table 7-2 for 
more information on these options.
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4. Select how many times you want to run the tests, and whether or not you 
want to print reports or to stop on a failure.

5. Click on the Start button to start the diagnostics.

LCQ Advantage MAX starts testing and displays a chronological log of all 
diagnostic tests in the Testing text box. Once testing for a specific subsystem 
is completed, LCQ Advantage MAX displays either Pass or Fail in the 
Results group box. If the LCQ Advantage MAX diagnostics indicates a 
problem, perform the maintenance procedure indicated by the 
LCQ Advantage MAX diagnostics, by Thermo Electron San Jose Technical 
Support, or by a Thermo Electron San Jose Customer Support Engineer. For 
more information on the LCQ Advantage MAX diagnostics, refer to the 
LCQ Advantage MAX online Help.

Figure 7-1. Diagnostics dialog box
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Table 7-1. Diagnostic tests in Tune Plus

If you Select Diagnostics will 

Everything test Status, RF, Lenses, Ion Detection, and API source (5 
minutes to complete)

Status check all device static values, refer to Table 7-2

RF test five RF devices, refer to Table 7-2

Lenses test four LENSES devices, refer to Table 7-2

Ion Detection test three ION DETECTION devices, refer to Table 7-2

API source test three API source devices, refer to Table 7-2

Table 7-2. Diagnostic items tested in Tune Plus

Item Tested in 
What to Test 
Group Box 

Scanning Device Number in Graph 
View

Scanning Device Name 

Status n/a Refer to Table A-1 in the Appendix for 
static details

RF-1 03 (readback number 06) Aux amplitude (V) 0 to 83.2 

RF-2 10 Main RF DAC (16-bit) 0 to 65535

RF-3 11 (readback number 50) Vernier det. RF amp (V) 0 to 65535 

RF-4 11 (readback number 51) Vernier RF DAC (16-bit) 0 to 65535

RF-5 25 (readback number 52) Octapole RF DAC (V) 0 to 1000 

Lenses-1 30 Octapole 1 offset (V) -132 to 132

Lenses-2 01 Octapole 2 offset (V) -132 to 132

Lenses-3 07 Octapole lens (V) -136 to 136

Lenses-4 25 Octapole det. RF amp. (V) 0 to 1000

Ion Detection-1 04 Trap Offset (V) -132 to 132

Ion Detection-2 17 Tube gate (V) -200 to 198

Ion Detection-3 05 (readback number 41) Multiplier (V) 0 to -2200

API-1 20 Auxiliary gas flow (arb) 0 to 60

API-2 19 Sheath gas flow (arb) 20 to 100

API-3 23 Ion Transfer Capillary Voltage (V) -132 to 
132
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7.2 Replacing a Fuse
Fuses protect the various circuits by opening the circuits whenever 
overcurrent occurs. On the MS detector the fuses are located on the System 
Control PCB and the RF Voltage Amplifier PCB. The function and current 
rating of the various fuses are listed in Table 7-3.

Check fuses when power is lost to a fused subsystem.

To replace a fuse on the System Control PCB or RF Voltage Amplifier PCB, 
proceed as follows:

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Advantage MAX system as described in the topic 
Shutting Down the System Completely in the System Shutdown, 
Startup, and Reset chapter).

• To replace a fuse on the System Control PCB, go to step 2.

• To replace a fuse on the RF Voltage Amplifier PCB, go to step 3.

2. To replace a fuse on the System Control PCB, proceed as follows. See 
Figure 7-2 on page 7-7 for the location of the System Control PCB and its 
fuses.

CAUTION. Always place the electronics service switch in the Service 
position (or shut down the system and disconnect the power cord) before 
you replace fuses on the System Control PCB or RF Voltage Amplifier PCB.

Table 7-3. MS detector fuses

Location Fuse Circuit Description P/N

RF Voltage 
Amplifier PCB

F1 +36 V 1.0 A, quick act, 5 x 20 mm, 250 V 00006-07610

RF Voltage 
Amplifier PCB

F2 -28 V 0.5 A, quick act, 5 x 20 mm, 250 V 00006-07608

System Control 
PCB

F5 Ion transfer 
capillary heater

3.15 A, Type F, 5 x 20 mm, 250 V 00006-10510

System Control 
PCB

F3, F4 APCI vaporizer 
heater

2.5 A, time lag, 5 x 20 mm, 250 V 00006-10510

Caution. Use only the fuses specified in Table 7-3. Never replace a fuse 
with a fuse of a different type, voltage, or current rating.

CAUTION. Make sure that the LCQ Series MS detector electronic service 
switch is in the Service position (or shut down the system and disconnect the 
power cord) before you proceed.
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a. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful 
not to damage any fused silica tubing leading to the API source.

b. Remove the right side cover of the MS detector as follows:

i. Loosen the screw that secures the right side cover to the chassis 
of the MS detector.

ii. Slide the side cover forward, and then lift it out and away from 
the MS detector.

c. Remove the protective cover on the System Control PCB.

d. Locate and replace the defective fuse on the System Control PCB 
with a fuse of the same type, voltage, and current rating. Refer to 
Table 7-3.

e. Reinstall the protective cover over the System Control PCB.

f. Reinstall the right side cover of the MS detector as follows:

i. Slide the side cover back through the guide slots.

ii. Tighten the screw that secures the side cover to the chassis of the 
MS detector. Go to step 4.

3. To replace a fuse on the RF Voltage Amplifier PCB, proceed as follows. 
See Figure 7-5 on page 7-14 for the location of the RF Voltage 
Amplifier PCB.

a. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful 
not to damage any fused silica tubing leading to the API source.

b. Remove the top cover of the MS detector as follows:

i. Loosen the two fasteners that hold the top cover to the MS 
detector chassis. The fasteners are located in the upper right and 
left corners of the chassis.

ii. Slide the top cover forward by about 1.2 cm (0.5 in.).

iii. With one hand under the center of the top cover, lift the top cover 
up and away from the MS detector.

c. With a Phillips screwdriver, loosen the eight screws that hold the 
metal cover to the RF Voltage Amplifier PCB. Remove the cover.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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d. Locate and replace the defective fuse on the RF Voltage Amplifier 
PCB with a fuse of the same type, voltage, and current rating. Refer to 
Table 7-3.

e. Place the metal cover over the RF Voltage Amplifier PCB. With a 
Phillips screwdriver, tighten the eight screws that secure the cover.

f. Reinstall the top cover of the MS detector as follows:

i. With one hand under the center of the top cover, place the top 
cover over the MS detector such that the front of the cover is 
about 1.2 cm (0.5 in.) in front of the front of the MS detector.

ii. Slide the cover back until it is flush with the front doors (when 
they are closed).

iii. Tighten with a Phillips screwdriver the two fasteners to secure the 
top cover to the chassis.

4. Close the front door of MS detector. Tighten the 1/4-in. Allen screw on 
the right side of the door with an Allen wrench.

5. Place the electronics service switch in the Operational position.

6. Run the LCQ Advantage MAX diagnostics to verify that the system is 
operational.

Figure 7-2. System Control PCB, showing the location of the fuses

Fuses
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7.3 Replacing PCBs and Assemblies 
in the MS Detector

PCBs and assemblies in the MS detector for which replacement procedures 
are presented in this chapter can be categorized as follows:

• Power supplies that are in the electronics tower

• PCBs that are in the embedded computer

• PCBs and assemblies that are accessible from the top of the MS detector

• PCBs and assemblies that are accessible from the right side of the MS 
detector

• PCBs and assemblies that are accessible from the left side of the MS 
detector

Replacing Power Supplies in the Tower

The following power supplies are installed in the tower. See Figure 7-3.

• +36 V, -28 V dc switching power supply

• +5 V, ±15 V, +24 V dc switching power supply

• +48, +24 switching power supply

• ± 210 V linear power supply

CAUTION. With the electronics service switch in the Service position, the 
system is still under vacuum. Power is still supplied to the forepump, +48, 
+24 V dc switching power supply, Turbomolecular Pump Controller, 
turbomolecular pump, turbomolecular pump fan, embedded computer fan, 
tower fan, vent valve, and Vent Delay PCB. Thus, before these components 
can be serviced, the main power circuit breaker switch must be placed in the 
OFF (O) position and the power cord must be unplugged from the power 
outlet.

Caution. Never insert a test probe (for example, an oscilloscope probe) into 
the sockets of female cable connectors on PCBs. This can damage the 
sockets.
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Figure 7-3. Power supplies in the electronics tower 

+36 V, -28 V dc 
Switching Power 
Supply

8 kV Power 
Supply

+5V, ±15 V, ± 24 
V dc Switching 
Power Supply

+5V, + 24 V dc 
Switching Power 
Supply

±210 V dc Linear 
Power Supply
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To replace the +36, -28 V dc switching power supply (P/N 97033-60022), 
+5 V, ±15 V, +24 V dc switching power supply (P/N 97033-60021), +48, +24 
V dc switching power supply (P/N 97133-60060), or the ±210 V dc linear 
power supply (P/N 97033-60024), proceed as follows:

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely in the System Shutdown, Startup, and Reset 
chapter. 

2. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful not to 
damage any fused silica tubing leading to the API source. 

3. If necessary, remove the cover to the +48, +24 V dc switching power 
supply.

4. The power supplies in the tower have bulkhead connectors on the back. 
To remove a power supply, loosen the fastener that holds it to the chassis 
and then carefully tug on the power supply to remove it as a module.

5. Unpack the new power supply. Retain the packing materials so that you 
can pack and ship the defective switching power supply assembly to the 
Thermo Electron San Jose Repair Center. Be sure to note the apparent 
problem or symptoms on the enclosed forms.

6. Slide the new power supply into the space occupied by the old power 
supply. Push carefully on the power supply to seat the connectors in the 
rear.

7. Tighten with a Phillips screwdriver the fastener that holds the power 
supply to the tower.

8. Reinstall the plastic cover to the +48, +24 V dc switching power supply if 
you removed it earlier.

9. Close the front door of the MS detector. Tighten the 1/4-in. Allen screw 
on the right side of the door with an Allen wrench.

10. Restart the system as described in the topic Starting Up the System 
After a Complete Shutdown in the System Shutdown, Startup, and 
Reset chapter.

11. Run the LCQ Advantage MAX diagnostics to verify that the system is 
operational.

CAUTION. Make sure that the LCQ Advantage MAX power cord is 
unplugged before you proceed.
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Replacing PCBs in the Embedded Computer

The Ethernet PCB (P/N 97000-60165), Support PCB (P/N 97033-61020), 
Acquisition DSP PCB (P/N 97000-61260), Control DSP PCB 
(P/N 97000-61270), and Waveform DDS PCB (P/N 97000-61280) reside in 
the embedded computer. The RS 232/485 Converter PCB 
(P/N 97033-61110) plugs into a serial port on the right side of the embedded 
computer. See Figure 7-4. (Refer to Figure 7-5 on page 7-14 for the location 
of the embedded computer)

To replace a PCB in the embedded computer, proceed as follows:

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Advantage MAX system as described in the topic 
Shutting Down the System Completely in the System Shutdown, 
Startup, and Reset chapter).

2. Open the front door of the MS detector.

3. Remove the top cover of the MS detector as follows:

a. Loosen the two fasteners that hold the top cover to the MS detector 
chassis. The fasteners are located in the upper right and left corners of 
the chassis.

b. Slide the top cover forward by about 1.2 cm (0.5 in.).

c. With one hand under the center of the top cover, lift the top cover up 
and away from the MS detector.

4. Disconnect the embedded computer fan cable from the front of the 
embedded computer.

5. Loosen the knurled fastener that holds the front cover to the embedded 
computer. Remove the front cover of the embedded computer.

6. Locate the PCB you want to replace. See Figure 7-4.

7. Disconnect all electrical cables to the PCB that you want to replace.

8. With a Phillips screwdriver, turn the screw on the retainer bracket 
counterclockwise one half turn. Remove the retainer bracket.

9. Unseat the PCB from the mainboard and pull it out of the embedded 
computer.

CAUTION. Make sure that the LCQ Advantage MAX electronic service 
switch is in the Service position (or shut down or shut down the system and 
disconnect the power cord) before you proceed.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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10. Unpack the new PCB. Retain the packing materials so that you can pack 
and ship the defective PCB to the Thermo Electron San Jose Repair 
Center. Be sure to note the apparent problem or symptoms on the 
enclosed forms.

11. Seat the new PCB in the mainboard.

12. Reinstall the retainer bracket that holds the PCBs in place. With a Phillips 
screwdriver, tighten the retainer bracket screw.

13. Reconnect all electrical cables to the PCB that you replaced.

14. Reinstall the front cover of the embedded computer. Tighten with a 
Phillips screwdriver the knurled fastener that holds the front cover to the 
embedded computer.

15. Reattach the fan cable to the front of the embedded computer.

16. Reinstall the top cover of the MS detector as follows:

a. With one hand under the center of the top cover, place the top cover 
over the MS detector such that the front of the cover is about 1.2 cm 
(0.5 in.) in front the front of the MS detector.

Figure 7-4. Embedded computer (with front cover removed)
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b. Slide the cover back until it is flush with the front doors (when they 
are closed).

c. Tighten with a Phillips screwdriver the two fasteners to secure the top 
cover to the chassis.

17. Close the front door of the MS detector. Tighten the 1/4-in. Allen screw 
on the right side of the door with an Allen wrench.

18. Place the electronics service switch in the Operational position.

19. Run the LCQ Advantage MAX diagnostics to verify that the system is 
operational.

Replacing the Vent Delay PCB

The Vent Delay PCB can be accessed from the top of the MS detector. See 
Figure 7-5.

To replace the Vent Delay PCB, proceed as follows: 

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely in the System Shutdown, Startup, and Reset 
chapter.

2. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful not to 
damage any fused silica tubing leading to the API source.

3. Remove the top cover of the MS detector as follows:

a. Loosen the two fasteners that hold the top cover to the MS detector 
chassis. The fasteners are located in the upper right and left corners of 
the chassis.

b. Slide the top cover forward by about 1.2 cm (0.5 in.).

c. With one hand under the center of the top cover, lift the top cover up 
and away from the MS detector.

4. On the Vent Delay PCB, disconnect at J1 the cable to the vent valve.

5. Disconnect at J2 the cable to the power supply.

6. With a Phillips screwdriver, loosen the four screws that secure the Vent 
Delay PCB to the MS detector chassis. Remove the Vent Delay PCB.

CAUTION. The LCQ Advantage MAX system must be shut down and the 
power cord unplugged before you service the Vent Delay PCB. 

CAUTION. Make sure that the LCQ Advantage MAX power cord is 
unplugged before you proceed.
____________________ Finnigan LCQ Series Hardware Manual___________________  7-13������
���������������	�
��



LCQ Advantage MAX Diagnostics and PCB and Assembly Replacement
Replacing PCBs and Assemblies in the MS Detector ___________________________ �������������	
��
�
7. Unpack the new Vent Delay PCB (P/N 97000-61370). Retain the packing 
materials so that you can pack and ship the defective PCB to the Thermo 
Electron San Jose Repair Center. Be sure to note the apparent problem 
or symptoms on the enclosed forms.

8. Replace the battery (P/N 00301-05720) if necessary.

9. Position the new Vent Delay PCB in the space that was occupied by the 
old PCB.

10. With a Phillips screwdriver, tighten the four screws that secure the Vent 
Delay PCB.

11. Reconnect at J1 the cable that goes to the vent valve.

12. Reconnect at J2 the cable that comes from the power supply.

Figure 7-5. PCBs and assemblies that are accessible from the top of the MS detector
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13. Reinstall the top cover of the MS detector as follows:

a. With one hand under the center of the top cover, place the top cover 
over the MS detector such that the front of the cover is about 1.2 cm 
(0.5 in.) in front the front of the MS detector.

b. Slide the cover back until it is flush with the front doors (when they 
are closed).

c. Tighten with a Phillips screwdriver the two fasteners to secure the top 
cover to the chassis.

14. Close the front door of the MS detector. Tighten the 1/4-in. Allen screw 
on the right side of the door with an Allen wrench.

15. Restart the system as described in the topic Starting Up the System 
After a Complete Shutdown in the System Shutdown, Startup, and 
Reset chapter.

16. Run the LCQ Advantage MAX diagnostics to verify that the system is 
operational.

Replacing the Electron Multiplier and 
Conversion Dynode Power Supply, Switched 
Balun PCB, Top Cover PCB, Waveform 
Amplifier PCB, RF Voltage Amplifier PCB, 
8 kV Power Supply, and Battery Backup 

The electron multiplier and conversion dynode power supply, Switched Balun 
PCB, Top Cover PCB, Waveform Amplifier PCB, RF Voltage Amplifier 
PCB, 8 kV power supply, and battery (battery backup) are accessible from the 
top of the MS detector. See Figure 7-5 on page 7-14.

To replace the electron multiplier power supply, conversion dynode power 
supply, Top Cover PCB, Switched Balun PCB, Waveform Amplifier PCB, RF 
Voltage Amplifier PCB, or battery (battery backup), proceed as follows: 

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Advantage MAX system as described in the topic 
Shutting Down the System Completely in the System Shutdown, 
Startup, and Reset chapter).

2. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful not to 
damage any fused silica tubing leading to the API source.

CAUTION. Make sure that the LCQ Advantage MAX electronic service 
switch is in the Service position (or shut down the system and disconnect the 
power cord) before you proceed.
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3. Remove the top cover of the MS detector as follows:

a. Loosen the two fasteners that hold the top cover to the MS detector 
chassis. The fasteners are located in the upper right and left corners of 
the chassis.

b. Slide the top cover forward by about 1.2 cm (0.5 in.).

c. With one hand under the center of the top cover, lift the top cover up 
and away from the MS detector.

d. Choose one of the following:

• To replace the electron multiplier power and conversion dynode 
power supply, go to step 4. 

• To replace the Switched Balun PCB, go to step 5.

• To replace the Top Cover PCB, go to step 6.

• To replace the Waveform Amplifier PCB, go to step 7.

• To replace the RF Voltage Amplifier PCB, go to step 8.

• To replace the 8 kV power supply, go to step 9.

• To replace the battery (battery backup) on the Vent Delay PCB, 
go to step 10.

4. To replace the electron multiplier / conversion dynode power supply, 
proceed as follows. See Figure 7-5 on page 7-14 for the location of the 
electron multiplier and conversion dynode power supply.

a. Disconnect the conversion dynode high voltage cable at the 
conversion dynode feedthrough by pulling it free from the 
feedthrough.

b. Disconnect the electron multiplier high voltage cable at the electron 
multiplier power supply.

c. Disconnect from the front of the electron multiplier and conversion 
dynode power supply the electrical cable that comes from the System 
Control PCB.

d. Loosen by hand or with a Phillips screwdriver the two fasteners that 
hold the electron multiplier and conversion dynode power supply 
module to the MS detector chassis.

e. Carefully lift the electron multiplier and conversion dynode power 
supply module up and away from the MS detector.

f. Unpack the new power supply (P/N 97000-98042). Retain the 
packing materials so that you can pack and ship the defective power 
supply module or PCB to the Thermo Electron San Jose Repair 
Center. Be sure to note the apparent problem or symptoms on the 
enclosed forms.
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g. Install the new electron multiplier and conversion dynode power 
supply module in the space occupied by the old power supply 
module.

h. Tighten with a Phillips screwdriver the two fasteners that hold the 
electron multiplier and conversion dynode power supply module to 
the MS detector chassis.

i. Reconnect to the electron multiplier and conversion dynode power 
supplies the electrical cable that comes from the System Control 
PCB.

j. Reconnect the electron multiplier high voltage cable to the power 
supply.

k. Reconnect the conversion dynode high voltage cable to the 
conversion dynode feedthrough. Go to step 11.

5. To replace the Switched Balun PCB, proceed as follows. See Figure 7-5 
on page 7-14 for the location of the Switched Balun PCB.

a. Disconnect from the Switched Balun PCB (at J1) the endcaps RF / 
octapole RF coaxial cable that comes from the Waveform Amplifier 
PCB.

b. Disconnect from the Switched Balun PCB (at P1) the endcaps dc 
offset cable.

c. With a Phillips screwdriver, remove the screws that hold the Switched 
Balun PCB to the standoffs on the top cover plate of the vacuum 
manifold. Remove the PCB.

d. Unpack the new Switched Balun PCB (P/N 97033-61060). Retain the 
packing materials so that you can pack and ship the defective PCB to 
the Thermo Electron San Jose Repair Center. Be sure to note the 
apparent problem or symptoms on the enclosed forms.

e. Align the new Switched Balun PCB with the standoffs.

f. With a Phillips screwdriver, reinstall the screws that hold the 
Switched Balun PCB to the standoffs on the top cover plate.

g. Reconnect to the Switched Balun PCB (at J1) the endcaps RF / 
octapole RF coaxial cable that comes from the Waveform Amplifier 
PCB. 

h. Reconnect to the Switched Balun PCB (at P1) the endcaps dc offset 
cable. Go to step 11.

6. To replace the Top Cover PCB, proceed as follows. See Figure 7-5 on 
page 7-14 for the location of the Top Cover PCB.

a. Remove the Switched Balun PCB as described in steps 5a through 5c.

b. Disconnect the electron multiplier high voltage coaxial cable that 
comes from the electron multiplier power supply.
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c. Disconnect from the Top Cover PCB (at ACQU/DSP) the 
electrometer cable. (If necessary, use a small screw driver to loosen 
the screws that secure the cable.)

d. Disconnect from the Top Cover PCB (at ANALYZER) the lenses / 
octapole dc offsets cable that comes from the System Control PCB.

e. With a Phillips screwdriver, remove the metal cover from the Top 
Cover PCB.

f. With a Phillips screwdriver, remove the screws that hold the Top 
Cover PCB to the top cover plate of the vacuum manifold.

g. Remove the standoffs
.

h. Unseat and remove the Top Cover PCB from the top cover plate.

i. Unpack the new Top Cover PCB (P/N 97033-62060). Retain the 
packing materials so that you can pack and ship the defective PCB to 
the Thermo Electron San Jose Repair Center. Be sure to note the 
apparent problem or symptoms on the enclosed forms.

j. Carefully align and seat the new Top Cover PCB into the 8-pin and 
4-pin feedthroughs on the top cover plate.

k. With a Phillips screwdriver, reinstall the screws and standoffs that 
hold the Top Cover PCB to the top cover plate.

l. With a Phillips screwdriver, reinstall the metal cover.

m. Reinstall the Switched Balun PCB as described in steps 5e and f.

n. Reinstall the two cables to the Switched Balun PCB (steps 5g and 5h).

o. Reconnect the lenses / octapole dc offsets cable that comes from the 
System Control PCB

p. Reconnect the electron multiplier high voltage coaxial cable that 
comes from the electron multiplier power supply.

q. Reconnect the electrometer cable. Go to step 11.

7. To replace the Waveform Amplifier PCB, proceed as follows. See 
Figure 7-5 on page 7-14 for the location of the Waveform Amplifier PCB.

a. Disconnect all cables to the Waveform Amplifier PCB.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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b. With a Phillips screwdriver, remove the metal cover from the 
Waveform Amplifier PCB.

c. With a Phillips screwdriver, remove the screws that secure the 
Waveform Amplifier PCB to the top of the tower. Remove the 
Waveform Amplifier PCB.

d. Unpack the new Waveform Amplifier PCB (P/N 96000-61110). 
Retain the packing materials so that you can pack and ship the 
defective PCB to the Thermo Electron San Jose Repair Center. Be 
sure to note the apparent problem or symptoms on the enclosed 
forms.

e. Install the new PCB in the place occupied by the old PCB.

f. With a Phillips screwdriver, reinstall the screws that secure the 
Waveform Amplifier PCB to the top of the tower.

g. Reinstall the metal cover to the top of the Waveform Amplifier PCB.

h. Reconnect all cables to the Waveform Amplifier PCB that you 
disconnected in step 7a. Go to step 11.

8. To replace the RF Voltage Amplifier PCB, proceed as follows: 

a. Disconnect all cables that go to the RF Voltage Amplifier PCB.

b. With a Phillips screwdriver, remove the metal cover from the RF 
Voltage Amplifier PCB.

c. With a Phillips screwdriver, remove the screws that secure the RF 
Voltage Amplifier PCB to the top of the tower. Remove the RF 
Voltage Amplifier PCB.

d. Unpack the new RF Voltage Amplifier PCB (P/N 97000-61090). 
Retain the packing materials so that you can pack and ship the 
defective PCB to the Thermo Electron San Jose Repair Center. Be 
sure to note the apparent problem or symptoms on the enclosed 
forms.

e. Install the new PCB in the place occupied by the old PCB.

f. With a Phillips screwdriver, reinstall the screws that secure the RF 
Voltage Amplifier to the top of the tower.

g. Reinstall the metal cover to the top of the RF Voltage Amplifier PCB.

h. Reconnect all cables to the RF Voltage Amplifier PCB that you 
disconnected in step 8a. Go to step 11.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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9. To replace the 8 kV power supply, proceed as follows. See Figure 7-3 on 
page 7-9 for the location of the 8 kV power supply.

a. Disconnect from the 8 kV power supply the thin cable that comes 
from the API panel.

b. Disconnect from the rear of the System Control PCB (at J5), the 
thick cable that goes from the 8 kV power supply to the System 
Control PCB.

c. Loosen by hand (or with a Phillips screwdriver) the two fasteners that 
hold the 8 kV power supply to the tower.

d. Remove the 8 kV power supply.

e. Unpack the new 8 kV power supply (P/N 97000-60142). Retain the 
packing materials so that you can pack and ship the defective 8 kV 
power supply to the Thermo Electron San Jose Repair Center. Be 
sure to note the apparent problem or symptoms on the enclosed 
forms.

f. Reinstall the new 8 kV power supply in the space occupied by the old 
power supply.

g. Tighten by hand the two fasteners that hold the 8 kV power supply to 
the tower (underneath the Vent Control PCB).

h. Reconnect to the rear of the System Control PCB (at J5) the thick 
cable that comes from the 8 kV power supply.

i. Reconnect to the 8 kV power supply the thin cable that comes from 
the API panel. Go to step 11.

10. To replace the battery on the Vent Delay PCB, proceed as follows. See 
Figure 7-5 on page 7-14 for the location of the battery.

a. Remove the battery from the Vent Delay PCB.

b. Reinstall a new battery (P/N 00301-05720) in the place occupied by 
the old battery.

11. Reinstall the top cover of the MS detector as follows:

a. With one hand under the center of the top cover, place the top cover 
over the MS detector such that the front of the cover is about 1.25 cm 
(0.5 in.) in front the front of the MS detector.

b. Slide the cover back until it is flush with the front doors (when they 
are closed).

c. Tighten with a Phillips screwdriver the two fasteners to secure the top 
cover to the chassis.

12. Close the front door of the MS detector. Tighten the 1/4-in. Allen screw 
on the right side of the door with an Allen wrench.

13. Place the electronics service switch in the Operational position.
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14. Run the LCQ Advantage MAX diagnostics to verify that the system is 
operational.

Replacing the System Control PCB

To replace the System Control PCB, proceed as follows. See Figure 7-2 on 
page 7-7 for the location of the System Control PCB. 

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Advantage MAX system as described in the topic 
Shutting Down the System Completely in the System Shutdown, 
Startup, and Reset chapter).

2. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful not to 
damage any fused silica tubing leading to the API source.

3. Remove the top cover of the MS detector as follows:

a. Loosen the two fasteners that hold the top cover to the MS detector 
chassis. The fasteners are located in the upper right and left corners of 
the chassis.

b. Slide the top cover forward by about 1.2 cm (0.5 in.).

c. With one hand under the center of the top cover, lift the top cover up 
and away from the MS detector.

4. Remove the right side cover of the MS detector as follows:

a. Loosen the screw that secures the right side cover to the chassis of the 
MS detector.

b. Slide the side cover forward, and then lift it out and away from the 
MS detector.

CAUTION. Make sure that the LCQ Advantage MAX electronic service 
switch is in the Service position (or shut down or shut down the system and 
disconnect the power cord) before you proceed.
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5. Disconnect all cables to the System Control PCB. The following cables 
are connected to the System Control PCB: 

• LC I/O (P4)

• RF control (P8)

• RF and waveform amplifiers (P12)

• Linear power supply (P1)

• Spray shield (J6)

• Analyzer (J3)

• Ion gauge / Convectron gauge (P9)

• Switching power supplies (J2)

• Electron multiplier / conversion dynode power supplies (P3)

• APCI heater (J4)

• High speed serial (P6, backside)

• 8 kV power supply (J5, backside)

6. With a Phillips screwdriver, loosen the seven fasteners that hold the 
System Control PCB to the MS detector chassis.

7. Carefully lift the System Control PCB out and away from the MS 
detector.

8. Unpack the new System Control PCB (P/N 97033-61016). Retain the 
packing materials so that you can pack and ship the defective PCB to the 
Thermo Electron San Jose Repair Center. Be sure to note the apparent 
problem or symptoms on the enclosed forms.

9. Use the guide hole at the top center of the PCB and the guide post on the 
MS detector chassis to position the new System Control PCB in the space 
occupied by the old PCB. 

10. With a Phillips screwdriver, tighten the seven fasteners that hold the 
System Control PCB to the MS detector chassis.

11. Reconnect all cables to the System Control PCB. The following cables 
are connected to the System Control PCB: 

• LC I/O (P4)

• RF control (P8)

• RF and waveform amplifiers (P12)

• Linear power supply (P1)

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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• Spray shield (J6)

• Analyzer (J3)

• Ion gauge / Convectron gauge (P9)

• Switching power supplies (J2)

• Electron multiplier / conversion dynode power supplies (P3)

• APCI heater (J4)

• High speed serial line (P6, backside)

• 8 kV power supply (J5, backside)

12. Reinstall the right side cover of the MS detector as follows:

a. Slide the side cover back through the guide slots.

b. Tighten the screw that secures the side cover to the chassis of the MS 
detector. 

13. Reinstall the top cover of the MS detector as follows:

a. With one hand under the center of the top cover, place the top cover 
over the MS detector such that the front of the cover is about 1.25 cm 
(0.5 in.) in front the front of the MS detector.

b. Slide the cover back until it is flush with the front doors (when they 
are closed).

c. Tighten with a Phillips screwdriver the two fasteners to secure the top 
cover to the chassis.

14. Close the front door of MS detector. Tighten the 1/4-in. Allen screw on 
the right side of the door with an Allen wrench.

15. Place the electronics service switch in the Operational position.

16. Run the LCQ Advantage MAX diagnostics to verify that the system is 
operational.

Replacing the RF Voltage Control PCB and 
the Low Pass Filter PCB

To replace the RF Voltage Control PCB (and its housing) and the Low Pass 
Filter PCB, proceed as follows. See Figure 7-6 for the location of the RF 
Voltage Control PCB and the Low Pass Filter PCB.

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Advantage MAX system as described in the topic 
Shutting Down the System Completely in the System Shutdown, 
Startup, and Reset chapter).
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2. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful not to 
damage any fused silica tubing leading to the API source.

3. Remove the left side cover of the MS detector as follows:

a. Loosen the screw that secures the left side cover to the chassis of the 
MS detector.

b. Slide the side cover forward, and then lift it out and away from the 
MS detector.

CAUTION. Make sure that the LCQ Advantage MAX electronics service 
switch is in the Service position (or shut down the system and disconnect the 
power cord) before you proceed.

Figure 7-6. Left side of the MS detector, showing the Low Pass Filter 
PCB and the RF Voltage Control PCB 

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.

Low Pass
Filter PCB

RF Voltage
Control PCB
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• To replace the RF Voltage Amplifier PCB, go to step 4.

• To replace the Low Pass Filter PCB, go to step 5.

4. To replace the RF Voltage Amplifier PCB, proceed as follows:

a. With a Phillips screwdriver, remove the nine screws that secure the 
front cover of the RF Voltage Control PCB. Remove the front cover 
to expose the RF Voltage Control PCB.

b. Disconnect the cable that comes from the RF Voltage Amplifier PCB.

c. Disconnect the cable that comes from the System Control PCB.

d. With a Phillips screwdriver, remove the 21 screws that hold the RF 
Voltage Control PCB housing to the vacuum manifold. Remove the 
RF Voltage Control PCB and its housing as a unit. Reinstall the cover 
plate on the housing.

e. Unpack the new RF Voltage Control PCB and housing 
(P/N 96000-61100). Retain the packing materials so that you can 
pack and ship the defective PCB and housing to the Thermo Finnigan 
Repair Center in San Jose. Be sure to note the apparent problem or 
symptoms on the enclosed forms.

f. Position the new RF Voltage Control PCB and its housing against the 
vacuum manifold where the old assembly was located. With a Phillips 
screwdriver, reinstall the 21 screws that hold the RF Voltage Control 
PCB housing to the vacuum manifold.

g. With a Phillips screwdriver, remove the nine screws that hold the 
front cover of the RF Voltage Control PCB housing to the RF Voltage 
Control PCB housing. Remove the front cover to expose the RF 
Voltage Control PCB.

h. Reconnect the cable that comes from the System Control PCB.

i. Reconnect the cable that comes from the RF Voltage Amplifier PCB.

j. Position the front cover over the RF Voltage Control PCB. With a 
Phillips screwdriver, reinstall the screws that hold the front cover to 
the RF Voltage Control PCB housing. Go to step 6.

5. To replace the Low Pass Filter PCB, proceed as follows:

a. Disconnect the two coaxial cables from the BNC connectors on the 
Low Pass Filter PCB.

b. With a Phillips screwdriver, remove the 4 screws that hold the metal 
cover to With a Phillips screwdriver, remove the screws that hold the 
Low Pass Filter PCB to the MS detector chassis. Remove the Low 
Pass Filter PCB.

c. Unpack the new PCB (P/N 97000-61380). Retain the packing 
materials so that you can pack and ship the defective PCB to the 
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Thermo Electron San Jose Repair Center. Be sure to note the apparent 
problem or symptoms on the enclosed forms.

d. Position the new Low Pass Filter PCB in the place that was occupied 
by the old PCB. With a Phillips screwdriver, reinstall the screws that 
hold the Low Pass Filter PCB to the MS detector chassis.

e. Position the metal cover over the Low Pass Filter PCB. With a 
Phillips screwdriver, reinstall the 4 screws that hold the metal cover to 
the Low Pass Filter PCB.

f. Reconnect the two coaxial cables to the BNC connectors that are 
located on the rear of the Low Pass Filter PCB.

6. Reinstall the left side cover of the MS detector as follows:

a. Open the front door completely (180°).

b. Align the cover with the top and bottom guide slots on the left side of 
the LCQ Advantage MAX.

c. Slide the side cover back through the guide slots.

d. Tighten the screw that secures the side cover to the chassis of the MS 
detector. 

7. Close the front door of MS detector. Tighten the 1/4-in. Allen screw on 
the right side of the door with an Allen wrench.

8. Place the electronics service switch in the Operational position.

9. Run the LCQ Advantage MAX diagnostics to verify that the system is 
operational.
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Chapter 8
LCQ Deca XP MAX Diagnostics and PCB

and Assembly Replacement

Many of the MS detector components can be tested by the LCQ Deca XP 
MAX diagnostics. Thermo Electron’s service philosophy for the LCQ Deca 
XP MAX system calls for troubleshooting to the lowest part, assembly, PCB, 
or module listed in the Replaceable Parts chapter. You should replace LCQ 
Deca XP MAX components when indicated by the LCQ Deca XP MAX 
diagnostics, by Thermo Electron San Jose Technical Support, or by a Thermo 
Electron San Jose Customer Support Engineer.

This chapter contains the following sections:

• Running the LCQ Deca XP MAX Diagnostics

• Replacing a Fuse

• Replacing PCBs and Assemblies in the MS Detector
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8.1 Running the LCQ Deca XP MAX 
Diagnostics 

The LCQ Deca XP MAX diagnostics system is used to test the major 
electronic circuits within the instrument and indicate whether the circuits pass 
or fail the tests. If there is a problem with the instrument electronics, the LCQ 
Deca XP MAX diagnostics can often locate the problem. You can then often 
correct the problem yourself by replacing a faulty PCB or assembly.

The LCQ Deca XP MAX diagnostics does not diagnose problems that are not 
electrical in nature. For example, it does not diagnose poor sensitivity due to 
misaligned or dirty components or to improper tuning. Therefore, it is 
important to have someone who is familiar with system operation and basic 
hardware theory run the diagnostics and use it to assist in isolating any 
problems.

Before running the diagnostics, you should consider the following:

• Did the system fail when you were running samples?

• Did problems occur after you performed maintenance on the instrument, 
data system, or peripherals?

• Did you change the system’s configuration, cables, or peripherals just 
before the problem occurred?

If the answer is yes to the first item above, there is the possibility of a 
hardware failure, and running the diagnostics is appropriate.

If the answer is yes to one of the last two items above, the problem is probably 
mechanical, not electrical. Reverify that alignment, configurations, and cable 
connections are correct before you run the LCQ Deca XP MAX diagnostics.

To run the LCQ Deca XP MAX diagnostics, proceed as follows:

1. Tune the ring electrode and octapole RF voltages as described in the topic 
Tuning the Ring Electrode and Octapole RF Voltages on page 5-34 in 
the LCQ Deca XP MAX MS Detector Maintenance chapter.

2. In the Tune Plus window, choose Diagnostics > Diagnostics. (To 
open Tune Plus, choose Start > Programs > Xcalibur > LCQ Tune.) 
The Diagnostics dialog box appears. See Figure 8-1.

3. Select one of the following options (refer to Table 8-1):

• To test all of the electronic subsystems (that is, the vacuum system, 
power supplies, lenses, ion detection system, and RF voltage 
electronics), click on the All tab and select the Everything option.

• To test an individual subsystem, click on the tab corresponding to that 
subsystem and select the appropriate options. Refer to Table 8-2 for 
more information on these options.
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4. Select how many times you want to run the tests, and whether or not you 
want to print reports or to stop on a failure.

5. Click on the Start button to start the diagnostics.

LCQ Deca XP MAX starts testing and displays a chronological log of all 
diagnostic tests in the Testing text box. Once testing for a specific subsystem 
is completed, LCQ Deca XP MAX displays either Pass or Fail in the Results 
group box. If the LCQ Deca XP MAX diagnostics indicates a problem, 
perform the maintenance procedure indicated by the LCQ Deca XP MAX 
diagnostics, by Thermo Electron San Jose Technical Support, or by a Thermo 
Electron San Jose Customer Support Engineer. For more information on the 
LCQ Deca XP MAX diagnostics, refer to the LCQ Deca XP MAX online 
Help.

Figure 8-1. Diagnostics dialog box
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Table 8-1. Diagnostic tests in Tune Plus

If you Select Diagnostics will 

Everything test Status, RF, Lenses, Ion Detection, and API source (5 
minutes to complete)

Status check all device static values, refer to Table 8-2

RF test five RF devices, refer to Table 8-2

Lenses test four LENSES devices, refer to Table 8-2

Ion Detection test three ION DETECTION devices, refer to Table 8-2

API source test three API source devices, refer to Table 8-2

Table 8-2. Diagnostic items tested in Tune Plus

Item Tested in 
What to Test 
Group Box 

Scanning Device Number in Graph 
View

Scanning Device Name 

Status n/a Refer to Table A-1 in the Appendix for 
static details

RF-1 03 (readback number 06) Aux amplitude (V) 0 to 83.2 

RF-2 10 Main RF DAC (16-bit) 0 to 65535

RF-3 11 (readback number 50) Vernier det. RF amp (V) 0 to 65535 

RF-4 11 (readback number 51) Vernier RF DAC (16-bit) 0 to 65535

RF-5 25 (readback number 52) Octapole RF DAC (V) 0 to 1000 

Lenses-1 30 Octapole 1 offset (V) -132 to 132

Lenses-2 01 Octapole 2 offset (V) -132 to 132

Lenses-3 07 Octapole lens (V) -136 to 136

Lenses-4 25 Octapole det. RF amp. (V) 0 to 1000

Ion Detection-1 04 Trap Offset (V) -132 to 132

Ion Detection-2 17 Tube gate (V) -200 to 198

Ion Detection-3 05 (readback number 41) Multiplier (V) 0 to -2200

API-1 20 Auxiliary gas flow (arb) 0 to 60

API-2 19 Sheath gas flow (arb) 20 to 100

API-3 23 Ion Transfer Capillary Voltage (V) -132 to 
132
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8.2 Replacing a Fuse
Fuses protect the various circuits by opening the circuits whenever 
overcurrent occurs. On the MS detector, most of the fuses are located on the 
System Control PCB. Several fuses, however, are located on the RF Voltage 
Amplifier PCB, Analyzer Auxiliary PCB, and Power Module. The function 
and current rating of the various fuses are listed in Table 8-3.

Check fuses when power is lost to a fused subsystem.

CAUTION. Always place the electronics service switch in the Service 
position (or shut down the system and disconnect the power cord) before 
you replace fuses on the System Control PCB or RF Voltage Amplifier PCB.

Table 8-3. MS Detector Fuses

Location Fuse Circuit Description P/N

System 
Control PCB

F1 Multipoles and tube lens power supplies, 
ion gauge grid

0.25 A, time lag, 5 
x 20 mm, 250 V

00006-01700

System 
Control PCB

F2 Multipoles and tube lens power supplies 0.25 A, time lag, 5 
x 20 mm, 250 V

00006-01700

System 
Control PCB

F3 Ion transfer capillary, multipoles, and 
mass analyzer DC offsets

0.16 A, time lag, 5 
x 20 mm, 250 V

00006-01700

System 
Control PCB

F4 Ion transfer capillary, multipoles, and 
mass analyzer DC offsets

0.16 A, time lag, 5 
x 20 mm, 250 V

00006-01700

System 
Control PCB

F5 Ion gauge filament 3.15 A, time lag, 5 
x 20 mm, 250 V

00006-10510

System 
Control PCB

F6 Ion transfer capillary heater 3.15 A, time lag, 5 
x 20 mm, 250 V

00006-10510

System 
Control PCB

F7 Conversion dynode power supply 0.25 A, time lag, 5 
x 20 mm, 250 V

00006-11204

System 
Control PCB

F8 RF detector power supply 0.4 A, time lag, 5 
x 20 mm, 250 V

00006-05080

System 
Control PCB

F9 RF detector power supply 0.4 A, time lag, 5 
x 20 mm, 250 V

00006-05080

System 
Control PCB

F10 
F11

APCI vaporizer heater 2.5 A, time lag, 5 
x 20 mm, 250 V

00006-10510

RF Voltage 
Amplifier 
PCB

F1 +36 V 1.0 A, quick act, 5 
x 20 mm, 250 V

00006-07610 

RF Voltage 
Amplifier 
PCB

F2 -28 V 0.5 A, quick act, 5 
x 20 mm, 250 V

00006-07608 
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To replace a fuse on the System Control PCB, RF Voltage Amplifier PCB, or 
Analyzer Auxiliary PCB, proceed as follows:

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Deca XP MAX system as described in the topic 
Shutting Down the System Completely on page 6-5 in the System 
Shutdown, Startup, and Reset chapter).

2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22.

• To replace a fuse on the System Control PCB, go to step 3.

• To replace a fuse on the RF Voltage Amplifier PCB, go to step 4.

• To replace a fuse on the Analyzer Auxiliary PCB, go to step 5.

3. To replace a fuse on the System Control PCB, proceed as follows. See 
Figure 8-2 for the location of the System Control PCB and its fuses.

a. Remove the right side cover of the MS detector, as follows:

i. Loosen the fastener that secures the right side cover to the chassis 
of the MS detector.

ii. Slide the side cover back about 1.25 cm (0.5 in.), and then pull it 
out and away from the MS detector.

Analyzer 
Auxiliary 
PCB

F1 -28 V 1.6 A, quick act, 5 
x 20 mm, 250 V

00006-08610 

Analyzer 
Auxiliary 
PCB

F2 +36 V 1.6 A, quick act, 5 
x 20 mm, 250 V

00006-08610 

Power 
Module

F1 Voltage select switch 3.5 A, time lag, 5 
x 20 mm, 250 V

00006-10510 

Table 8-3. MS Detector Fuses, continued

Location Fuse Circuit Description P/N

Caution. Use only the fuses specified in Table 8-3. Never replace a fuse 
with a fuse of a different type, voltage, or current rating.

Note. To replace the fuse in the Power Module you need to remove the 
tower, System Control PCB, and embedded computer. Do not replace the 
fuse in the Power Module unless you are qualified to do so

CAUTION. Make sure that the LCQ Deca XP MAX electronic service 
switch is in the Service position (or shut down the system and disconnect the 
power cord) before you proceed.
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b. Remove the right side cover of the MS detector as follows:

i. Loosen the screw that secures the right side cover to the chassis 
of the MS detector.

ii. Slide the side cover forward, and then lift it out and away from 
the MS detector.

c. Remove the System Control PCB protective cover, as follows:

i. With a Phillips screwdriver, loosen the five screws that hold the 
protective cover to the MS detector chassis.

ii. Pull the cover up and out of the guide slots on the MS detector 
chassis.

d. Locate and replace the defective fuse on the System Control PCB 
with a fuse of the same type, voltage, and current rating. Refer to 
Table 8-3.

e. Reinstall the protective cover over the System Control PCB.

f. Reinstall the right side cover of the MS detector as follows:

i. Slide the side cover back through the guide slots.

ii. With a Phillips screwdriver, tighten the five screws that hold the 
protective cover to the MS detector chassis. Go to step 6.

4. To replace a fuse on the RF Voltage Amplifier PCB, proceed as 
follows. See Figure 8-5 on page 8-18 for the location of the RF Voltage 
Amplifier PCB.

a. Open the front door of the MS detector by loosening the 1/4-in. Allen 
screw on the right side of the door with an Allen wrench. Be careful 
not to damage any fused silica tubing leading to the API source.

b. Remove the top cover of the MS detector as follows:

i. Loosen the two fasteners that hold the top cover to the MS 
detector chassis. The fasteners are located in the upper right and 
left corners of the chassis.

ii. Slide the top cover forward by about 1.2 cm (0.5 in.).

iii. With one hand under the center of the top cover, lift the top cover 
up and away from the MS detector.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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c. With a Phillips screwdriver, loosen the eight screws that hold the 
metal cover to the RF Voltage Amplifier PCB. Remove the cover.

d. Locate and replace the defective fuse on the RF Voltage Amplifier 
PCB with a fuse of the same type, voltage, and current rating. Refer to 
Table 8-3.

e. Place the metal cover over the RF Voltage Amplifier PCB. With a 
Phillips screwdriver, tighten the eight screws that secure the cover.

5. To replace a fuse on the Analyzer Auxiliary PCB, proceed as follows. See 
Figure 8-5 on page 8-18 for the location of the Analyzer Auxiliary PCB.

a. Disconnect the seven cables that connect to the top of the Analyzer 
Auxiliary PCB. (Three coaxial cables come from the Analyzer PCB, 
one coaxial cable comes from the Waveform DDS PCB in the 
embedded computer, one coaxial cable comes from the Waveform 
Amplifier PCB, one 7-lead cable comes from the System Control 
PCB, and one 4-lead cable comes from the 36 V power supply.)

Figure 8-2. System Control PCB, showing the location of the fuses

Fuses
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b. With a Phillips screwdriver, loosen the six screws that hold the metal 
cover to the Analyzer Auxiliary PCB. Remove the protective cover to 
expose the Analyzer Auxiliary PCB.

c. Locate and replace the defective fuse on the Analyzer Auxiliary PCB 
with a fuse of the same type, voltage, and current rating. Refer to 
Table 8-3.

d. Reinstall the protective cover on the Analyzer Auxiliary PCB. With a 
Phillips screwdriver, tighten the six screws that hold the metal cover 
to the Analyzer Auxiliary PCB.

e. Reconnect the seven cables that connect to the top of the Analyzer 
Auxiliary PCB. (Three coaxial cables come from the Analyzer PCB, 
one coaxial cable comes from the Waveform DDS PCB in the 
embedded computer, one coaxial cable comes from the Waveform 
Amplifier PCB, one 7-lead cable comes from the System Control 
PCB, and one 4-lead cable comes from the 36 V power supply.)

6. Reinstall the top cover of the MS detector as follows:

a. With one hand under the center of the top cover, place the top cover 
over the MS detector such that the front of the cover is about 1.2 cm 
(0.5 in.) in front of the front of the MS detector.

b. Slide the cover back until it is flush with the front doors (when they 
are closed).

c. Tighten with a Phillips screwdriver the two fasteners to secure the top 
cover to the chassis.

7. Close the front door of MS detector. Tighten the 1/4-in. Allen screw on 
the right side of the door with an Allen wrench.

8. Place the electronics service switch in the Operational position.

9. Run the LCQ Deca XP MAX diagnostics to verify that the system is 
operational.
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8.3 Replacing PCBs and Assemblies 
in the MS Detector

This section presents the following replacement procedures for PCBs and 
assemblies:

• Replacing PCBs and assemblies in the tower

• Replacing PCBs in the embedded computer

• Replacing the Vent Delay PCB and backup battery, ion gauge, and vent 
valve

• Replacing the electron multiplier and Conversion Dynode Power 
Supplies, Analyzer PCB, Analyzer Auxiliary PCB, Waveform Amplifier 
PCB, RF Voltage Amplifier PCB

• Replacing the System Control PCB

• Replacing the RF Voltage Control

• Replacing the Low Pass Filter PCB

Replacing Power Supplies in the Tower

The following power supplies are installed in the tower. See Figure 8-3.

• +5 V, 15 V, +24 V dc and +36 V, -28 V dc switching power supplies

• Turbomolecular Pump Controller/ +48V, +24V, switching power supply

• 8 kV power supply

• Toroidal Transformer Power Module

CAUTION. With the electronics service switch in the Service position, the 
system is still under vacuum. Power is still supplied to the forepump, +48, 
+24 V dc switching power supply, Turbomolecular Pump Controller, 
turbomolecular pump, turbomolecular pump fan, embedded computer fan, 
tower fan, vent valve, and Vent Delay PCB. Thus, before these components 
can be serviced, the main power circuit breaker switch must be placed in the 
OFF (O) position and the power cord must be unplugged from the power 
outlet.

Caution. Never insert a test probe (for example, an oscilloscope probe) into 
the sockets of female cable connectors on PCBs. This can damage the 
sockets.

Note. To service the Power Module you need to remove the tower, System 
Control PCB, and embedded computer. Do not service the Power Module 
unless you are qualified to do so.
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Figure 8-3. Power supplies in the electronics tower 

+36 V, -28 V dc Switching 
Power Supply

8 kV Power 
Supply

+5V, ±15 V, ± 24 V dc 
Switching Power Supply

+48 V Power Supply

±205 V dc Toroidal 
Transformer 
Power Supply

Turbomolecular Pump 
Controller
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To replace a PCB or power supply in the tower, proceed as follows:

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely on page 6-5 in the System Shutdown, Startup, 
and Reset chapter. 

2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22. 

3. Reposition the embedded computer (to expose the tower), as follows:

a. Disconnect the cables that connect to the top of the embedded 
computer.

b. Loosen the six fasteners that secure the embedded computer to the 
vacuum manifold, base plate, and chassis. 

c. Lift up the embedded computer a sufficient distance to access the two 
cables that connect to the bottom of the embedded computer. 
Disconnect the two cables that connect to the bottom of the embedded 
computer.

d. Lift the embedded computer and reposition it such that the two hooks 
in the back of the embedded computer box insert into the two slots in 
the MS detector chassis. See Figure 8-4 on page 8-16 for the location 
of the slots.

e. Choose one of the following:

• To replace the switching power supply assembly (which includes 
the +5 V, 15 V, +24 V dc and +36 V, -28 V dc switching power 
supplies), go to step 4.

• To replace the Turbomolecular Pump Controller, go to step 5.

• To replace the 8 kV power supply, go to step 6.

4. To replace the switching power supply assembly (which includes the +5 
V, 15 V, +24 V dc and +36 V, -28 V dc switching power supplies), 
proceed as follows:

a. Disconnect the cable to the RF Voltage Amplifier PCB from the 
connector on the RF Voltage Amplifier PCB. (See Figure 8-5 on page 
8-18 for the location of the RF Voltage Amplifier PCB, Analyzer 
Auxiliary PCB, and Waveform Amplifier PCB.)

b. Disconnect the two cables to the Analyzer Auxiliary PCB from the 
two connectors on the Analyzer Auxiliary PCB.

c. Disconnect the cable to the Waveform Amplifier PCB from the 
connector on the Waveform Amplifier PCB.

d. Disconnect the cable that is connected to the fan cable.

CAUTION. Make sure that the LCQ Deca XP MAX power cord is 
unplugged before you proceed.
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e. Disconnect the two cables to the Power Module from the two (upper) 
connectors on the Power Module.

f. Disconnect the cable that is connected to the reset button cable.

g. Loosen by hand (or with a Phillips screwdriver) the fastener that 
holds the switching power supply assembly to the tower.

h. Remove the switching power supply assembly from the tower.

i. Unpack the new switching power supply assembly 
(P/N 97000-60151). Retain the packing materials so that you can 
pack and ship the defective switching power supply assembly to the 
Thermo Electron San Jose Repair Center. Be sure to note the apparent 
problem or symptoms on the enclosed forms.

j. Install the new switching power supply assembly in the space 
occupied by the old assembly.

k. Tighten by hand the fastener that holds the switching power supply 
assembly to the tower.

l. Reconnect the cable that is connected to the reset button cable.

m. Reconnect the two cables to the Power Module to the two (upper) 
connectors on the Power Module.

n. Reconnect the cable that is connected to the fan cable.

o. Reconnect the cable to the Waveform Amplifier PCB to the connector 
on the Waveform Amplifier PCB.

p. Reconnect the two cables to the Analyzer Auxiliary PCB to the two 
connectors on the Analyzer Auxiliary PCB.

q. Reconnect the cable to the RF Voltage Amplifier PCB to the 
connector on the RF Voltage Amplifier PCB. Go to step 7.

5. To replace the Turbomolecular Pump Controller, or the +48V, +24V 
switching power supply, proceed as follows:

a. Disconnect from the Turbomolecular Pump Controller the thick cable 
to the turbomolecular pump.

b. Disconnect from the Turbomolecular Pump Controller the thin cable 
that comes from the Power Module.

c. Disconnect the four pin connector from the Turbomolecular Pump 
Controller Sled.

d. Loosen by hand (or with a Phillips screwdriver) the fastener that 
holds the Turbomolecular Pump Controller Sled to the tower.

e. Remove the Turbomolecular Pump Controller Sled from the tower.

f. Unpack the new Turbomolecular Pump Controller 
(P/N 00108-10012). Retain the packing materials so that you can 
pack and ship the defective Turbomolecular Pump Controller to the 
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Thermo Electron San Jose Repair Center. Be sure to note the apparent 
problem or symptoms on the enclosed forms.

g. Install the new Turbomolecular Pump Controller in the space 
occupied by the old controller.

h. Unpack the new +48V, +24V switching power supply 
(P/N 00012-24208).

i. Install the +48V, +24V switching power supply. Reconnect the three 
cables which were disconnected during removal. 

j. Tighten by hand the fastener that holds the Turbomolecular Pump 
Controller to the tower. Reconnect the four pin connector to the 
Turbomolecular Pump Controller Sled.

k. Reconnect to the Turbomolecular Pump Controller the thin cable that 
comes from the Power Module.

l. Reconnect to the Turbomolecular Pump Controller the thick cable 
that goes to the turbomolecular pump. Go to step 7.

6. To replace the 8 kV power supply, proceed as follows:

a. Disconnect from the 8 kV power supply the cable that comes from the 
API panel.

b. Disconnect from the rear of the System Control PCB (at J5), the thick 
cable that goes to the System Control PCB.

c. Loosen by hand (or with a Phillips screwdriver) the fastener that 
holds the 8 kV power supply to the tower.

d. Remove the 8 kV power supply from the tower.

e. Unpack the new 8 kV power supply (P/N 97000-60142). Retain the 
packing materials so that you can pack and ship the defective 8 kV 
power supply to the Thermo Electron San Jose Repair Center. Be sure 
to note the apparent problem or symptoms on the enclosed forms.

f. Reinstall the new 8 kV power supply in the space occupied by the old 
power supply.

g. Tighten by hand the fastener that holds the 8 kV power supply to the 
tower.

h. Reconnect to the rear of the System Control PCB (at J5), the thick 
cable that comes from the 8 kV power supply.

i. Reconnect to the 8 kV power supply the thin cable that comes from 
the API panel. Go to step 7.

7. Return the embedded computer to its original position as follows:

a. Lift the embedded computer up and away from the MS detector 
chassis. Lift up the embedded computer a sufficient distance to access 
the bottom of the embedded computer.
������
���������������	�
��8-14 ___________________ Finnigan LCQ Series Hardware Manual ____________________



LCQ Deca XP MAX Diagnostics and PCB and Assembly Replacement

�������������	
��
�____________________________Replacing PCBs and Assemblies in the MS Detector
b. Reconnect to the bottom of the embedded computer the cable that 
comes from the switching power supplies.

c. Reconnect the fan power cable to the embedded computer fan. Make 
sure that the plug on the end of the cable contours the fan (that is, the 
concave side of the plug is against the fan).

d. Reposition the embedded computer in its original position in front of 
the tower.

e. Tighten the six fasteners that secure the embedded computer to the 
vacuum manifold, base plate, and chassis. 

f. Reconnect the cables that connect to the top of the embedded 
computer. See Figure 8-4 on page 8-16 and Figure 8-5 on page 8-18.

8. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 5-34.

9. Close the front doors of the MS detector.

10. Restart the system as described in the topic Starting Up the System 
After a Complete Shutdown on page 6-7 in the System Shutdown, 
Startup, and Reset chapter.

11. Run the Tune Plus diagnostics to verify that the system is operational.

Replacing PCBs in the Embedded Computer

The Ethernet PCB (P/N 97033-60280), Acquisition DSP PCB 
(P/N 97000-61260), Control DSP PCB (P/N 97000-61270), Waveform DDS 
PCB (P/N 97000-61430), and CPU PCB (P/N 97144-60260) reside in the 
embedded computer. See Figure 8-4. (See Figure 8-5 on page 8-18 for the 
location of the embedded computer.)

To replace a PCB in the embedded computer, proceed as follows:

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Deca XP MAX system as described in the topic 
Shutting Down the System Completely on page 6-5 in the System 
Shutdown, Startup, and Reset chapter).

2. Open the front doors of the MS detector.

3. With a Phillips screwdriver, loosen the two fasteners that hold the front 
cover to the embedded computer. Remove the front cover of the 
embedded computer.

4. Locate the PCB you want to replace. See Figure 8-4.

CAUTION. Make sure that the LCQ Deca XP MAX electronic service 
switch is in the Service position (or shut down or shut down the system and 
disconnect the power cord) before you proceed.
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5. Disconnect all electrical cables to the PCB that you want to replace.

6. With a Phillips screwdriver, remove the screw that holds the PCB to the 
card cage.

Figure 8-4. Embedded computer (with front cover removed)

Ethernet PCB

CPU PCB

Acquisition 
DSP PCB

Control DSP 
PCB

Waveform 
DDS PCB

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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7. Unseat the PCB from the mainboard and pull it out of the embedded 
computer.

8. Unpack the new PCB. Retain the packing materials so that you can pack 
and ship the defective PCB to the Thermo Electron San Jose Repair 
Center. Be sure to note the apparent problem or symptoms on the 
enclosed forms.

9. Seat the new PCB in the mainboard.

10. Reinstall the retainer bracket that holds the PCBs in place. With a Phillips 
screwdriver, tighten the retainer bracket screw.

11. Reconnect all electrical cables to the PCB that you replaced.

12. Reinstall the front cover of the embedded computer. Tighten the knurled 
fastener that holds the front cover to the embedded computer.

13. Close the front doorS of the MS detector. 

14. Place the electronics service switch in the Operational position.

15. Run the LCQ Deca XP MAX diagnostics to verify that the system is 
operational.

Replacing the Vent Delay PCB and Backup 
Battery, Ion Gauge, and Vent Valve

The Vent Delay PCB, backup battery, ion gauge, and vent valve all can be 
accessed from the top of the MS detector. See Figure 8-5.

To replace the Vent Delay PCB, proceed as follows: 

1. Shut down and vent the system as described in the topic Shutting Down 
the System Completely on page 6-5 in the System Shutdown, Startup, 
and Reset chapter.

CAUTION. The LCQ Deca XP system must be shut down and the power 
cord unplugged before you service the vent valve, Vent Delay PCB, 
Convectron gauge, or ion gauge. 

CAUTION. Make sure that the LCQ Deca XP MAX power cord is 
unplugged before you proceed.
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2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22.

• To replace the Vent Delay PCB and backup battery, go to step 3.

• To replace the vent valve, go to step 4.

• To replace the ion gauge, go to step 5.

3. To replace the Vent Delay PCB, proceed as follows:

a. Disconnect at J1 the cable to the vent valve.

b. Disconnect at J2 the cable to the Power Module.

c. With a Phillips screwdriver, loosen the four screws that secure the 
Vent Delay PCB to the MS detector chassis. Remove the Vent Delay 
PCB.

Figure 8-5. PCBs and assemblies that are accessible from the top of the MS detector
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d. Unpack the new Vent Delay PCB (P/N 97000-61370). Retain the 
packing materials so that you can pack and ship the defective PCB to 
the Thermo Electron San Jose Repair Center. Be sure to note the 
apparent problem or symptoms on the enclosed forms.

e. Replace the battery (P/N 00301-05720) if necessary. To replace the 
battery on the Vent Delay PCB, proceed as follows. See Figure 8-5 on 
page 8-18 for the location of the battery. Remove the battery from the 
Vent Delay PCB. Reinstall a new battery (P/N 00301-05720).

f. Position the new Vent Delay PCB in the space that was occupied by 
the old PCB.

g. With a Phillips screwdriver, tighten the four screws that secure the 
Vent Delay PCB.

h. Reconnect at J1 the cable that goes to the vent valve.

i. Reconnect at J2 the cable that comes from the Power Module. Go to 
step 6.

4. To replace the vent valve, proceed as follows:

a. Disconnect the cable that comes from the Vent Delay PCB.

b. With a 7/16-in. open-end wrench, loosen the fitting to the vent valve 
solenoid. Remove the vent valve.

c. Replace the old vent valve with a new one (P/N 97000-60128).

d. With a 7/16-in. open-end wrench, tighten the fitting to the vent valve 
solenoid.

e. Reconnect the cable that comes from the Vent Delay PCB. Go to 
step 6.

5. To replace the ion gauge, proceed as follows:

a. Disconnect the cable from the top of the ion gauge by pulling it free 
from the ion gauge.

b. Unscrew the ion gauge by hand from the vacuum manifold.

c. Replace the old ion gauge with a new one (P/N 00105-01525). Screw 
it into the vacuum manifold.

d. Reattach the cable to the top of the ion gauge. Go to step 6.

6. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 5-34.

7. Restart the system as described in the topic Starting Up the System 
After a Complete Shutdown on page 6-7 in the System Shutdown, 
Startup, and Reset chapter.
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Replacing the Electron Multiplier and 
Conversion Dynode Power Supplies, 
Analyzer PCB, Analyzer Auxiliary PCB, 
Waveform Amplifier PCB, RF Voltage 
Amplifier PCB 

The electron multiplier and conversion dynode power supplies, Analyzer 
PCB, Analyzer Auxiliary PCB, Waveform Amplifier PCB, and RF Voltage 
Amplifier PCB are accessible from the top of the MS detector. See Figure 8-5 
on page 8-18.

To replace the electron multiplier power supply, conversion dynode power 
supply, Analyzer PCB, Analyzer Auxiliary PCB, Waveform Amplifier PCB, 
or RF Voltage Amplifier PCB, proceed as follows: 

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Deca XP MAX system as described in the topic 
Shutting Down the System Completely on page 6-5 in the System 
Shutdown, Startup, and Reset chapter).

2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22. 

• To replace the electron multiplier power supply and the conversion 
dynode power supply, go to step 3. 

• To replace the Analyzer PCB, go to step 4.

• To replace the Analyzer Auxiliary PCB, go to step 5.

• To replace the Waveform Amplifier PCB, go to step 6.

• To replace the RF Voltage Amplifier PCB, go to step 7.

3. To replace the electron multiplier power supply and/or the conversion 
dynode power supply, proceed as follows. See Figure 8-5 on page 8-18 
for the location of the electron multiplier and conversion dynode power 
supplies.

a. Disconnect the conversion dynode high voltage cable at the 
conversion dynode feedthrough by pulling it free from the 
feedthrough.

b. Disconnect the electron multiplier high voltage cable at the electron 
multiplier power supply.

CAUTION. Make sure that the LCQ Deca XP MAX electronic service 
switch is in the Service position (or shut down the system and disconnect the 
power cord) before you proceed.
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c. Disconnect from the top of the electron multiplier and conversion 
dynode power supplies the electrical cable that comes from the 
System Control PCB.

d. Loosen by hand or with a Phillips screwdriver the two fasteners that 
hold the electron multiplier and conversion dynode power supply 
module to the MS detector chassis.

e. Carefully lift the electron multiplier and conversion dynode power 
supply module up and away from the MS detector.

f. You must replace the conversion dynode power supply and the 
electron multiplier power supply together as a module 
(P/N 97000-98042). Retain the packing materials so that you can 
pack and ship the defective power supply module or PCB to the 
Thermo Electron San Jose Repair Center. Be sure to note the apparent 
problem or symptoms on the enclosed forms.

g. Install the electron multiplier and conversion dynode power supply 
module in the space occupied by the old power supply module.

h. With a Phillips screwdriver, tighten the two fasteners that hold the 
electron multiplier and conversion dynode power supply module to 
the MS detector chassis.

i. Reconnect to the electron multiplier and conversion dynode 
power supplies the electrical cable that comes from the System 
Control PCB.

j. Reconnect the electron multiplier high voltage cable to the electron 
multiplier power supply.

k. Reconnect the conversion dynode high voltage cable to the 
conversion dynode feedthrough. Go to step 8.

4. To replace the Analyzer Auxiliary PCB, proceed as follows. See 
Figure 8-5 on page 8-18 for the location of the Analyzer Auxiliary PCB.

a. Disconnect (at P5) the octapoles cable that comes from the Analyzer 
Auxiliary PCB. 

b. Disconnect (at P4) the lenses cable that comes from the System 
Control PCB.

c. Disconnect (at P2 and P3) the two endcap electrode cables that come 
from the Analyzer Auxiliary PCB.

d. Disconnect (at P1) the electrometer cable. (If necessary, use a small 
screw driver to loosen the screws that secure the cable.)

e. Disconnect the electron multiplier high voltage cable that comes from 
the electron multiplier power supply.

f. Use a 7/16-in. open-end wrench to disconnect the helium damping 
gas line from the fitting.
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g. With a Phillips screwdriver, remove the metal cover from the 
Analyzer PCB.

h. With a Phillips screwdriver, remove the screws that hold the Analyzer 
PCB to the top cover plate of the vacuum manifold.

i. Unseat and remove the Analyzer PCB from the top cover plate.

j. Unpack the new Analyzer PCB (P/N 97033-61051). Retain the 
packing materials so that you can pack and ship the defective PCB to 
the Thermo Electron San Jose Repair Center. Be sure to note the 
apparent problem or symptoms on the enclosed forms.

k. Carefully align and seat the Analyzer PCB into the 8-pin and 4-pin 
feedthrough on the top cover plate.

l. With a Phillips screwdriver, reinstall the screws that hold the 
Analyzer PCB to the top cover plate.

m. With a Phillips screwdriver, reinstall the metal cover.

n. Use a 7/16-in. open-end wrench to reconnect the helium damping gas 
line to the fitting.

o. Reconnect (at P5) the octapoles cable that comes from the Analyzer 
Auxiliary PCB.

p. Reconnect (at P4) the lenses cable that comes from the System 
Control PCB.

q. Reconnect (at P2 and P3) the two endcap cables that come from the 
Analyzer Auxiliary PCB.

r. Reconnect (at P1) the electrometer cable.

s. Reconnect the electron multiplier high voltage cable that comes from 
the electron multiplier power supply. Go to step 8.

5. To replace the Analyzer Auxiliary PCB, proceed as follows. See 
Figure 8-5 on page 8-18 for the location of the Analyzer Auxiliary PCB.

a. Disconnect all cables to the Analyzer Auxiliary PCB.

b. With a Phillips screwdriver, remove the metal cover from the 
Analyzer Auxiliary PCB.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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c. With a Phillips screwdriver, remove the screws that hold the Analyzer 
Auxiliary PCB to the top of the vacuum manifold. Remove the 
Analyzer Auxiliary PCB.

d. Unpack the new Analyzer Auxiliary PCB (P/N 97000-61340). Retain 
the packing materials so that you can pack and ship the defective PCB 
to the Thermo Electron San Jose Repair Center. Be sure to note the 
apparent problem or symptoms on the enclosed forms.

e. Install the new PCB in the place occupied by the old PCB.

f. With a Phillips screwdriver, reinstall the screws that secure the 
Analyzer Auxiliary PCB to the top of the vacuum manifold.

g. Reinstall the metal cover to the top of the Analyzer Auxiliary PCB.

h. Reconnect all cables to the Analyzer Auxiliary PCB that you 
disconnected in step 5a. Go to step 8.

6. To replace the Waveform Amplifier PCB, proceed as follows. See 
Figure 8-5 on page 8-18 for the location of the Waveform Amplifier PCB.

a. Disconnect all cables to the Waveform Amplifier PCB.

b. With a Phillips screwdriver, remove the metal cover from the 
Waveform Amplifier PCB.

c. With a Phillips screwdriver, remove the screws that secure the 
Waveform Amplifier PCB to the top of the tower. Remove the 
Waveform Amplifier PCB.

d. Unpack the new Waveform Amplifier PCB (P/N 96000-61110). 
Retain the packing materials so that you can pack and ship the 
defective PCB to the Thermo Electron San Jose Repair Center. Be 
sure to note the apparent problem or symptoms on the enclosed 
forms.

e. Install the new PCB in the place occupied by the old PCB.

f. With a Phillips screwdriver, reinstall the screws that secure the 
Waveform Amplifier PCB to the top of the tower.

g. Reinstall the metal cover to the top of the Waveform Amplifier PCB.

h. Reconnect all cables to the Waveform Amplifier PCB that you 
disconnected in step 6a. Go to step 8.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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7. To replace the RF Voltage Amplifier PCB, proceed as follows: 

a. Disconnect all cables to the RF Voltage Amplifier PCB.

b. With a Phillips screwdriver, remove the metal cover from the RF 
Voltage Amplifier PCB.

c. With a Phillips screwdriver, remove the screws that secure the RF 
Voltage Amplifier PCB to the top of the tower. Remove the RF 
Voltage Amplifier PCB.

d. Unpack the new RF Voltage Amplifier PCB (P/N 97144-61016). 
Retain the packing materials so that you can pack and ship the 
defective PCB to the Thermo Electron San Jose Repair Center. Be 
sure to note the apparent problem or symptoms on the enclosed 
forms.

e. Install the new PCB in the place occupied by the old PCB.

f. With a Phillips screwdriver, reinstall the screws that secure the RF 
Voltage Amplifier to the top of the tower.

g. Reinstall the metal cover to the top of the RF Voltage Amplifier PCB.

h. Reconnect all cables to the RF Voltage Amplifier PCB that you 
disconnected in step 7a. Go to step 8. 

8. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 5-34.

9. Place the electronics service switch in the Operating Position.

10. Run the Tune Plus diagnostics to verify that the system is operational.

11. If you replaced the Analyzer PCB, Analyzer Auxiliary PCB, or RF 
Voltage Amplifier PCB, tune the ring electrode and quadrupole/octapole 
RF voltages as described in the topic Tuning the Ring Electrode and 
Quadrupole/Octapole RF Voltages on page 5-34.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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Replacing the System Control PCB

To replace the System Control PCB, proceed as follows. See Figure 8-2 on 
page 8-8 for the location of the System Control PCB. 

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Deca XP MAX system as described in the topic 
Shutting Down the System Completely on page 6-5 in the System 
Shutdown, Startup, and Reset chapter).

2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22.

3. Remove the right side cover of the MS detector as follows:

a. Loosen the screw that secures the right side cover to the chassis of the 
MS detector.

b. Slide the side cover forward, and then lift it out and away from the 
MS detector.

4. Remove the System Control PCB protective cover, as follows:

a. With Phillips screwdriver, loosen the five screws that hold the 
protective cover to the MS detector chassis.

b. Pull the cover up and out of the guide slots on the MS detector 
chassis.

5. Disconnect all cables to the System Control PCB. The following cables 
are connected to the System Control PCB: 

• Ion gauge / Convectron gauge (P9)

• Front panel (P2)

• Analyzer (J3)

• Spray shield (J6)

• RF and waveform amplifiers (P12)

• Analyzer Aux. (P5)

• Electron multiplier / conversion dynode power supplies (P3)

• RF control (P8)

• LC I/O (P4)

• Switching power supplies (J2)

• APCI heater (J4)

CAUTION. Make sure that the LCQ Deca XP MAX electronic service 
switch is in the Service position (or shut down or shut down the system and 
disconnect the power cord) before you proceed.
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• Transformer (XMFR) (P1)

• High speed serial (P6 backside of PCB)

• 8 kV power supply (J5 backside of PCB)

6. With a Phillips screwdriver, loosen the eight fasteners that hold the 
System Control PCB to the MS detector chassis.

7. Slide the System Control PCB toward the front of the MS detector by 1.2 
cm (0.5 in.) so that it clears the data system cable connector.

8. Carefully lift the System Control PCB out and away from the MS 
detector. Disconnect the high speed serial cable and 8 kV power supply 
cables if you have not already done so.

9. Unpack the new System Control PCB (P/N 97044-61010). Retain the 
packing materials so that you can pack and ship the defective PCB to the 
Thermo Electron San Jose Repair Center. Be sure to note the apparent 
problem or symptoms on the enclosed forms.

10. Position the new System Control PCB in the space occupied by the old 
PCB. 

11. With a Phillips screwdriver, tighten the three screws and the eight 
fasteners that hold the System Control PCB to the MS detector chassis.

12. Reconnect all cables to the System Control PCB. The following cables 
are connected to the System Control PCB: 

• Ion gauge / Convectron gauge (P9)

• Front panel (P2)

• Analyzer (J3)

• Spray shield (J6)

• RF and waveform amplifiers (P12)

• Analyzer Aux. (P5)

• Electron multiplier / conversion dynode power supplies (P3)

• RF control (P8)

• LC I/O (P4)

• Switching power supplies (J2)

• APCI heater (J4)

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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• Transformer (XMFR) (P1)

• High speed serial (P6 backside of PCB)

• 8 kV power supply (J5 backside of PCB)

13. Reinstall the protective cover over the System Control PCB, as follows:

a. Insert the protective cover into the guide slots on the MS detector 
chassis and push the cover down until it is seated.

b. With Phillips screwdriver, tighten the five screws that hold the 
protective cover to the MS detector chassis.

14. Reinstall the right side cover of the MS detector, as follows:

a. Place the cover against the right side of the MS detector such that the 
studs on the cover insert into the guide slots on the System Control 
PCB protective cover.

b. Slide the side cover forward about 1.2 cm (0.5 in.) until the studs on 
the cover lock in the guide slots.

c. Tighten by hand the fastener that secures the side cover to the chassis 
of the MS detector. 

15. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 5-34.

16. Place the electronics service switch in the Operating Position.

17. Run the Tune Plus diagnostics to verify that the system is operational.

Replacing the RF Voltage Control PCB

To replace the RF Voltage Control PCB (and its housing), proceed as follows. 
See Figure 8-6 for the location of the RF Voltage Control PCB.

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Deca XP MAX system as described in the topic 
Shutting Down the System Completely on page 6-5 in the System 
Shutdown, Startup, and Reset chapter).

2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22.

3. Remove the left side cover of the MS detector, as follows:

a. Loosen the fastener that secures the left side cover to the chassis of 
the MS detector.

CAUTION. Make sure that the LCQ Deca XP MAX electronics service 
switch is in the Service position (or shut down the system and disconnect the 
power cord) before you proceed.
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b. Slide the side cover back about 1.25 cm (0.5 in.), and then pull it out 
and away from the MS detector.

4. With a Phillips screwdriver, remove the nine screws that secure the front 
cover of the RF Voltage Control PCB. Remove the front cover to expose 
the RF Voltage Control PCB.

5. Disconnect the cable that comes from the RF Voltage Amplifier PCB.

6. Disconnect the cable that comes from the System Control PCB.

7. With a Phillips screwdriver, remove the screws that hold the RF Voltage 
Control PCB housing to the vacuum manifold. Remove the RF Voltage 

Figure 8-6. Left side of the MS detector, showing the RF Voltage 
Control PCB 

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.

RF Voltage
Control PCB
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Control PCB and its housing as a unit. Reinstall the cover plate on the 
housing.

8. Unpack the new RF Voltage Control PCB and housing 
(P/N 96000-61100). Retain the packing materials so that you can pack 
and ship the defective PCB and housing to the Thermo Electron San Jose 
Repair Center. Be sure to note the apparent problem or symptoms on the 
enclosed forms.

9. Position the new RF Voltage Control PCB and its housing against the 
vacuum manifold where the old assembly was located. With a Phillips 
screwdriver, reinstall the 21 screws that hold the RF Voltage Control PCB 
housing to the vacuum manifold.

10. With a Phillips screwdriver, remove the nine screws that hold the front 
cover of the RF Voltage Control PCB housing to the RF Voltage Control 
PCB housing. Remove the front cover to expose the RF Voltage Control 
PCB.

11. Reconnect the cable that comes from the System Control PCB.

12. Reconnect the cable that comes from the RF Voltage Amplifier PCB.

13. Position the front cover over the RF Voltage Control PCB. With a Phillips 
screwdriver, reinstall the screws that hold the front cover to the RF 
Voltage Control PCB housing.

14. Reinstall the left side cover of the MS detector as follows:

a. Place the cover against the left side of the MS detector such that the 
studs on the cover insert into the guide slots in the MS detector 
chassis.

b. Slide the side cover forward about 1.25 cm (0.5 in.) until the studs on 
the cover lock in the guide slots.

c. Tighten by hand the fastener that secures the side cover to the chassis 
of the MS detector.

15. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 5-34.

16. Place the electronics service switch in the Operating Position.

17. Run the Tune Plus diagnostics to verify that the system is operational.

Replacing the Low Pass Filter PCB

To replace the Low Pass Filter PCB, proceed as follows. See Figure 8-7 for 
the location of the Low Pass Filter PCB.

1. Place the electronics service switch in the Service position (or shut down 
and vent the LCQ Deca XP MAX system as described in the topic 
Shutting Down the System Completely on page 6-5 in the System 
Shutdown, Startup, and Reset chapter).
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2. Remove the top cover of the MS detector as described in the topic 
Removing the Top Cover of the MS Detector on page 5-22.

3. Remove the rear cover of the MS detector as follows:

a. With a Phillips screwdriver, loosen the 10 screws that secure the rear 
cover to the chassis of the MS detector.

b. Slide the rear cover up about 1.25 cm (0.5 in.), and then lift it out and 
away from the MS detector.

4. Disconnect the two coaxial cables from the BNC connectors that are 
located on the rear of the Low Pass Filter PCB.

Figure 8-7. Rear view of the MS detector, showing the Vent Delay PCB 
and Low Pass Filter PCB

CAUTION. Make sure that the LCQ Deca XP MAX electronics service 
switch is in the Service position (or shut down the system and disconnect the 
power cord) before you proceed.

Fan, Low Pass Filter, Vent 
Control Assembly

Vent Delay PCB with 
Backup Battery

Low Pass 
Filter PCB
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5. With a Phillips screwdriver, remove the 8 screws that hold the metal cover 
of the Low Pass Filter PCB to the fan, low pass filter, vent control 
assembly. Remove the metal cover.

6. With a Phillips screwdriver, remove the screws that hold the Low Pass 
Filter PCB to the fan, low pass filter, vent control assembly. Remove the 
Low Pass Filter PCB.

7. Unpack the new PCB (P/N 97000-61380). Retain the packing materials 
so that you can pack and ship the defective PCB to the Thermo Electron 
San Jose Repair Center. Be sure to note the apparent problem or 
symptoms on the enclosed forms.

8. Position the new Low Pass Filter PCB in the place that was occupied by 
the old PCB. With a Phillips screwdriver, reinstall the screws that hold the 
Low Pass Filter PCB to the fan, low pass filter, vent control assembly.

9. Position the metal cover over the Low Pass Filter PCB. With a Phillips 
screwdriver, reinstall the 8 screws that hold the metal cover of the Low 
Pass Filter PCB to the fan, low pass filter, vent control assembly.

10. Reconnect the two coaxial cables to the BNC connectors that are located 
on the rear of the Low Pass Filter PCB.

11. Reinstall the rear cover of the MS detector as follows:

a. Place the cover against the rear of the MS detector such that the 
screws in the MS detector chassis insert into the guide slots on the 
rear cover.

b. Slide the rear cover down about 1.2 cm (0.5 in.) until the screws lock 
in the guide slots on the cover.

c. With a Phillips screwdriver, tighten the ten screws that secure the rear 
cover to the chassis of the MS detector.

12. Reinstall the top cover of the MS detector as described in the topic 
Reinstalling the Top Cover of the MS Detector on page 5-34.

13. Place the electronics service switch in the Operating Position.

14. Run the Tune Plus diagnostics to verify that the system is operational.

Caution. To prevent damage to the electronics due to electrostatic 
discharge, attach an electrostatic discharge (ESD) strap to your wrist before 
continuing.
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Chapter 9
LCQ Advantage MAX Replaceable Parts

This chapter contains part numbers for replaceable and consumable parts for the MS detector, data 
system, and kits. To ensure proper results in servicing the LCQ Advantage MAX system, order 
only the parts listed or their equivalent.

For information on how to order parts, refer to the topic Replaceable Parts in the LCQ 
Advantage MAX Preinstallation Requirements Guide.
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9.1 MS Detector
Replaceable parts are available to support the following:

• ESI probe assembly

• APCI probe assembly

• API probe guide

• API stack

• Ion optics

• Mass analyzer

• Ion detection system (electron multiplier/conversion dynode)

• Top cover plate of vacuum manifold

• Divert/inject valve

• Syringe pump

• Turbomolecular pump

• Forepump

• Vacuum assemblies

• Mechanical assemblies

• Electrical assemblies

• Printed circuit boards (PCBs)

• RF control/detection assemblies

• Cables

• Covers

For replaceable parts for the ESI Probe Assembly and APCI Probe Assembly, refer to the 
Finnigan Ion Max API Source Hardware Manual. For all other replaceable parts, refer to the 
following lists.

API Stack

Assembly, API Stack ................................................................................................... 97134-60003
Assembly, API, interconnect................................................................................ 97000-63002
Assembly, capillary heater................................................................................... 97144-60160
Clip, mount, skimmer and tube lens................................................................... 97144-10006
Cone, ion sweep .................................................................................................... 97144-20006
Cone, spray shield ................................................................................................ 97144-20004
Fitting, 3/8-in. hose, 1 1/2-in. × 13, UNC, male .................................................. 97000-20269
Mount, extension .................................................................................................. 97144-20007
Mount, skimmer and tube lens, 0.060 OFFSET ................................................ 97144-20008
Nut, thumb, 6-32, knurled, 303 stainless steel .....................................................  2804- 2748
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O-ring, 0.739-in. ID, 0.070-in. thick, Viton ......................................................... 00107-10100
O-ring, 0.375-in. ID, 1/16-in. thick, Viton........................................................... 00107-05500
O-ring, 3.875-in. ID, 3/16-in. thick, Viton........................................................... 00107-14100
O-ring, 0.30-in. ID, D, 0.064 W, Kalrez®, compound 4079 ................................ 00107-12750
Plunger, ball, 6-40, 0.310 long, 1 lb-ft.................................................................. 00201-11719
Screw-set, socket HD, #6-32 × 5/8-in., stainless steel ...........................................  8311- 0610
Screw, pan head, Phillips, 4-40 × 1/4-in., stainless steel .................................... 00415-44004
Screw, Socket, 6-32 × 3/8-in., stainless steel........................................................ 00419-63206
Seal graphite source heater.................................................................................. 70111-20216
Seal/Insulator, spray-shield.................................................................................. 97144-20107
Skimmer................................................................................................................. 97000-20201
Spring, wave, stainless steel ................................................................................. 00201-11599
Tube lens ................................................................................................................ 97000-20200
Tube, ion transfer, 450 micron............................................................................. 97133-20001
Washer, stepped .................................................................................................... 70111-20097

Assembly, Capillary Heater........................................................................................ 97144-60160
Assembly, lower block/heater .............................................................................. 97144-60150
Ball, tungsten-carbide, 5/16-in. diameter, grade 25T ........................................ 00007-00660
Block heater, upper source-heater....................................................................... 70111-20093
Cap Valve port source-heater .............................................................................. 70111-20101
Insulator, heater block.......................................................................................... 97144-20005
Screw socket, 2-56 × 3/16-in., stainless steel ....................................................... 00419-25603
Screw, buttonhead, socket, 2-56 × 1/8-in. L, 
stainless steel, temp............................................................................................... 00452-25610
Screw, pan head, Phillips, 4-40 × 3/16-in., stainless steel .................................. 00415-44003
Spring, heater block.............................................................................................. 97144-10004
Spring, heater-clip, source-heater ....................................................................... 70111-20128
Spring, sensor clip, source-heater ....................................................................... 70111-20134

Ion Optics

Lens, interoctapole ........................................................................................................ 97114-20004

Mount, trap .................................................................................................................... 70333-20015

Mount, octapole............................................................................................................. 97033-20035

Octapole, non-split (second), 2.0-in. long, welded ....................................................... 97000-60016

Octapole, split (first), 2.0-in. long, welded ................................................................... 97033-60230

Thumb screw, 10-32 ...................................................................................................... 97000-20235

Kit, Feedthrough, 4 Pin............................................................................................... 97000-62004
Feedthrough, 4 pin, modified............................................................................... 97000-98016
O-ring, 0.737-in. ID, 3/32-in. thick, Viton........................................................... 00107-10056
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Spacer, 4 pin feedthrough..................................................................................... 97000-20226

Kit, Feedthrough, 8 Pin............................................................................................... 97000-62008
Feedthrough, 8 pin................................................................................................ 96000-20115
______________________ Finnigan LCQ Series Hardware Manual__________________  9-3������
���������������	�
��



LCQ Advantage MAX Replaceable Parts
MS Detector






















































 �������������	
��
�
O-ring, 0.737-in. ID, 3/32-in. thick, Viton .......................................................... 00107-10056
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Spacer, 8 pin feedthrough .................................................................................... 97000-20225

Mass Analyzer

Electrode, ring............................................................................................................... 96000-20016

Electrode, endcap, entrance/exit ................................................................................... 97044-20000

Exit lens ........................................................................................................................ 97000-20205

Mount, analyzer ............................................................................................................ 97033-20015

Nipple, damping gas ......................................................................................................96000-20117

Nut ................................................................................................................................ 97000-20339

Post................................................................................................................................ 97000-20338

Sleeve, exit lens ............................................................................................................ 97044-20001

Sleeve, octapole adapter ............................................................................................... 97033-20014

Spacer, ring ................................................................................................................... 97000-20302

Spring washer, 0.33-in. ID, 0.49-in. OD, stainless steel................................................00474-11618

Tubing, Teflon, 14 gauge, 0.016-in. wall thickness ...................................................... 00007-94320

Ion Detection System 
(Electron Multiplier / Conversion Dynode)

Disk, shield, dynode...................................................................................................... 97000-20263

Shield, dynode .............................................................................................................. 97000-20210

Kit, Conversion Dynode ............................................................................................. 97000-62085
Feedthrough, dynode............................................................................................ 97000-60171
O-ring, 1.37-in. ID, 0.103-in. thick, Viton .......................................................... 00107-10400
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Spring, coil, 1.358-in. ID, 0.083-in. height. ..........................................................00201-11680
Tube, shield, dynode............................................................................................. 97000-20275

Kit, Electron Multiplier.............................................................................................. 96000-62019
Anode, electron multiplier ................................................................................... 96000-20076
Feedthrough, high voltage ................................................................................... 96000-20073
Feedthrough, electron multiplier ........................................................................ 96000-20072
O-ring, 0.375-in. ID, 0.103-in. thick, Viton ........................................................ 00107-07000
O-ring, 0.688-in. ID, 0.103-in. thick, Viton ........................................................ 00107-09500
Screw, socket, cap, 2-56 × 1/8-in., vented, stainless steel................................... 00452-20000

Assembly, Electron Multiplier ................................................................................... 96000-60036
Cathode (insert), electron multiplier .................................................................. 00022-02400
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Screw, pan head, Phillips, 2-56 × 1/4-in., vented, 
stainless steel.......................................................................................................... 00452-25605
Washer, wave, 0.731-in. OD × 0.588-in. ID......................................................... 00471-50080
Ring, high voltage ................................................................................................. 96000-20074
Shield, electron multiplier.................................................................................... 96000-20071
Support, electron multiplier................................................................................. 96000-20070
Support plate, electron multiplier ....................................................................... 96000-20077
Tube, high voltage connection.............................................................................. 96000-20078

Top Cover Plate of Vacuum Manifold

Assembly, Top Cover................................................................................................... 97133-60020
Connector, Swagelok®, modified.......................................................................... 96000-30005
Fitting, Swagelok, ferrule, 1/8-in., tee set ........................................................... 00101-09250
Fitting, Swagelok, nut knurled, 1/8-in., brass .................................................... 00101-12902
Nipple, damping gas ............................................................................................. 96000-20117
Pin guide, large top cover..................................................................................... 97000-20267
Pin guide, top cover .............................................................................................. 97000-20222
Pin, PCB, top cover............................................................................................... 97000-20223
Plate, top, manifold............................................................................................... 97000-20133

Kit, Handle Top Cover, 8-in........................................................................................ 97000-62003
Handle, 8-in., top cover ........................................................................................ 97000-20220

Divert/Inject Valve (Option)

Kit, Divert/Inject Valve Assembly.............................................................................97033--62190
Bracket, Divert Valve............................................................................................ 97033-10024
Divert/inject valve, 24 V dc .................................................................................. 00110-09998
Ferrule, Valco 1/16 HPLC stainless steel ............................................................ 00101-18122
Screw, flat, Phillips, 8-32 × 3/8-in., zinc .............................................................. 00407-83205
Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel .................................... 00415-63206
Valve-Acc Nut, Valco 1/16 PHLC, stainless steel ............................................... 00110-16008
LC-Acc, Valco 20 µL Sample Loop, stainless steel ............................................ 00301-30000

Syringe Pump

Syringe Pump, Modified, TSP ...................................................................................... 97033-98020

Turbomolecular Pump

O-ring, 4.100-in. ID, 3/16-in. thick, Viton .................................................................... 00107-11100

Lubrication oil reservoir, felt, turbomolecular pump TMH 261 ................................... 00950-01117

Bar, left turbo mount, .................................................................................................... 97033-20028

Bar, right turbo mount, .................................................................................................. 97033-20026
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Hinge, left turbo mount................................................................................................. 97033-20029

Hinge, right turbo mount .............................................................................................. 97033-20027

Pump, turbomolecular, TMH 261/130, 200 L/s............................................................ 00108-02644

Screw, socket, 1/4-in. × 20 × 1.25-in. long, stainless steel ........................................... 00419-42019

Washer, flat, 5/16-in. ID, 0.062-in. thick, stainless steel .............................................. 00472-02500

Forepump

Interconnect Kit, Forepump with hardware, 220 V ac ........................................... 97000-62016
Adapter, hose 25 mm............................................................................................ 00108-09005
Clamp, hose, adjustable, 0.81-in. to 1.5-in., stainless steel................................ 00108-09001
Pump oil, vacuum, 1 L ......................................................................................... 00301-15101
Pump, rotary-vane, 650 L/min, 220 V ac, 50/60 Hz .......................................... 00108-02655
Vacuum hardware, clamp, KF20/25 ................................................................... 00102-10020

Vacuum System Assemblies

Assembly, Vent Valve .................................................................................................. 97000-60128
Filter, sintered nylon ............................................................................................ 00201-06050
Fitting, Swagelok, male adapter, 1/8-in. MPT × 1/4-in. .................................... 00101-01740
Fitting, Swagelok, O-seal, 1/4-in. tube, 7/16-in. × 20......................................... 00101-13510
O-ring, 0.468-in. ID, 0.078-in. thick, Viton ........................................................ 00107-07600
Ribbon dope, 1/4-in. ............................................................................................. 00301-16501
Valve, 2 way, solenoid, 6 V dc, 1/32-in., stainless steel, 
normally open ........................................................................................................00110-10708

Assembly, Foreline ..................................................................................................... 97033-60200
Clamp, hose, adjustable, 0.81-in. to 1.5-in., stainless steel................................ 00108-09001
Hose, adapter, 25 mm........................................................................................... 00108-09005
Hose, PVC, reinforced, 1.0-in. ID, 1.25-in. OD, 
1.5 ft. (0.5 m) l ....................................................................................................... 00301-24141
Manifold, 3-way, angled....................................................................................... 97033-20016
Union, LCQ Advantage MAX, forelines, 90 degree .......................................... 97000-20294
Vacuum hardware, clamp, KF 20/25, steel......................................................... 00102-10070

Assembly, Helium, Inlet.............................................................................................. 97033-60200
Ferrule, 1/8-in. to 0.4 mm, graphite / Vespel.......................................................00101-18115
Fitting, Swagelok, bulkhead-union, 1/8-in. × 1/8-in., brass .............................. 00101-02101
Fitting, Swagelok, plug, 1/8-in. FPT, brass......................................................... 00101-02210
Regulator, 0-10 psi, 1/8-in., NPT, stainless steel................................................. 00105-03015
Tubing, fused silica, 0.075 mm ID 0.67 ft. (0.2 m) l ........................................... 00106-10520
Tubing, Teflon, 0.125-in. OD, 0.030-in. width, FEP .......................................... 00101-50000

Kit, Hose Adapter ....................................................................................................... 97000-62005
Adapter, pump manifold, 1.0-in. hose to wall .................................................... 97000-60185
Convectron™ gauge ............................................................................................. 00105-00501
O-ring, 0.862-in. ID, 0.103-in. thick, Viton ........................................................ 00107-15350
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Ribbon dope, 1/4-in............................................................................................... 00301-16501
Screw, pan head, Phillips, 6-32 × 1-1/2-in., stainless steel ................................. 00425-63224

Kit, Lid Manifold......................................................................................................... 97000-62006
Manifold lid ........................................................................................................... 97000-20243
O-ring, 3.6-in. ID, 0.21-in. thick, Viton ............................................................... 00107-14050
Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel .................................... 00415-63206

Kit, Ion Gauge ............................................................................................................. 97000-62010
Dynode shield, ....................................................................................................... 97000-20282
Ion gauge, mini, 0.75-in. OD tube........................................................................ 00105-01525
O-ring, 0.737-in. ID, 3/32-in. thick, Viton........................................................... 00107-10056
Sleeve, 0.75-in. ID, O-ring compression.............................................................. 97000-20211
Sleeve, threaded O-ring seal ................................................................................ 97000-20212

Mechanical Assemblies

Cover, top, octapole RF voltage coil ............................................................................. 97000-60162

Fan, embedded computer .............................................................................................. 00013-00243

Fan, low pass filter, vent control ................................................................................... 97033-60130

I/O panel, ...................................................................................................................... 97033-60120

Electrical Assemblies

Power supply, 8 kV, 100 µA, without bracket (ESI / APCI) ........................................ 97000-98041

Power supply, electron multiplier / conversion dynode, 

±15 kV at 1 µA, 0 to –2.5 kV at 230 µA....................................................................... 97000-98042

Assembly, Power Module............................................................................................ 97033-60100
Circuit breaker, 10 A, double-pole, high in-rush ............................................... 00019-00505
Circuit breaker, 2 pole, 10 A, 230 V ac ............................................................... 00019-00508
Connector, panel, power inlet, IEC 320/C20 ...................................................... 00004-89660
Filter, line, 20 A, screw terminal.......................................................................... 00007-18349
Nut, hex-KEP, 6-32, stainless steel....................................................................... 00461-26320
Screw, flat, Phillips, 4-40 × 3/8-in., stainless steel .............................................. 00407-44006
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Surge absorber PCB ............................................................................................. 70005-61090

Power supply, switching, +48 V, +24 V........................................................................ 97133-60060

Power supply, switching, +36 V (11 A), -28 V (4.2 A) ................................................ 97033-60022

Power supply, switching, +5 V, ±15 V, +24V, 200 W ................................................... 97033-60021

Power supply, linear, +/- 210 V................................................................................... 97033-60024
Fuse, 0.315 A, 5 x 20, 250 V, time lag .................................................................. 00006-04550
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Printed Circuit Boards (PCBs)

PCB, Dc Ring Filter.......................................................................................................96000-61130

PCB, Divert / Inject Valve .............................................................................................97033-61100

PCBs, Embedded Computer
PCB, Acquisition DSP.......................................................................................... 97000-61260
PCB, Computer Mainboard ................................................................................ 97033-60040
PCB, Control DSP ................................................................................................ 97000-61270
PCB, Ethernet, SMC, .......................................................................................... 97033-60280
PCB, ISA, Computer support ............................................................................. 97033-61020
PCB, RS 485/232 Converter ................................................................................. 97033-61110
PCB, Serial I/O (RS-232, 8 Port) ........................................................................ 97000-60124
PCB, Waveform DDS............................................................................................97033-61130

PCB, Front Panel .......................................................................................................... 97033-61090

PCB, I/O Panel.............................................................................................................. 97033-61040

PCB, Low Pass Filter.................................................................................................... 97000-61380

PCB, RF Voltage Amplifier .......................................................................................... 96000-61090

Fuse, 0.50 A, 5 × 20 mm, 250 V, quick acting, (F2)............................................ 00006-07608
Fuse, 1.00 A, 5 × 20 mm, 250 V, quick acting, (F1)............................................ 00006-07610

PCB, RF Voltage Control...............................................................................................96000-61100

PCB, Service Relay........................................................................................................97033-61120

PCB, Syringe Pump Control ......................................................................................... 97033-61030

PCB, System Control .................................................................................................. 97033-61016
Fuse, 0.90 A, HLD, Reset, PTC resistor ............................................................. 00006-30090
Fuse, 3.15 A, 5 × 20 mm, 250 V, time lag (F10) .................................................. 00006-10510

PCB, Switched Balun ................................................................................................... 97033-61060

PCB, Top Cover ............................................................................................................ 97033-61050

PCB, Vent Delay.......................................................................................................... 97000-61370
Battery, 7.2 V, nickel / cadmium.......................................................................... 00301-05720

PCB, Waveform Amplifier ............................................................................................96000-61110

RF Control / Detection Assemblies

Assembly, RF Tuning.................................................................................................. 97000-60141
Assembly, RF detector ......................................................................................... 97000-60078
Assembly, RF plate ceramic ................................................................................ 97000-60133
Connector, coax, BNC bulkhead jack, RU-58.................................................... 00004-33000
RF detector lid housing........................................................................................ 97000-20186
RF detector plate insulator.................................................................................. 96000-20048
RF detector ring shield ........................................................................................ 97000-20266
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Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel .................................... 00415-63206
Stud, fine tuning .................................................................................................... 97000-20322
Terminal lug, ring, # 6, solder.............................................................................. 00007-41500
Terminal lug, ring, 3/8-in., solder ........................................................................ 00007-39500
Tubing, Teflon, 18 gauge, 0.016-in. wall thickness ............................................. 00007-94330
Tuning bell, RF coil............................................................................................... 96000-20068

Kit, RF Feedthrough ................................................................................................... 96000-62024
O-ring, 1.37-in. ID, 0.103-in. thick, Viton ........................................................... 00107-10400
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
RF feedthrough ..................................................................................................... 97000-60169

Cables

Cable kit, top assembly ................................................................................................. 97133-62020

Cable, System Control PCB – RF Voltage Control PCB (ribbon) ................................ 97000-63015

Cable, interconnect (embedded computer), Control DSP 
PCB – Acquisition DSP PCB (ribbon).......................................................................... 97000-63031

Cable, RF Voltage Control PCB – RF Voltage Amplifier PCB .................................... 97000-63047

Cable, System Control PCB – RF Voltage Amplifier PCB – 
Waveform DDS PCB (ribbon) ...................................................................................... 97000-63048

Cable, System Control PCB – spray shield – external 
interconnect ................................................................................................................... 97000-63050

Cable, Sheath / Aux gas valve – I/O PCB..................................................................... 97000-63051

Cable, switching power supply – embedded computer fan – 
RF Voltage Control PCB fan – interconnect to tower fans ........................................... 97033-63002

Cable, Service Relay PCB – RF coil fan – tower fan ................................................... 97033-63010

Cable, reset button – Service Relay PCB – I/O PCB – Support 
PCB – Syringe Pump Controller – embedded computer fan ........................................ 97033-63030

Cable, AC Power Module harness assembly ................................................................ 97033-63040

Cable System Control PCB – Front Panel APCI Heater 
Connector – Service Relay PCB ................................................................................... 97134-63010

Cable, I/O PCB – System Control PCB, LC I/O........................................................... 97033-63070

Cable, Top Cover PCB – Acquisition DSP PCB........................................................... 97033-63080

Cable, System Control PCB – DC Ring Filter – Top Cover 
PCB – Switched Balun PCB ......................................................................................... 97033-63090

Cable, Waveform Amplifier PCB – Switched Balun PCB ........................................... 97033-63100

Cable, Vent Delay PCB – vent valve............................................................................. 97033-63110

Cable, RF amplifier PCB – low pass filter.................................................................... 97033-63120

Cable, I/O PCB – Front Panel PCB............................................................................... 97033-63130
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Cable, Ethernet PCB (embedded computer) – power panel,
coax............................................................................................................................... 97033-63140

Cable, Waveform DDS PCB – WF Amplifier PCB – RF 
Amplifier PCB .............................................................................................................. 97033-63150

Cable, System Control PCB – API stack spray shield.................................................. 97033-63180

Cable, I/O Panel – syringe pump controller ................................................................. 97033-63200

Cable, embedded computer mainboard– Support PCB power ..................................... 97033-63220

Cable, embedded computer fan .................................................................................... 97033-63230

Cable, System Control PCB – electron multiplier / conversion 
dynode power supply .................................................................................................... 97033-63290

Cable, conversion dynode/electron multiplier power supply – 
top cover plate............................................................................................................... 97033-63300

Cable, System Control PCB – ion gauge – convectron gauge...................................... 97033-63310

Cable, divert valve – front panel LED.......................................................................... 97033-63320

Cable, System Control PCB – Control DSP PCB, high speed
serial.............................................................................................................................. 97033-63330

Cable, low pass filter – main RF coil............................................................................ 97033-63340

Cable, Waveform DDS PCB – Control DSP PCB........................................................ 97033-63350

Cable, System Control PCB – RF Voltage Amplifier PCB– 
Waveform Amplifier PCB ............................................................................................ 97033-63360

Cable, PCI-DDS power – Support PCB ....................................................................... 97033-63370

Cable, 8 KV panel supply ............................................................................................. 97134-63020

Covers

Cover, Analyzer PCB, small ......................................................................................... 97000-98033

Cover, balun, shield ...................................................................................................... 97033-98070

Cover, box, balun .......................................................................................................... 97000-98032

Cover, low pass filter .................................................................................................... 97033-10027

Cover, RF Voltage Amplifier PCB ............................................................................... 97000-10028

Cover, System Control PCB ......................................................................................... 97033-10009

Cover, Waveform Amplifier PCB................................................................................. 97000-10029

Cover, zero box, RF voltage detector ........................................................................... 97000-20262
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9.2 Data System – Hardware
Kit, Data System, Hardware ...................................................................................... 97044-62111

Cable, thinwire Ethernet...................................................................................... 97044-63060
CD ROM, Norton Utilities 2001 .......................................................................... 00800-00105
Computer system .................................................................................................. 00825-01120
Connector, T-Connector, thinwire Ethernet ....................................................... 00012-50967
Software, MS Microsoft Office XP Suite ............................................................ 00800-00222
Terminator, thinwire Ethernet............................................................................. 00950-00918
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9.3 Chemicals Kit
Kit, Chemicals ............................................................................................................. 97000-62042

Caffeine, 1 mg/mL, in methanol.......................................................................... 00301-12310
Reserpine, 1 gram................................................................................................. 00301-12901
Met-Arg-Phe-Ala (MRFA), solids ....................................................................... 00301-07702
Sample, Met-Arg-Phe-Ala (MRFA), solids, 10 mg each ................................... 40061-60002
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9.4 Accessory Kit
Accessory Kit ............................................................................................................... 97134-62003

Air duct, 1.0-in. ID, flex, blue, 15 ft. (4.5 m) l..................................................... 00301-08301
Box, accessory ....................................................................................................... 97000-01005
Cable, shielded, 2-twisted pair, 22 gauge, 24 ft. (7 m) l ..................................... 00302-01800
Chemicals kit ......................................................................................................... 97000-62042
Ferrule, Finger-Tight™ 2, Upchurch (3 each) ................................................... 00101-18196
Ferrule, Tefzel, 1/16-in., electrospray (2 each) ................................................... 00102-10148
Ferrule, 0.008-in. ID, KEL-F, HPLC (4 each) .................................................... 00101-18114
Ferrule, 0.016-in. ID, PEEK, HPLC (4 each) ..................................................... 00101-18120
Fitting, ferrule, 1/8-in., Tefzel (2 each)................................................................ 00101-18199
Fitting, ferrule, Swagelok, back, 1/4-in. (2 each) ............................................... 00101-04000
Fitting, ferrule, Swagelok, front, 1/4-in. (2 each) ............................................... 00101-10000
Fitting, ferrule, Swagelok, front, 1/8-in. (2 each) ............................................... 00101-08500
Fitting, ferrule, Swagelok, back, 1/8-in. (2 each) ............................................... 00101-02500
Fitting, Finger-Tight™ 2, Upchurch (2 each)..................................................... 00101-18195
Fitting, HPLC union, 0.010-in. orifice, PEEK (2 each) ..................................... 00101-18202
Fitting, HPLC, tee, 0.020-in. orifice, PEEK (1 each) ......................................... 00101-18204
Fitting, Swagelok, nut, 1/4-in., brass (1 each) .................................................... 00101-12500
Fitting, Swagelok, nut, 1/8-in., brass (2 each) .................................................... 00101-15500
Fuse, 0.16 A, 5 × 20 mm, 250 V, time lag (8 each) .............................................. 00006-01700
Fuse, 0.25 A, 5 × 20 mm, 250 V, time lag (2 each) .............................................. 00006-11204
Fuse, 0.315 A, 5 × 20 mm, 250 V, time lag (2 each) ............................................ 00006-04550
Fuse, 0.40 A, 5 × 20 mm, 250 V, time lag (4 each) .............................................. 00006-05080
Fuse, 0.50 A, 5 × 20 mm, 250 V, quick acting (2 each)....................................... 00006-07608
Fuse, 1.00 A, 5 × 20 mm, 250 V, quick acting (2 each)....................................... 00006-07610
Fuse, 3.15 A, 5 × 20 mm, 250 V, time lag (4 each) .............................................. 00006-10510
Hose, PVC, reinforced, 28, 1.5 ft. (0.5 m) l ......................................................... 00301-24141
Manual, HPLC troubleshooting (1 each)............................................................ 00920-05914
Needle, corona discharge...................................................................................... 70005-98033
Needle, ESI, D point, 26 gauge, 51 mm. (2-in) l 1 each...................................... 00950-00990
Nut, flangeless, 1/16-in., electrospray (1 pack)................................................... 00102-10146
O-ring, 0.299-in. ID × 0.103-in. thick, Kalrez..................................................... 00107-10059
O-ring, 0.30-in. ID, D × 0.04 W, Kalrez, CMPD: 4079 ...................................... 00107-12750
Pump oil, rotary-vane vacuum pump, 1 L.......................................................... 00301-15101
Seal, ESI needle, 5000 series ................................................................................ 00950-00952
Seal, graphite, source heater................................................................................ 70111-20216
Syringe, 250 µL, Gastight®, removable needle (2 each) .................................... 00301-19015
Syringe, 500 µL Gastight, removable needle (1 each) ....................................... 00301-19016
Tool, capillary removal ......................................................................................... 70001-20258
Tool, needle seal removal...................................................................................... 70005-20304
Tube, hypodermic 28 gauge × 10-in. (254 mm), L304 
stainless steel (1 each) ........................................................................................... 00106-20000
Tube, ion transfer, 450 µm ................................................................................... 97133-20001
Tubing, 0.25-in. OD × 0.062-in. wall thickness, PFA, 
15 ft. (4.5 m) l......................................................................................................... 00101-50100
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Tubing, fused silica, 0.150 mm ID × 0.390 mm OD, 
2 ft. (0.6 m) l .......................................................................................................... 00106-10498
Tubing, fused silica, 0.050 mm ID × 0.190 mm OD, 
6 ft. (1.8 m) l .......................................................................................................... 00106-10502
Tubing, fused silica, 0.1 mm ID × 0.4 mm OD, deactivated 
3 ft. (1 m) ............................................................................................................... 00106-10504
Tubing, fused silica, 0.1 mm ID × 0.190 mm OD, 
6 ft. (1.8 m) l .......................................................................................................... 00106-10499
Tubing, PVC, unreinforced, clear, 3/8-in. ID, 
10 ft. (3 m) l ........................................................................................................... 00301-22895
Tubing, PEEK, red, 0.005-in. ID × 1/16-in. OD, 
5 ft. (1.5 m) l .......................................................................................................... 00301-22912
Wrench, Allen / Hex 1/4-in. ball point ................................................................ 00725-00022
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9.5 Recommended Spares
Battery, 7.2 V, nickel / cadmium................................................................................... 00301-05720

Bushing, snap, 1.75-in. diameter, white plastic............................................................. 00201-19081

Dc ring filter box ........................................................................................................... 97000-98004

Fan gasket...................................................................................................................... 97000-20298

Fan, 100 cfm, 24 V dc ................................................................................................... 00013-00243

Fan, kit........................................................................................................................... 97000-62021

Filter, fan ....................................................................................................................... 97000-20299

Finger guard .................................................................................................................. 00007-18600

Fitting, Swagelok, bulkhead-union, 1/8-in. × 1/8-in., 
stainless steel ................................................................................................................. 00101-02102

Foot, bumper ................................................................................................................. 00007-18115

Fuse, 0.16 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-01700

Fuse, 0.25 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-11204

Fuse, 0.40 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-05080

Fuse, 0.50 A, 5 × 20 mm, 250 V, quick acting .............................................................. 00006-07608

Fuse, 1.00 A, 5 × 20 mm, 250 V, quick acting .............................................................. 00006-07610

Fuse, 1.60 A, 5 × 20 mm, 250 V, quick acting .............................................................. 00006-08610

Fuse, 2.50 A, 5 × 20 mm, 250 V, Type F ...................................................................... 00006-11202

Fuse, 3.15 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-10510

Hinge, open 180 degree................................................................................................. 00250-08003

Nut, hex-KEP, 6-32, cadmium plated............................................................................ 00460-16321

Nut, hex-KEP, 8-32, stainless steel ............................................................................... 00461-28320

Plug, 1.75-in. diameter, white, nylon ............................................................................ 00201-20500

Pump oil, turbomolecular, reservoir, felt, TPH 240 ...................................................... 00950-01116

Pump oil, rotary-vane vacuum pump, 1 L..................................................................... 00301-15101

Screw, pan head, Phillips, 6-32 × 1 3/4-in., zinc plated ................................................ 00405-63228

Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel............................................... 00415-63208

Screw, pan head, Phillips, 6-32 × 1/4-in., stainless steel............................................... 00415-63204

Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel............................................... 00415-63206

Screw, pan head, slot, 2-56 × 1/4-in., stainless steel ..................................................... 00414-25604

Screw, pan head, slot, 6-32 × 1/4-in., cadmium plated ................................................. 00404-63204

Stud, ball, 6-32 × 0.375-in............................................................................................. 00201-12110
______________________ Finnigan LCQ Series Hardware Manual_________________  9-15������
���������������	�
��



LCQ Advantage MAX Replaceable Parts
Recommended Spares














































 �������������	
��
�
Switchcap, manifold cover, interconnect ...................................................................... 97000-40009

Switchcap, right door, interconnect .............................................................................. 97000-40010

Tubing, Teflon, 18 gauge, 0.016-in. wall thickness ...................................................... 00007-94330

Valve assembly, sheath/aux gas, dual manifold .............................................................00110-20014

Washer, flat, #6, stainless steel ..................................................................................... 00472-00600

Washer, interlock, 5/16-in. ID, stainless steel............................................................... 00479-04400
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9.6 Divert / Inject Valve Accessories
Ferrule, HPLC 1/16-in. stainless steel, Valco................................................................ 00101-18122

Syringe adapter, 1/16-in. fill port liner / ferrule, Valco ................................................. 00110-16002

Syringe adapter, 1/16-in. fill port, Valco ....................................................................... 00110-16000

Valve, replacement nut, 1/16-in. HPLC, stainless steel ................................................ 00110-16008

Valve, replacement rotor seal, Valco ............................................................................. 00110-16006

Valve, replacement stator, Valco ................................................................................... 00110-16004

5 µL sample loop, stainless steel, Valco........................................................................ 00110-16010

20 µL sample loop, stainless steel, Valco...................................................................... 00301-30000
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9.7 Optional Tools
Hexdriver, 0.28-in. ........................................................................................................ 00025-01810

Hexdriver, 0.35-in. ........................................................................................................ 00025-08041

Tool pin extractor, AMP, large...................................................................................... 00725-00013

Tool pin extractor, AMP, small ..................................................................................... 00725-00020

Wrench, Allen / hex drive, 1/4-in. (with handle) .......................................................... 00725-00015

Tool, capillary removal ..................................................................................................70111-20258

Tool, removal, TEE seal................................................................................................ 70005-20304
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Chapter 10
LCQ Deca XP MAX Replaceable Parts

This chapter contains part numbers for replaceable and consumable parts for 
the MS detector, data system, and kits. To ensure proper results in servicing 
the LCQ Advantage MAX system, order only the parts listed or their 
equivalent.

For information on ordering parts, refer to the topic Replaceable Parts in the 
LCQ Series Preinstallation Requirements Guide.
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10.1 MS Detector
Replaceable parts are available to support the following:

• ESI probe assembly

• APCI probe assembly

• API probe guide

• API stack

• Ion optics

• Mass analyzer

• Ion detection system (electron multiplier/conversion dynode)

• Top cover plate of vacuum manifold

• Divert/inject valve

• Syringe pump

• Turbomolecular pump

• Rotary-vane pumps

• Vacuum system assemblies

• Mechanical assemblies

• Electrical assemblies

• Printed circuit boards (PCBs)

• RF control/detection assemblies

• Cables

• Covers

For replaceable parts for the ESI Probe Assembly and APCI Probe Assembly, refer to the 
Finnigan Ion Max API Source Hardware Manual. For all other replaceable parts, refer to the 
following lists.

API Stack

Assembly, API Stack ................................................................................................... 97345-60004
Assembly, API, interconnect................................................................................ 97000-63002
Assembly, capillary heater................................................................................... 97144-60160
Assembly, sprayshield ........................................................................................... 97144-60111
Clip, mount, skimmer and tube lens................................................................... 97144-10006
Cone, ion sweep .................................................................................................... 97144-20006
Cone, spray shield ................................................................................................ 97144-20004
Container, shipping API stack ............................................................................ 00707-10014
Fitting, 3/8-in. hose, 1 1/2-in. × 13, UNC, male .................................................. 97000-20269
Lens, interoctapole ............................................................................................... 97044-20004
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Mount, extension................................................................................................... 97144-20007
Mount, skimmer and tube lens, .060 OFFSET .................................................. 97144-20008
Nut, thumb, 6-32, knurled, 303 stainless steel .....................................................   2804- 2748
O-ring, 0.739-in. ID, 0.070-in. thick, Viton ......................................................... 00107-10100
O-ring, 0.375-in. ID, 1/16-in. thick, Viton........................................................... 00107-05500
O-ring, 3.875-in. ID, 3/16-in. thick, Viton........................................................... 00107-14100
O-ring, 0.30-in. ID, D, 0.064 W, Kalrez®, 
compound 4079 ..................................................................................................... 00107-12750
Plunger, ball, 6-40, 0.310 long, 1 lb-ft.................................................................. 00201-11719
Screw-set, socket HD, #6-32 × 5/8-in., stainless steel ..........................................   8311- 0610
Screw, pan head, Phillips, 4-40 × 1/4-in., stainless steel .................................... 00415-44004
Screw, Socket, 6-32 × 3/8-in., stainless steel........................................................ 00419-63206
Seal, graphite source heater................................................................................. 70111-20216
Seal, insulator, spray-shield ................................................................................. 97144-20107
Skimmer (LCQ Deca XP) .................................................................................... 97144-20009
Skimmer (LCQ Deca XP MAX).......................................................................... 97144-20070
Spring, wave, stainless steel ................................................................................. 00201-11599
Tube lens ................................................................................................................ 97000-20200
Tube, ion transfer, 550 µm ................................................................................... 97133-20001
Washer, stepped .................................................................................................... 70111-20097

Assembly, Capillary Heater........................................................................................ 97144-60160
Assembly, lower block/heater .............................................................................. 97144-60150
Ball, tungsten-carbide, 5/16-in. diameter, grade 25T ........................................ 00007-00660
Block heater, upper source-heater....................................................................... 70111-20093
Cap Valve port source-heater .............................................................................. 70111-20101
Insulator, heater block.......................................................................................... 97144-20005
Screw socket, 2-56 × 3/16-in., stainless steel ....................................................... 00419-25603
Screw, buttonhead, socket, 2-56 × 1/8-in. L, 
stainless steel, temp............................................................................................... 00452-25610
Screw, pan head, Phillips, 4-40 × 3/16-in., stainless steel .................................. 00415-44003
Spring, heater block.............................................................................................. 97144-10004
Spring, heater-clip, source-heater ....................................................................... 70111-20128
Spring, sensor clip, source-heater ....................................................................... 70111-20134

Ion Optics

Lens, interoctapole ........................................................................................................ 97144-20032

Mount, analyzer............................................................................................................. 97044-20005

Mount, quadrupole (formerly named octapole mount) ................................................. 97000-20164

Octapole, 2.0-in. long, welded ...................................................................................... 97000-60016

Quadrupole, 2.0-in. long ............................................................................................... 97044-60060

Thumb screw, 10-32 ...................................................................................................... 97000-20235

Kit, Feedthrough, 4 Pin............................................................................................... 97000-62004
Feedthrough, 4 pin, modified............................................................................... 97000-98016
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O-ring, 0.737-in. ID, 3/32-in. thick, Viton .......................................................... 00107-10056
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Spacer, 4 pin feedthrough .................................................................................... 97000-20226

Kit, Feedthrough, 8 Pin .............................................................................................. 97000-62008
Feedthrough, 8 pin ................................................................................................96000-20115
O-ring, 0.737-in. ID, 3/32-in. thick, Viton .......................................................... 00107-10056
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Shield box, PCB .................................................................................................... 97000-10083
Spacer, 8 pin feedthrough .................................................................................... 97000-20225

Mass Analyzer

Electrode, ring............................................................................................................... 96000-20016

Electrode, endcap, entrance/exit ................................................................................... 97044-20000

Exit lens ........................................................................................................................ 97000-20205

Mount, analyzer ............................................................................................................ 97044-20005

Nipple, damping gas ......................................................................................................96000-20117

Nut ................................................................................................................................ 97000-20339

Post................................................................................................................................ 97000-20338

Sleeve, entrance lens..................................................................................................... 97044-20002

Sleeve, exit lens ............................................................................................................ 97044-20001

Spacer, ring ................................................................................................................... 97000-20302

Spring washer, 0.33-in. ID, 0.49-in. OD, stainless steel................................................00474-11618

Tubing, Teflon, 14 gauge, 0.016-in. wall thickness ...................................................... 00007-94320

Ion Detection System 
(Electron Multiplier / Conversion Dynode)

Disk, shield, dynode...................................................................................................... 97000-20263

Shield, dynode .............................................................................................................. 97000-20210

Kit, Conversion Dynode ............................................................................................. 97000-62085
Feedthrough, dynode............................................................................................ 97000-60171
O-ring, 1.37-in. ID, 0.103-in. thick, Viton .......................................................... 00107-10400
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Spring, coil, 1.358-in. ID, 0.083-in. height. ..........................................................00201-11680
Tube, shield, dynode............................................................................................. 97000-20275

Kit, Electron Multiplier.............................................................................................. 96000-62019
Anode, electron multiplier ................................................................................... 96000-20076
Feedthrough, HV.................................................................................................. 96000-20073
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Feedthrough, electron multiplier......................................................................... 96000-20072
O-ring, 0.375-in. ID, 0.103-in. thick, Viton ......................................................... 00107-07000
O-ring, 0.688-in. ID, 0.103-in. thick, Viton ......................................................... 00107-09500
Screw, socket, cap, 2-56 × 1/8-in., vented, stainless steel ................................... 00452-20000
Ring, high voltage ................................................................................................. 96000-20074
Shield, electron multiplier.................................................................................... 96000-20071
Support, electron multiplier................................................................................. 96000-20070
Support plate, electron multiplier ....................................................................... 96000-20072
Tube, high voltage ................................................................................................. 96000-20078

Assembly, Electron Multiplier.................................................................................... 96000-60036
Cathode, electron multiplier ................................................................................ 00022-02400
Screw, pan head, Phillips, 2-56 × 1/4-in., vented, 
stainless steel.......................................................................................................... 00452-25605
Washer, wave, 0.731-in. OD × 0.588-in. ID......................................................... 00471-50080

Top Cover Plate of Vacuum Manifold

Assembly, Top Cover................................................................................................... 97133-60020
Connector, Swagelok®, modified ........................................................................ 96000-30005
Fitting, Swagelok, ferrule, 1/8-in., tee set ........................................................... 00101-09250
Fitting, Swagelok, nut knurled, 1/8-in., brass .................................................... 00101-12902
Nipple, damping gas ............................................................................................. 96000-20117
Pin guide, large top cover..................................................................................... 97000-20267
Pin guide, top cover .............................................................................................. 97000-20222
Pin, PCB, top cover............................................................................................... 97000-20223
Plate, top, manifold............................................................................................... 97000-20133

Kit, Handle Top Cover, 8-in........................................................................................ 97000-62003
Handle, 8-in., top cover ........................................................................................ 97000-20220

Divert/Inject Valve (Option)

Interconnect Assembly, Divert/Inject Valve.............................................................. 97345-60002
Divert/inject valve, 24 V dc .................................................................................. 00110-09998
Screw, flat, Phillips, 8-32 × 3/8-in., zinc .............................................................. 00407-83205
Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel .................................... 00415-63206
Spacer, 0.125-in. long, #6. ID, 1/4-in. OD, stainless steel ................................... 00007-68301

Syringe Pump

Interconnect Kit, Syringe Pump ................................................................................ 97000-62075
Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel .................................... 00415-63206
Syringe pump ........................................................................................................ 97000-98021
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Turbomolecular Pump

Rail, turbomolecular pump, mount kit.......................................................................... 97033-62200

Pump, turbo................................................................................................................... 00108-10010

Forepumps

Interconnect Kit, Forepump with hardware, 220 V ac
(2 each) ......................................................................................................................... 97000-62016

Adapter, hose 25 mm............................................................................................ 00108-09005
Clamp, hose, adjustable, 0.81-in. to 1.5-in., stainless steel................................ 00108-09001
Pump oil, vacuum, 1 L ......................................................................................... 00301-15101
Pump, rotary-vane, 650 L/min, 220 V ac, 50/60 Hz .......................................... 00108-02655
Vacuum hardware, clamp, KF20/25 ................................................................... 00102-10020

Vacuum System Assemblies

Assembly, Vent Valve .................................................................................................. 97000-60128
Filter, sintered nylon ............................................................................................ 00201-06050
Fitting, Swagelok, male adapter, 1/8-in. MPT × 1/4-in. .................................... 00101-01740
Fitting, Swagelok, O-seal, 1/4-in. tube, 7/16-in. × 20......................................... 00101-13510
O-ring, 0.424-in. ID, 0.103-in. thick, Viton ........................................................ 00107-05550
Ribbon dope, 1/4-in. ............................................................................................. 00301-16501
Valve, 2 way, solenoid, 6 V dc, 1/32-in., stainless steel, 
normally open ........................................................................................................00110-10708

Assembly, Foreline Interconnect ............................................................................... 97144-60170
Clamp, hose, adjustable, 0.18-in. to 1.5-in., stainless steel................................ 00108-09001
Clamp, hose, adjustable, 9/16-in. to 1-1/16-in., 
stainless steel screw .............................................................................................. 00108-10016
Elbow, turbo, exhaust............................................................................................ 70111-20104
Hose adapter, 25 mm............................................................................................ 00108-09005
Hose, 1/2-in., steel reinforced .............................................................................. 00301-24155
Hose, 1-in., embedded poly spiral ....................................................................... 00301-24141
Screw, socket, cap, m4 × 20 mm, black oxide .................................................... 00419-63222
Tee, hose 1-in. × 1-in. × 1/2-in., aluminum ......................................................... 97144-20031
Union, duo, forelines, 90 degrees......................................................................... 97000-20294
Vacuum hardware, clamp, KF 20/25 .................................................................. 00102-10020

Assembly, Helium, Inlet.............................................................................................. 97000-60137
Ferrule, 1/8-in. to 0.4 mm, graphite / Vespel.......................................................00101-18115
Fitting, Swagelok, bulkhead-union, 1/8-in. × 1/8-in., brass .............................. 00101-02101
Fitting, Swagelok, plug, 1/8-in. FPT, brass......................................................... 00101-02210
Regulator, 0-10 psi, 1/8-in., NPT, stainless steel................................................. 00105-03010
Tubing, fused silica, 0.075 mm ID 0.67 ft. (0.2 m) l ........................................... 00106-10520
Tubing, Teflon, 0.125-in. OD, 0.030-in. width, FEP .......................................... 00101-50000

Kit, Hose Adapter ....................................................................................................... 97000-62005
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Adapter, pump manifold, 1.0-in. hose to wall .................................................... 97000-20215
Convectron™ gauge ............................................................................................. 00105-00501
O-ring, 0.862-in. ID, 0.103-in. thick, Viton ......................................................... 00107-15350
Ribbon dope, 1/4-in............................................................................................... 00301-16501
Screw, pan head, Phillips, 6-32 × 1-1/2-in., stainless steel ................................. 00425-63224

Kit, Ion Gauge ............................................................................................................. 97000-62010
Dynode shield, ....................................................................................................... 97000-20282
Ion gauge, mini, 0.75-in. OD tube........................................................................ 00105-01525
O-ring, 0.737-in. ID, 3/32-in. thick, Viton........................................................... 00107-10056
Sleeve, 0.75-in. ID, O-ring compression.............................................................. 97000-20211
Sleeve, threaded O-ring seal ................................................................................ 97000-20212

Mechanical Assemblies

Cover, top, octapole RF voltage coil ............................................................................. 97000-60162

Fan, tower...................................................................................................................... 97000-60153

Fan, low pass filter, vent control ................................................................................... 97033-60130

Electrical Assemblies

Power supply, 8 kV, 100 µA, without bracket (ESI / APCI)......................................... 70005-98037

Transformer, 240 VA toroid .......................................................................................... 97000-98001

Assembly, Turbomolecular Pump Controller ........................................................... 97144-60040
Frequency, converter, Leybold, TPS ................................................................... 00108-10012
Power supply, switch, 24 V (85 A), 48V (4 A), 400 W........................................ 00012-24208

Assembly, Power Module............................................................................................ 97044-60050
Circuit breaker, 15 A, double-pole, high in-rush ............................................... 00019-00522
Circuit breaker, 2 pole, 10 A, 230 V ac, unmarked rocker ............................... 00019-00508
Connector, panel, power inlet, IEC 320/C20 ...................................................... 00004-89660
Filter, line, 20 A, screw terminal.......................................................................... 00007-18349
Fuse, 3.15 A, 5 × 20 mm, 250 V, time lag ........................................................... 00006-10510
Nut, hex-KEP, 10-32, stainless steel..................................................................... 00461-20320
Screw, flat, Phillips, 4-40 × 3/8-in., stainless steel .............................................. 00407-44006
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
Shunt, insulated, mini wrap................................................................................. 00004-89551
Switching power supply, 24 V (1.1 A) ................................................................. 00012-52104

Module, Electron Multiplier / Conversion Dynode 
Power Supply ................................................................................................................ 97000-98042

Assembly, Switching Power Supply........................................................................... 97000-60151
Power supply, +36 V (11 A), -28 V (4.2 A) .......................................................... 00012-24223
Power supply, +5 V, ±15 V, +24V, 200 W ............................................................ 00012-24221
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Printed Circuit Boards (PCBs)

PCB, Analyzer Top Cover ............................................................................................ 97033-61051

PCB, Analyzer Auxiliary .............................................................................................. 97000-61340

Fuse, 1.60 A, 5 × 20 mm, 250 V, quick acting, (F1 - F2) ............................................. 00006-08610

PCB, DC Ring Filter ......................................................................................................96000-61130

PCB, Divert / Inject Valve ............................................................................................ 97000-61390

PCBs, Embedded Computer
PCB, Acquisition DSP.......................................................................................... 97000-61260
PCB, Control DSP ................................................................................................ 97000-61270
PCB, CPU.............................................................................................................. 97144-60260
PCB, Ethernet, SMC............................................................................................ 97033-60280
PCB, Waveform DDS........................................................................................... 97000-61430

PCB, Front Panel .......................................................................................................... 97000-61400

PCB, I/O Panel.............................................................................................................. 97000-61421

PCB, Low Pass Filter.................................................................................................... 97000-61380

PCB, RF Voltage Amplifier........................................................................................ 96000-61090
Fuse, 0.50 A, 5 × 20 mm, 250 V, quick acting, (F2)............................................ 00006-07608
Fuse, 1.00 A, 5 × 20 mm, 250 V, quick acting, (F1)............................................ 00006-07610

PCB, RF Voltage Control...............................................................................................96000-61100

PCB, Syringe Pump ...................................................................................................... 97000-61410

PCB, System Control .................................................................................................. 97144-61016
PCB, System Control ........................................................................................... 97144-61016
Fuse, 0.16 A, 5 × 20 mm, 250 V, time lag (F1 - F4) ............................................ 00006-01700
Fuse, 0.25 A, 5 × 20 mm, 250 V, time lag (F7) .....................................................00006-11204
Fuse, 0.40 A, 5 × 20 mm, 250 V, time lag (F8 - F9) ............................................ 00006-05080
Fuse, 2.50 A, 5 × 20 mm, 250 V, type F (F6)........................................................00006-11202
Fuse, 3.15 A, 5 × 20 mm, 250 V, time lag (F5) .................................................... 00006-10510

PCB, Switched Balun ................................................................................................... 97033-61060

PCB, Vent Delay.......................................................................................................... 97000-61370
Battery, 7.2 V, nickel / cadmium.......................................................................... 00301-05720

PCB, APCI, safety, interlock ........................................................................................ 97144-61020

PCB, Waveform Amplifier ............................................................................................96000-61110

RF Control / Detection Assemblies

Assembly, RF Tuning.................................................................................................. 97000-60141
Assembly, RF detector ......................................................................................... 97000-60078
Assembly, RF plate ceramic ................................................................................ 97000-60133
Connector, coax, BNC bulkhead jack, RU-58.................................................... 00004-33000
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RF detector lid housing ........................................................................................ 97000-20186
RF detector plate insulator .................................................................................. 96000-20048
RF detector ring shield......................................................................................... 97000-20266
Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel .................................... 00415-63206
Stud, fine tuning .................................................................................................... 94011-20107
Terminal lug, ring, # 6, solder.............................................................................. 00007-41500
Terminal lug, ring, 3/8-in., solder ........................................................................ 00007-39500
Tubing, Teflon, 18 gauge, 0.016-in. wall thickness ............................................. 00007-94330

Kit, RF Feedthrough ................................................................................................... 96000-62024
O-ring, 1.37-in. ID, 0.103-in. thick, Viton ........................................................... 00107-10400
Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel .................................... 00415-63208
RF feedthrough ..................................................................................................... 97000-60169

Cables

Cable kit, top assembly ............................................................................................... 97345-60007
Cord, power, 230 V ac, 15 A, North America..................................................... 96000-98035
Cord, power, 230 V ac, 15 A, International ........................................................ 96000-98036
Cable, System Control PCB - ion gauge - Convectron gauge ........................... 97000-63001
Cable, API front panel - APCI heater................................................................. 97033-63210
Cable, Serial I/O PCB - Divert Valve Select PCB (ribbon)............................... 97000-63011
Cable, System Control PCB - I/O Panel PCB (ribbon) ..................................... 97000-63013
Cable, System Control PCB - RF Voltage Control PCB (ribbon) .................... 97000-63015
Cable, System Control PCB - Conversion Dynode Power Supply PCB
(15 kV) - Electron Multiplier Power Supply PCB ............................................. 97000-63016
Cable, Electron Multiplier Power Supply PCB - electron multiplier 
HV connector (top cover plate) (coax) ................................................................ 97000-63017
Cable, Analyzer PCB - Acquisition DSP PCB (embedded computer)............. 97000-63018
Cable, System Control PCB -Analyzer Auxiliary PCB..................................... 97044-63030
Cable, Analyzer Auxiliary PCB - Analyzer PCB - RF Voltage 
Amplifier PCB (4 cables)...................................................................................... 97000-63022
Cable, Vent Delay PCB - vent valve .................................................................... 97000-63023
Cable, RF Voltage Amplifier PCB - Low Pass Filter PCB (coax) .................... 97000-63034
Cable, Low Pass Filter PCB - RF voltage coil connection at front box ........... 97000-63035
Cable, System Control PCB - Front Panel PCB (ribbon) ................................. 97000-63036
Cable, System Control PCB - Analyzer Auxiliary............................................. 97044-63030 
Cable, ground strap, EMI .................................................................................... 97044-63040
Cable, Front Panel PCB - Serial I/O PCB .......................................................... 97044-63050
Cable, Power Module - internal Ethernet connector - Ethernet PCB 
(embedded computer)........................................................................................... 97000-63040
Cable, Waveform DDS PCB (embedded computer) - Waveform 
Amplifier PCB - RF Voltage Amplifier PCB
- Analyzer Auxiliary PCB .................................................................................... 97000-63041
Cable, System Control PCB - Control DSP PCB 
(embedded computer)........................................................................................... 97000-63042
Cable, switching power supply - embedded computer fan - RF 
Voltage Control PCB fan - interconnect to tower fans ...................................... 97000-63046
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Cable, RF Voltage Control PCB - RF Voltage 
Amplifier PCB ...................................................................................................... 97000-63047
Cable, System Control PCB - RF Voltage Amplifier PCB
- Waveform DDS PCB (ribbon) .......................................................................... 97000-63048
Cable, System Control PCB - Analyzer 
Auxiliary PCB (ribbon) ....................................................................................... 97000-63049
Cable, System Control PCB - spray shield -
external interconnect ........................................................................................... 97000-63050
Cable, APCI control, safety interlock................................................................. 97345-63010

Covers

Cover, Analyzer PCB, small ......................................................................................... 97000-98033

Cover, Analyzer Auxiliary PCB ................................................................................... 97000-10088

Cover, balun, shield ...................................................................................................... 96000-98013

Cover, box, balun .......................................................................................................... 97000-98032

Cover, manifold front, interconnect .............................................................................. 97000-40003

Cover, RF Voltage Amplifier PCB ............................................................................... 97000-10028

Cover, Waveform Amplifier PCB................................................................................. 97000-10029

Cover, zero box, RF voltage detector ........................................................................... 97000-20262
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10.2 Data System – Hardware
Kit, Data System, Hardware ...................................................................................... 97044-62111

Cable, thinwire Ethernet...................................................................................... 00012-50969
Connector, T-Connector, thinwire Ethernet ....................................................... 00012-50967
Terminator, thinwire Ethernet............................................................................. 00950-00918
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10.3 Chemicals Kit
Kit, Chemicals ............................................................................................................. 97000-62042

Caffeine, 1 mg/mL, in methanol.......................................................................... 00301-12310
Reserpine, 1 gram................................................................................................. 00301-12901
Met-Arg-Phe-Ala (MRFA), solids ....................................................................... 00301-07702
Sample, Met-Arg-Phe-Ala (MRFA), solids, 20 mg each ................................... 40061-60002
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10.4 Accessory Kit
Accessory Kit ............................................................................................................... 97345-62003

Air duct, 1.0-in. ID, flex, blue, 15 ft. (4.5 m) l..................................................... 00301-08301
Cable, shielded, 2-twisted pair, 22 gauge, 24 ft. (7 m) l ..................................... 00302-01800
Cable, serial, W2690, DB99M-DB9F .................................................................. 00012-51086
Ferrule, HPLC, 1/16-in. stainless steel, Valco (4 each) ...................................... 00101-18122
Ferrule, FingerTight™ 2, Upchurch (3 each) .................................................... 00101-18196
Ferrule, Tefzel, 1/16-in., electrospray (2 each) ................................................... 00102-10148
Ferrule, 0.008-in. ID, KEL-F, HPLC (4 each) .................................................... 00101-18114
Ferrule, 0.016-in. ID, PEEK, HPLC (4 each) ..................................................... 00101-18120
Fitting, ferrule, 1/8-in., Tefzel (2 each)................................................................ 00101-18199
Fitting, ferrule, Swagelok, back, 1/4-in. (2 each) ............................................... 00101-04000
Fitting, ferrule, Swagelok, front, 1/4-in. (2 each) ............................................... 00101-10000
Fitting, ferrule, Swagelok, front, 1/8-in. (2 each) ............................................... 00101-08500
Fitting, ferrule, Swagelok, back, 1/8-in. (2 each) ............................................... 00101-02500
Fitting, FingerTight™ 2, Upchurch (2 each)...................................................... 00101-18195
Fitting, HPLC union, 0.010-in. orifice, PEEK (2 each) ..................................... 00101-18202
Fitting, HPLC, tee, 0.020-in. orifice, PEEK (1 each) ......................................... 00101-18204
Fitting, Swagelok, nut, 1/4-in., brass (1 each) .................................................... 00101-12500
Fitting, Swagelok, nut, 1/8-in., brass (2 each) .................................................... 00101-15500
Fitting, tee, 1-in., barbed (1 each)........................................................................ 00102-10120
Fuse, 0.16 A, 5 × 20 mm, 250 V, time lag (8 each) .............................................. 00006-01700
Fuse, 0.25 A, 5 × 20 mm, 250 V, time lag (2 each) .............................................. 00006-11204
Fuse, 0.40 A, 5 × 20 mm, 250 V, time lag (4 each) .............................................. 00006-05080
Fuse, 0.50 A, 5 × 20 mm, 250 V, quick acting (2 each)....................................... 00006-07608
Fuse, 1.00 A, 5 × 20 mm, 250 V, quick acting (2 each)....................................... 00006-07610
Fuse, 1.60 A, 5 × 20 mm, 250 V, quick acting (2 each)....................................... 00006-08610
Fuse, 2.50 A, 5 × 20 mm, 250 V, T-F (2 each)...................................................... 00006-11202
Fuse, 3.15 A, 5 × 20 mm, 250 V, time lag (4 each) .............................................. 00006-10510
Hose, PVC, reinforced, 1.0-in. ID, 1.25-in. OD .................................................. 00301-24141
Manual, HPLC troubleshooting (1 each)............................................................ 00920-05914
Needle, ESI, D point, 26 gauge, 2-in. long (51 mm) 1 each ............................... 00950-00990
Nut, flangeless, 1/16-in., electrospray (1 pack)................................................... 00102-10146
Nut, 1/16-in., stainless steel, Valco ....................................................................... 00110-16008
O-ring, 0.299-in. ID × 0.103-in. thick, Kalrez..................................................... 00107-10059
Pump oil, rotary-vane vacuum pump, 1 L.......................................................... 00301-15101
Sample loop, 20 µL, stainless steel, Valco ........................................................... 00301-30000
Seal, ESI needle, 5000 series ................................................................................ 00950-00952
Syringe, 10 µL, Rheodyne (1 each)...................................................................... 00301-19008
Syringe, 250 µL, Gastight®, removable needle (2 each) ................................... 00301-19015
Syringe, 500 µL Gastight, removable needle (1 each) ....................................... 00301-19016
Tube, copper, 1/8-in. OD × 0.030-in. wall, refrigerant, 
16.5 ft. (5 m) l......................................................................................................... 00301-22701 
Tube, hypodermic 26 gauge × 10-in. (254 mm), 304S 
stainless steel (1 each) ........................................................................................... 00106-20005
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Tube, Teflon, 0.030-in. ID × 1/16-in. OD, 1.5 ft.
(0.5 m) l.................................................................................................................. 00301-22915
Tubing, 0.25-in. OD × 0.062-in. wall thickness, PFA, 
15 ft. (4.5 m) l ........................................................................................................ 00101-50100
Tubing, fused silica, 0.150 mm ID × 0.390 mm OD, 
2 ft. (0.6 m) l .......................................................................................................... 00106-10498
Tubing, fused silica, 0.050 mm ID × 0.190 mm OD, 
6 ft. (1.8 m) l .......................................................................................................... 00106-10502
Tubing, fused silica, 0.1 mm ID × 0.4 mm OD, 
deactivated 3 ft. (1 m)........................................................................................... 00106-10504
Tubing, fused silica, 0.1 mm ID × 0.190 mm OD, 
6 ft. (1.8 m) l .......................................................................................................... 00106-10499
Tubing, PVC, unreinforced, clear, 3/8-in. ID, 
10 ft. (3 m) l ........................................................................................................... 00301-22895 
Tubing, PEEK, red, 0.005-in. ID × 1/16-in. OD, 
5 ft. (1.5 m) l .......................................................................................................... 00301-22912
Wrench, Allen, hex 1/4-in. ball point .................................................................. 00725-00022
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10.5 Recommended Spares
Battery, 7.2 V, nickel / cadmium ................................................................................... 00301-05720

Bushing, snap, 1.75-in. diameter, white plastic............................................................. 00201-19081

Dc ring filter box ........................................................................................................... 97000-98004

Fan gasket...................................................................................................................... 97000-20298

Fan, 100 cfm, 24 V dc ................................................................................................... 00013-00243

Fan, kit........................................................................................................................... 97000-62021

Filter, fan ....................................................................................................................... 97000-20299

Finger guard .................................................................................................................. 00007-18600

Fitting, Swagelok, bulkhead-union, 1/8-in. × 1/8-in., stainless steel ............................ 00101-02102

Foot, bumper ................................................................................................................. 00007-18115

Fuse, 0.16 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-01700

Fuse, 0.25 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-11204

Fuse, 0.40 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-05080

Fuse, 0.50 A, 5 × 20 mm, 250 V, quick acting .............................................................. 00006-07608

Fuse, 1.00 A, 5 × 20 mm, 250 V, quick acting .............................................................. 00006-07610

Fuse, 1.60 A, 5 × 20 mm, 250 V, quick acting .............................................................. 00006-08610

Fuse, 2.50 A, 5 × 20 mm, 250 V, Type F ...................................................................... 00006-11202

Fuse, 3.15 A, 5 × 20 mm, 250 V, time lag .................................................................... 00006-10510

Hinge, open 180 degree................................................................................................. 00250-08003

Nut, hex-KEP, 6-32, cadmium plated............................................................................ 00460-16321

Nut, hex-KEP, 8-32, stainless steel ............................................................................... 00461-28320

Plug, 1.75-in. diameter, white, nylon ............................................................................ 00201-20500

Pump oil, turbomolecular, reservoir, felt, TPH 240 ...................................................... 00950-01116

Pump oil, rotary-vane vacuum pump, 1 L..................................................................... 00301-15101

Screw, pan head, Phillips, 6-32 × 1 3/4-in., zinc plated ................................................ 00405-63228

Screw, pan head, Phillips, 6-32 × 1/2-in., stainless steel............................................... 00415-63208

Screw, pan head, Phillips, 6-32 × 1/4-in., stainless steel............................................... 00415-63204

Screw, pan head, Phillips, 6-32 × 3/8-in., stainless steel............................................... 00415-63206

Screw, pan head, slot, 2-56 × 1/4-in., stainless steel ..................................................... 00414-25604

Screw, pan head, slot, 6-32 × 1/4-in., cadmium plated ................................................. 00404-63204

Stud, ball, 6-32 × 0.375-in............................................................................................. 00201-12110
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Switchcap, manifold cover, interconnect ...................................................................... 97000-40009

Switchcap, right door, interconnect .............................................................................. 97000-40010

Tubing, Teflon, 18 gauge, 0.016-in. wall thickness ...................................................... 00007-94330

Valve assembly, sheath/aux gas, dual manifold .............................................................00110-20014

Washer, flat, #6, stainless steel ..................................................................................... 00472-00600

Washer, interlock, 5/16-in. ID, stainless steel............................................................... 00479-04400
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10.6 Divert / Inject Valve Accessories
Ferrule, HPLC 1/16-in. stainless steel, Valco................................................................ 00101-18122

Syringe adapter, 1/16-in. fill port liner / ferrule, Valco ................................................. 00110-16002

Syringe adapter, 1/16-in. fill port, Valco ....................................................................... 00110-16000

Valve, replacement nut, 1/16-in. HPLC, stainless steel ................................................ 00110-16008

Valve, replacement rotor seal, Valco ............................................................................. 00110-16006

Valve, replacement stator, Valco ................................................................................... 00110-16004

5 µL sample loop, stainless steel, Valco........................................................................ 00110-16010

20 µL sample loop, stainless steel, Valco...................................................................... 00301-30000
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10.7 Optional Tools
Hexdriver, 0.28-in. ........................................................................................................ 00025-01810

Hexdriver, 0.35-in. ........................................................................................................ 00025-08041

Tool pin extractor, AMP, large...................................................................................... 00725-00013

Tool pin extractor, AMP, small ..................................................................................... 00725-00020

Wrench, Allen / hex drive, 1/4-in. (with handle) .......................................................... 00725-00015

Tool, capillary removal ..................................................................................................70111-20258

Tool, removal, TEE seal................................................................................................ 70005-20304
������
���������������	�
��10-18__________________ Finnigan LCQ Series Hardware Manual ____________________



Index
�������������	
��
�_____________________________________________________________________
Index

Symbols
+24 V keep alive power supply description, 2-33
+36 V, -28 V dc switching power supply

description, 2-34
replacing, 7-8, 8-10

+48 V, +24 V dc switching power supply
description, 2-33
replacing, 7-8, 8-10
servicing (CAUTION), 7-8, 8-10

+5 V, ±15 V, +24 V dc switching power supply
replacing, 7-8, 8-10

+5 V, 15 V, +24 V dc switching power supply
description, 2-34

± 210 V dc linear power supply
description, 2-34
replacing, 7-8, 8-10

#
4-pin feedthroughs location (figure), 2-28
8 kV power supply

description, 2-34
replacing, 7-8, 8-10

8-pin feedthroughs location (figure), 2-28

A
Accessory kit

LCQ Advantage MAX replaceable parts, 9-13
LCQ Deca XP MAX replaceable parts, 10-13

Acquisition DSP PCB
description, 2-45
location (figure), 7-12, 8-16
replacing, 7-11

acquisition DSP PCB replacing, 8-15
Agilent

1100 LC, 2-4
Air leaks

checking for, 3-4
indications of, 3-4

Analog input ports location (figure), 2-32
Analyzer Auxiliary PCB

fuses, 8-6
fuses, replacing, 8-6

Analyzer mount
location (figure), 4-24, 4-26, 4-27, 5-24, 5-26, 5-27

Analyzer region, vacuum manifold
description, 2-26
location (figure), 2-27

Anode feedthrough, electron multiplier
location (figure), 4-42, 5-42

Anode, electron multiplier
description, 2-22
location (figure), 4-42, 5-42
replacing, 4-40, 5-40

APCI probe

flushing, 5-6
APCI probe flushing, 4-6
APCI source on/off status (table), 6-16
API heater location (figure), 4-16, 5-16
API probe flushing (note), 4-12, 5-12
API source

API stack, 2-11
control circuitry, 2-37
description, 2-11
maintenance overview, 4-6, 5-6
on/off status (table), 6-16

API stack
cleaning, 4-11, 4-17, 5-11, 5-17
cross sectional view (figure), 2-12
description, 2-11
disassembling, 4-14, 5-14
exploded view (figure), 4-16, 5-16
extension mount, 2-13
figure, 4-14, 5-14
heater assembly, 2-13
ion sweep cone, 2-13
ion transfer capillary, 2-13
ion transfer capillary, replacing, 4-11, 5-11
maintaining, 4-11, 5-11
reassembling, 4-18, 5-18
reinstalling, 4-20, 5-19
removing, 4-13, 5-13
replaceable parts, 9-2, 10-2
skimmer, 2-14
spray cone, 2-13
spray shield, 2-13
tube lens, 2-13
tube lens and skimmer mount, 2-14
vent prevent ball valve, 2-13

Assemblies
mechanical, replaceable parts, 9-7, 10-7
replacing, 7-8, 8-10
vacuum system, replaceable parts, 9-6, 10-6

AT box, See Embedded computer, 7-12, 8-16
Atmospheric pressure ionization source, 2-11
Autosampler

description, 2-3
startup, 6-8
TSP AS, 2-3

Auxiliary Amplifier PCB description, 2-41
Auxiliary gas

on/off status (table), 6-16
pressure, 2-31

Auxiliary gas valve description, 2-31

B
Baffle, top cover plate location (figure), 4-24, 5-24
Battery backup

description, 2-40
replacing, 7-15
vent valve, 2-30
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Cables

LCQ Advantage MAX replaceable parts, 9-9
LCQ Deca XP MAX replaceable parts, 10-9

Capillary-skimmer region lid location (figure), 2-27
Cathode, electron multiplier

description, 2-22
location (figure), 4-43, 5-43
replacing, 4-40, 5-40

CAUTIONS
APCI vaporizer high temperature, 4-9, 5-9
chemical disposal, 4-4, 5-4
fuse replacement, 7-5, 8-5
nitrogen supply, 3-3
PCB replacement, 7-8, 8-10
RF Voltage Amplifier PCB, replacing fuses, 7-5, 8-5
Switched Balun PCB, replacing fuses, 7-5, 8-5
System Control PCB, replacing fuses, 7-5, 8-5

Cautions
air leaks, 3-4
fuse replacement, 7-5, 8-6
inserting probes in connector sockets, 7-8, 8-10
mass analyzer spacer rings, 4-29, 5-29
MS detector covers, 2-32
rotary-vane pump, 2-30
spacer rings, handling, 4-28, 5-28
spring in extension mount, 4-15, 5-15

Centroid scan defined, 1-10
Charge state determined by ZoomScan, 1-9
Chemicals kit

replaceable parts, 9-12, 10-12
Chemicals, disposal of (warning), 4-4, 5-4
Circuit breaker, 2-9
Cleaning procedures

APCI probe, flushing, 4-6, 5-6
API probe, 4-6, 5-6
API stack components, 4-17, 5-17
conversion dynode, 4-31, 5-33
electron multiplier, 4-31, 5-33
ESI probe, flushing, 4-6, 5-6
fan filter, 4-49, 5-48
frequency, 4-5, 5-5
ion detection system, 4-31, 5-33
ion optics, 4-21, 5-21
ion transfer capillary, 4-8, 5-8
mass analyzer, 4-21, 5-21
sample transfer line, 4-6, 5-6
sample tube, 4-6, 5-6
spray shield, 4-8, 5-8
vacuum manifold, 4-33, 5-33

Communication LED
description, 2-8
MS detector reset, 6-11
MS detector startup, 6-8
note, 6-13

Computer features, 2-47
Contact closure ports, location (figure), 2-32
Control DSP PCB

description, 2-44
location (figure), 7-12, 8-16
replacing, 7-11

control DSP PCB, replacing, 8-15
Convectron gauge

control circuitry, 2-37
description, 2-30
on/off status (table), 6-16
pressure readings (table), 3-5

Conversion dynode
cleaning, 4-31, 5-33
control circuit, 2-37
location (figure), 2-27
on/off status (table), 6-16
voltages, 2-22

Conversion dynode power supply, replacing, 7-15, 8-20
Cooling fans, description, 2-32
Corona discharge needle voltage, on/off status (table), 
6-16
Covers

LCQ Advantage MAX
replaceable parts, 9-10

LCQ Deca XP MAX
replaceable parts, 10-10

right side, reinstalling, 7-6, 7-26, 8-7
right side, removing, 7-6, 7-24, 8-7
top, reinstalling, 4-34, 5-34
top, removing, 4-22, 5-22

CPU PCB
location (figure), 7-12, 8-16
replacing, 7-11, 8-15

Cross sectional views
API stack, 2-12
electron multiplier, 2-23
ion detection system, 2-23
ion optics, 2-15, 2-16
mass analyzer, 2-18

D
Daily maintenance

API probe, flushing, 4-6, 5-6
ion transfer capillary, flushing, 4-8, 5-8
rotary-vane pump oil, purging, 4-45, 5-45
sample tube, flushing, 4-6, 5-6
spray shield, flushing, 4-8, 5-8
transfer line, flushing, 4-6, 5-6

Daily system checks
air leaks, 3-4
disk space, 3-2
helium supply, 3-3
nitrogen supply, 3-3
overview, 3-1
Status view hard copy, 3-6

Damping gas
description, 2-20
on/off status (table), 6-16
shutoff (note), 2-31

Damping gas inlet, location (figure), 2-28
Damping gas nipple, location (figure), 4-27, 5-27
Damping gas valve, description, 2-31
Data system

description, 2-47
instrument interface, 2-47
personal computer, 2-47
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primary Ethernet adapter, 2-47
resetting, 6-13
secondary Ethernet adapter, 2-48
shutdown, 6-6
startup, 6-7

Data system hardware
LCQ Advantage MAX

replaceable parts, 9-11
LCQ Deca XP MAX

replaceable parts, 10-11
Data types defined, 1-10
dc ring filter, description, 2-41
Detector system, 2-22
Diagnostics dialog box (figure), 4-35, 5-36
Diagnostics, running, 7-2, 8-2
Disk space, checking, 3-2
Divert/inject valve

button and LEDs (figure), 2-9
button, location (figure), 2-6
control circuitry, 2-36
description, 2-6
Divert/inject Valve dialog box, 2-6
LCQ Advantage MAX

replaceable parts, 9-5
LCQ Deca XP MAX

replaceable parts, 10-5
LEDs, location (figure), 2-6
location (figure), 2-6
loop injection, 2-6
replaceable parts, 9-17, 10-17
syringe port, location (figure), 2-6

Dynode, 2-22

E
Electrical assemblies

LCQ Advantage MAX, replaceable parts, 9-7
LCQ Deca XP MAX, replaceable parts, 10-7

Electrical feedthroughs, vacuum manifold, 2-28
Electrodes

entrance endcap electrode, 2-17
exit endcap electrode, 2-17
ring electrode, 2-17

Electrometer circuit, description, 2-43
Electron multiplier, 2-22

anode, description, 2-22
anode, location (figure), 4-42, 5-42
cathode, location (figure), 4-43, 5-43
checking, 4-40, 5-40
cleaning, 4-31, 5-33
control circuitry, 2-37
cross sectional view (figure), 2-23
description, 2-22, 2-43
exploded view (figure), 4-42, 4-43, 5-42, 5-43
location (figure), 2-28
on/off status (table), 6-16
replacing, 4-40, 5-40
voltage, setting, 4-44, 5-44
voltages, 2-22

Electron multiplier power supply, replacing, 7-15, 8-20
Electron multiplier shield, location (figure), 4-43
Electron multiplier shield, ocation (figure), 5-43

Electron multiplier support, location (figure), 4-42, 5-42
Electronic assemblies

+36 V, -28 V dc switching power supply, replacing, 7-8, 
8-10

+48 V, +24 V dc switching power supply, replacing, 7-8, 
8-10

+5 V, ±15 V, +24 V dc switching power supply, 
replacing, 7-8, 8-10

± 210 V linear power supply, replacing, 7-8, 8-10
8 kV power supply, replacing, 7-8, 8-10
Acquisition DSP PCB, description, 2-45
Acquisition DSP PCB, location (figure), 7-12, 8-16
Acquisition DSP PCB, replacing, 7-11
Control DSP PCB, description, 2-44
Control DSP PCB, location (figure), 7-12, 8-16
Control DSP PCB, replacing, 7-11
CPU PCB, location (figure), 7-12, 8-16
CPU PCB, replacing, 7-11
description, 2-32
Ethernet adapter, description, 2-45
Ethernet PCB, location (figure), 7-12, 8-16
Ethernet PCB, replacing, 7-11
ion detection system, 2-42
Low Pass Filter PCB, description, 2-41
Low Pass Filter PCB, location (figure), 7-24, 8-28
Low Pass Filter PCB, replacing, 8-29
power distribution, 2-35
Power Module, description, 2-33
replacing, 7-8, 8-10
RF Voltage Amplifier PCB, description, 2-41
RF Voltage Amplifier PCB, replacing, 7-15, 8-20
RF Voltage Control PCB, description, 2-41
RF Voltage Control PCB, location (figure), 7-24, 8-28
RF Voltage Control PCB, replacing, 7-23, 8-27
RF/waveform voltage generation, description, 2-40
Serial I/O PCB, replacing, 7-11
Switched Balun PCB, description, 2-41
Switched Balun PCB, replacing, 7-15
System Control PCB, description, 2-36
System Control PCB, replacing, 7-21, 8-25
Top Cover PCB, description, 2-42
Top Cover PCB, replacing, 7-15
Turbomolecular Pump Controller, description, 2-40
Turbomolecular Pump Controller, replacing, 7-8, 8-10
vacuum system, 2-38
Vent Delay PCB, description, 2-40
Vent Delay PCB, replacing, 7-13, 8-17
Waveform Amplifier PCB, description, 2-41
Waveform Amplifier PCB, replacing, 7-15, 8-20
Waveform DDS PCB, description, 2-41
Waveform DDS PCB, location (figure), 7-12, 8-16
Waveform DDS PCB, replacing, 7-11

Electronics service switch
description, 2-9, 2-34
location (figure), 6-2, 6-3
MS detector components on/off status, 6-16
MS detector, description, 2-33

Embedded computer
description, 2-44
functional block diagram, 2-46
location (figure), 7-12, 8-16
PCBs, replacing, 7-11
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resetting, 6-11
temperature warning, 2-7

embedded computer, replacing PCBs, 8-15
Emergency shutdown

main power circuit breaker, 2-9
note, 2-9, 2-34
procedure, 6-2

Entrance endcap electrode
description, 2-17
location (figure), 2-18, 4-27, 5-27
wiring diagram, 4-32, 5-32

ESI needle, voltage, on/off status (table), 6-16
ESI probe, flushing, 4-6, 5-6
ESI source, on/off status (table), 6-16
Ethernet adapter, description, 2-45
Ethernet PCB

location (figure), 7-12, 8-16
replacing, 7-11

ethernet PCB, replacing, 8-15
Exit endcap electrode

description, 2-17
location (figure), 2-18, 4-27, 5-27
wiring diagram, 4-32, 5-32

Exit lens
description, 2-17
location (figure), 2-18, 4-27, 5-27
wiring diagram, 4-32, 5-32

Exit lens sleeve, location (figure), 4-27, 5-27
Exploded views

API stack, 4-16, 5-16
API stack, front end, 4-19, 5-19
electron multiplier, 4-42, 4-43, 5-42, 5-43
ion optics, 4-26, 5-26
mass analyzer, 4-27, 5-27

Extension mount
description, 2-13
location (figure), 2-12, 4-14, 4-16, 5-14, 5-16

F
Failure condition

description, 2-8
Power LED, 2-8

Fan filter, cleaning, 4-49, 5-48
Fans

description, 2-32
filter, cleaning, 4-49, 5-48
on/off status (table), 6-16

Feedthroughs
4-pin, location (figure), 2-28
4-pin, wiring diagram, 4-32, 5-32
8-pin, location (figure), 2-28
8-pin, wiring diagram, 4-32, 5-32
vacuum manifold, 2-28

Figures
API stack, 2-12, 4-14, 5-14
API stack (front end), 4-19, 5-19
API stack exploded view, 4-16, 5-16
Assemblies accessible from top of MS detector, 7-14, 

8-18
Diagnostics dialog box, 4-35, 5-36, 7-3, 8-3
divert/inject valve, 2-6

divert/inject valve button and LEDs, 2-9
electron multiplier exploded view, 4-42, 4-43, 5-42, 

5-43
embedded computer functional block diagram, 2-46
front panel LEDs, 2-8
Graph view, octapole RF voltage tuning, 4-36, 5-36
Graph view, ring electrode RF voltage modulation 

tuning, 4-37, 5-37
Graph view, ring electrode RF voltage tuning, 4-38, 

5-38
I/O panel, 2-32
ion detection system, 2-23
ion detection system electronic assemblies, 2-43
ion optics and mass analyzer, 4-24, 5-24
ion optics exploded view, 4-26, 5-26
LCQ Advantage MAX system, 1-1
LCQ Advantage MAX system (block diagram), 2-2
LCQ Advantage MAX vacuum system electronic 

assemblies, 2-39
LCQ Advantage MAX vacuum system functional block 

diagram, 2-25
LCQ Deca XP MAX vacuum system electronic 

assemblies, 2-39
LCQ Deca XP MAX vacuum system functional block 

diagram, 2-26
left side of MS detector, 7-24, 8-28
mass analyzer cross sectional view, 2-18
mass analyzer exploded view, 4-27, 5-27
PCBs accessible from top of MS detector, 7-14, 8-18
Power Module and power distribution, 2-35
power panel

LCQ Advantage MAX, 2-10, 6-2
LCQ Deca XP MAX, 2-10, 6-3

RF/waveform voltage generation electronic 
assemblies, 2-42

syringe pump, 2-5
System Control PCB, 7-7, 8-8
System Control PCB fuses, 7-7, 8-8
top cover plate of vacuum manifold, 2-28
tower, 7-9, 8-11
turbomolecular pump, 4-47, 5-46
vacuum manifold (interior), 2-27
vacuum manifold cover plate, 4-23, 5-23
wiring diagram, 4-32, 5-32

First octapole region, vacuum manifold
description, 2-26
location (figure), 2-27

First octapole, location (figure), 4-24, 4-26, 5-24, 5-26
Foreline union, location (figure), 4-47, 5-46
Forepump

power cord (caution), 2-30
Front panel LEDs

description, 2-7
figure, 2-8

Full scan mode
defined, 1-6

Full scan type
single stage, defined, 1-6
two stage, defined, 1-7

Functional description
autosampler, 2-3
data system, 2-47
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divert/inject valve, 2-6
LCQ Advantage MAX system, 2-1
liquid chromatograph, 2-4
mass analyzer, 2-17
MS detector, 2-7
syringe pump, 2-5

Fuses, MS detector
replacing, 7-5, 8-5
replacing (CAUTION), 7-5, 8-5
RF Voltage Amplifier PCB, 7-5, 8-6
Switched Balun PCB, 7-5
System Control PCB, 7-5, 8-6
table, 7-5

G
Graph view

octapole RF voltage tuning (figure), 4-36, 5-36
ring electrode RF voltage modulation tuning (figure), 

4-37, 5-37
ring electrode RF voltage tuning (figure), 4-38, 5-38

Guide posts, location (figure), 2-28

H
Hard drive, checking disk space, 3-2
Hardware data system

LCQ Advantage MAX
replaceable parts, 9-11

LCQ Deca XP MAX
replaceable parts, 10-11

Heater assembly, description, 2-13
Heater block, location (figure), 2-12
Helium damping gas, 2-20
Helium gas inlet, location (figure), 2-32
Helium supply

checking, 3-3
pressure, 3-3
shutoff (note), 2-31

Hewlett Packard
1050 LC, 2-4
1090 LC, 2-4

High speed serial line, description, 2-44
High voltage feedthrough, electron multiplier, location 
(figure), 4-42, 5-42
High voltage ring, electron multiplier, location (figure), 
4-43, 5-43
High voltage tube, electron multiplier, location (figure), 
4-43, 5-43
HPLC, 2-4

I
I/O panel (figure), 2-32
Inlet gasses hardware

auxiliary gas valve, 2-31
damping gas valve, 2-31
description, 2-24
functional block diagram

LCQ Advantage MAX, 2-25
LCQ Deca XP MAX, 2-26

sheath gas valve, 2-31
vent valve, 2-30

Instrument Configuration window, opening, 2-3
Instrument Setup window, opening, 2-3
Interoctapole lens

description, 2-15
location (figure), 4-26, 5-26
on/off status (table), 6-16
voltages, 2-15
wiring diagram, 4-32, 5-32

Ion detection system
cleaning, 4-31, 5-33
conversion dynode, 2-22
cross sectional view (figure), 2-23
description, 2-22
electron multiplier gain, 2-24
electron multiplier voltage, setting, 4-44, 5-44
electron multiplier, checking, 4-40, 5-40
electron multiplier, description, 2-22
electron multiplier, replacing, 4-40, 5-40
electronic assemblies, 2-42
functional block diagram, 2-43
on/off status (table), 6-16
replaceable parts, 9-4, 10-4

Ion gauge
control circuitry, 2-37
description, 2-30
on/off status (table), 6-16
pressure readings (table), 3-5
replacing, 7-13, 8-17

Ion optics
cleaning, 4-21, 5-21
disassembling, 4-25, 5-25
exploded view (figure), 4-26, 5-26
interoctapole lens, description, 2-15
LCQ Advantage MAX

cross sectional view (figure), 2-15
description, 2-14
RF voltage, 2-14

LCQ Deca XP MAX
cross sectional view (figure), 2-16

location (figure), 2-28
octapoles, description, 2-14
on/off status (table), 6-16
reassembling, 4-28, 5-29
reinstalling, 4-30, 5-30
removing, 4-23, 5-23
replaceable parts, 9-3
split octapole, description, 2-14

Ion polarity modes, defined, 1-3
Ion sweep cone

description, 2-13
location (figure), 2-12, 4-19, 5-19

Ion transfer capillary
cleaning, 4-17, 5-17
description, 2-13
flushing, 4-8, 5-8
heater control circuit, 2-37
location (figure), 2-12, 4-19, 5-19
on/off status (table), 6-16
replacing, 4-11, 5-11
unblocking (note), 4-11, 5-11
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Ion transfer capillary-skimmer region, vacuum manifold
description, 2-26

Ion trap, 2-17

K
Kit, accessory

LCQ Advantage MAX, replaceable parts, 9-13
LCQ Deca XP Max, replaceable parts, 10-13

Kit, chemicals
replaceable parts, 10-12

Kit, chemicals, replaceable parts, 9-12

L
LC, 2-4
LCQ Advantage MAX system

figure, 1-1
functional description, 2-1
power panel (figure), 2-10
replaceable parts, 9-1
service philosophy, 7-1

LCQ Deca XP MAX system
power panel (figure), 2-10
replaceable parts, 10-1
service philosophy, 8-1

LCQ Deca XP Max system
diagnostics, 8-2

LCQ Series system
autosampler, 2-3
complete shutdown, 6-5
daily system checks, 3-1
data system, 2-47
data types, 1-10
diagnostics, 7-2
divert/inject valve, 2-6
Failure condition, 2-8
ion polarity modes, 1-3
ionization modes, 1-4
LEDs and system startup, 6-11
liquid chromatograph, 2-4
MS detector, 2-7
Normal condition, 2-7
operating conditions, setting, 6-9
parameters, displaying, 3-6
scan mode, 1-5
scan types, 1-6
standby condition, 6-4
startup, 6-7
syringe pump, 2-5
Warning condition, 2-8

LCQ-Series system
overview, 1-1

Leaks
checking for, 3-4
indications of, 3-4

LEDs
Communication LED, 2-8
Communication LED, MS detector reset, 6-11
Communication LED, MS detector startup, 6-8
divert/inject valve LEDs, 2-8

Power LED, 2-7
Power LED, MS detector reset, 6-11
Power LED, MS detector startup, 6-8
Scan LED, 2-8
syringe pump LED, 2-5, 2-8
System LED, 2-8
System LED, MS detector reset, 6-11
System LED, MS detector startup, 6-8
Vacuum LED, 2-7, 2-8

Left side cover
reinstalling, 7-26, 8-29
removing, 7-24, 8-27

Line filter
description, 2-33

Line power
specifications, 2-33

Liquid chromatograph (LC)
functional description, 2-4
solvent flow, turning off, 6-4
startup, 6-7

Loop injection
divert/inject valve, 2-6

Low Pass Filter PCB
description, 2-41
location (figure), 7-24, 8-28
replacing, 8-29

M
Main power circuit breaker

description, 2-9
emergency shutdown, 2-9
MS detector components on/off status, 6-16

Main power circuit breaker switch
location (figure), 6-3

Maintenance
API probe, flushing, 4-6, 5-6
API source, overview, 4-6, 5-6
API stack, 4-11, 5-11
API stack, cleaning, 4-17, 5-17
fan filter, cleaning, 4-49, 5-48
ion optics, cleaning, 4-21, 5-21
ion transfer capillary, cleaning, 4-8, 5-8
keys to success (note), 4-3, 5-3
LCQ Deca XP MAX

overview, 5-1
mass analyzer, cleaning, 4-21, 5-21
overview, 4-1
procedures (table), 4-1, 5-1
rotary-vane pump oil, purging, 4-45, 5-45
sample transfer line, flushing, 4-6, 5-6
sample tube, flushing, 4-6, 5-6
spray shield, cleaning, 4-8, 5-8
supplies, 4-4, 5-4
tools, 4-4, 5-4
turbomolecular pump, changing oil reservoir, 4-47
turbomolecular pump, replacing (note), 4-46

Maintenance procedures
frequency, 4-1, 5-1

Mass analyzer, 2-17
cleaning, 4-21, 5-21
cross sectional view (figure), 2-18
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dc offset voltage, 2-17
description, 2-17
disassembling, 4-25, 5-25
electrodes, 2-17
entrance endcap electrode, 2-17
exit endcap electrode, 2-17
exit lens, 2-17
exploded view (figure), 4-27, 5-27
helium damping gas, 2-20
LCQ Advantage MAX

replaceable parts, 9-4
LCQ Deca XP MAX

replaceable parts, 10-4
location (figure), 2-28
on/off status (table), 6-16
operation, 2-21
reassembling, 4-28, 5-29
reinstalling, 4-30, 5-30
removing, 4-23, 5-23
RF voltage, 2-18
ring electrode, 2-17
ring electrode RF voltage, 2-18
spacer rings, 2-18
spacer rings, handling (caution), 4-29, 5-29
wiring diagram, 4-32, 5-32

Mechanical assemblies
replaceable parts, 9-7, 10-7

Mechanical pump, 2-29
MS detector

API source, 2-11
calibration (note), 3-1, 6-9
covers, caution, 2-32
damping gas valve, 2-31
data types, 1-10
diagnostics, 7-2, 8-2
electronic assemblies, 2-32
electronics service switch, 2-33
emergency shutdown, 6-2
Failure condition, 2-8
fans, 2-32
features, 2-7
frequency of cleaning, 4-5, 5-5
functional description, 2-7
fuses (table), 7-5
fuses, replacing, 7-5, 8-5
inlet gasses hardware, 2-24
ion detection system, 2-22
ion detection system electronic assemblies, 2-42
ion gauge, 2-30
ion polarity modes, 1-3
ionization modes, 1-4
LCQ Advantage MAX

ion optics, 2-14
replaceable parts, 9-2

LCQ Deca XP MAX
replaceable parts, 10-2

maintenance overview, 4-1, 5-1
maintenance procedures (table), 4-1, 5-1
mass analyzer, 2-17
mass analyzer (figure), 2-18
Normal condition, 2-7
off condition, 6-16

on/off status of components, 6-16
Power Module, description, 2-33
pressure readings (table), 3-5
resetting, 6-11
RF/waveform voltage generation electronic 

assemblies, 2-40
scan mode, 1-5
scan types, 1-6
service philosophy, 7-1, 8-1
shutdown, 6-5
standby condition, 6-4, 6-16
startup, 6-7
switching power supplies, 2-34
System Control PCB, 2-36
top cover, reinstalling, 4-34, 5-34
top cover, removing, 4-22, 5-22
transformer, description, 2-34
tuning (note), 3-1, 6-9
turbomolecular pump, 2-29
turning off, 6-15
vacuum manifold, 2-26
vacuum system, 2-24
vacuum system electronic assemblies, 2-38
vent valve, 2-30
Warning condition, 2-8

MS scan mode
defined, 1-5

MS/MS scan
selected reaction monitoring (SRM), 1-8

MSn scan mode
defined, 1-5

N
Nanospray ion source

maintenance procedures (note), 4-6, 5-6
Nitrogen

pressure, 2-31
rate of consumption, 3-3

Nitrogen gas inlet
location (figure), 2-32

Nitrogen supply
CAUTION, 3-3
checking, 3-3
pressure, 3-3

Normal condition
description, 2-7
Power LED, 2-7

Notes
APCI vaporizer high temperature, 4-10, 5-10
calibration frequency, 3-1
Communication LED, 6-13
damping gas shutoff, 2-31
detector calibration, 3-1
detector tuning, 3-1
emergency shutdown, 2-9, 2-34
flushing API probe, 4-12, 5-12
maintenance keys to success, 4-3, 5-3
MS detector calibration, 6-9
MS detector tuning, 6-9
nanospray ion source maintenance procedures, 4-6, 
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solvents, cleaning, 4-17, 5-17
tuning frequency, 3-1
turbomolecular pump, replacing, 4-46
unblocking ion transfer capillary, 4-11, 5-11
vacuum LED, 6-8

Nuts, mass analyzer
location (figure), 4-27, 5-27

O
Octapole mount

location (figure), 4-24, 4-26, 5-24, 5-26
Octapoles

dc offset voltage, 2-14
description, 2-14
location (figure), 4-24, 4-26, 5-24, 5-26
on/off status (table), 6-16
RF voltage, 2-14
RF voltage, tuning, 4-34, 5-34
wiring diagram, 4-32, 5-32

Off condition
MS detector components on/off status, 6-16

O-rings
vacuum manifold, location (figure), 2-27

P
Parent ions

defined, 1-5
Part numbers, 9-1, 10-1
PCBs

Acquisition DSP PCB, description, 2-45
Acquisition DSP PCB, location (figure), 7-12, 8-16
Acquisition DSP PCB, replacing, 7-11
Control DSP PCB, description, 2-44
Control DSP PCB, location (figure), 7-12, 8-16
Control DSP PCB, replacing, 7-11
CPU PCB, location (figure), 7-12, 8-16
CPU PCB, replacing, 7-11
Ethernet PCB, location (figure), 7-12, 8-16
Ethernet PCB, replacing, 7-11
Low Pass Filter PCB, description, 2-41
Low Pass Filter PCB, location (figure), 7-24, 8-28
Low Pass Filter PCB, replacing, 8-29
replaceable parts, 9-8, 10-8
replacing, 7-8, 8-10
replacing (CAUTION), 7-8, 8-10
RF Control PCB, description, 2-41
RF Voltage Amplifier PCB, description, 2-41
RF Voltage Amplifier PCB, replacing, 7-15, 8-20
RF Voltage Control PCB, location (figure), 7-24, 8-28
RF Voltage Control PCB, replacing, 7-23, 8-27
Serial I/O PCB, replacing, 7-11
Switched Balun PCB, description, 2-41
Switched Balun PCB, replacing, 7-15
System Control PCB, description, 2-36
System Control PCB, replacing, 7-21, 8-25
Top Cover PCB, description, 2-42
Top Cover PCB, replacing, 7-15
Vent Delay PCB, description, 2-40

Vent Delay PCB, replacing, 7-13, 8-17
Waveform Amplifier PCB, description, 2-41
Waveform Amplifier PCB, replacing, 7-15, 8-20
Waveform DDS PCB, description, 2-41
Waveform DDS PCB, location (figure), 7-12, 8-16
Waveform DDS PCB, replacing, 7-11

Personal computer
features, 2-47

Posts, mass analyzer
location (figure), 4-27, 5-27

Power
specifications, 2-33

Power cord
rotary-vane pump (caution), 2-30

Power distribution
description, 2-33
functional block diagram, 2-35

Power LED
description, 2-7
Failure condition, 2-7
MS detector reset, 6-11
MS detector startup, 6-8
Normal condition, 2-7
Warning condition, 2-7

Power Module
description, 2-33
functional block diagram, 2-35

Power panel (figure)
LCQ Advantage MAX, 2-10
LCQ Deca XP MAX, 2-10
LQC Advantage MAX, 6-2
LQC Deca XP MAX, 6-3

Power supplies
+36 V, -28 V dc switching power supply, replacing, 7-8, 

8-10
+48 V, +24 V dc switching power supply, replacing, 7-8, 

8-10
+5 V, ±15 V, +24 V dc switching power supply, 

replacing, 7-8, 8-10
± 210 V linear power supply, replacing, 7-8, 8-10
8 kV power supply, replacing, 7-8, 8-10
conversion dynode power supply, description, 2-43
conversion dynode power supply, replacing, 7-15, 8-20
electron multiplier power supply, description, 2-43
electron multiplier power supply, replacing, 7-15, 8-20
on/off status (table), 6-16
replaceable parts, 9-7, 10-7

Pressure
checking, 3-4
readings (table), 3-5

Printer
setting up, 2-48

Product ions
defined, 1-5

Profile scan
defined, 1-10

Pumps
rotary-vane pump, 2-29
turbomolecular pump, 2-29
turbomolecular pump maintenance, 4-46
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Q
Quadrupole ion trap, 2-17

R
Reagents

disposal (warning), 4-4, 5-4
Recommended spares

LCQ Advantage
replaceable parts, 9-15

LCQ Deca XP MAX
replaceable parts, 10-15

Replaceable parts
API stack, 9-2, 10-2
cables, 9-9, 10-9
chemicals kit, 9-12, 10-12
covers, 10-10
divert/inject valve, 9-5, 9-17, 10-5, 10-17
electrical assemblies, 9-7, 10-7
ion detection system, 9-4, 10-4
ion optics, 9-3
LCQ Advantage MAX

accessory kit, 9-13
covers, 9-10
hardware data system, 9-11
recommended spares, 9-15

LCQ Deca XP MAX
accessory kit, 10-13
hardware data system, 10-11
recommended spares, 10-15

mass analyzer, 9-4, 10-4
mechanical assemblies, 9-7, 10-7
MS detector, 9-2, 10-2
optional tools, 9-18, 10-18
PCBs, 9-8, 10-8
RF control / detection assemblies, 9-8, 10-8
rotary-vane pump, 9-6, 10-6
top cover plate of vacuum manifold, 9-5, 10-5
turbomolecular pump, 9-5
vacuum assemblies, 9-6, 10-6

Replacement procedures
+36 V, -28 V dc switching power supply, 7-8, 8-10
+48, +24V dc switching power supply, 7-8, 8-10
+5 V, ±15 V, +24 V dc switching power supply, 7-8, 

8-10
± 210 V dc linear power supply, 7-8, 8-10
8 kV power supply, 7-8, 8-10
Acquisition DSP PCB, 7-11
anode, electron multiplier, 4-40, 5-40
battery backup, 7-15, 8-17
cathode, electron multiplier, 4-40, 5-40
Control DSP PCB, 7-11
conversion dynode power supply, 7-15, 8-20
CPU PCB, 7-11
electron multiplier, 4-40, 5-40
electron multiplier power supply, 7-15, 8-20
embedded computer PCBs, 7-11
Ethernet PCB, 7-11
fuses, 7-5, 8-5
ion gauge, 7-13, 8-17

ion transfer capillary, 4-11, 5-11
Low Pass Filter PCB, 8-29
oil reservoir, turbomolecular pump, 4-47
RF Voltage Amplifier PCB, 7-15, 8-20
RF Voltage Control PCB, 7-23, 8-27
Serial I/O PCB, 7-11
Switched Balun PCB, 7-15
switching power supplies, 7-8, 8-10
System Control PCB, 7-21, 8-25
Top Cover PCB, 7-15
turbomolecular pump (note), 4-46
Turbomolecular Pump Controller, 7-8, 8-10
Vent Delay PCB, 7-13, 8-17
vent valve, 7-13, 8-17
Waveform Amplifier PCB, 7-15, 8-20
Waveform DDS PCB, 7-11

Reset button
LCQ Series reset, 6-11
location (figure), 6-2, 6-3

Resonance ejection RF voltage
description, 2-20

Resonance excitation RF voltage
description, 2-19

Retainer clip, API stack
location (figure), 4-14, 4-16, 5-14, 5-16

RF control / detection assemblies
LCQ Advantage

replaceable parts, 9-8
LCQ Deca XP MAX

replaceable parts, 10-8
RF Voltage Amplifier PCB

description, 2-41
fuses, replacing, 7-5, 8-6
fuses, replacing (CAUTION), 7-5, 8-5
replacing, 7-15, 8-20

RF voltage coil
description, 2-41

RF Voltage Control PCB
description, 2-41
location (figure), 7-24, 8-28
replacing, 7-23, 8-27

RF voltages
ion isolation waveform, 2-19
mass analyzer ring electrode, 2-18
octapoles, 2-14
octapoles, tuning, 4-34, 5-34
resonance ejection RF voltage, 2-20
resonance voltage, 2-19
ring electrode RF voltage, 2-18
ring electrode, tuning, 4-34, 5-34
storage voltage, 2-19
tuning stud, location (figure), 4-39, 5-39

RF/waveform voltage generation
functional block diagrams, 2-42

Right side cover
reinstalling, 7-6, 8-7
removing, 7-6, 8-7

Ring electrode
description, 2-17
location (figure), 2-18, 4-27, 5-27

Ring electrode RF voltage
description, 2-18
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manual adjustment, 4-38, 5-39
tuning, 4-34, 5-34

Ring electrode RF voltage feedthrough
location (figure), 2-27

Rotary-vane pump
description, 2-29
oil, purging, 4-45, 5-45
on/off status (table), 6-16
replaceable parts, 9-6, 10-6
servicing (CAUTION), 7-8, 8-10

Rough pump, 2-29

S
safety precautions, 1-xviii
Sample transfer line

flushing, 4-6, 5-6
Sample tube

flushing, 4-6, 5-6
Scan

defined, 1-2
Scan data types

centroid scan, 1-10
profile scan, 1-10

Scan LED
description, 2-8

Scan power
defined, 1-5

Scan types
defined, 1-6
full scan, 1-6
selected ion monitoring (SIM), 1-7
selected reaction monitoring (SRM), 1-8
single-stage full scan, 1-6
two-stage full scan, 1-7
ZoomScan, 1-9

Second octapole
location (figure), 4-24, 4-26, 5-24, 5-26

Selected ion monitoring (SIM)
defined, 1-7

Selected reaction monitoring (SRM)
defined, 1-8

Serial I/O PCB
replacing, 7-11

Service Relay PCB
description, 2-34

Service switch, 2-9
Sheath gas

on/off status (table), 6-16
pressure, 2-31

Sheath gas valve
description, 2-31

Shutdown
complete shutdown, 6-5
data system, 6-6
emergency procedure, 6-2
emergency, main power circuit breaker, 2-9
MS detector, 6-5

SIM, 1-7
Skimmer

description, 2-14
location (figure), 2-12, 4-16, 5-16

Skimmer lead pin
location (figure), 4-16, 5-16

Solvents
cleaning (note), 4-17, 5-17
disposal (warning), 4-4, 5-4
MS detector maintenance, 4-4, 5-4

solvents
purity requirements, 1-xx

Spacer rings, mass analyzer
description, 2-17
handling (caution), 4-28, 5-28
location (figure), 2-18, 4-27, 5-27

Split octapole
dc offset voltage, 2-14
description, 2-14

Spray cone
description, 2-13
location (figure), 2-12, 4-14, 4-19, 5-14, 5-19

Spray shield
cleaning, 4-18, 5-18
description, 2-13
flushing, 4-8, 5-8
location (figure), 2-12, 4-14, 4-16, 5-14, 5-16

Spring washers, mass analyzer
location (figure), 4-27, 5-27

SRM, 1-8
Standby condition

MS detector components on/off status, 6-16
placing system in, 6-4

Startup
autosampler, 6-8
data system, 6-7
LCQ-Series system, 6-7
liquid chromatograph, 6-7
MS detector, 6-7
operating conditions, setting, 6-9

Status view
displaying, 3-6
printing a hard copy of, 3-6

Supplies
MS detector maintenance, 4-4, 5-4

Support plates, electron multiplier
location (figure), 4-43, 5-43

Surge suppressor
description, 2-33

Switched Balun PCB
description, 2-41
fuses, replacing, 7-5
fuses, replacing (CAUTION), 7-5, 8-5
replacing, 7-15

Switching power supplies
description, 2-34
replacing, 7-8, 8-10

Syringe pump
description, 2-5
location (figure), 2-5
start/stop button, location (figure), 2-5
Syringe Pump dialog box, 2-5

Syringe pump LED
description, 2-5, 2-8
location (figure), 2-5

System Control PCB
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API source control, 2-37
Convectron gauge control circuitry, 2-37
conversion dynode control circuit, 2-37
dc voltage control, 2-36
description, 2-36
diagnostic circuitry, 2-37
divert/inject valve control, 2-36
electron multiplier control circuit, 2-37
embedded computer interface, 2-38
fuses, replacing, 7-5, 8-6
fuses, replacing (CAUTION), 7-5, 8-5
ion gauge control circuitry, 2-37
ion transfer capillary heater control circuit, 2-37
power supplies, 2-36
replacing, 7-21, 8-25
RF voltage control circuit, 2-37
temperature monitoring circuitry, 2-37
vacuum protection circuitry, 2-37
vaporizer heater control circuit, 2-37

System LED
description, 2-8
MS detector reset, 6-11
MS detector startup, 6-8

System shutdown
emergency procedure, 6-2
non-emergency procedure, 6-5

T
Tables

MS detector fuses, 7-5
MS detector maintenance procedures, 4-1, 5-1
on/off status of MS detector components, 6-16
pressure readings, 3-5
tools, equipment, and chemicals, 4-4, 5-4

Thermo Electron Finnigan
P4000 LC, 2-4
Surveyor LC, 2-4

Thermo Finnigan
service philosophy, 7-1, 8-1

Thermoe Electron Finnigan
P2000 LC, 2-4

Tools
MS detector maintenance, 4-4, 5-4
optional tools, 9-18, 10-18

Top cover of MS detector
reinstalling, 4-34, 5-34
removing, 4-22, 5-22

Top Cover PCB
description, 2-42
replacing, 7-15

Top cover plate of vacuum manifold
description, 2-28
figure, 2-28
reinstalling, 4-33, 5-33
removing, 4-22, 5-22
replaceable parts, 9-5, 10-5

Tower
location (figure), 7-9, 8-11
PCBs, replacing, 7-8, 8-10

Troubleshooting
diagnostics, 7-2, 8-2

Tube gate, 2-11
Tube lens

description, 2-13
location (figure), 2-12, 4-14, 4-16, 5-14, 5-16
on/off status (table), 6-16
voltages, 2-13

Tube lens and skimmer mount
description, 2-14
location (figure), 2-12, 4-14, 4-16, 5-14, 5-16

Tube lens lead pin
location (figure), 4-16, 5-16

Tune Plus window
opening, 2-5

Tuning
octapole RF voltage, 4-34, 5-34
ring electrode RF voltage, 4-34, 5-34
tube lens offset voltage, 2-13

Turbomolecular pump
description, 2-29
location (figure), 4-47, 5-46
maintenance, 4-46
oil reservoir, changing, 4-47
on/off status (table), 6-16
reinstalling, 4-48, 5-47
removing, 4-46, 5-45
replaceable parts, 9-5
replacing (note), 4-46
servicing (CAUTION), 7-8, 8-10

Turbomolecular Pump Controller
description, 2-40
replacing, 7-8, 8-10
servicing (CAUTION), 7-8, 8-10

Turbomolecular pump fan
servicing (CAUTION), 7-8, 8-10

Turbomolecular pump rails
location (figure), 4-47, 5-46

V
Vacuum assemblies

replaceable parts, 9-6, 10-6
Vacuum hose clamp

location (figure), 4-47, 5-46
Vacuum LED

description, 2-8
note, 6-8

Vacuum levels
checking, 3-4

Vacuum manifold
cleaning, 4-33, 5-33
description, 2-26
electrical feedthroughs, 2-28
interior (figure), 2-27
pressure readings (table), 3-5
top cover plate (figure), 4-23, 5-23
top cover plate, description, 2-28
top cover plate, reinstalling, 4-33, 5-33
top cover plate, removing, 4-22, 5-22

Vacuum protection
description, 2-37

Vacuum pumps
rotary-vane pump, 2-29
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turbomolecular pump, 2-29
turbomolecular pump, replacing (note), 4-46

Vacuum system
air leaks, 3-4
auxiliary gas valve, 2-31
battery backup, 2-30
checking pressure levels, 3-4
Convectron gauge, 2-30
damping gas valve, 2-31
description, 2-24
electronic assemblies, 2-38
function block diagram

LCQ Advantage MAX, 2-25
LCQ Deca XP MAX, 2-26

ion gauge, 2-30
LCQ Advantage MAX

electrical assemblies, block diagram, 2-39
LCQ Deca XP MAX

electrical assemblies, block diagram, 2-39
on/off status (table), 6-16
pressure readings, 3-5
replaceable parts, 9-6, 10-6
rotary-vane pump, 2-29
sheath gas valve, 2-31
turbomolecular pump, 2-29
Vacuum LED, 2-8
vacuum protection circuitry, 2-38
vent valve, 2-30

Valve accessories
replaceable parts, 9-17, 10-17

Vaporizer
heater control circuit, 2-37

Vent Delay PCB
description, 2-40
replacing, 7-13, 8-17
servicing (CAUTION), 7-8, 8-10

Vent prevent ball
location (figure), 2-12

Vent prevent ball valve
description, 2-13

Vent valve
battery backup, 2-30, 2-40
description, 2-30
open/closed status (table), 6-16
replacing, 7-13, 8-17
servicing (CAUTION), 7-8, 8-10
venting on power failure, 2-40

Voltages
conversion dynode, 2-22
electron multiplier, 4-44, 5-44

electron multiplier (cathode), 2-22
ESI needle, 2-34
interoctapole lens, 2-15
line power specifications, 2-33
mass analyzer dc offset voltage, 2-17
MS detector power supplies, 2-34
octapoles, 2-14
on/off status (table), 6-16
resonance ejection RF voltage, 2-20
resonance excitation RF voltage, 2-19
resonance voltage, 2-19
ring electrode RF voltage, 2-18
storage voltage, 2-19
tube lens, 2-14

W
Warning condition

description, 2-8
Power LED, 2-8

Waters Alliance
2690 LC, 2-4

Waveform Amplifier PCB
description, 2-41
replacing, 7-15, 8-20

Waveform DDS PCB
description, 2-41, 2-44
location (figure), 7-12, 8-16
replacing, 7-11

waveform DDS PCB
replacing, 8-15

Waveform voltages
description, 2-19
ion isolation waveform, description, 2-19

Wiring diagram
4-pin feedthroughs, 4-32, 5-32
8-pin feedthrough, 4-32, 5-32
exit lens, 4-32, 5-32
interoctapole lens, 4-32, 5-32
ion optics, 4-32, 5-32
mass analyzer, 4-32, 5-32
octapoles, 4-32, 5-32

Z
ZoomScan

defined, 1-9
for charge determination, 1-9
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